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Preface

This ninth edition of Digital Electronics: A Practical Approach with VHDL provides
the fundamentals of digital circuitry to students in engineering and technology curric-
ula. The digital circuits are introduced using fixed-function 7400 ICs and evolve into
FPGA (Field Programmable Gate Arrays) programmed with VHDL (VHSIC Hardware
Description Language). (Note: Those schools not wishing to develop logic using
VHDL and FPGAs can completely skip those sections of the textbook without affect-
ing the continuity of the remainder of the text, which describes logic design and imple-
mentation using 7400-series ICs.)

Coverage begins with the basic logic gates used to perform arithmetic operations
and proceeds through sequential logic and memory circuits used to interface to mod-
ern PCs. Professor Kleitz uses his vast experience of teaching electronics online and in
class from his best-selling textbooks to know what it takes for an entry-level student to
be brought up to speed in this emerging field. It was important to design this new text-
book to present practical examples, be easy to read, and provide all of the information
necessary for motivated students to teach themselves this new subject matter. This
makes it ideal for learning in an online environment as well as from conventional in-
class lectures.

Digital electronic ICs (integrated circuits) and FPGAs are the “brains” behind
common microprocessor-based systems such as those found in automobiles, personal
computers, and automated factory control systems. The most exciting recent develop-
ment in this field is that students now have the choice to design, simulate, and imple-
ment their circuits using a programming language called VHDL instead of wiring
individual gates and devices to achieve the required function.

Each topic area in this text consistently follows a very specific sequence of steps,
making the transition from problem definition, to practical example, to logic IC imple-
mentation, to VHDL and FPGA implementation. To accomplish this, the text first in-
troduces the theory of operation of the digital logic and then implements the design in
integrated circuit form (see Figure P—1). Once the fixed-function IC logic is thoroughly
explained, the next step is to implement the design as a graphic design file and then to
implement it using the VHDL hardware descriptive language, all within the free version
of the Altera Quartus® II development software. Several examples are used to bolster
the student’s understanding of the subject before moving on to system-level design and
troubleshooting applications of the logic. This step-by-step method has proven over the
years to be the most effective method to build the fundamental understanding of digital
electronics before proceeding to implement the logic design in VHDL.

The Altera Quartus® II software is a free download that allows students to either
graphically design their circuit by drawing the logic (using logic gates or 7400 macro-
functions) or use VHDL to define their logic. The design can then be simulated on a
PC before using the same software to download the logic to an FPGA on one of the
commercially available FPGA programmer boards, such as the Altera DE2 illustrated
in this text.
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Over 1,000 four-color illustrations are used to exemplify the operation of com-
plex circuit operations. Most of the illustrations contain annotations describing the in-
puts and outputs, and many have circuit operational notes. The VHDL program listings
are enriched with many annotations, providing a means for students to teach them-

selves the intricacies of the language (see Figure P-2).

Each chapter begins with an outline, objectives, and introduction and concludes
with review questions, summary, glossary, design and troubleshooting problems,

schematic interpretation problems, MultiSIM® problems, and FPGA problems.

BE® figs_13.vhd 0

Library LIBRARY ieee; Declare which VHDL
library to use

Declaration ~ L ys¢ jeee.std logic 1164.aLL;

ENTITY (Figh 13) 1S

Entity PORT(
declaration a, b: IH std_logic;
Xz 0UT std_logic);

Architecture
body

{RRBH]IEBTURE 0F (Figh_13) 15

%<=a AND\b: %Deﬁne the logic

[Gne 17 [Col 1 [INSi+l |

Figure P-2 A sample annotated VHDL program used to define logic in an FPGA.
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New to the Ninth Edition

The first eight editions were developed from an accumulation of 28 years of class
notes. Teaching online from the eighth edition for the past 3 years has given me the op-
portunity to review several suggestions from my students and other faculty regarding
such things as improving a circuit diagram, clarifying an explanation, and redesigning
an application to make it easier to duplicate in lab.

More than 140 schools have adopted the eighth edition. To write the ninth edition,
I have taken advantage of the comments from these schools as well as my own experi-
ence and market research to develop an even more practical and easier-to-learn-from
textbook. In addition to rewriting several of the examples and applications based on my
classroom and online teaching experience, I have added the following material:

* Greatly expanded coverage of programmable logic devices
* Steps involved in converting from 7400-series ICs to FPGAs

e Beginning- and intermediate-level VHDL programming taught by example
(Note: VHDL and FPGA coverage is optional, and its omission will not affect
the remainder of the text.)

* New basic and intermediate-level problem sets

* New MultiSIM® examples and problems to help facilitate online learning and
experimentation

* Real-world and ““green” applications
* Several new and revised annotated figures
* WWW references throughout

Chapter Organization

Basically, the text can be divided into two halves: Chapters 1 to 8 cover basic digital
logic and combinational logic, and Chapters 9 to 18 cover sequential logic and digi-
tal systems. Chapters 1 and 2 provide the procedures for converting between the var-
ious number systems and introduce the student to the electronic signals and switches
used in digital circuitry. Chapter 3 covers the basic logic gates and introduces the
student to timing analysis and troubleshooting techniques. Chapter 4 explains how to
implement designs using FPGAs. Chapter 5 shows how several of the basic gates can
be connected together to form combinational logic. Boolean algebra, De Morgan’s
theorem, VHDL programming, and Karnaugh mapping are used to reduce the logic
to its simplest form. Chapters 6, 7, and 8 discuss combinational logic used to provide
more advanced functions, such as parity checking, arithmetic operations, and code
converting.

The second half of this book begins with a discussion of the operating character-
istics and specifications of the TTL and CMOS logic families (Chapter 9). Chapter 10
introduces flip-flops and the concept of sequential timing analysis. Chapter 11 makes
the reader aware of the practical limitations of digital ICs and some common circuits
that are used in later chapters to facilitate the use of medium-scale ICs. Chapters 12
and 13 expose the student to the operation and use of several common medium-scale
ICs and their VHDL equivalents used to implement counter and shift register systems.
Chapter 14 deals with oscillator and timing circuits built with digital ICs and with the
555 timer IC. Chapter 15 teaches the theory behind analog and digital conversion
schemes and the practical implementation of ADC and DAC IC converters. Chapter 16
covers semiconductor, magnetic, and optical memory as they apply to PCs and mi-
croprocessor systems. Chapter 17 introduces microprocessor hardware and soft-
ware to form a bridge between digital electronics and a follow-up course in
microprocessors. Chapter 18 provides a working knowledge of one of today’s most
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popular microcontrollers, the 8051. The book concludes with several appendices used
to supplement the chapter material.

Prerequisites

Although not mandatory, it is helpful if students using this text have an understanding
of, or are concurrently enrolled in, a basic electricity course. Otherwise, all of the fun-
damental concepts of basic electricity required to complete this text are presented in
Appendix F.

Margin Annotations Icons

Several annotations are given in the page margins throughout the text. These are in-
tended to highlight particular points that were made on the page. They can be used as
the catalyst to develop a rapport between the instructor and the students and to initiate
online team discussions among the students. Four different icons are used to distin-
guish between the annotations.

Common Misconception: These annotations point out areas of digital electronics that
have typically been stumbling blocks for students and need careful attention. Pointing
out these potential problem areas helps students avoid making related mistakes.

Team Discussion: These annotations are questions that tend to initiate a discussion
about a particular topic. The instructor can use them as a means to develop cooperative
learning by encouraging student interaction.

Helpful Hint: These annotations offer suggestions for circuit analysis and highlight
critical topics presented in that area of the text. Students use these tips to gain insights
regarding important concepts.

Inside Your PC: These annotations are used to illustrate practical applications of the theory
in that section as it is applied inside a modern PC. This will help the student to understand
many of the terms used to describe the features that define the capability of a PC.

Basic Problem Sets

A key part of learning any technical subject matter is for the student to have practice solv-
ing problems of varying difficulty. The problems at the end of each chapter are grouped
together by section number. Within each section are several basic problems designed to
get the student to solve a problem using the fundamental information presented in the
chapter. In addition to the basic problems, there are three other problem types:

D (Design): Problems designated with the letter D ask the student to modify an
existing circuit or to design an original circuit to perform a specific task. This type of
exercise stimulates creative thinking and instills a feeling of accomplishment on suc-
cessful completion of a circuit design.

T (Troubleshooting): Problems designated with the letter 7 present the student
with a malfunctioning circuit to be diagnosed or ask for a procedure to follow to test
for proper circuit operation. This develops the student’s analytical skills and prepares
him or her for troubleshooting tasks that would typically be faced on the job.

C (Challenging): Problems designated with the letter C are the most challenging
to solve. They require a thorough understanding of the material covered and go a step
beyond by requiring the student to develop some of his or her own strategies to solve a
problem that is different from the examples presented in the chapter. This also expands
the student’s analytical skills and develops critical thinking techniques.

PREFACE
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MultiSIM® Examples and Problems

MultiSIM® (National Instruments) is a software simulation tool that is used to rein-
force the theory presented in each chapter. It provides an accurate simulation of digital
and analog circuit operations along with a simulation of instruments used by techni-
cians to measure IC, component, and circuit characteristics. With the purchase of this
software, you have the ability to build and test most of the circuits presented in this
text. This provides a great avenue for in-class as well as online experimentation.
Several MultiSIM® examples and problems are included within each chapter
(see Figure P-3). The textbook companion website provides all of the circuit files and
instructions needed to solve each circuit. There are three types of problems: (1) circuit
interaction problems require the student to change input values and take measurements
at the outputs to verify circuit operation, (2) design problems require the student to de-
sign, or modify, a circuit to perform a particular task, and (3) troubleshooting problems
require the student to find and fix the fault that exists in the circuit that is given.
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Figure P-3  Using MultiSIM® to determine the switching thresholds of an IC.

Schematic Interpretation Problems

These problems are designed to give the student experience interpreting circuits
and ICs in complete system schematic diagrams. The student is asked to identify
certain components in the diagram, describe their operation, modify circuit ele-
ments, and design new circuit interfaces. This gives the student experience work-
ing with real-world, large-scale schematics like the ones that he or she will see on
the job.
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FPGA Problems and Examples

Field Programmable Gate Array (FPGA) problems are included at the end of several
chapters. Designing digital logic with FPGAs is becoming very popular in situations
where high complexity and programmability are important. The FPGA problems use
the free downloadable Altera Quartus® II software to solve designs that were previ-
ously implemented using fixed-function 7400-series ICs. The student is asked to solve
the design using a graphic design approach as well as a VHDL solution. After compil-
ing the design, the student is then asked to perform a software simulation of the circuit
before downloading the implementation to an actual FPGA. This provides a great av-
enue for in-class as well as online experimentation. The Quartus project files for all
FPGA examples are provided at the textbook companion website.

VHDL Programming

The VHDL programming language has become a very important tool in the design of
digital systems. Throughout the text, digital design solutions are first done with fixed-
function 7400-series logic gates, and then the same solution is completed using the
VHDL hardware description language. It is important for today’s technician to be able
to read and modify VHDL programs as well as in some cases to write original pro-
grams to implement intermediate-level digital circuits.

Laboratory Experimentation

Giving the students the opportunity for hands-on laboratory experience is a very use-
ful component of any digital course. An important feature of this text is that there is
enough information given for any of the circuits so that they can be built and tested in
the lab and that you can be certain they will give the same response as shown in the
text. The lab exercises are best performed by first implementing the digital logic ex-
plained in the text using 7400-series fixed-function ICs, then repeating the same ex-
periment using the free Altera Quartus® II software. The Quartus® II software allows
you to draw the design using logic gates or by using 7400-series macrofunctions, or it
can be designed in the VHDL hardware description language. The software then al-
lows the student to visualize the operation on simulation waveforms before download-
ing the logic to an actual FPGA IC.

Altera Quartus” II Software

Altera Corporation, a leading supplier of FPGAs, supplies the design, simulation, and
programming software (Quartus® II) free on the world-wide web (see Figure P—4). It is
suggested that each school enroll in the Altera University Program at www.altera.com.
Enrollment ensures that the college will be kept up-to-date on the latest products and
software updates.

FPGA Programming Board

The final step in any FPGA design process is to implement the logic design in an ac-
tual FPGA by programming it with the supplied software. This lab experience is
achieved by downloading the design created by Quartus® II to an FPGA programming
board containing an actual FPGA. One programming board recommended for this
exercise is the DE-2 Development and Education Board by Altera (www.altera.com).
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Figure P-4 Altera Quartus® II opening screen. (Courtesy of Altera Corporation.)

Microprocessor Fundamentals

The “brains” behind most high-level digital systems is the microprocessor. The basic
understanding of microprocessor software and hardware is imperative for the techni-
cian to design and troubleshoot digital systems. Chapter 17 provides the fundamentals
of microprocessor software and hardware. Chapter 18 covers one of today’s work-
horses, the 8051. Its internal architecture, hardware interfacing, and software program-
ming are introduced and then demonstrated by solving several complete data-acquisition
applications.

To the Instructor: Teaching and Learning
Digital Electronics

I would like to share with you some teaching strategies that I've developed over the
past 25 years of teaching digital electronics. Needless to say, students have become
very excited about learning digital electronics because of the increasing popularity of
the digital computer and the expanding job opportunities for digital technicians and
engineers. Students are also attracted to the subject area because of the availability of
inexpensive digital ICs and FPGAs, which have enabled them to construct useful dig-
ital circuits in the lab or at home at a minimal cost.
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Student Projects: 1 always encourage the students to build some of the fundamental
building-block circuits that are presented in this text. The circuits that [ recommend are
the 5-V power supply in Figure 11-43, the 60-Hz pulse generator in Figure 11-44, the
cross-NAND switch debouncer in Figure 11-40, and the seven-segment LED display
in Figure 12-47. Having these circuits provides a starting point for the student to test
many of the other circuits in the text at his or her own pace, at home.

Team Discussions: As early as possible in the course, I take advantage of the Team
Discussion margin annotations. These are cooperative learning exercises through
which students are allowed to form teams, discuss the problem, and present their con-
clusion to the class in person or online. These activities give them a sense of team co-
operation and create a student network connection that will carry on throughout the
rest of their studies.

Circuit Illustrations: Almost every topic in the text has an illustration associated with
it. Because of the extensive art program, I normally lecture directly from illustration to
illustration. To do this, I project the figures using a document presentation camera or
PowerPoint®, with its pen feature. All figures and tables in the text are available in
PowerPoint® format for instructors adopting the text.

Testing: Rather than let a long period of time elapse between tests, I try to give a half-
hour quiz each week. Besides the daily homework, this forces the students to study at
least once per week. I also believe that it is appropriate to allow them to have a formula
sheet for the quiz or test (along with TTL or CMOS datasheets). This formula sheet
can contain anything they want to write on it. Making up the formula sheet is a good
way for them to study and eliminates a lot of routine memorization that they would not
normally have to do on the job.

The Learning Process: The student’s knowledge is generally developed by learning
the theory and the tools required to understand a particular topic, working through the
examples provided, answering the review questions at the end of each section, and
finally, solving the problems at the end of the chapter. I always encourage the students
to rework the solutions given in the examples without looking at the solutions in the
book until they are done. This gives them extra practice and a secure feeling of know-
ing that the detailed solution is right there at their disposal.

Online Course Presentation: This can be an ideal course to be taught in the online
format. First and most important, the text is very readable with no stone left unturned.
Each new concept is clearly presented so that students can teach themselves material that
the instructor assigns. Second, the text has several solved MultiSIM® and Quartus® I ex-
amples that students can use to simulate the circuit operation discussed in theory (these
circuit files are provided at the textbook companion website). Third, podcast lectures of
most of the textbook material are available at the textbook companion website. These
podcasts were created by me for my online students. Each chapter concludes with
MultiSIM® and Quartus® II problems that can be submitted in lieu of a hands-on lab.

Unique Learning Tools

Special features included in this textbook to enhance the learning and comprehension
process are as follows:

* FPGA solutions to common digital circuits are annotated and completely
explained.

* A step-by-step tutorial for using Quartus® II software explains design and
FPGA programming.
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« Over 100 MultiSIM® exercises are aimed at enhancing student understanding of
fundamental concepts, troubleshooting strategies, and circuit design procedures.

* Over 200 examples are worked out step-by-step to clarify problems that are
normally stumbling blocks.

e Over 1000 detailed illustrations with annotations give visual explanations and
serve as the basis for all discussions. Color operational notes are included on sev-
eral of the illustrations to describe the operation of a particular part of the figure.

* A full-color format provides a visual organization to the various parts of each
section.

* More than 1000 problems and questions are provided to enhance problem-
solving skills. A complete range of problems, from straightforward to very
challenging, is included.

* Troubleshooting applications and problems are used throughout the text to
teach testing and debugging procedures.

* Reference to manufacturers’ data sheets throughout the book provides a valu-
able experience with real-world problem solving.

* Timing waveforms are used throughout the text to illustrate the timing analy-
sis techniques used in industry and to give a graphical picture of the sequential
operations of digital ICs and FPGAs.

e Several tables of commercially used ICs provide a source for state-of-the-art
circuit design.

 Several photographs are included to illustrate specific devices and circuits dis-
cussed in the text.

* Performance-based objectives at the beginning of each chapter outline the
goals to be achieved.

* Review questions summarize each section and are answered to see that each
learning objective is met.

* A summary at the end of each chapter provides a review of the topics covered.

* A glossary at the end of each chapter serves as a summary of the terminology
just presented.

* A supplementary index of ICs provides a quick way to locate a particular IC
by number.

Extensive Supplements Package

An extensive package of supplementary material is available to aid in the teaching and
learning process (see Figure P-5).

* Online Instructor’s Resource Manual (ISBN 0132164639), containing solu-
tions and answers to in-text problems and solutions to the Laboratory Manual

e Online PowerPoint lecture notes for all chapters and all figures and tables
(ISBN 0132160862)

at: www.pearsonhighered.com/educator

i Download Instructor Resources
[ |

Figure P-5 Pearson Instructor Resource Center (for qualified instructors).
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* Laboratory Manual to provide hands-on laboratory experience and reinforce
the material presented in the textbook (ISBN 0132160870)

* Online TestGen, for producing customized tests and quizzes (ISBN 0132160846)

e Companion website, a student resource containing additional online multiple-
choice questions and other textbook-related links, found at
www.pearsonhighered.com/kleitz (see Figure P—6)

(a) National Instruments MultiSIM® circuit data files for each chapter
(b) Solutions to in-text Altera FPGA examples
(c) Podcast lectures and tutorials

To access supplementary materials online, instructors need to request an instructor
access code. Go to www.pearsonhighered.com/irc, where you can register for an
instructor access code. Within 48 hours after registering, you will receive a confirm-
ing e-mail, including an instructor access code. Once you have received your code,
go to the site and log on for full instructions on downloading the materials you wish
to use.

—  Download Textbook
Supplementary Material
L— 1 at:www.pearsonhighered.com/kleitz

Figure P-6 Textbook companion website containing supplementary questions, circuit data
files, and podcast lectures (for students and instructors).

To the Student: Getting the Most from This Textbook

Digital electronics is the foundation of computers and microprocessor-based systems
found in automobiles, industrial control systems, and home entertainment systems.
You are beginning your study of digital electronics at a good time. Technological ad-
vances made during the past 30 years have provided us with ICs that can perform com-
plex tasks with a minimum amount of abstract theory and complicated circuitry.
Before you are through this book, you’ll be developing exciting designs that you’ve
always wondered about but can now experience firsthand. The study of digital elec-
tronics also provides the prerequisite background for your future studies in micro-
processors and microcomputer interfacing. It also provides the job skills to become a
computer service technician, production test technician, or digital design technician
or to fill a multitude of other positions related to computer and microprocessor-based
systems.

This book is written as a learning tool, not just as a reference. The concept and
theory of each topic is presented first. Then an explanation of its operation is given.
This is followed by several worked-out examples and, in some cases, a system design
application. The review questions at the end of each chapter will force you to dig back
into the reading to see that you have met the learning objectives given at the beginning
of the chapter. The problems at the end of each chapter will require more analytical
reasoning, but the procedures for their solutions were already given to you in the ex-
amples. One good way to prepare for homework problems and tests is to cover up the
solutions to the examples and try to work them out yourself. If you get stuck, you’ve
got the answer and an explanation for the answer right there.
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You should also view my podcast lectures provided on the textbook companion
website. For circuit simulation, take advantage of your MultiSIM® and Quartus® I
software. The more practice you get, the easier the course will be. I wish you the best
of luck in your studies and future employment.

Professor Bill Kleitz
State University of New York—Tompkins Cortland
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Number Systems and Codes

OUTLINE
1-1 Digital versus Analog
1-2 Digital Representations of Analog Quantities
1-3 Decimal Numbering System (Base 10)
1-4 Binary Numbering System (Base 2)
1-5 Decimal-to-Binary Conversion
1-6 Octal Numbering System (Base 8)
1-7  Octal Conversions
1-8 Hexadecimal Numbering System (Base 16)
1-9 Hexadecimal Conversions

1-10 Binary-Coded-Decimal System

1-11 Comparison of Numbering Systems
1-12 The ASCII Code

1-13 Applications of the Numbering Systems

OBJECTIVES

Upon completion of this chapter, you should be able to do the following:

* Determine the weighting factor for each digit position in the decimal, binary,
octal, and hexadecimal numbering systems.

* Convert any number in one of the four number systems (decimal, binary, octal,
and hexadecimal) to its equivalent value in any of the remaining three numbering
systems.

* Describe the format and use of binary-coded decimal (BCD) numbers.

* Determine the ASCII code for any alphanumeric data by using the ASCII code
translation table.




INTRODUCTION

Digital circuitry is the foundation of digital computers and many automated control
systems. In a modern home, digital circuitry controls the appliances, alarm systems,
and heating systems. Under the control of digital circuitry and microprocessors, newer
automobiles have added safety features, are more energy efficient, and are easier to
diagnose and correct when malfunctions arise.

Other uses of digital circuitry include the areas of automated machine control,
energy monitoring and control, inventory management, medical electronics, and music.
For example, the numerically controlled (NC) milling machine can be programmed by
a production engineer to mill a piece of stock material to prespecified dimensions with
very accurate repeatability, within 0.01% accuracy. Another use is energy monitoring
and control. With the high cost of energy, it is very important for large industrial and
commercial users to monitor the energy flows within their buildings. Effective control
of heating, ventilating, and air-conditioning can reduce energy bills significantly. More
and more grocery stores are using the universal product code (UPC) to check out and
total the sale of grocery orders as well as to control inventory and replenish stock auto-
matically. The area of medical electronics uses digital thermometers, life-support sys-
tems, and monitors. We have also seen more use of digital electronics in the reproduction
of music. Digital reproduction is less susceptible to electrostatic noise and therefore
can reproduce music with greater fidelity.

Digital electronics evolved from the principle that transistor circuitry could eas-
ily be fabricated and designed to output one of two voltage levels based on the levels
placed at its inputs. The two distinct levels (usually +5 volts [V] and 0 V) are HIGH
and LOW and can be represented by 1 and 0.

The binary numbering system is made up of only 1s and Os and is therefore used
extensively in digital electronics. The other numbering systems and codes covered in
this chapter represent groups of binary digits and therefore are also widely used.

1-1 Digital versus Analog

Digital systems operate on discrete digits that represent numbers, letters, or symbols.
They deal strictly with ON and OFF states, which we can represent by Os and 1s.
Analog systems measure and respond to continuously varying electrical or physical
magnitudes. Analog devices are integrated electronically into systems to continuously
monitor and control such quantities as temperature, pressure, velocity, and position
and to provide automated control based on the levels of these quantities. Figure 1-1
shows some examples of digital and analog quantities.

Review Questions*

1-1. List three examples of analog quantities.

1-2. Why do computer systems deal with digital quantities instead of
analog quantities?

1-2 Digital Representations of Analog Quantities
Most naturally occurring physical quantities in our world are analog in nature. An

analog signal is a continuously variable electrical or physical quantity. Think about a
mercury-filled tube thermometer; as the temperature rises, the mercury expands in

*Answers to Review Questions are found at the end of each chapter.
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Figure 1-1 Analog versus digital: (a) analog waveform; (b) digital waveform;
(c) analog watch; (d) digital watch.

analog fashion and makes a smooth, continuous motion relative to a scale measured in
degrees. A baseball player swings a bat in an analog motion. The velocity and force
with which a musician strikes a piano key are analog in nature. Even the resulting vi-
bration of the piano string is an analog, sinusoidal vibration.

So why do we need to use digital representations in a world that is naturally analog?
The answer is that if we want an electronic machine to interpret, communicate, process,
and store analog information, it is much easier for the machine to handle it if we first
convert the information to a digital format. A digital value is represented by a combi-
nation of ON and OFF voltage levels that are written as a string of 1s and Os.

For example, an analog thermometer that registers 72°F can be represented in a
digital circuit as a series of ON and OFF voltage levels. (We’ll learn later that the
number 72 converted to digital levels is 0100 1000.) The convenient feature of using
ON/OFF voltage levels is that the circuitry used to generate, manipulate, and store them
is very simple. Instead of dealing with the infinite span and intervals of analog voltage
levels, all we need to use is ON or OFF voltages (usually +5 V=0ON and 0 V = OFF).

A good example of the use of a digital representation of an analog quantity is the
audio recording of music. Compact disks (CDs) and digital versatile disks (DVDs) are
commonplace and are proving to be superior means of recording and playing back
music. Musical instruments and the human voice produce analog signals, and the
human ear naturally responds to analog signals. So, where does the digital format fit
in? Although the process requires what appears to be extra work, the recording indus-
tries convert analog signals to a digital format and then store the information on a CD
or DVD. The CD or DVD player then converts the digital levels back to their corre-
sponding analog signals before playing them back for the human ear.

To accurately represent a complex musical signal as a digital string (a series
of 1s and 0Os), several samples of an analog signal must be taken, as shown in

CHAPTER 1 | NUMBER SYSTEMS AND CODES
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Figure 1-2 (a) Digital representation of three data points on an analog waveform;
(b) converting a 2-V analog voltage into a digital output string.

CD recorder Audio
amplifier
(A-to-D
conversion) (Analog)
CD player Analog
sound
(D-to-A
conversion)
CD
(Digital)

*Figure 1-3  The process of converting analog sound to digital and then back to analog.

Figure 1-2(a). The first conversion illustrated is at a point on the rising portion of the ana-
log signal. At that point, the analog voltage is 2 V. Two volts are converted to the digital
string 0000 0010, as shown in Figure 1-2(b). The next conversion is taken as the analog
signal in Figure 1-2(a) is still rising, and the third is taken at its highest level. This process
continues throughout the entire piece of music to be recorded. To play back the music, the
process is reversed. Digital-to-analog conversions are made to recreate the original analog
signal (see Figure 1-3). If a high-enough number of samples are taken of the original ana-
log signal, an almost-exact reproduction of the original music can be made.

*For additional information on A-to-D and D-to-A be sure to view the podcasts provided on the textbook website
www.pearsonhighered.com/kleitz.

SECTION 1-2 | DIGITAL REPRESENTATIONS OF ANALOG QUANTITIES

»' Helpful

Hint
One of the more interesting
uses of analog-to-digital
(A-to-D) and digital-to-
analog (D-to-A) conversion
is in CD audio systems.
Also, several A-to-D and
D-to-A examples are given
in Chapter 15.

Inside
Your PC

A typical 4-minute song
requires as many as

300 million ON/OFF
digital levels (bits) to be
represented accurately. To
be transmitted efficiently
over the Internet, data
compression schemes such
as the MP3 standard are
employed to reduce the
number of bits 10-fold.
(For information about
specifications, visit the
MP3 Web site listed in
Appendix A.)

Inside
Your PC

The CD player uses the
optics of a laser beam to
look for pits or nonpits on
the CD as it spins beneath
it. These pits, which are
burned into the CD by the
CD recorder, represent the
1s and 0s of the digital
information the player
needs to recreate the
original data. A CD
contains up to 650 million
bytes of digital 1s and 0s
(1 byte = 8 bits).

Another optical storage
medium is the digital
versatile disk (DVD).

A DVD is much denser
than a CD. It can hold up
to 17 billion bytes of data!
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It certainly is extra work, but digital recordings have virtually eliminated prob-
lems such as electrostatic noise and the magnetic tape hiss associated with earlier
methods of audio recording. These problems have been eradicated because, when im-
perfections are introduced to a digital signal, the slight variation in the digital level
does not change an ON level to an OFF level, whereas a slight change in an analog
level is easily picked up by the human ear as shown in Figure 1-4.

Analog irregularities
will be heard by the
human ear Still looks

like an OFF
Still looks
like an ON

1A

Time Time

() (b)

Voltage
Voltage

Figure 1-4 Adding unwanted electrostatic noise to (a) an analog waveform and
(b) a digital waveform.

Another application of digital representations of analog quantities is data log-
ging of alternative energy sources. It is very important for energy technicians to keep
track of the efficiency of their energy-collection systems. In the case of the solar-
collection system shown in Figures 1-5(a) and (b), system efficiency can be deter-
mined by dividing the number of watts produced by the solar photovoltaic (PV)
panels by the total solar energy (irradiance) striking the panels. However, since all
naturally occurring quantities like solar, wind, temperature, and pressure are analog
values, we need to convert them to a digital representation before they can be under-
stood by a computer system.

Solar energy Data Printer
values to be logger Personal (spreadsheet
measured system USB computer USB b raph)
(Analog) (detail below) |(Digital) (Digital) S
(a)
Data logger subsystem
Real-time
clock
M
Solar panel 0 — 111
| L) — — Paralleldata [l 5 (5
Solar panel 1 } Analog-to- |—1 Database |—|  bus-to- output
Solar panel 2 — p digital management serial USB
Solar panel 3 — M 1 converter | andstorage [_| converter
olar pane i e — (shift register)
€
r

Solar pyranometer —

(5 analog inputs)

~

b)

Figure 1-5 Solar radiation data-logger system: (a) system block diagram; (b) data logger
subsystem.
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In Figure 1-5(a) there are five analog solar quantities input to a data-logging sys-
tem. The data logger digitizes these values and outputs them as a data stream in the
USB (Universal Serial Bus) format to a personal computer, which can then be used to
analyze the data via a spreadsheet to determine efficiency.

The details of the data-logging system are shown in Figure 1-5(b). It shows the
input to the system as four solar PV panels and one solar pyranometer. The pyranome-
ter is used to measure the solar energy striking the earth at that location in watts-per-
meter”. As the solar PV panels convert sunlight to power (watts), each panel also
provides an analog voltage that is proportional to the watts produced. These four ana-
log values are connected to a multiplexer (covered in Chapter 8), which alternately
routes each of the analog quantities, one at a time, to the analog-to-digital converter
(ADC). (ADCs are covered in Chapter 15.) As each value is received, the ADC outputs
its equivalent as an 8-bit digital number (8-, 10-, 12- and higher-bit ADC converters are
available). These data need to be time-stamped to help the technician keep track of
efficiency at different times of the day and other modifications he or she may have made
to the panels during the day. A digital real-time clock circuit provides this time stamp.
(Clocks and timing oscillators are covered in Chapters 12 and 14.)

Finally, before the data logger can communicate to the PC, the digital data which
are now in “parallel” format must be converted to “serial” format to comply with the
USB standard used by PCs. (Serial and parallel data methods are covered in Chapter
2.) This parallel-to-serial conversion is made by a shift register similar to those dis-
cussed in Chapter 13. The following sections teach you how to develop and interpret
these binary codes that are used in digital systems.

Review Questions

1-3. Complete the following sentences with the word analog or digital:

a) Wind speed is an example of a(an) quantity?

b) A music CD contains information?

¢) A USB connector transmits data?

d) Hourly outdoor air temperatures exhibit variations?

1-4. An automobile speedometer display is (digital, analog, or could be
either)

1-5. An analog-to-digital converter outputs an analog voltage. True or
false?

1-6. A music CD player is an example of a(n) (ADC or DAC) process?

1-7. Electrostatic noise causes more of a problem with which type of sig-
nal (analog or digital). Why?

1-8. Figure 1-5 implies that the internal circuitry of a PC can only work
on (digital, analog) signals?

1-9. What is the purpose of the multiplexer in Figure 1-5(b)?
1-10. What is the purpose of the shift register in Figure 1-5(b)?

1-3  Decimal Numbering System (Base 10)
In the decimal numbering system, each position contains 10 different possible digits.

These digits are 0, 1,2, 3,4, 5, 6,7, 8, and 9. Each position in a multidigit number will
have a weighting factor based on a power of 10.

SECTION 1-3 | DECIMAL NUMBERING SYSTEM (BASE 10)



EXAMPLE 1-1

In a four-digit decimal number, the least significant position (rightmost)
has a weighting factor of 10% the most significant position (leftmost) has a
weighting factor of 10%:

10° 10? 10" 10°

where  10° = 1000

10> =100
10' =10
10°=1

To evaluate the decimal number 4623, the digit in each position is
multiplied by the appropriate weighting factor:

4 6 2 3
| 3% 100 = 3
2 X 10" = 20
6 X 10> = 600

4 X 10° = 44000
4623 Answer

Example 1-1 illustrates the procedure used to convert from some number sys-
tem to its decimal (base 10) equivalent. (In the example, we converted a base 10 num-
ber to a base 10 answer.) Now let’s look at base 2 (binary), base 8 (octal), and base 16
(hexadecimal).

1-4  Binary Numbering System (Base 2)

Digital electronics use the binary numbering system because it uses only the digits 0
and 1, which can be represented simply in a digital system by two distinct voltage lev-
els,suchas+5V=1and 0 V=0.

The weighting factors for binary positions are the powers of 2 shown in Table 1-1.

TABLE 1-1 | Powers-of-2 Binary Weighting Factors

20 = 1
2= 2
(128 |64 (32 16 | 8 | 4 2 1 22 = 4
—_— " 2= 3
27 26 23 24 23 2 b 20 2= g
2= 32
20 = 64
27 =128
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EXAMPLE 1-2

Convert the binary number 01010110, to decimal. (Notice the subscript 2
used to indicate that 01010110 is a base 2 number. A capital letter B can
also be used, i.e., 01010110B.)

Solution: Multiply each binary digit by the appropriate weight factor and
total the results.

128 64 32 16 8 4 2 1
0O 1 0 10110

L————mxﬁzo

1 x2l= 2

1 x22= 4

0x22= 0

1 xX2*=16

0xX2= 0

1 X 20 =64

0ox2"=0

861y Answer

Although seldom used in digital systems, binary weighting for values less than 1
is possible (fractional binary numbers). These factors are developed by successively
dividing the weighting factor by 2 for each decrease in the power of 2. This is also use-
ful to illustrate why 2° is equal to 1, not zero (see Figure 1-6).

2’=38 \;2
2?=4 —
\+2
2'=2 —
\+2
2= —

Figure 1-6 Successive division by 2 to develop fractional binary weighting factors and
show that 2° is equal to 1.

SECTION 1-4 | BINARY NUMBERING SYSTEM (BASE 2)



10

1-5

EX

AMPLE 1-3

Convert the fractional binary number 1011.1010, to decimal.

Solution: Multiply each binary digit by the appropriate weighting factor
given in Figure 1-6, and total the results. (We skip the multiplication for
the binary digit O because it does not contribute to the total.)

1 011 .1010
|—.1><2—3=0.125
1 x 271 =0.500

1 x2° =1

1 x2' =2

1 x2 =38

11.625,, Answer

Review Questions
1-11. Why is the binary numbering system commonly used in digital
electronics?

1-12. How are the weighting factors determined for each binary position
in a base 2 number?

1-13. Convert 0110 1100, to decimal.
1-14. Convert 1101.0110, to decimal.

Decimal-to-Binary Conversion

The conversion from binary to decimal is usually performed by the digital computer
for ease of interpretation by the person reading the number. Conversely, when a person
enters a decimal number into a digital computer, that number must be converted to bi-
nary before it can be operated on. Let’s look at decimal-to-binary conversion.

EX

AMPLE 1-4

Convert 133, to binary.

Solution: Referring to Table 1-1, we can see that the largest power of 2
that will fit into 133 is 27 (27 = 128), but that will still leave the value
5(133 — 128 = 5) to be accounted for. Five can be taken care of by 2% and
20 (22=4,2%=1). So the process looks like this:

133 $1,0,0 0,0 414041
_@_)%7 |%7|26|25|24|23|22|21|20|
5
_74_)22
1
_71_)20
0

CHAPTER 1 | NUMBER SYSTEMS AND CODES



Answer: 10000101,

Note: The powers of 2 needed to give the number 133 were first deter-
mined. Then all other positions were filled with zeros.

EXAMPLE 1-

5

Convert 122, to binary.

Solution:

122
_@ N 26
L

0

1 1.1 1 O

1

0

27 26 25 24 23 22 ol 20
A

58

_2_)25

26

—m—>24

10

— 23

— 2!

|
o oo o

Answer: 0 1 1 1101 0,

Another method of converting decimal to binary is by successive division.
Successive division involves dividing repeatedly by the number of the base to which
you are converting. Continue the process until the answer is 0. For example, to convert
122, to base 2, use the following procedure:

122 = 2 =61
61 ~ 2 =30
30 - 2=15
15 +2=7
7+2=3
3+2=1
1+2=0

with a remainder of 0 (LSB)

with a remainder of 1
with a remainder of O
with a remainder of 1
with a remainder of 1
with a remainder of 1
with a remainder of 1

(MSB)

The first remainder, 0, is the least significant bit (LSB) of the answer; the last
remainder, 1, is the most significant bit (MSB) of the answer. Therefore, the answer

is as follows:

LSB

1111010,

However, because most computers or digital systems deal with groups of 4, 8, 16,
or 32 bits (binary digits), we should keep all our answers in that form. Adding a lead-
ing zero to the number 1 1 1 1 0 1 0, will not change its numeric value; therefore, the

8-bit answer is as follows:

1111010,=01111010,

SECTION 1-5 | DECIMAL-TO-BINARY CONVERSION

.' Helpful

Hint
This is a good time to
realize that a useful way to
learn new material like this
is to re-solve the examples
with the solutions covered
up. That way, when you
have a problem, you can
uncover the solution and
see the correct procedure.

11



>4 | Common
Misconception

Remember not to reverse
the LSB and MSB when
listing the binary answer.

12

EXAMPLE 1-6

Convert 152, to binary using successive division.

Solution:
152 = 2 =76 remainder0 (LSB)

76 + 2 = 38 remainder (0
38 ~ 2 =19 remainder0
19 = 2 =9 remainder |
+ 2 =4 remainder 1
2 =2 remainder 0
= 2 =1 remainder 0
= 2 =0 remainderl (MSB)

Answer: 10011000,

— N B~ O
|

Review Questions

1-15. Convert 43, to binary.
1-16. Convert 170, to binary.

1-6  Octal Numbering System (Base 8)

The octal numbering system is a method of grouping binary numbers in groups of
three. The eight allowable digits are 0, 1, 2, 3,4, 5, 6, and 7.

The octal numbering system is used by manufacturers of computers that utilize
3-bit codes to indicate instructions or operations to be performed. By using the octal
representation instead of binary, the user can simplify the task of entering or reading
computer instructions and thus save time.

In Table 1-2, we see that when the octal number exceeds 7, the least significant
octal position resets to zero and the next most significant position increases by 1.

TABLE 1-2 | Octal Numbering System

Decimal Binary Octal

000 0
001 1
010 2
011 3
100 4
101 5
110 6
111 7
1000 10
1001 11
1010 12

SO WN R WN—O

—

1-7  Octal Conversions
Converting from binary to octal is simply a matter of grouping the binary positions in

groups of three (starting at the least significant position) and writing down the octal
equivalent.

CHAPTER 1 | NUMBER SYSTEMS AND CODES



EXAMPLE 1-7

ConvertO 1 1 1 0 1, to octal.

Solution:
011 101
o
3 5 = 353 Answer

EXAMPLE 1-8

Convert1 0 1 1 1 0 0 1, to octal.

Solution:

111 001,

10
add a leading zero
-
010
< —
2 7 1

To convert octal to binary, you reverse the process.

= 271y Answer

EXAMPLE 1-9

Convert 6 2 44 to binary.

Solution:

110 010 100=110010100, Answer

To convert from octal to decimal, follow a process similar to that in Section 1-3
(multiply by weighting factors).

EXAMPLE 1-10 (~
.' Helpful
Hint

Convert 3 2 64 to decimal.

Solution: When converting from
octal to decimal, some

3 26 students find it easier to

0 _ _ convert to binary first and
6 X8 =06X 1= 6 then convert binary to
2x8=2x 8= 16 decimal.

3X 8 =3X64=192
214,y Answer

SECTION 1-7 | OCTAL CONVERSIONS 13
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To convert from decimal to octal, the successive-division procedure can be
used.

EXAMPLE 1-11

Convert4 8 6, to octal.

Solution:
486 ~ 8 = 60 remainder 6
60 ~ 8 = 7 remainder 4 7464
7 - 8= 0 remainder 7
486,y = 7463 Answer
Check:
7 4 6
|—» 6x8= 6
4x8 = 32
7 X 8% = 448
486

Review Questions

1-17. The only digits allowed in the octal numbering system are O to 8.
True or false?

1-18. Convert 111011, to octal.
1-19. Convert 2634 to binary.
1-20. Convert 6144 to decimal.

1-21. Convert 90, to octal.

1-8  Hexadecimal Numbering System (Base 16)

The hexadecimal numbering system, like the octal system, is a method of grouping
bits to simplify entering and reading the instructions or data present in digital computer
systems. Hexadecimal uses 4-bit groupings; therefore, instructions or data used in 8-,
16-, or 32-bit computer systems can be represented as a two-, four-, or eight-digit hexa-
decimal code instead of using a long string of binary digits (see Table 1-3).

Hexadecimal (hex) uses 16 different digits and is a method of grouping binary
numbers in groups of four. Because hex digits must be represented by a single charac-
ter, letters are chosen to represent values greater than 9. The 16 allowable hex digits are
0,1,2,3,4,5,6,7,8,9,A,B,C,D,E, and F.

To signify a hex number, a subscript 16 or the letter H is used (that is, A7,4 or
ATH). Two hex digits are used to represent 8 bits (also known as a byte). Four bits (one
hex digit) are sometimes called a nibble.

CHAPTER 1 | NUMBER SYSTEMS AND CODES



TABLE 1-3 | Hexadecimal Numbering System

Decimal Binary Hexadecimal
0 0000 0
1 0001 1
2 0010 2
3 0011 3
4 0100 4
5 0101 5
6 0110 6
7 0111 7
8 1000 8
9 1001 9
10 1010 A
11 1011 B
12 1100 C
13 1101 D
14 1110 E
15 1111 F
16 0001 0000 10
17 0001 0001 11
18 0001 0010 12
19 0001 0011 13

20 0001 0100 14

1-9 Hexadecimal Conversions

To convert from binary to hexadecimal, group the binary number in groups of four
(starting in the least significant position) and write down the equivalent hex digit.

EXAMPLE 1-12

Convert 01101101, to hex.

Solution:

0110 1101,
—_———  ——
6 D = 6D, Answer

To convert hexadecimal to binary, use the reverse process.

EXAMPLE 1-13

Convert A9 to binary.

Solution:
A 9

—— —
1010 100 1=10101001, Answer

SECTION 1-9 | HEXADECIMAL CONVERSIONS



»' Helpful

Hint
When converting from
hexadecimal to decimal,
some students find it easier
to convert to binary first

and then to convert binary
to decimal.

ﬁ Helpful

Hint

At this point, you may be
asking if you can use your
hex calculator key instead
of the hand procedure to
perform these conversions.
It is important to master

these conversion procedures

before depending on your
calculator so that you
understand the concepts
involved.

Team
Discussion

Which is the largest
number—142g, 142, or
14244?
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To convert hexadecimal to decimal, use a process similar to that in Section 1-3.

EXAMPLE 1-14

Convert 2 A 6,4 to decimal.

L L6 x16°= 6x 1= 6
A X 16! =10 X 16 = 160
2 X 16> = 2 X 256 =512

678,y Answer

Solution:

EXAMPLE 1-15

Redo Example 1-14 by converting first to binary and then to decimal.

Solution:

0010 1010 0110 = 2 + 4+ 32 + 128 + 512 = 678,y Answer

To convert from decimal to hexadecimal, use successive division. (Note:
Successive division can always be used when converting from base 10 to any other
base numbering system.)

EXAMPLE 1-16

Convert 151 to hex.

Solution:
151 = 16 = 9 remainder 7 (LSD)
9 +~ 16 =0 remainder 9 (MSD)
1510 = 97,4 Answer
Check:
7X16°= 7
9 X 16! = 144
151
EXAMPLE 1-17
Convert 498, to hex.
Solution:
498 +~ 16 = 31 remainder 2 (LSD)
31 + 16 = 1 remainder 15 ( =F)
1 =+ 16 = 0 remainder 1 (MSD)

498, =1 F 2,4 Answer
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Check:
1F2¢ 2X16°= 2%x 1= 2

F X 16' = 15 X 61 = 240
1 X 16> = 1 X 256 = 256
498

Review Questions
1-22. Why is hexadecimal used instead of the octal numbering system
when working with 8- and 16-bit digital computers?

1-23. The successive-division method can be used whenever converting
from base 10 to any other base numbering system. True or false?

1-24. Convert 0110 1011, to hex.
1-25. Convert E7,¢4 to binary.
1-26. Convert 16C,4 to decimal.
1-27. Convert 300, to hex.

1-10 Binary-Coded-Decimal System

The binary-coded-decimal (BCD) system is used to represent each of the 10
decimal digits as a 4-bit binary code. This code is useful for outputting to displays
that are always numeric (0 to 9), such as those found in digital clocks or digital
voltmeters.

To form a BCD number, simply convert each decimal digit to its 4-bit binary
code.

EXAMPLE 1-18

Convert4 9 6,,to BCD.
Solution:

4 9 6

—_——

0100 1001 0110 = 0100 1001 O110gcp Answer

To convert BCD to decimal, just reverse the process.

EXAMPLE 1-19

Convert 0111 0101 1000gcp to decimal.

Solution:
0111 0101 1000
—_— Y= Y=
7 5 8 = 758,y Answer

SECTION 1-10 | BINARY-CODED-DECIMAL SYSTEM
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EXAMPLE 1-20

Convert 0110 0100 1011pcp to decimal.
Solution:
0110 0100 1011
6 4 *

*This conversion is impossible because 1011 is not a valid binary-coded decimal. It is not in the range 0 to 9.

1-11 Comparison of Numbering Systems

Table 1-4 compares numbers written in the five number systems commonly used in
digital electronics and computer systems.

TABLE 1-4 | Comparison of Numbering Systems

Decimal Binary Octal Hexadecimal BCD
0 0000 0 0 0000
1 0001 1 1 0001
2 0010 2 2 0010
3 0011 3 3 0011
4 0100 4 4 0100
5 0101 5 5 0101
6 0110 6 6 0110
7 0111 7 7 0111
8 1000 10 8 1000
9 1001 11 9 1001
10 1010 12 A 0001 0000
11 1011 13 B 0001 0001
12 1100 14 C 0001 0010
13 1101 15 D 0001 0011
14 1110 16 E 0001 0100
15 1111 17 F 0001 0101
16 0001 0000 20 10 0001 0110
17 0001 0001 21 11 0001 0111
18 0001 0010 22 12 0001 1000
19 0001 0011 23 13 0001 1001
20 0001 0100 2 4 14 0010 0000

1-12 The ASCII Code

To get information into and out of a computer, we need more than just numeric repre-
sentations; we also have to take care of all the letters and symbols used in day-to-day
processing. Information such as names, addresses, and item descriptions must be input
and output in a readable format. But remember that a digital system can deal only with
1s and Os. Therefore, we need a special code to represent all alphanumeric data (letters,
symbols, and numbers).

Most industry has settled on an input/output (I/O) code called the American
Standard Code for Information Interchange (ASCII). The ASCII code uses 7 bits to
represent all the alphanumeric data used in computer I/O. Seven bits will yield 128 dif-
ferent code combinations, as listed in Table 1-5.
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TABLE 1-5 | American Standard Code for Information Interchange

MSB
LSB 000 001 010 011 100 101 110 111
0000 NUL DLE SP 0 @ P ! p
0001 SOH DC, ! 1 A Q a q
0010 STX DC, » 2 B R b r
0011 ETX DG, # 3 C S c S
0100 EOT DCy $ 4 D T d t
0101 ENQ NAK % 5 E U e u
0110 ACK SYN & 6 F v f v
0111 BEL ETB ! 7 G W g w
1000 BS CAN ( 8 H X h X
1001 HT EM ) 9 I Y i y
1010 LF SUB * : J Z J v
1011 VT ESC + ; K [ k {
1100 FF FS s < L \ 1 |
1101 CR GS - = M ] m }
1110 SO RS : > N ) n ~
1111 SI [N} / ? (0) — o DEL
Definitions of control abbreviations: FS Form separator
ACK Acknowledge GS Group separator
BEL Bell HT Horizontal tab
BS Backspace LF Line feed
CAN Cancel NAK Negative acknowledge
CR Carriage return NUL Null
DC,-DC, Direct control RS Record separator
DEL Delete idle SI Shift in
DLE Data link escape SO Shift out
EM End of medium SOH Start of heading
ENQ Enquiry SP Space
EOT End of transmission STX Start text
ESC Escape SUB Substitute
ETB End of transmission block SYN Synchronous idle
ETX End text [N} Unit separator
FF Form feed VT Vertical tab

Each time a key is depressed on an ASCII keyboard, that key is converted into

its ASCII code and processed by the computer. Then, before outputting the computer
contents to a display terminal or printer, all information is converted from ASCII into
standard English.

To use the table, place the 4-bit group in the least significant positions and the

3-bit group in the most significant positions.

EXAMPLE 1-21

100 0111 is the code for G.
AN

3-bit group  4-bit group

EXAMPLE 1-22

Using Table 1-5, determine the ASCII code for the lowercase letter p.

Solution: 1110000 (Note: Often, a leading zero is added to form an 8-bit
result, making p = 0111 0000.)

SECTION 1-12 | THE ASCII CODE

Team
Discussion

Have you ever tried display-
ing non-ASCII data to your
PC screen using a disk util-
ity program? If you were to
read a file created by the
IRS for your tax return,
which fields would be
ASCII?
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Review Questions

1-28. How does BCD differ from the base 2 binary numbering system?
1-29. Why is ASCII code required by digital computer systems?

1-30. Convert 947, to BCD.

1-31. Convert 1000 0110 0111pcp to decimal.

1-32. Determine the ASCII code for the letter E.

1-13 Applications of the Numbering Systems

Because digital systems work mainly with 1s and Os, we have spent considerable time
working with the various number systems. Which system is used depends on how the
data were developed and how they are to be used. In this section, we work with
several applications that depend on the translation and interpretation of these digital
representations.

APPLICATION 1-1

A geothermal electricity generation facility uses a computer to monitor the
temperature and pressure of four liquid storage tanks, as shown in Figure
1-7(a). Whenever a temperature or a pressure exceeds the danger limit, an
internal tank sensor applies a 1 to its corresponding output to the computer.
If all conditions are OK, then all outputs are 0.

'l
L Helpful Tarkt Tank Tank Tarl}

Hint D C B A
This and the following five P P P P
applications illustrate the T T T T

answer to the common
student question, “Why are
we learning this stuff?”

1

PD ’TI) PC ’T( PB 'l-li PA T—\

Computer

monitoring
system

(@)
|PDITI)IPCIT('IPBITBIPAITkl

M L P = pressure sensor
S S T = temperature sensor
B B

(b)

Figure 1-7 (a) Circuit connections for temperature and pressure monitors at a
geothermal electricity generation facility; (b) layout of binary data read by the
computer monitoring system.

(a) If the computer reads the binary string 0010 1000, what problems exist?

Solution: Entering that binary string into the chart of Figure 1-7(b) shows
us that the pressure in tanks C and B is dangerously high.
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(b) What problems exist if the computer is reading 55H (55 hex)?
Solution: 55H = 0101 0101, meaning that all temperatures are too high

(¢) What hexadecimal number is read by the computer if the temperature
and pressure in both tanks D and B are high?

Solution: CCH (1100 1100 = CCH)

(d) Tanks A and B are taken out of use, and their sensor outputs are con-
nected to 1s. A computer programmer must write a program to ignore these
new circuit conditions. The computer program must check that the value
read is always less than what decimal equivalent when no problem exists?

Solution: <31,,, because, with the 4 low-order bits HIGH, if TC goes
HIGH, then the binary string will be 0001 1111, which is equal to 31,

(e) In another area of the plant, only three tanks (A, B, and C) have to be
monitored. What octal number is read if tank B has a high temperature
and pressure?

Solution: 144 (001 100, = 14y)

APPLICATION 1-2

A particular brand of CD player has the capability of converting 12-bit sig-
nals from a CD into their equivalent analog values.

(a) What are the largest and smallest hex values that can be used in this
CD system?

Solution: Largest: FFF ¢; smallest: 0004
(b) How many different analog values can be represented by this system?

Solution: FFF4 is equivalent to 4095 in decimal. Including 0, this is a
total of 4096 unique representations.

APPLICATION 1-3

Typically, digital thermometers use BCD to drive their digit displays.

(a) How many BCD bits are required to drive a 3-digit thermometer display? V
: Common

Solution: 12; 4 bits for each digit Misconception
(b) What 12 bits are sent to the display for a temperature of 147°F? You may have a hard time
Solution: 0001 0100 0111 visualizing why we add or
subtract 1 to determine
memory locations. Answer
this question: How many
problems must you solve if
APPLICATION 1-4 your teacher assigns
problems 5 through 10?
(You would subtract 5 from
10 and then add 1.) How

(a) How many hex characters are required to identify the address of each about if you solve 8
memory location? problems starting with 10:

Would the last problem be
Solution: Five (Each hex digit represents 4 bits.) 18 or 172

Most PC-compatible computer systems use a 20-bit address code to iden-
tify each of over 1 million memory locations.
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Inside
Your PC

The address settings of
your PC I/O devices are
given as hexadecimal
numbers. They can be
determined on a Windows-
based machine by pressing
the sequence:

My Computer > Control
Panel > System > Device
Manager > Properties >
I/0. Determine from the
list on your screen what
the address settings are for
your keyboard, printer,
and floppy disk.
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(b) What is the 5-digit hex address of the 200th memory location?

Solution: 000C7TH (200;, = C8H; but the first memory location is
00000H, so we have to subtract 1).

(c) If 50 memory locations are used for data storage starting at location
00C8H, what is the location of the last data item?

Solution: 000F9H (000C8H = 200y, 200 + 50 = 2509, 250 — 1 = 249,,
249,, = F9H [We had to subtract 1 because location C8H (200,,) received
the first data item, so we needed only 49 more memory spaces.])

APPLICATION 1-5

If the part number 651-M is stored in ASCII in a computer memory, list the
binary contents of its memory locations.

Solution:
6 =011 0110
5 =011 0101
1 =011 0001
— =010 1101
M = 100 1101

Because most computer memory locations are formed by groups of 8
bits, let’s add a zero to the leftmost position to fill each 8-bit memory loca-
tion. (The leftmost position is sometimes filled by a parity bit, which is dis-
cussed in Chapter 6.)

Therefore, the serial number, if strung out in five memory locations,
would look like the following:

0011 0110 0011 0101 0011 0001 0010 1101 0100 1101

If you look at these memory locations in hexadecimal, they will read as
follows:
36 35 31 2D 4D

APPLICATION 1-6

To look for an error in a BASIC program, a computer programmer uses a
debugging utility to display the ASCII codes of a particular part of her pro-
gram. The codes are displayed in hex as 474F5430203930. Assume that the
leftmost bit of each ASCII string is padded with a 0.

(a) Translate the program segment that is displayed.
Solution: GOTO 90.

(b) If you know anything about programming in BASIC, try to determine
what the error is.

Solution: Apparently a number zero was typed in the GOTO statement
instead of the letter O. Change it, and the error should go away.
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B Summary

In this chapter, we have learned the following:

1. Numeric quantities occur naturally in analog form but must be con-
verted to digital form to be used by computers or digital circuitry.

2. The binary numbering system is used in digital systems because the 1s
and Os are easily represented by ON or OFF transistors, which output 0 V
forOand 5 V for 1.

3. Any number system can be converted to decimal by multiplying each
digit by its weighting factor.

4. The weighting factor of the least significant digit in any numbering sys-
tem is always 1.

5. Binary numbers can be converted to octal by forming groups of 3 bits
and to hexadecimal by forming groups of 4 bits, beginning with the LSB.
Each group is then converted to an octal or hex digit.

6. The successive-division procedure can be used to convert from decimal
to binary, octal, or hexadecimal.

7. The binary-coded-decimal system uses groups of 4 bits to drive decimal
displays such as those in a calculator.

8. ASCII is used by computers to represent all letters, numbers, and sym-
bols in digital form.

| Glossary .

Alphanumeric: Characters that contain alphabet letters as well as numbers and symbols.

Analog: A system that deals with continuously varying physical quantities such as
voltage, temperature, pressure, or velocity. Most quantities in nature occur
in analog, yielding an infinite number of different levels.

ASCII Code: American Standard Code for Information Interchange. ASCII is a 7-bit
code used in digital systems to represent all letters, symbols, and numbers
to be input or output to the outside world.

BCD: Binary-coded decimal. A 4-bit code used to represent the 10 decimal digits O to 9.

Binary: The base 2 numbering system. Binary numbers are made up of 1s and Os, each
position being equal to a different power of 2 (23, 22, 2!, 2°, and so on).

Bit: A single binary digit. The binary number 1101 is a 4-bit number.

Decimal: The base 10 numbering system. The 10 decimal digits are 0, 1, 2, 3, 4, 5, 6,
7, 8, and 9. Each decimal position is a different power of 10 (103, 10%, 10",
100, and so on).

Digital: A system that deals with discrete digits or quantities. Digital electronics deals
exclusively with 1s and Os or ONs and OFFs. Digital codes (such as ASCII)
are then used to convert the 1s and Os to a meaningful number, letter, or
symbol for some output display.

Hexadecimal: The base 16 numbering system. The 16 hexadecimal digits are 0, 1, 2,
3,4,5,6,7,8,9, A, B, C, D, E, and F. Each hexadecimal position repre-
sents a different power of 16 (163, 16 16", 16°, and so on).

Least Significant Bit (LSB): The bit having the least significance in a binary string. The
LSB will be in the position of the lowest power of 2 within the binary number.

GLOSSARY

ﬁ Helpful

Hint

Skimming through the
glossary terms is a good

way to review the chapter.
You should also feel that

you have a good
understanding of all the
topics listed in the

objectives at the beginning

of the chapter.
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Most Significant Bit (MSB): The bit having the most significance in a binary string.
The MSB will be in the position of the highest power of 2 within the binary
number.

Octal: The base 8 numbering system. The eight octal numbers are 0, 1, 2, 3,4, 5, 6,
and 7. Each octal position represents a different power of 8 (83, 82, 8! 8%
and so on).

IS ProbLem s 1

Section 1-4
1-1. Convert the following binary numbers to decimal.
(a) 0110 (b) 1011 (c) 1001 (d) 0111
(e) 1100 (f) 0100 1011 (g) 0011 O111
(h) 1011 0101 (i) 1010 0111 (j) 0111 0110
Section 1-5
1-2. Convert the following decimal numbers to 8-bit binary.
(@) 1860  (b) 214y (¢) 279 (d) 251}y  (e) 146y

Sections 1-6 and 1-7
1-3. Convert the following binary numbers to octal.

(a) 011001 (b) 11101 (c) 1011100
(d) 01011001 (e) 1101101

1-4. Convert the following octal numbers to binary.

(a) 464 (b) 744 (c) 613 (d) 324 (e) 574

1-5. Convert the following octal numbers to decimal.

(a) 27; (b) 374 (c) 14g d) 724 (e) 51

1-6. Convert the following decimal numbers to octal.

(a) 1264 (b) 49 (c) 87y (d) 94y (e) 108,

Sections 1-8 and 1-9
1-7. Convert the following binary numbers to hexadecimal.

(a) 1011 1001 (b) 1101 1100 (c) 0111 0100
(d) 1111 1011 (e) 11000110

1-8. Convert the following hexadecimal numbers to binary.

(@ C5;s () FAjg  (c) D6 (d) A%4y5 (&) 6246
1-9. Convert the following hexadecimal numbers to decimal.

(@) 8646 (b) F4i5  (0) 924 (d) ABy4 (e) 3C546
1-10. Convert the following decimal numbers to hexadecimal.
(@) 127 (b) 689 () 1075 (d) 615 (&) 29y

Section 1-10
1-11. Convert the following BCD numbers to decimal.

(a) 1001 1000gcp () 0110 1001gcp  (¢) 0111 01005cp
(d) 0011 0110gcp, () 1000 0001pcp
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1-12. Convert the following decimal numbers to BCD.
(@ 87,0 (b) 142)5  (c) 94y (d) 61 () 44y

1-13. Fill in all of the empty cells in Table P1-13 by performing the indi-
cated conversion as shown in the row labeled “sample.”

1-14. Fill in all of the empty cells in Table P1-14 by performing the indi-
cated conversion as shown in the row labeled “sample.”

TABLE P1-13
Decimal Binary Octal BCD Hexadecimal
Sample 16 0001 0000 020 0001 0110 10
(a) 35
(b) 0010 1001
© 053
(d) 0111 1000
(e) 3A
TABLE P1-14
Decimal Binary Octal BCD Hexadecimal
Sample 59 0011 1011 073 0101 1001 3B
(@) 44
(b) 1001 1000
() 127
(d) 0011 0100
(e) 45

Section 1-12

1-15. Use Table 1-5 to convert the following letters, symbols, and num-
bers to ASCIL

(@ % (b) $14 (¢) N-6 (d) CPU (e) Pg

1-16. Insert a zero in the MSB of your answers to Problem 1-13, and list
your answers in hexadecimal.

Section 1-13

C*

1-17. The computer monitoring system at the geothermal facility shown
in Figure 1-7 is receiving the following warning codes. Determine the
problems that exist for each code (H stands for hex).

(a) 0010 0001, (b) CO4¢ (c) 88H (d) 0244 (e) 48y
1-18. What is the BCD representation that is sent to a three-digit display

on a voltmeter that is measuring 120 V?

1-19. A computer programmer observes the following hex string when
looking at a particular section of computer memory: 736B753433.

(a) Assume that the memory contents are ASCII codes with leading zeros
and translate this string into its alphanumeric equivalent.

(b) The programmer realizes that the program recognizes only capital (up-
percase) letters. Convert all letters in the alphanumeric equivalent to cap-
ital letters, and determine the new hex string.

*The letter C signifies problems that are more Challenging and thought provoking.

PROBLEMS
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mmmmm Schematic Interpretation Problems m—"———

(Note: Appendix G contains four schematic diagrams of actual digital systems. At the
end of each chapter, you will have the opportunity to work with these diagrams to gain
experience with real-world circuitry and observe the application of digital logic that
was presented in the chapter.)

S* 1-20. Locate the HC11DO master board schematic in Appendix G.
Determine the component name and grid coordinates of the following com-
ponents. (Example: Q3 is a 2N2907 located at A3.)

(a) Ul (b) U16 (c) Q1 (d) P2

S 1-21. Find the date and revision number for the HC11D0 master board
schematic.
S 1-22. Find the quantity of the following devices that are used on the

watchdog timer schematic.
(a) 74HCS85 (b) 74HCO8 (c) 74HC74 (d) 74HC32

mmmm MultiSIM® Exercises

MultiSIM is a software simulation tool that is used to reinforce the theory presented in
each chapter. It provides an accurate simulation of digital and analog circuit operation
along with a simulation of instruments used by a technician to measure IC, component,
and circuit characteristics. With this software, you have the ability to build and test
most of the circuits presented in this text. The data files for all MultiSIM examples and
problems in this textbook are provided on the textbook Web site.

The problems at the end of each chapter are based on the circuits and theory pre-
sented in the section corresponding to the file name. Before attempting any MultiSIM
problems, you must thoroughly understand the material presented in that textbook sec-
tion. The problem definition for each MultiSIM circuit is fully explained in the
Description Window that appears in each MultiSIM file.

The problems are basically of three types: (1) circuit interaction problems require
the student to change input values and take measurements at the outputs to verify circuit
operation; (2) design problems require the student to design, or modify, a circuit to
perform a particular task; and (3) troubleshooting problems require the student to find
and fix the fault that exists in the circuit that is given.

You will notice that the MultiSIM problems use a slightly different notation to
represent certain variables. For example, A is represented by A’, C, is represented by
Cp, and 2° is represented by 2/0.

E1-1. (Note: You need to understand binary to hexadecimal conversions
[Section 1-8] before attempting this exercise.) Load the circuit file for
Section 1-08. This circuit is used to demonstrate the conversion between
the binary and hexadecimal numbering systems similar to Examples 1-12
and 1-13. The Word Generator is used to drive eight binary lights and two
hexadecimal displays. Read the instructions for the circuit in the Description
window at the bottom of the screen.

(a) What 8-bit binary number will you see on the lights if you press Step
five times? (An ON lightis a 1.) Try it.

(b) How many times must you press Step to get the binary number
0000 10117 Try it.

*The letter S designates Schematic interpretation problem.

CHAPTER 1 | NUMBER SYSTEMS AND CODES



1-1.

1-2.

1-4.
1-5.
1-6.
1-7.

1-8.
1-9.
1-10.

1-11.

1-12.

(c)
(d)

‘What hexadecimal number will you see if you press Step 14 times? Try it.

How many times must you press Step to see the hexadecimal number
1b? Try it.

E1-2. (Note: You need to understand the operation of the geothermal
facility monitoring system presented in Figure 1-7 before attempting this
exercise.) Load the circuit file for Section 1-13. Turn the power switch
ON. The hex display should read 00H, which indicates that there are no
high temperature or pressure levels.

(a)

Read the instructions for the circuit in the Description window at the
bottom of the screen. What would you expect the hex display to read
if there is a high temperature in Tank D? To check your answer, raise
the temperature in Tank D by pressing the indicated key several
times. Return the temperature to a low level by holding the Ctrl key
as you press 2 repeatedly.

(b) What would you expect the display to read if all temperatures are
high? Check your answer, then return the levels to a low state.

(c) What levels are too high if the hex display reads 0CH? Check your
answer by raising the levels on the appropriate tank(s). Return all

levels to a low state.

(d) What levels are too high if the hex display reads AAH? Check your
answer by raising the levels on the appropriate tanks(s). Return all

levels to a low state.

Answers to Review Questions

Temperature, pressure, 1-13. 108,
velocity, weight, sound 1-14. 13.375,,
Begau?e digital quantities are 1-15. 0010 1011,
easier for a computer system to
store and interpret 1-16. 1010 1010,
(a) Analog  (b) Digital 1-17. False
(c) Digital (d) Analog 1-18. 734
Could be either 1-19. 010110011, or 1011 0011,
False 1-20. 396,
DAC 1-21. 1324
Analog, because small irregu- 1-22. Because hexadecimal uses
larities in the waveform will be 4-bit groupings
heard, but a digital signal with 1-23. True
noise still looks like a HIGH or 1-24. 6B,
LOW (1 or 0) voltage level. 1=25. 11100111,
?lg“al . . 1-26. 364,
0 route just one input at a _
time to the ADC 1=27. 12C16.
To convert the parallel data 1-28. dBeSi?nlsl Lzlsie?t;)r(l)l{otg gﬁpi_esietnt
into serial before outputting to oUDines &
the USB connector EroupIngs.
Because it uses only two digits 1-29. To get alphanumeric data into
0 and 1, which can be repre- and out of a computer
sented by using two distinct 1-30. 1001 0100 011 1pcp
voltage levels 1-31. 867,
By powers of 2 1-32. 0100 0101 pgcpy

ANSWERS TO REVIEW QUESTIONS
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Digital Electronic Signals
and Switches

OUTLINE

Digital Signals
Clock Waveform Timing
Serial Representation

Switches in Electronic Circuits
A Relay as a Switch
2-7 A Diode as a Switch
2-8 A Transistor as a Switch
2-9 The TTL Integrated Circuit
2-10 MultiSIM® Simulation of Switching Circuits
2-11 The CMOS Integrated Circuit
2-12 Surface-Mount Devices

1
2
3
—4 Parallel Representation
5
6

Upon completion of this chapter, you should be able to do the following:

* Describe the parameters associated with digital voltage-versus-time waveforms.

» Convert between frequency and period for a periodic clock waveform.

* Sketch the timing waveform for any binary string in either the serial or parallel
representation.

* Discuss the application of manual switches and electromechanical relays in
electric circuits.

» Explain the basic characteristics of diodes and transistors when they are forward
biased and reverse biased.

 Calculate the output voltage in an electric circuit containing diodes or transistors
operating as digital switches.

 Perform input/output timing analysis in electric circuits containing electro-
mechanical relays or transistors.

» Explain the operation of a common-emitter transistor circuit used as a digital
inverter switch.




INTRODUCTION

As mentioned in Chapter 1, digital electronics deals with 1s and 0s. These logic states
will typically be represented by a high and a low voltage level (usually 1 = 5V and
0=0V).

In this chapter, we see how these logic states can be represented by means of a tim-
ing diagram and how electronic switches are used to generate meaningful digital signals.

2-1 Digital Signals

A digital signal is made up of a series of 1s and Os that represent numbers, letters, sym-
bols, or control signals. Figure 2—1 shows the timing diagram of a typical digital sig-
nal. Timing diagrams are used to show the HIGH and LOW (1 and 0) levels of a digital
signal as it changes relative to time. In other words, it is a plot of voltage versus time.
The y axis of the plot displays the voltage level and the x axis, the time. Digital systems
respond to the digital state (0 or 1), not the actual voltage levels. For example, if the
voltage levels in Figure 2—1(a) were not exactly 0 V and +5 V, the digital circuitry
would still interpret it as the O state and 1 state and respond identically. The actual volt-
age level standards of the various logic families are discussed in detail in Chapter 9.

Figure 2-1(a) is a timing diagram showing the bit configuration 1 0 1 0 as it
would appear on an oscilloscope. Notice in the figure that the LSB comes first in time.
In this case, the LSB is transmitted first. The MSB could have been transmitted first as
long as the system on the receiving end knows which method is used.

Figure 2-1(b) is a photograph of an oscilloscope, which is a very important test
instrument for making accurate voltage versus time measurements.

LSB MSB
Time

(a) (b)

Figure 2-1 (a) Typical digital signal; (b) an oscilloscope displaying the digital waveform
from a clock generator instrument.

2-2  Clock Waveform Timing

Most digital signals require precise timing. Special clock and timing circuits are used
to produce clock waveforms to trigger the digital signals at precise intervals (timing
circuit design is covered in Chapter 14).

Figure 2-2 shows a typical periodic clock waveform as it would appear on an
oscilloscope displaying voltage versus time. The term periodic means that the wave-
form is repetitive, at a specific time interval, with each successive pulse identical to
the previous one.

A\ (&

(o)




Team
Discussion

D

An interesting exercise is to
sketch the waveform from
a 10-cps clock that is
allowed to run for 1s. How
long did it take to complete
one cycle? How did you
find that time? Next,
repeat for a 1-MHz clock.

»' Helpful

Hint
Frequency and time
calculations can often be
made without a calculator
if you realize some of the
common reciprocal
relationships (e.g.,
1/milli = Kilo, 1/micro =
mega). When using a
calculator, if the result is
not a power of 3, 6, 9, or
12, then the answer must
be converted to one of
these common engineering
prefixes using algebra or, if
available, the ENG key on
your calculator.
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Figure 2-2 shows eight clock pulses, which we label 0, 1, 2, 3,4, 5, 6, and 7. The
period of the clock waveform is defined as the length of time from the falling edge of
one pulse to the falling edge of the next pulse (or rising edge to rising edge) and is
abbreviated ¢, in Figure 2-2. The frequency of the clock waveform is defined as the

P
reciprocal of the clock period. Written as a formula,
1 1
f=— and 1,= -
[ f
Clock —> C, C,
circuitry 1
= Falling Rising
edge edge

Figure 2-2 Periodic clock waveform as seen on an oscilloscope displaying voltage versus time.

The basic unit for frequency is hertz (Hz), and the basic unit for period is seconds (s).
Frequency is often referred to as cycles per second (cps) or pulses per second (pps).

EXAMPLE 2-1

What is the frequency of a clock waveform whose period is 2 microseconds
(us)?

Solution:

= 0.5 megahertz (0.5 MHz or 500 kHz)

_ 1
f_t

b 2us

Hint: To review engineering notation, see Table 2—1.

TABLE 2-1 | Common Engineering Prefixes
Prefix Abbreviation Power of 10
Tera T 102
Giga G 10°
Mega M 10°
Kilo k 10°
Milli m 1073
Micro " 107°
Nano n 107°
Pico p 10712

EXAMPLE 2-2
A PC manufacturer specifies a microprocessor speed of 4 GHz (Gigahertz).
What is the period of the microprocessor’s waveform?

Solution:
t, = LI 250 pS
P £ 7 p
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Digital communications concerns itself with the transmission of bits (1s and 0Os).
The rate, or frequency, at which they are transmitted is given in bits-per-second (bps).

Common transmission rates for a PC connected to the Internet via a telephone line are
28.8 kilobits-per-second (28.8 kbps) and 56 kbps.

EXAMPLE 2-3

Sketch and label the x and y axis representing a 56 kbps (kilobits per sec-
ond) clock waveform transmitted between a PC and a peripheral device.

(Assume that the voltage levels were measured on an oscilloscope at
LOW = 0.2V and HIGH = 4.5V.)

Solution:
1

1, = — =
P f  56kbps

=179 us

Team
Discussion

For those students who have
a PC: Do you know (or
could you find out) at what
frequency and period your
internal microprocessor
operates?

45V
pIVARE I p S ey I
—17.9 us—>

Figure 2-3 Solution to Example 2-3.

EXAMPLE 2-4
,: Common
Determine the frequency of the waveform in Figure 2—4. Misconception

The period is labeled from
rising edge to rising edge
(or falling edge to falling
edge) and is not just the
positive pulse.

Solution:
f= RN
34.7 us

= 28.8 kHz (or 28.8 kbps)

I

vt LT 1 LI 1
—34.7 us—>

Figure 2-4 Waveform for Example 2—4.

Review Questions

2-1. What are the labels on the x axis and y axis of a digital signal mea-
sured on an oscilloscope?

2-2. What is the relationship between clock frequency and clock period?

2-3. What is the time period from the rising edge of one pulse to the rising
edge of the next pulse on a waveform whose frequency is 8 MHz?

2—4. What is the frequency of a periodic waveform having a period of 50 ns?
2-5. Repeat Example 2—1 for a period of 200 ns.
2-6. Repeat Example 2-2 for a frequency of 2.6 GHz.

2-7. Repeat Example 2-3 for a waveform frequency of 2.8 Mbps and volt-
age of 0.4 and 4.8 V.

2-8. Repeat Example 2—4 for a period of 17.1 us.

SECTION 2-2 | CLOCK WAVEFORM TIMING 31



.' Helpful

Hint
Although this is too
complicated to detail here,
you should realize that
often there are other
handshaking signals
involved in serial
communication (i.e., ready
to receive, ready to
transmit, start bits, stop
bits, parity, and so on).

Inside
Your PC

Standard transmission
speed for a PC’s serial
port (labeled COM on
Windows-based machines)
is 115 kbps. Much higher
serial speeds are achieved
using the newer (USB)
standard. The original
version 1.1 standard called
for 12 Mbps transmission
speeds. Version 2.0 specifies
480 Mbps and version 3.0
can transmit at speeds up
to 5 Gbps! (For more
information, visit the USB
Web site listed in Appendix
A.)
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2-3  Serial Representation

Binary information to be transmitted from one location to another will be in either
serial or parallel format. The serial format uses a single electrical conductor (and a
common ground) for the data to travel on. The serial format is inexpensive because it
only uses a single conductor and one set of input/output circuitry, but it is slow because
it can only transmit 1 bit for each clock period. Communication over telephone lines
(like the Internet) and computer-to-computer communication (like office networks)
use serial communication (see Figure 2-5). The ports labels COM on a PC are most
often used for the serial communication connection to telephone lines. A plug-in card
is used in a PC to provide network serial communication (e.g., Ethernet).

Serial communication can be sped up by using extremely high-speed clock sig-
nals. Modern Internet connections and office networks communicate at speeds ex-
ceeding 1 million bps. Several standards have been developed for high-speed serial
communications, the most common of which are V.90, ISDN, T1, T2, T3, Universal
Serial Bus (USB), Ethernet, 10baseT, 100baseT, 1000baseT, cable, and DSL.

Computer Computer
\ ‘

[L1tTo 111101

S
S

[e=] T
Serial data are transmitted
over a single conductor.

Figure 2-5 Serial communication between computers.

Let’s use Figure 2—6 to illustrate the serial representation of the binary number
01101100. The serial representation (S,) is shown with respect to some clock wave-
form (C,), and its LSB is drawn first. Each bit from the original binary number occu-
pies a separate clock period, with the change from one bit to the next occurring at each
falling edge of C, (C, is drawn just as a reference).

Sunininipinipipip

MSB

0 0 0 1 ‘ 1 0

Figure 2-6 Serial representation of the binary number 0110110.

2-4 Parallel Representation

The parallel format uses a separate electrical conductor for each bit to be transmitted
(and a common ground). For example, if the digital system is using 8-bit numbers,
eight lines are required (see Figure 2—7). This tends to be expensive, but the entire
8-bit number can be transmitted in one clock period, making it very fast.

Inside a computer, binary data are almost always transmitted on parallel channels
(collectively called the PCI data bus). Two parallel data techniques previously used by
computers to communicate to external devices were the Centronics printer interface
(port LPT1) and the Small Computer Systems Interface (SCSIL, pronounced scuzzy).
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M o— 0 (LSB)

0

Parallel data were transmitted to
Computer /

the printer on 8 conductors,
simultaneously.

1
1

///
7
(=)

/s | ;
—F——1 0MsB)

/i
/1

Printer

Figure 2-7 Original parallel communication between a computer and a printer.

Figure 2-8 illustrates the same binary number that was used in Figure 2-6
(01101100), this time in the parallel representation.

If the clock period were 2 us, it would take 2 us X 8 periods = 16 ws to transmit
the number in serial and only 2 us X 1 period = 2 us to transmit the same 8-bit
number in parallel. Thus, you can see that when speed is important, parallel transmission
is preferred over serial transmission.

The following examples further illustrate the use of serial and parallel repre-
sentations.

Team
Discussion
C, 1 0 1 2 3 41 15 ol 17 What other devices
0 might use parallel
Ll __(LSB) communi?ation? How
2 about serial
(1) = communication?
2]
0 —
2’ =
0 Inside
E . | e Your PC
§ 0 Most communication inside
:; 24 ! of a modern PC uses a
==§ 0 parallel connection scheme.
£ 2’ 1= The newest internal
0 parallel standard is called
5 1T PCI (Peripheral
0 Component Interconnect)
, 1 and PCI-Express. These
2 () et (MSB) busses range anywhere
from 1 to 32 bits in width
and can transmit at speeds
Figure 2-8 Parallel representation of the binary number 01101100. up to 16 Gbps!
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EXAMPLE 2-5

Sketch the serial and parallel representations of the 4-bit number 0 1 1 1.
If the clock frequency is 5 MHz, find the time to transmit using each
method.

Solution: Figure 2-9 shows the representation of the 4-bit number 0 1 1 1.

Sketch the Aserial cp 1 0 ) 5 3
data on a single 0
line relative to the 1 |
clock reference. —> ¢ ‘

o 0 —

o ] —

2
0

// =
21

Sketch the same 7 0
data in parallel
by using several ~

o
1
lines. 22
0

» !
0
Figure 2-9
t 1 ! 0.2
= —- = = . S
»~ f 7 5MHz H
tserial =4 X OZ[.LS = 0.8 S
tpa:allel = 1 X 02 MS = 02 S
EXAMPLE 2-6

Sketch the serial and parallel representations of the decimal number 74.
(Assume a clock frequency of 4 kHz.) Also, what is the state (1 or 0) of the
serial line 1.2 ms into the transmission?

Solution: 74;,=0100101 0,

1
== =025
PT T 4k m

Therefore, the increment of time at each falling edge increases by
0.25 ms. Because each period is 0.25 ms, 1.2 ms will occur within the
number 4 period, which, on the S, line, is a 0 logic state (see Figure 2—-10).
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0 1 2 3 4 5 6 7
00 025 050 075 1.0 125 150 1.75 2.0 (Time, ms)

; | e

1 ‘ 74 serial
> U
— 1.2 ms occurs within

this period.

0
l1
2 0

1
22
23

24

26

27
L— 74 parallel

Figure 2-10

SERIAL TRANSMISSION SIMULATION

Figure 2—11 shows a MultiSIM simulation of the transmission of the three ASCII characters MP3
from a transmitting device (the Word Generator) to a receiving device (the Logic Analyzer). ASCII

characters are generally transmitted most significant character first (but with the LSB of each

8-bit

code coming first). The top trace in the Logic Analyzer displays a clock reference waveform (CP) of

{ Cp Logic Analyzer-XLA1 . N

—
=)
—_

Time (5)

&DDD 8.000m 16.000m 24.000m 32.000m 40.000m

Term 2

50 LTIl F1rir L7 L <— serial dutput |
Term 4 h V ' ' '
Terms | ———
Term& | M i P 1 3

Term 7

S O OO

Term &

Term 3
Term 10 |
Term11 |
Term 12
Term 13 |
Term 14 |
P . Term 15 |
Receiving device Tarm 15|
Logic Analyzer-XLA1 Clock_int
Clock_Quz
Trigg_ous|

~

°" EAERLTEITIEIIEY!

o~

onQ OOOOOOOOOOOOOOO(B

O0O000000 00000000

b b e

5 00000000 00000000 o

(98]
—_

@ e e e e e e e Hep te e e e IO e 1)

Transmitting device

cf [T LML <— ¢lock reference sigipal

Word Generator-XWG1

4

{3

Clock

Stop || 11 oooos |0004 Clucksf=]
Reset T2 ﬁ -+ QL0005 0003 Set External {C) Qualifier ()
S E— 0,000 s Bl
Reverse T2-T1 ) e

Trigger
SEL |
Qualifier {T)
=

Figure 2-11 A MultiSIM simulation of the serial transmission of the ASCII characters MP3.
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24 clock periods, each period lasting 1 ms. The third trace shows the serial output data (SO). Since
ASCII is a 7-bit code, and since digital systems work in 8-bit groupings, a leading zero is added to
the MSB of each ASCII code. Also, since the LSB of each character is output first (on the left), the
bits read from 8 ms back to 0 ms are 01001101, which is the ASCII code for the letter M. Look up
the next two 8-bit groupings in an ASCII chart and you will see that it is transmitting the letters MP3.

Exercise: (a) On graph paper, draw a 24-cycle CP reference waveform and then the 24-bit serial
waveform for the ASCII letters USB. (b) Repeat for the letters jpg.

PARALLEL TRANSMISSION SIMULATION

Figure 2—-12 shows a MultiSIM simulation of the transmission of the three parallel ASCII characters
Y2K from a transmitting device (the Word Generator) to a receiving device (the Logic Analyzer).
The top trace in the Logic Analyzer displays a clock reference waveform (CP) of 3 clock periods,
each period lasting 1 ms. The next eight traces show the parallel output data (PO-P7). Since ASCII is
a 7-bit code and since digital systems work in 8-bit groupings, a leading zero is added to the MSB of
each ASCII code. During the first period (the first column), the parallel data lines contain the code
0101 1001, which is the ASCII code for the letter Y. Look up the next two 8-bit columns in an ASCII
chart and you will see that it is transmitting the letters Y2K.

Exercise: (a) On graph paper, draw a 3-period CP reference waveform and then the 3-bit parallel
waveforms for the ASCII letters ATM. (b) Repeat for the letters CDR.
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Figure 2-12 A MultiSIM simulation of the parallel transmission of the ASCII characters Y2K.

Review Questions

2-9. What advantage does parallel have over serial in the transmission of

digital signals?

2-10. Which system requires more electrical conductors and circuitry, se-

rial or parallel?
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2-11. How long will it take to transmit three 8-bit binary strings in serial
if the clock frequency is 5 MHz?

2-12. Repeat Question 2—11 for an 8-bit parallel system.

2-5 Switches in Electronic Circuits*

The transitions between 0 and 1 digital levels are caused by switching from one volt-
age level to another (usually 0 V to +5 V). One way that switching is accomplished is
to make and break a connection between two electrical conductors by way of a manual
switch or an electromechanical relay. Another way to switch digital levels is by use of
semiconductor devices such as diodes and transistors.

Manual switches and relays have almost ideal ON and OFF resistances in that
when their contacts are closed (ON) the resistance (measured by an ohmmeter) is
0 ohms (€2) and current is allowed to flow. When their contacts are open (OFF), the
resistance is infinite and no current can flow. Figures 2—13(a) and (b) show the single-
pole, single-throw manual switch. When used in a digital circuit, a single-pole,
double-throw manual switch can produce 0 and 1 states at some output terminal, as
shown in Figures 2—13(c) and 2-13(d), by moving the switch (SW) to the up or down
position.

Open Closed
A /i B A Y W = N >
SW SW
R=00Q R=0Q

(a) (b)

Figure 2-13 Manual switch: (a) switch open, R = % ohms; (b) switch closed, R = 0 ohms.

out

Figure 2-13(c) 1-Level output.

+5V

)

Figure 2-13(d) 0-Level output.

*The fundamentals of basic electricity are provided in Appendix F. Ohm’s law, simple series circuits, open circuits, and short
circuits are explained to help you understand the electrical principles used in the remainder of this chapter.

SECTION 2-5 | SWITCHES IN ELECTRONIC CIRCUITS

37



2-6 A Relay as a Switch*

An electromechanical relay has contacts like a manual switch, but it is controlled by
external voltage instead of being operated manually. They are often used to deliver
HIGH/LOW digital levels to a high power load like a motor or a high-wattage lamp (see
Figure 11-48). Figure 2—14 shows the physical layout of an electromechanical relay. In
Figure 2—14(a) the magnetic coil is energized by placing a voltage at terminals C;—C5;
this will cause the lower contact to bend downward, opening the contact between X; and
X,. This relay is called normally closed (NC) because, at rest, the contacts are touching,
or closed. In Figure 2-14(b), when the coil is energized, the upper contact will be

These contacts open when These contacts close when
the coil is energized. the coil is energized.
Magnetic \v Magnetic /
attraction attraction
l l Contacts l l Contacts
=] O X, = O X,
T l O X5 ™ — O Xa
(__D C__D
L —0P .
Coil <__> Coil b
<,__> oG C__D ©G
9 O C, 9 O G,
Insulating material Insulating material
(a) (®)

(©)

Figure 2-14 Physical representation of an electromechanical relay: (a) normally closed
(NC) relay; (b) normally open (NO) relay; (c) photograph of actual relays.

*Systems requiring complex relay switching schemes are generally implemented using programmable logic controllers (PLCs).
PLCs are microprocessor-based systems that are programmed to perform complex logic operations, usually to control electrical
processes in manufacturing and industrial facilities. They use a programming technique called ladder logic to monitor and control
several processes, eliminating the need for individually wired relays. PLC is a registered trademark of Allen-Bradley Corporation.
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attracted downward, making a connection between X; and X,. This is called a normally
open (NO) relay because at rest, the contacts are not touching, they are open.

A relay provides total isolation between the triggering source applied to C;—C,
and the output X;—X,. This total isolation is important in many digital applications,
and it is a feature that certain semiconductor switches (e.g., transistors, diodes, and in-
tegrated circuits) cannot provide. Also, the contacts are normally rated for currents
much higher than the current rating of semiconductor switches.

There are several disadvantages, however, of using a relay in electronic circuits.
To energize the relay coil, the triggering device must supply several milliamperes,
whereas a semiconductor requires only a few microamperes to operate. A relay is also
much slower than a semiconductor. It will take several milliseconds to switch, com-
pared to microseconds (or nanoseconds) for a semiconductor switch.

In Figure 2-15 a relay is used as a shorting switch in an electric circuit. The
+5-V source is used to energize the coil, and the +12-V source is supplying the ex-
ternal electric circuit. When the switch (SW) in Figure 2—15(a) is closed, the relay coil
will become energized, causing the relay contacts to open, which will make V
change from 0 V to 6 V with respect to ground. The voltage-divider equation (see
Appendix F) is used to calculate V,, as follows:

12V X 5kQ)

V. ————— =6V
T 5KQ + 5kQ
Applying +5 V to Applying +5 V to
the coil opens the coil closes
the NC contacts. the NO contacts.
+12V +12V
% 5kQ 5kQ
+5V _./ C1 X1 ———O Vout] +5V _./ C1 X] —O VouLZ
SW SW
R,
5kQ 5kQ
. Contacts Contacts
Coil
C, .€3
NC relay = NO relay =

(a) (b)

Figure 2-15 Symbolic representation of an electromechanical relay: (a) NC relay used in a
circuit and (b) NO relay used in a circuit.

When the switch in Figure 2—15(b) is closed, the relay coil becomes an energized relay
coil, causing the relay contacts to close, changing V., from 6 V to O V.

Now, let’s go a step further and replace the 5-V battery and switch with a clock
oscillator and use a timing diagram to analyze the results. In Figure 2-16, the relay is
triggered by the clock waveform, C,,. The diode D; is placed across the relay coil to
protect it from arcing each time the coil is deenergized. Timing diagrams are very use-
ful for comparing one waveform to another because the waveform changes states (1 or 0)
relative to time. The timing diagram in Figure 2—17 shows that when the clock goes
HIGH (1), the relay is energized, causing V3 to go LOW (0). When C,, goes LOW
(0), the relay is deenergized, causing V,,; to go to +5V (using the voltage divider
equation, Vo, = [10V X 5kQ]/[5kQ + 5kQ] = 5V).
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+10V
These contacts close

when Cpgoes HIGH.

5kQ

Clock
oscillator

ch[ 3

1

R /\D Ry — 5kQ
Coil Contacts

Figure 2-16 Relay used in a digital circuit.

Coil energized, contacts closed.

Coil deenergized, contacts open.

5V
G [o LAl L 1L _Jds11-+«]

ov

5V
Vouts I I I I I I I I I I

ov

Figure 2-17 Timing diagram for Figure 2—16.

The following examples illustrate electronic switching and will help to prepare
you for more complex timing analysis in subsequent chapters.

. EXAMPLE 2-7
,: Common
Misconception Draw a timing diagram for the circuit shown in Figure 2-18, given the C,

The effects of opens waveform in Figure 2—-19.
and shorts are often
miscalculated. Occasionally,

+5V
it is instructive to assume
that an open is equivalent
to a 10-MQ resistor and c 1kQ
calculate the voltage across Clock z
it using the voltage divider oscillator Vout1
equation. Appendix F G

T

provides several examples

of opens and shorts to

illustrate their effect on = =
circuits.

Figure 2-18

o " _ T LI LTI

Solution:

out 1

Figure 2-19
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Explanation: When C, is LOW, the R; coil is deenergized, the
R, contacts are open, Ijyg = 0A, Voo =1XR=0V, and
Vour = 5V = Oygop = 5V. When C, is HIGH, the R coil is energized,
the R, contacts are closed, and V,,; = 0 V. (See Appendix F for a review
of opens and shorts.)

EXAMPLE 2- ~ ‘1
8 »t" Helpful
Draw a timing diagram for the circuit shown in Figure 2-20(a), given the e

C, waveform in Figure 2-20(b). Remember that V,, is the
voltage measured from the

10V point in question to
ground.
6 kQ
Cl’
Clock A * O Vou
oscillator
Figure 2-20(a)
+5V
"oV 0 1 2 3

Solution: |, *+V
out 2

Figure 2-20(b)

Explanation: When the R, contacts are closed (R, is energized), the volt-

age at point A is 0 V, making V, equal to O V. When the R, contacts are
(Ryisd ized), the volt t 'tA'V—M—4V
open (R, is deenergized), the voltage at point A is V, 6K + 1kQ

and Vo = V4, = 4V.

ELECTRO-MECHANICAL RELAY SWITCHING SIMULATION

Figure 2-21 shows a MultiSIM simulation of a relay connected in a voltage-divider circuit. As the
clock energizes/de-energizes the relay coil, the relay contacts repeatedly short the 8 k resistor, caus-
ing the V,, waveform (Channel_B) to change from 0 V (3.000 V) to 8 V repeatedly as shown in the
oscilloscope display.

MultiSIM Exercise: Use MultiSIM to open file fig02_21 from the textbook website. Run the simulation
to create the waveforms shown in Figure 2-21. Move the measurement cursers ‘1’ and ‘2’ to display
the voltage levels shown. Make the following changes, predict the new values for V,, and rerun the
simulation:

(a) Change the 4 k to 8 k and the 8 k to 4 k.

(b) Change the top resistor to 20 k and the bottom resistor to 4 k.
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12v % Ext ];ri .
—

4kQ A B
+O= O
‘ I I Oscilloscope
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G, (ru 8 kQ
Relay
L
Oscilloscope-¥5C1 I x|
— - =
] Note: a HIGH Cp
f produces a Low V
C,
V()ll[
Cp =5V-TO-0V
/s V= 0V-T0-8V
g ./ [ -
Time Channel_a Channel_B
% gfg 12.687 ms 5,000 ¥ / 3.000 u¥ J Reverse |
2| 17.351ms 0,000V 8.000 v =
v ! YE

T2-T1 4,664 ms 5,000 8.000 ¥ | Ext. trigger

~Timebase Channel A Channel B Trigger

Scale: | S msfDiv Scale: |5 V/Div Scale: |5 V/Div edge: [7 %[ B [ext|

% pos.(Div): |0 ¥ pos.(Div): I 1 ¥ pos.(Div): |-2 Level: |3 | W
—|[vim add|a|am| | ac| 0 Joc & ac| o foc - | |Type [Sing. Nor.|auto| None|il
Figure 2-21 A MultiSIM simulation of an electro-mechanical relay switching circuit.

Review Questions

2-13. Describe the operation of a relay coil and relay contacts.

2-14. How does a normally open relay differ from a normally closed relay?

2-7 A Diode as a Switch

Manual switches and electromechanical relays have limited application in today’s dig-
ital electronic circuits. Most digital systems are based on semiconductor technology,
which uses diodes and transistors. In Chapter 9, we discuss in detail the formation of
digital circuits using transistors and diodes. Most electronics students should also take
a separate course in electronic devices to cover the in-depth theory of the operation of
diodes and transistors. However, without getting into a lot of detail, let’s look at how a
diode and a transistor can operate as a simple ON/OFF switch.

A diode is a semiconductor device that allows current to flow in one direction but
not the other. Figure 2-22 shows a diode in both the conducting and nonconducting
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A reversed-biased diode
acts like an open circuit

Diode Diode
N N
Anode ¥ Cathode A

sy Iflow @ //L:ght sV == e)

- \\})lﬂb T+ No / flow /‘ <

(a) (b)

Figure 2-22 Diode in a series circuit: (a) forward biased and (b) reverse biased.

states. The term forward biased refers to a diode whose anode voltage is more positive
than its cathode, thus allowing current flow in the direction of the arrow. (Bias is the
voltage necessary to cause a semiconductor device to conduct or cut off current flow.)
A reverse-biased diode will not allow current flow because its anode voltage is equal
to or more negative than its cathode. A diode is analogous to a check valve in a water
system (see Figure 2-23).

A diode is not a perfect short in the forward-biased condition, however. The
voltage-versus-current curve shown in Figure 2-24 shows the characteristics of a
diode. Notice in the figure that for the reverse-biased condition, as V,., becomes more
negative, there is still practically zero current flow.

In the forward-biased condition, as Vi, becomes more positive, no current
flows until a 0.7-V cut-in voltage is reached.* After that point, the voltage across the
diode (Vi) Will remain at approximately 0.7 V, and Iy, will flow, limited only by the
external resistance of the circuit and the 0.7-V internal voltage drop.

Only possible
direction of [T I:_M
water flow

Figure 2-23 Water system check valve.

forw

V, 0.7V V,

rev forw

I

rev

Figure 2-24 Diode voltage versus current characteristic curve.

#0.7 V is the typical cut-in voltage of a silicon diode, whereas 0.3 V is typical for a germanium diode. We use the silicon diode
because it is most commonly used in digital circuitry.
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What this means is that current will flow only if the anode is more positive than
the cathode, and under those conditions, the diode acts like a short circuit except for
the 0.7 V across its terminals. This fact is better illustrated in Figure 2-25.

N
LT OV

|+

5V _— glkﬂ 5V _—

(@

Ideal 0.7V
= oV, =5-07
Diode =43V
| I
1 § 1kQ
_5-07
I= 0 = 4.3 mA

(b)

Figure 2-25 Forward-biased diode in an electric circuit: (a) original circuit and (b) equiva-
lent circuit showing the diode voltage drop and V,, = 5 — 0.7 = 4.3 V.

The following examples and the problems at the end of the chapter demonstrate
the effect that diodes have on electric circuits.

EXAMPLE 2-9

Determine if the diodes shown in Figure 2-26 are forward or reverse biased.

DI
+5V v,
1kQ
1kQ
+5V Vi
D3
+sv —>F—
DS
ov—t—+—V;
D6

%1 kQ

Fiaure 2-26

+5V
DZ
V,
1 kQ
1kQ
+5V v,
D,
+5V
1kQ
OV—|<]—'—V(,
D7
+5V —|< I—
D,
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Solution: The diode is forward biased if the anode is more positive than
the cathode.

D is forward biased.

D, is reverse biased.

D5 is forward biased.

D, is reverse biased.

D5 is forward biased.

Dy is reverse biased.

D5 is forward biased.

Dy is reverse biased.

EXAMPLE 2-10

Determine V;, V,, V3, and V, (with respect to ground) for the circuits in
Example 2-9.

Solution: Vy: D is forward biased, dropping 0.7 V across its terminals.
Therefore, V|, = 4.3V (5.0 — 0.7).
V,: D, is reverse biased. No current will flow through the 1-k{} resis-

tor,so V, = 0 V.
Vi D5 is forward biased, dropping 0.7 V across its terminals, making
V;=0.7V.

V,: Dy is reverse biased, acting like an open. Therefore, V, = 5 V.

Vs: Because Dy is reverse biased (open), it has no effect on the circuit.
D5 is forward biased, dropping 0.7 V, making V5 = 4.3 V.

Vi: Dy is reverse biased (open), so it has no effect on the circuit. D5 is
forward biased, so it has +0.7 V on its anode side, which is +0.7 above the
0-V ground level, making Vg = +0.7 V.

Review Questions

2-15. To forward bias a diode, the anode is made more
(positive/negative) than the cathode.

2-16. A forward-biased diode has how many volts across its terminals?

2-8 A Transistor as a Switch

The bipolar transistor is a very commonly used switch in digital electronic circuits. It
is a three-terminal semiconductor component that allows an input signal at one of its
terminals to cause the other two terminals to become a short or an open circuit. The
transistor is most commonly made of silicon that has been altered into N-type material
and P-type material. N-type silicon is made by bombarding pure silicon with atoms
having structures with one more electron than silicon does. P-type silicon is made by
bombarding pure silicon with atoms having structures with one less electron than
silicon does.

Three distinct regions make up a bipolar transistor: emitter, base, and collector.
They can be a combination of N-P-N-type material or P-N-P-type material bonded to-
gether as a three-terminal device. Figure 2-27 shows the physical layout and symbol
for an NPN transistor. (In a PNP transistor, the emitter arrow points the other way.)
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Common
Misconception

Students often think that
the input signal to the base
of a transistor must
somehow be part of the
output at the collector or
emitter, but it is not. Once
you determine if the C-to-E
is a short or an open, you
can ignore the base circuit
altogether.
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Collector

N

Collector
Base Base

P
Emitter

N

Emitter (b)
() ©

Figure 2-27 The NPN bipolar transistor: (a) physical layout; (b) symbol; (¢) photograph.

In an electronic circuit, the input signal (1 or 0) is usually applied to the base of
the transistor, which causes the collector—emitter junction to become a short or an open
circuit. The rules of transistor switching are as follows:

1. In an NPN transistor, applying a positive voltage from base to emitter causes
the collector-to-emitter junction to short (this is called “turning the transistor
ON”). Applying a negative voltage or 0 V from base to emitter causes the col-
lector-to-emitter junction to open (this is called “turning the transistor OFF”).

2. In a PNP* transistor, applying a negative voltage from base to emitter turns
it ON. Applying a positive voltage or 0 V from base to emitter turns it OFF.

Figure 2-28 shows how an NPN transistor functions as a switch in an electronic
circuit. In the figure, resistors R and R are used to limit the base current and the col-
lector current. In Figure 2-28(a), the transistor is turned ON because the base is more
positive than the emitter (input signal = +2 V). This causes the collector-to-emitter
junction to short, placing ground potential at V (Vo = 0 V).

A positive voltage on the
base of an NPN causes
C-to-E to short.

+5V +5V
RC RC
9 V(Hli = 0 V 1 VOL\[ = 5 V
R, c . R, c .
Transistor ON Transistor OFF
(short C-to-E) (open C-to-E)
+ Input
oy — ™
signal
1 1 ov 1
(a) (b)
Figure 2-28 NPN transistor switch: (a) transistor ON and (b) transistor OFF.

*PNP transistor circuits are analyzed in the same way as NPN circuits except that all voltage and current polarities are reversed.
NPN circuits are much more common in industry and will be used most often in this book.
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In Figure 2-28(b), the input signal is removed, making the base-to-emitter junction
0V, turning the transistor OFF. With the transistor OFF, there is no current (0 amps)

through Re,s0 Voiu =5V — (0A X Rp) =5 V.
Digital input signals are usually brought in at the base of the transistor, and the
output is taken off the collector or emitter. The following examples use timing analy-

sis to compare the input and output waveforms.

EXAMPLE 2-11
Sketch the waveform at V, in the circuit shown in Figure 2-29, given the

input signal C,, in Figure 2-30.
+5V
The positive Cp
causes C-to-E to
short (transistor ON).

+5V | I
g Y
OFF | ON | OFF | ON | OFF | ON
Solution: 5V
V t
S I e I
Figure 2-29 Figure 2-30
Explanation: When Cp = 0V, the transistor is OFF and the equivalent
circuit is as shown in Figure 2-31(a).
IC = OA
Therefore,
Ve=5V —-—(0A X2kQ) =5V
+5V

% O

100 kQ

MW
c,,£ov
1

1

— +5V

C,

I
I}

+5V

2kQ 2kQ

VOU! = 5 V 1 VOLI[
C C
100 kQ

O AW
B

j:E

(b)

(a)
Figure 2-31 Equivalent circuits: (a) transistor OFF and (b) transistor ON.

When Cp = +5V, the transistor is ON and the equivalent circuit is
as shown in Figure 2-31(b). The collector is shorted directly to ground;

therefore, V,,, = OV.
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EXAMPLE 2-12

Sketch the waveform at V,, in the circuit shown in Figure 2-32, given the
input signal C,, in Figure 2-33.

+5V
R, 1 kQ
VOU[
+5V
100 kQ C,
ov
§ 20 kQ
C, )
Solution: 1476V
= = = " ov
Figure 2-32 Figure 2-33
Explanation: When C, = 0V, the transistor is OFF and the equivalent
circuit is as shown in Figure 2-34(a). From the voltage-divider equation,
Vo= 5V X20kQ 476V
M20kQ +1kQ
Next, when C, = +5 V, the transistor is ON and the equivalent circuit is as
shown in Figure 2-34(b). Now the collector is shorted to ground, making
Vout = 0 V. Notice the difference in V, as compared to Example 2-11,
which had no load resistor connected to V.
+5V +5V
1kQ ; 1kQ
I
" Vou Vou
—
c
100 kQ

=
S
§W‘
)
= O

AW

20kQ

£ ’ E §20m gq E
lov J lsv

(a) (b)
Figure 2-34

Equivalent circuits: (a) transistor OFF and (b) transistor ON.
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Review Questions

2-17. Name the three pins on a transistor.

2-18. To turn ON an NPN transistor, a (positive/negative)
voltage is applied to the base.

2-19. When a transistor is turned ON, its collector-to-emitter becomes a
(short/open).

2-9  The TTL Integrated Circuit

Transistor—transistor logic (TTL) is one of the most widely used integrated-circuit
technologies. TTL integrated circuits use a combination of several transistors, diodes,
and resistors integrated together in a single package.

One basic function of a TTL integrated circuit is as a complementing switch, or
inverter. The inverter is used to take a digital level at its input and complement it to the
opposite state at its output (1 becomes 0, 0 becomes 1). Figure 2-35 shows how a
common-emitter-connected transistor switch can be used to perform the same function.

Figure 2-35 Common-emitter transistor circuit operating as an inverter.

When V;, equals 1 (+5 V), the transistor is turned on (called saturation) and V
equals 0 (0 V). When V;, equals 0 (0 V), the transistor is turned off (called cutoff) and V,,
equals 1 (approximately 5 V), assuming that R; is much greater than R (R; => R().

EXAMPLE 2-13

Let’s assume that R- = 1kQ, R; = 10kQ, and V;, = 0 in Figure 2-35.
Vour Will equal 4.55 V:

5V X 10kQ

— =455V
1kQ + 10kQ

But if R; decreases to 1 k() by adding more loads in parallel with it, V
will drop to 2.5 V:

5V X 1kQ sy
1kQ + 1kQ )

We can see from Example 2-13 that the 1-level output of the inverter is very de-
pendent on the size of the load resistor (R;), which can typically vary by a factor of 10.
So right away you might say, “Let’s keep R very small so that R; is always much
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.' Helpful

Hint
If you understand the idea
that V¢ varies depending
on the size of the connected
load, it will help you
understand why gate
outputs in the upcoming
chapters are not exactly
0 V and 5 V. We discuss
TTL and CMOS
input/output characteristics
in Chapter 9.
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greater than R-” (R, >> R). Well, that’s fine for the case when the transistor is cut off
(Vour = 1), but when the transistor is saturated (V,,,, = 0), the transistor collector cur-
rent will be excessive if R is very small (I = 5 V/R; see Figure 2-36).

V=0

in

R-+R,
RL
Transistor
Notice that V.

cutoff — — out
is always the

inverse of V.

in

in this circuit.

V...= 0 (R, is shorted by
the transistor)

Transistor
saturated — —

Figure 2-36 Common-emitter calculations.

Therefore, it seems that when the transistor is cut off (V,,, = 1), we want R to
be small to ensure that V,, is close to 5 V, but when the transistor is saturated, we want
R to be large to avoid excessive collector current.

This idea of needing a variable R, resistance is accommodated by the TTL
integrated circuit (Figure 2-37). It uses another transistor (Q,) in place of R to act
like a varying resistance. Q, is cut off (acts like a high R) when the output transistor
(Q5) is saturated, and then Q, is saturated (acts like a low R-) when Q5 is cut off. (In
other words, when one transistor is ON, the other one is OFF.) This combination of Q5
and Q, is referred to as the totem-pole arrangement.

Transistor Q; is the input transistor used to drive Q,, which is used to control Qs
and Q,. Diode D, is used to protect Q; from negative voltages that might inadvertently
be placed at the input. D, is used to ensure that when Qj is saturated, Q4 will be cut off
totally. V¢ is the abbreviation used to signify the power supply to the integrated circuit.

TTL is a very popular family of integrated circuits. It is much more widely used
than RTL (resistor—transistor logic) or DTL (diode-transistor logic) circuits, which
were the forerunners of TTL. Details on the operation and specifications of TTL ICs
are given in Chapter 9. In that chapter, you will learn why V, is not exactly 0 V and
5 V (it is more typically 0.2 V and 3.4 V).

A single TTL integrated-circuit (IC) package such as the 7404 has six complete
logic circuits fabricated into a single silicon chip, each logic circuit being the equiva-
lent of Figure 2—-37. The 7404 has 14 metallic pins connected to the outside of a plas-
tic case containing the silicon chip. The 14 pins, arranged 7 on a side, are aligned on
14 holes of a printed-circuit board, where they are then soldered. The 7404 is called a
14-pin DIP (dual-in-line package) and costs less than 24 cents. Figure 2-38 shows a
sketch of a 14-pin DIP IC. In subsequent chapters, we will see how to use ICs in actual
digital circuitry.
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Figure 2-37 Schematic of a TTL Figure 2-38 A 7404 TTL IC chip.
inverter circuit.

ICs are configured as DIPs to ensure that the mechanical stress exerted on the
pins when being inserted into a socket is equally distributed and that, although most of
these pins serve as conductors to either the gates’ inputs or outputs, some simply pro-
vide structural support and are simply anchored to the IC casing. These latter pins are
denoted by the letters NC, meaning that they are not physically or electrically
connected to an internal component.

The pin configuration of the 7404 is shown in Figure 2—39. The power supply con-
nections to the IC are made to pin 14 (+5 V) and pin 7 (ground), which supplies power
to all six logic circuits. In the case of the 7404, the logic circuits are called inverters. The
symbol for each inverter is a triangle with a circle at the output. The circle is used to in-
dicate the inversion function. Although never shown in the pin configuration top view
of digital ICs, each gate is electrically tied internally to both V- and ground. The entire
circuit shown in Figure 2-37 is contained inside each of the six inverters.

[14] Ve

<
< <<
TR EE

L] L] [ [ o] [F]

GND | 7

Figure 2-39 A 7404 hex inverter pin configuration.

Figure 2—40 shows three different ICs next to a pencil to give you an idea of
their size.

2-10 MultiSIM® Simulation of Switching Circuits

The MultiSIM® software is useful for designing and simulating digital logic before
building the actual circuits in the lab. Figure 2—41 shows four switching circuits that
employ switches, transistors, inverter gates, and light-emitting diodes (LEDs). LEDs
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Figure 2-41 MultiSIM® simulation of switching circuits.
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are special diodes that illuminate when forward biased. They are often used in digital
circuitry to indicate HIGH/LOW logic levels.

If you have already installed MultiSIM on your computer, you can load the cir-
cuit file named fig2_41 from the textbook website and run the simulation shown in
Figure 2—41. In Figure 2—41(a), if the single-pole single-throw (SPST) switch is in the
UP position, no current can flow and the LED will not illuminate. With the switch
thrown DOWN, 5 V are applied to the circuit, which forward biases the LED and
makes it illuminate. (You can simulate this action by repeatedly pressing the space bar
on your computer to make the switch go DOWN and UP. Notice that MultiSIM desig-
nates an ON LED by making the LED arrows RED.)

Figure 2-41(b) uses a single-pole double-throw (SPDT) switch to input HIGH/
LOW levels into the circuit. With the switch in the UP position the current flows
through the lower circuit, illuminating LED2. With the switch DOWN, current is in-
stead allowed to flow down through LEDI1 via the 5-V supply and R;. Run the simula-
tion and watch the active LED as you throw the switch by pressing the space bar.

Figure 2-41(c) uses an NPN transistor to supply the current for the LED. In the
previous circuits, all of the LED current was funneled through the switch. In this circuit
the switch is used to “turn ON” or “turn OFF” the transistor, which in turn provides
a path for the current to flow to ground through the collector to the emitter. (The tran-
sistor base current required to turn ON a transistor is typically 0.5 mA, whereas the
LED current is typically 10 mA.) In later chapters we learn why this is important be-
cause the switches in Figure 2—41 (a) and (b) are replaced by digital logic ICs that may
not be able to pass 10 mA as the transistor can. Run the simulation and watch the ac-
tive LED as you throw the switch by pressing the space bar.

Figure 2—-41(d) uses digital logic (inverters in this case) to turn ON the LEDs.
One advantage of using logic gates is that you do not need to provide 5-V and 0-V lev-
els as the input to the circuit as we did above. You need only to provide a voltage that
looks HIGH to the input of the gate to make the gate’s output go to 5 V. (It gets its
5-V output voltage from the V¢ supply connected to pin 14 of the 7404 IC shown in
Figure 2-39.) In this illustration, the R, potentiometer (variable resistor) is set to its top
25% point, which drops the 5-V supply by 25%, equaling approximately 3.75 V. This
is definitely a HIGH input (1) to the inverters, making them output a LOW (0), which
provides a path for the current to turn ON LED4. The current actually flows through
LED#4 into the output pin of U2A (pin 2 of the 7404 shown in Figure 2-39) and then
down into ground via the ground pin 7 shown in Figure 2-39. At the same time, inverter
U2C will output a HIGH (1) keeping LED5 OFF. The three voltmeters in the circuit
show the voltage levels at various stages.

Turn ON the MultiSIM® simulation and decrease the voltage into the gates by re-
peatedly pressing the A key on your keyboard. Notice that when the voltage drops below
half, the LEDs switch states. Increase the voltage back up by repeatedly pressing Shift-A.
Keep in mind that a HIGH into an inverter produces a LOW output and vice versa.

2-11 The CMOS Integrated Circuit

Another common IC technology used in digital logic is the CMOS (complementary
metal oxide semiconductor). CMOS uses a complementary pair of metal oxide semi-
conductor field-effect transistors (MOSFETs) instead of the bipolar transistors used in
TTL chips. (Complete coverage of TTL and CMOS is given in Chapter 9.)

The major advantage of using CMOS is its low power consumption. Because of
that, it is commonly used in battery-powered devices such as handheld calculators and
digital thermometers. The disadvantage of using CMOS is that generally its switching
speed is slower than TTL and it is susceptible to burnout due to electrostatic charges if
not handled properly. Figure 242 shows the pin configuration for a 4049 CMOS
hex inverter.

SECTION 2-11 | THE CMOS INTEGRATED CIRCUIT
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Negative supply (or ground) Ves | 8

Figure 2-42 A 4049 CMOS hex inverter pin configuration.

(d) (e)

Figure 2-43 Typical surface-mount devices (SMDs) and their footprints: (a) small outline
(SO); (b) plastic leaded chip carrier (PLCC); (c) ball grid array (BGA); (d) photograph of
actual SMDs; (e) photograph of SMDs mounted on a printed-circuit board.
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2-12 Surface-Mount Devices

The future of modern electronics depends on the ability to manufacture smaller, more
dense components and systems. Surface-mount devices (SMDs) have fulfilled this
need. They have reduced the size of DIP-style logic by as much as 70% and reduced their
weight by as much as 90%. To illustrate the size difference, a 7400 IC in the DIP style
measures 19.23 mm by 6.48 mm, whereas the equivalent 7400 SMD is only 8.75 mm by
6.20 mm.

SMDs have also significantly lowered the cost of manufacturing printed-circuit
boards. This reduction occurs because SMDs are soldered directly to a metalized foot-
print on the surface of a PC board, whereas holes must be drilled for each leg of a DIP.
Also, SMDs can use the faster pick-and-place machines instead of the autoinsertion
machines required for “through-hole” mounting of DIP ICs. (Removal of defective
SMDs from PC boards is more difficult, however. Special desoldering tools and tech-
niques are required because of the SMD’s small size.)

Complete system densities can increase using SMDs because they can be placed
closer together and can be mounted to both sides of a printed-circuit board. This also
tends to decrease the capacitive and inductive problems that occur in digital systems
operating at higher frequencies. (This topic is discussed further in Chapter 9.)

The most popular SMD package styles are the SO (small outline), the PLCC
(plastic leaded chip carrier), and the ball grid array (BGA) shown in Figure 2-43. The
SO is a dual-in-line plastic package with leads spaced 0.050 in. apart and bent down and
out in a gull-wing format. The PLCC is the most common SMD for ICs requiring a
higher pin count (those having more than 28 pins). The PLCC is square, with leads on
all four sides. They are bent down and under in a J-bend configuration. They, too, are
soldered directly to the metalized footprint on the surface of the circuit board. For even
higher pin counts, the BGA uses an array of round solder tabs on the underside of the
package. Another version of the grid array is the pin grid array (PGA), which has pins
extending from the bottom. It is soldered in holes in a circuit board or placed in a socket
for easy removal. Large-scale microprocessors like the Pentium are usually PGA ICs.

The SO package is available for the most popular lower-complexity TTL and CMOS
digital logic and analog IC devices. PLCCs, BGAs, and PGAs are available to implement
more complex logic, such as microprocessors, microcontrollers, and large memories.

Review Questions

2-20. In a common-emitter transistor circuit, when V is 0, R should be
(small/large), and when V; is 1, R should be
(small/large).

2-21. Which transistor in the schematic of the TTL circuit in Figure 2-37
serves as a variable R resistance?

B Summary

In this chapter, we have learned that

1. The digital level for 1 is commonly represented by a voltage of 5 V in
digital systems. A voltage of 0 V is used for the 0 level.

2. An oscilloscope can be used to observe the rapidly changing voltage-
versus-time waveform in digital systems.

3. The frequency of a clock waveform is equal to the reciprocal of the
waveform’s period.

SUMMARY
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4. The transmission of binary data in the serial format requires only a single
conductor with a ground reference. The parallel format requires several
conductors but is much faster than the serial format.

5. Electromechanical relays are capable of forming shorts and opens in
circuits requiring high current values but not high speed.

6. Diodes are used in digital circuitry whenever there is a requirement for
current to flow in one direction but not in the other.

7. The transistor is the basic building block of the modern digital IC. It can be
switched on or off by applying the appropriate voltage at its base connection.

8. TTL and CMOS ICs are formed by integrating thousands of transistors in
a single package. They are the most popular ICs used in digital circuitry today.

9. SMD-style ICs are gaining popularity over the through-hole style DIP
ICs because of their smaller size and reduced manufacturing costs.

Glossary

Bias: The voltage necessary to cause a semiconductor device to conduct or cut off
current flow. A device can be forward or reverse biased, depending on what
action is desired.

Chip: The term given to an integrated circuit. It comes from the fact that each inte-
grated circuit comes from a single chip of silicon crystal.

CMOS: Complementary metal oxide semiconductor. A family of integrated circuits
used to perform logic functions in digital circuits. The CMOS is noted for
its low power consumption but sometimes slow speed.

Cutoff: A term used in transistor switching signifying that the collector-to-emitter
junction is turned off or is not allowing current flow.

Diode: A semiconductor device used to allow current flow in one direction but not
the other. As an electronic switch, it acts like a short in the forward-biased
condition and like an open in the reverse-biased condition.

DIP: Dual-in-line packages. The most common pin layout for integrated circuits. The
pins are aligned in two straight lines, one on each side.

Energized Relay Coil: By applying a voltage to the relay coil, a magnetic force is in-
duced within it; this is used to attract the relay contacts away from their
resting positions.

Frequency: A measure of the number of cycles or pulses occurring each second. Its
unit is the hertz (Hz), and it is the reciprocal of the period.

Hex Inverter: An integrated circuit containing six inverters on a single DIP package.

Integrated Circuit: The fabrication of several semiconductor and electronic devices
(transistors, diodes, and resistors) onto a single piece of silicon crystal.
Integrated circuits are being used to perform the functions that once re-
quired several hundred discrete semiconductors.

Inverter: A logic circuit that changes its input into the opposite logic state at its out-
put (O to 1 and 1 to 0).

Logic State: A 1 or 0 digital level.

Oscilloscope: An electronic measuring device used in design and troubleshooting to
display a waveform of voltage magnitude (y axis) versus time (x axis).
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Parallel: A digital signal representation that uses several lines or channels to transmit
binary information. The parallel lines allow for the transmission of an en-
tire multibit number with each clock pulse.

Period: The measurement of time from the beginning of one periodic cycle or clock
pulse to the beginning of the next. Its unit is the second(s), and it is the re-
ciprocal of frequency.

Relay: An electric device containing an electromagnetic coil and normally open or
normally closed contacts. It is useful because, by supplying a small trig-
gering current to its coil, the contacts will open or close, switching a higher
current on or off.

Saturation: A term used in transistor switching that signifies that the collector-to-
emitter junction is turned on, or conducting current heavily.

Serial: A digital signal representation that uses one line or channel to transmit binary
information. The binary logic states are transmitted 1 bit at a time, with the
LSB first.

Surface-Mounted Device: A newer style of integrated circuit, soldered directly to
the surface of a printed circuit board. They are much smaller and lighter
than the equivalent logic constructed in the DIP through-hole-style logic.

Timing Diagram: A diagram used to display the precise relationship between two or
more digital waveforms as they vary relative to time.

Totem Pole: The term used to describe the output stage of most TTL integrated circuits.
The totem-pole stage consists of one transistor in series with another, config-
ured in such a way that when one transistor is saturated, the other is cut off.

Transistor: A semiconductor device that can be used as an electronic switch in digi-
tal circuitry. By applying an appropriate voltage at the base, the collector-
to-emitter junction will act like an open or a shorted switch.

TTL: Transistor—transistor logic. The most common integrated circuit used in digital
electronics today. A large family of different TTL integrated circuits is used
to perform all the logic functions necessary in a complete digital system.

I ProbLeim s

Sections 2-1 and 2-2
2—-1. Determine the period of a clock waveform whose frequency is
(a) 2 MHz (b) 500 kHz (c) 4.27 MHz (d) 17 MHz
Determine the frequency of a clock waveform whose period is

(€ 2us () 100us (g 0.75ms  (h) L.5pus

Sections 2-3 and 2-4

2-2. Sketch the serial and parallel representations (similar to Figure 2—10)
of the following numbers, and calculate how long they will take to transmit
(clock frequency = 2 MHz).

(@) 99 (b) 124,

2-3. (a) How long will it take to transmit the number 33 in serial if the
clock frequency is 3.7 MHz? (Transmit the number as an 8-bit
binary number.)

(b) Is the serial line HIGH or LOW at 1.21 us?

PROBLEMS
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2-4. (a) How long will it take to transmit the three ASCII-coded charac-
ters $14 in 8-bit parallel if the clock frequency is 8 MHz?

(b) Repeat for $78.18 at 4.17 MHz.

Sections 2-5 and 2-6

C 2-5. Draw the timing diagram for V., Voun, and Vs in Figure P2-5.
+8V
+8V
10 kQ
10 kQ
Ry
Clock Vout1
oscillator

C,
VoulZ
@ 10kQ R
10 kQ

c, [ | [ & 10kQ

Voul 3
Vou( 1

‘/(\u‘ 2

Vou[ 3

Figure P2-5

Section 2-7
2-6. Determine if the diodes in Figure P2—6 are reverse or forward biased.
C 2-7. Determine Vi, V5, V3, V4, Vs, Vi, and V; in the circuits of Figure P2—-6.

2-8. In Figure P26, if the cathode of any one of the diodes Dg, Dy, or Dy
is connected to 0 V instead of +5 V, what happens to V,?

2-9. In Figure P2-6, if the anode of any of the diodes D, D5, or D3 is
connected to +5 V instead of 0 V, what happens to V;?
Section 2-8
2-10. Find V and V,, for the circuits of Figure P2—-10.
2-11. Sketch the waveforms at V, in the circuit of Figure 2-32 using

Section 2-9

2-12. To use a common-emitter transistor circuit as an inverter, the input
signal is connected to the (base, collector, or emitter) and the
output signal is taken from the (base, collector, or emitter).
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+5V BV
10 kQ
Vi
10 kQ Ds
(©
Dll
oV —P—
D12
ov —DH—¢
Dl3
ov —H—e+—v,
10 kQ
(d) (e) ®
Figure P2-6
+5V +5V
10 kQ
100 kQ
Vou! 1
100 kQ
+5V Vour
10 kQ
(@) (b)
Figure P2-10
C 2-13. Determine V,,, for the common-emitter transistor inverter circuit of
Figure 2-35using V;, = 0V, Rz = 1 MQ, R = 330, and R,y = 1 M.
C 2-14. If the load resistor (R),,q) used in Problem 2—13 is changed to 470 (2,
describe what happens to V.
C 2-15. In the circuit of Figure 2-35 with V;, = 0V, V,, will be almost 5 V

as long as R,,,q is much greater than R.. Why not make R very small to

ensure that the circuit will work for all values of R,,4?

C 2-16. In Figure 2-35, if R- = 100 (2, find the collector current when
Vin = +5V.
C 2-17. Describe how the totem-pole output arrangement in a TTL circuit

overcomes the problems faced when using the older common-emitter tran-

sistor inverter circuit.

PROBLEMS
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2-18. Sketch the waveform at C, and V., for Figure P2-18.

+12V

§8k9

Vou!
10 kQ |/
w—| o
5V
ov Cr
Figure P2-18
E;)J’? mmmmm Schematic Interpretation Problems m———"

See Appendix G for the schematic diagrams.

S 2-19. Y1 in the 4096/4196 control card schematic sheet 1 is a crystal used
to generate a very specific frequency.

(a) What is its rated frequency?
(b) What time period does that create?

S 2-20. Repeat Problem 2-19 for the crystal X1 in the HC11D0O master
board schematic.

S 2-21. The circuit on the HC11DO0 schematic is capable of parallel as well
as serial communication via connectors P; and P,. Which is parallel, and
which is serial? (Hint: TX stands for transmit, RX stands for receive.)

S 2-22. Is diode D, of the HC11DO0 schematic forward or reverse biased?
(Hll’lt VCC =5 V)

S 2-23. The transistor Q; in the HC11DO0 schematic is turned ON and OFF by

the level of pin 2 on U3:A. At what level must pin 2 be to turn Q; ON, and
what will happen to the level on the line labeled RESET B when that happens?

MultiSIM® Exercises

E2-1. Load the circuit file for Section 2-3. Read the instructions in the
Description window.

(a) Determine the three ASCII characters that are transmitted in serial.
(b) Determine the number of serial bits transmitted.

E2-2. Load the circuit file for Section 2-4. Read the instructions in the
Description window.

(a) Determine the three ASCII characters that are transmitted in parallel.
(b) How many clock pulses did it take to complete the transmission?
E2-3. Load the circuit file for Section 2—-6a. Read the instructions in the

Description window. The normally open relay contacts are used to create a
short across the lower 5-k(} resistor when C, goes HIGH.
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(a) Measure the voltage levels of C, and V3 with the oscilloscope. Note
the relationship between the two waveforms.

(b) Change the upper resistor to 2 k() and the lower resistor to 8 k(). Predict
the new voltage levels, then measure them with the oscilloscope.

(c) If the normally closed relay contacts were used, what change would
you expect in the V3 waveform? Try it.

E2-4. Load the circuit file for Section 2—-6b. Read the instructions in the

Description window. The normally closed relay contacts are used to create

an open between the two resistors when C, goes HIGH.

(a) Measure the voltage levels of C,, and V4 with the oscilloscope. Note the
relationship between the two waveforms. (The top waveform is V).

(b) Change the upper resistor to 2 k() and the lower resistor to 8 k(). Predict
the new voltage levels, then measure them with the oscilloscope.

(c¢) If the normally open relay contacts were used instead of the normally
closed contacts, what change would you expect in the V4 wave-
form? Try it.

E2-5. Load the circuit file for Section 2-7. Read the instructions in the
Description window. Before turning the power switch ON, predict the volt-
age V1, V2, V3, and V4.

(a) Turn the switch ON and check your answers.

(b) Reverse all six diodes, and predict what V1, V2, V3, and V4 will
become. Turn the power switch ON, and check your answers.

E2-6. Load the circuit file for Section 2-8. Read the instructions in the

Description window.

(a) Measure the voltage levels of C, and V,,, with the oscilloscope. Note
the relationship between the two waveforms.

(b) Change the upper resistor to 2 k() and the lower resistor to 8 k(). Predict
the new voltage levels, then measure them with the oscilloscope.

Answers to Review Questions

2-1. x axis, time; y axis, voltage

2-2. The clock frequency is the
reciprocal of the clock period.

2-3. 125ns

The contacts will either make a
connection (NO relay) or break
a connection (NC relay) when
the coil is energized.

24 201 e A0 iy e e
2-5. 5MHz relay breaks connection when
2-6. 385 ps energized.
2-7. Frequency = 357 ns 2-15. Positive
2-8. 58.5kHz 2-16. Approximately 0.7 V
2-9. It is faster. 2-17. Emitter, base, collector
2-10. Parallel 2-18. Positive
2-11. 4.80 us 2-19. Short
2-12. 600 ns 2-20. Large, small
2-13. The relay coil is energized by 2-21. Q4

placing a voltage at its terminals.

ANSWERS TO REVIEW QUESTIONS
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Basic Logic Gates

OUTLINE

3-1 The AND Gate
3-2 The OR Gate
3-3 Timing Analysis
3-4 Enable and Disable Functions
3-5 Using IC Logic Gates
3-6 Introduction to Troubleshooting Techniques
3-7 The Inverter
3-8 The NAND Gate
3-9 The NOR Gate
3-10 Logic Gate Waveform Generation
3-11 Using IC Logic Gates
3-12 Summary of the Basic Logic Gates and IEEE/IEC Standard Logic Symbols

Upon completion of this chapter, you should be able to do the following:

* Describe the operation and use of AND gates and OR gates.

¢ Construct truth tables for two-, three-, and four-input AND and OR gates.

e Draw timing diagrams for AND and OR gates.

* Describe the operation, using timing analysis, of an ENABLE function.

 Sketch the external connections to integrated-circuit chips to implement AND
and OR logic circuits.

* Explain how to use a logic pulser and a logic probe to troubleshoot digital
integrated circuits.

e Describe the operation and use of inverter, NAND, and NOR gates.

 Construct truth tables for two-, three-, and four-input NAND and NOR gates.

e Draw timing diagrams for inverter, NAND, and NOR gates.

* Use the outputs of a Johnson shift counter to generate specialized waveforms
utilizing various combinations of the five basic gates.

* Develop a comparison of the Boolean equations and truth tables for the five
basic gates.




INTRODUCTION

Logic gates are the basic building blocks for forming digital electronic circuitry. A
logic gate has one output terminal and one or more input terminals. Its output will be
HIGH (1) or LOW (0) depending on the digital level(s) at the input terminal(s).
Through the use of logic gates, we can design digital systems that will evaluate digital
input levels and produce a specific output response based on that particular logic cir-
cuit design. The five basic logic gates are the AND, OR, NAND, NOR, and inverter.

3-1 The AND Gate

Let’s start by looking at the two-input AND gate whose schematic symbol is shown in
Figure 3—1. The operation of the AND gate is simple and is defined as follows: The
output, X, is HIGH if input A AND input B are both HIGH. In other words, if A = 1
AND B = 1, then X = 1. If either A or B or both are LOW, the output will be LOW.

} Output X

Figure 3-1 Two-input AND gate symbol.

Input A

Input B

The best way to illustrate how the output level of a gate responds to all the pos-
sible input-level combinations is with a truth table. Table 3-1 is a truth table for a
two-input AND gate. On the left side of the truth table, all possible input-level combi-
nations are listed, and on the right side, the resultant output is listed.

TABLE 3-1 | Truth Table for a Two-Input AND

Gate
Inputs Output
A B X = AB
0 0 0
0 1 0
1 0 0
1 1 1

From the truth table, we can see that the output at X is HIGH only when both A
AND B are HIGH. If this AND gate is a TTL integrated circuit, HIGH means +5V
and LOW means 0 V (i.e., 1 is defined as +5 V and 0 is defined as 0 V).

One example of how an AND gate might be used is in a bank burglar alarm system.
The output of the AND gate will go HIGH to turn on the alarm if the alarm activation key
is in the ON position AND the front door is opened. This setup is illustrated in Figure
3-2(a). Figure 3-2(b) shows the result for every combination of Key (K) and Door (D).

K=0

D=0
K=0
Alarm K D=1 A4=0
activation
key — ON K=1
D=0
— alarm
Bank
D _
OPENED D=1

(a) (b)

Figure 3-2 AND gate: (a) Used to activate a burglar alarm; (b) all combinations of key ON
(K) and door OPEN (D).
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(a)

Another way to illustrate the operation of an AND gate is by use of a series elec-
tric circuit. In Figure 3-3, using manual and transistor switches, the output at X is
HIGH if both switches A AND B are HIGH (1).

Figure 3-3 also shows what is known as the Boolean equation for the AND
function, X = A and B, which can be thought of as X equals 1 if A AND B both equal 1.

+5V
+5V
\O A
AO
10
X=AAND B
B_
BO
X=AAND B

(a) (b)

Figure 3-3 Electrical analogy for an AND gate: (a) using manual switches;
(b) using transistor switches.

The Boolean equation for the AND function can more simply be writtenas X = A - B
or just X = AB (which is read as “X equals A AND B”). Boolean equations will be
used throughout the rest of the book to depict algebraically the operation of a logic gate
or a combination of logic gates.

AND gates can have more than two inputs. Figure 3—4 shows a four-input, a
three-input, and an eight-input AND gate. The truth table for an AND gate with four

AB A —

Bad -

D [E—
F— X =ABCD } X=ABC }— X = ABCDEFGH
c E —

) F
G —_—

H —]

(c)

Figure 3-4 Multiple-input AND gate symbols: (a) 4-input; (b) 3-input formed with two
2-input gates; (c) 8-input.

inputs is shown in Table 3-2. To determine the total number of different combinations
to be listed in the truth table, use the equation

number of combinations = 2, where N = number of inputs 3-1)

Therefore, in the case of a four-input AND gate, the number of possible input combi-
nations is 2* = 16.

When building the truth table, be sure to list all 16 different combinations of in-
put levels. One easy way to ensure that you do not inadvertently overlook a combina-
tion of these variables or duplicate a combination is to list the inputs in the order of a
binary counter (0000, 0001, 0010, ..., 1111). Also notice in Table 3-2 that the A col-
umn lists eight Os, then eight 1s; the B column lists four Os, four 1s, four Os, four 1s;
the C column lists two Os, two 1s, two Os, two 1s, and so on; and the D column lists one
0, one 1, one 0, one 1, and so on.

CHAPTER 3 | BASIC LOGIC GATES



TABLE 3-2 | Truth Table for a Four-Input AND Gate

The output at X is
A B C D X HIGH only if all
0 0 0 0 0 inputs are HIGH.
0 0 0 1 0
0 0 1 0 0
0 0 1 1 0
0 1 0 0 0
0 1 0 1 0
0 1 1 0 0
0 1 1 1 0
1 0 0 0 0
1 0 0 1 0
1 0 1 0 0
1 0 1 1 0
1 1 0 0 0
1 1 0 1 0
1 1 1 0 0
1 1 1 1 1

3-2 The OR Gate

The OR gate also has two or more inputs and a single output. The symbol for a two-
input OR gate is shown in Figure 3—5. The operation of the two-input OR gate is defined
as follows: The output at X will be HIGH whenever input A OR input B is HIGH or both
are HIGH. As a Boolean equation, this can be written X = A + B (which is read as “X
equals A OR B”). Notice the use of the + symbol to represent the OR function.

SRS
I
)
I
(=]

S
|

=
o
(=}
>
1

Il
>
I

Lk

Input A
Output X
Input B

(a) (b)

S~
I

Figure 3-5 Two-input OR gate: (a) symbol; (b) all input combinations.

The truth table for a two-input OR gate is shown in Table 3-3.

TABLE 3-3 | Truth Table for a Two-Input

OR Gate
Inputs Output
A B X=A+B
0 0 0
0 1 1
1 0 1
1 1 1

SECTION 3-2 | THE OR GATE

> | Common
Misconception

When you build a truth
table, you might mistakenly
omit certain input
combinations if you don’t
set the variables up as a
binary counter.
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From the truth table you can see that X is 1 whenever A OR B is 1 or if both A
and B are 1. Using manual or transistor switches in an electric circuit, as shown in
Figure 3-6, we can observe the electrical analogy to an OR gate. From the figure, we
see that the output at X will be 1 if A or B, or both, are HIGH (1).

+5V

X=AORB

L
X=AORB =

() (b)
Figure 3-6 Electrical analogy for an OR gate: (a) using manual switches; (b) using

transistor switches.

OR gates can also have more than two inputs. Figure 3—7 shows three-input OR
gates and Figure 3-8 shows an eight-input OR gate. The truth table for the three-
input OR gate will have eight entries (2° = 8), and the eight-input OR gate will have
256 entries (2° = 256).

A+B
A /
] O
A

(a) (b)

Figure 3-7 Three-input OR gate: (a) symbol; (b) three inputs formed with two 2-input gates.

A

C
g }X:A+B+C+D+E+F+G+H
F

G
H—

Figure 3-8 FEight-input OR gate symbol.

Let’s build a truth table for the three-input OR gate.

The truth table of Table 3—4 is built by first using Equation 3—1 to determine that
there will be eight entries, then listing the eight combinations of inputs in the order of
a binary counter (000 to 111), and then filling in the output column (X) by realizing
that X will always be HIGH as long as at least one of the inputs is HIGH. When you
look at the completed truth table, you can see that the only time the output is LOW is
when all the inputs are LOW.
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TABLE 3-4 | Truth Table for a Three-Input

EXAMPLE 3-1

Determine the output at U, V, W, X, Y, and Z in Figure 3-9.

0 0

U v
0 I
| — | —

X Y
0— ]

Figure 3-9 Basic AND and OR gate operation.

Solution:
U=0 (OORO = 0)

V=1 (0ORI =1)
W=1 (0OR1ORO = 1)
X=0 (1ANDO = 0)
Y=1 (1ANDI1 = 1)
Z=0 (0AND1ANDO = 0)

Review Questions

OR Gate
The output at X is

A B (& X HIGH if any

0 0 0 0 input is HIGH.
0 0 1 1

0 1 0 1

0 1 1 1

1 0 0 1

1 0 1 1

1 1 0 1

1 1 1 1

=ay
=D

3-1. All inputs to an AND gate must be HIGH for it to output a HIGH.

True or false?
3-2. What is the purpose of a truth table?

3-3. What is the purpose of a Boolean equation?

3—4. What input conditions must be satisfied for the output of an OR gate

to be LOW?

3-3  Timing Analysis

Another useful means of analyzing the output response of a gate to varying input-
level changes is by means of a timing diagram. A timing diagram, as described in
Chapter 2, is used to illustrate graphically how the output levels change in response to

input-level changes.

SECTION 3-3 | TIMING ANALYSIS

w

V4
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The output goes HIGH
when both inputs
are HIGH

(@) (b)

Figure 3-10 Timing analysis of an AND gate: (a) waveform sketch; (b) actual logic
analyzer display.

The timing diagram in Figure 3—10 shows the two input waveforms (A and B)
that are applied to a two-input AND gate and the X output that results from the AND
operation. (For TTL and most CMOS logic gates, 1| = +5V and 0 = 0V.) As you
can see, timing analysis is very useful for visually illustrating the level at the output for
varying input-level changes.

Timing waveforms can be observed on an oscilloscope or a logic analyzer. A
dual-trace oscilloscope can display two voltage-versus-time waveforms on the same
x axis. That is ideal for comparing the relationship of one waveform relative to another.
The other timing analysis tool is the logic analyzer. Among other things, it can display
up to 16 voltage-versus-time waveforms on the same x axis (see Figure 3—10[b]). It can
also display the levels of multiple digital signals in a state table, which lists the binary
levels of all the waveforms, at predefined intervals, in binary, hexadecimal, or octal.
Timing analysis of 8 or 16 channels concurrently is very important when analyzing ad-
vanced digital and microprocessor systems in which the interrelationship of several
digital signals is critical for proper circuit operation.

AND-GATE SIMULATION

The MultiSIM® analysis of the same two-input AND gate circuit is shown in Figure 3—11. The Four-
Channel Oscilloscope is chosen because we can observe both the A and B inputs and the X output
simultaneously. Different colors are chosen for the three signals so that they can be distinguished on
the oscilloscope display. Also, the Y position of the A input and X output are adjusted so that the
waveforms don’t overlay on each other. The Word Generator is set up as an up counter to create the
combination of waveforms required for A and B. (Choose Set..., then UP Counter, Display + Hex.)

MultiSIM exercise: Use MultiSIM to open the file fig3_ /1 from the textbook website. Run the sim-
ulation to create the waveforms shown in Figure 3—11. Make the following changes to the gate (U1)
and rerun the simulation:

(a) Change Ul to a two-input OR gate (OR2).
(b) Change Ul to a three-input AND gate (AND3) and add the third input waveform.
(¢) Change Ul to a three-input OR gate (OR3) and add the third input waveform.
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Figure 3-11  Using the MultiSIM® Four-Channel Oscilloscope to monitor the
input and output waveforms of a two-input AND gate.

EXAMPLE 3-2

Sketch the output waveform at X and Y for the two-input OR gate and AND
gate shown in Figure 3—12(a), with the given A and B input waveforms in

Figure 3-12(b). 4
o

Figure 3-12(a) (@

A_

B—

[

Solution: 4

Answers

(b)
Figure 3-12(b) Solution to Example 3-2.
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EXAMPLE 3-3

Sketch the output waveform at X for the three-input AND gate and OR gate
shown in Figure 3-13, with the given A, B, and C input waveforms in

Figure 3-14.
= =D
B— X B Y
C— C
Figure 3-13
Solution: A |
B —
C
X
Answers
Y

Figure 3-14 Solution to Example 3-3.

EXAMPLE 3-4
The input waveform at A and the output waveform at X are given for the

AND gate in Figure 3—15(a). Sketch the input waveform that is required at
B to produce the output at X in Figure 3—15(b). Repeat for the OR gate.

L 5] -
X Y
B D

Figure 3-15(a)

Solution:
A C
X Y —
B D

m = Don’t care (B can be HIGH or LOW

to get the same output at X.)

Figure 3-15(b) Solution to Example 3-4.

3-4 Enable and Disable Functions

AND and OR gates can be used to enable or disable a waveform from being transmit-
ted from one point to another. For example, let’s say that you wanted a 1-MHz clock
oscillator to transmit only four pulses to some receiving device. You would want to enable
four clock pulses to be transmitted and then disable the transmission from then on.
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The clock frequency of 1 MHz converts to 1 us (1/1 MHz) for each clock period.
Therefore, to transmit four clock pulses, we have to provide an enable signal for 4 us.
Figure 3—16 shows the circuit and waveforms to enable four clock pulses. For the
HIGH clock pulses to get through the AND gate to point X, the second input to the AND
gate (enable signal input) must be HIGH; otherwise, the output of the AND gate will
be LOW. Therefore, when the enable signal is HIGH for 4 us, four clock pulses pass
through the AND gate. When the enable signal goes LOW, the AND gate disables any
further clock pulses from reaching the receiving device.

Clock
oscillator
Receiving
device
Enable X
signal
_,l Ly |(_
Oscciﬁzlt(or 2 3 4 5 6 7 8 |  This LOW disables the
clock from reaching the
Enable I X-output.
signal
X 1 2 3 4
A ‘
Enabled Disabled |

Figure 3-16 Using an AND gate to enable/disable a clock oscillator.

An OR gate can also be used to disable a function. The difference is that the en-
able signal input is made HIGH to disable, and that the output of the OR gate goes
HIGH when it is disabled, as shown in Figure 3—17.

Clock
oscillator
Receiving
device
Enable X
signal

This HIGH forces
1 2 3 4 5 6 7 8 the X-output HIGH,
disabling the clock.

Clock
oscillator

Enable ﬁ
signal I
X I I 3 I I 4 I I
Disabled }<— Enabled *»{ Disabled

Figure 3-17 Using an OR gate to enable/disable a clock oscillator.
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ENABLE AND DISABLE SIMULATION

Figure 3—18 shows a MultiSIM simulation of enabling and disabling func-
tions. The word generator is used to create the enable signal (En) and the
clock oscillator (Cp). Notice that whenever En is HIGH, the AND gate
passes Cp to the output at X. When En is LOW, the OR gate passes Cp to
the output at Y, otherwise Y is HIGH.

Enable Signal (En) G
Ue;

‘Word Generator Clock Osc (Cp) A B C D i
RN R NN N RN NN N sa— 0-scope| OO QQ
2 056056665 0666505652 I
_.O <3
< S © O X
_.O B~
T PRO00000 000000005 AND2
AR EEEERRRRER E v
OR2

4 Channel Dscilloscope-XSC1 x|

Cp

-] | E—— N r— i I - =

| | _2_’
T + Time Channel_a Channel_B Channel_C Channel_D Reverse
= 0.0005 2,000V 4.500 ¥ 0.000 Y 5,000 V Mo |
*|| o0.000s 2.000% 4.500 ¥ 0.000V 5.000 Y Yo
T2-T1 0.000s 0.000 % 0,000 Y 0.000 Y 0.000 % GND
r Timebase Channel_A Trigger
A
Scale: | S ms/Div Scale: |10 V/Div Edge: [+ | EC
%pos.Ov): [0 ¥pos.(Oi): |1 E B tever: |2 [v
&
— | ap>lasw>|  Jacfofoc .| © € € € |[no e |auo|one] 7> e

3ﬁg3_18

Figure 3-18 A MultiSIM simulation of enable/disable functions.

Review Questions

3-5. Describe the purpose of a timing diagram.

3-6. Under what circumstances would diagonal “don’t care” hash
be used in a timing diagram?

3-7. A (HIGH/LOW) level is required at the input to an

marks

AND gate to enable the signal at the other input to pass to the output.
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3-5  Using IC Logic Gates

AND and OR gates are available as ICs. The IC pin layout, logic gate type, and tech-
nical specifications are all contained in the logic data manual supplied by the manu-
facturer of the IC. For example, referring to a TTL or a CMOS logic data manual, we
can see that there are several AND and OR gate ICs. To list just a few:

1. The 7408 (74LS08, 74HCO8) is a quad two-input AND gate.
2. The 7411 (74LS11, 74HCI11) is a triple three-input AND gate.
3. The 7421 (74LS21, 74HC21) is a dual four-input AND gate.
4. The 7432 (74LS32, 74HC32) is a quad two-input OR gate.

In each case, the letters LS stand for the Low-Power Schottky TTL family (explained
in Section 9—4) and the letters HC stand for the High-Speed CMOS family (explained
in Section 9-5). For example, the basic part number 7408 refers to an AND gate IC
with four (quad) internal AND gates each having two inputs. The most common TTL
version is the 74LS08, and the most common CMOS version is the 74HCOS8. They both
have exactly the same pin layout and function. (Hint: The pin layout for the basic logic
gates is provided inside the front cover of this textbook.) Throughout this book, the
basic part number is usually given, and it depends on the particular application as to
which family is used to implement the design based on IC availability and speed and
power considerations.

Besides the family designation (LS, HC, etc.), most ICs will have a prefix that
specifies the manufacturer. Two examples of this are SN for Texas Instruments—
SN7400 and DM for Fairchild—DM?7400. Also, a suffix is added to the end of the part
number to specify the package style. Two examples of this are N for Plastic Dual-In-
Line Package (P-DIP)—SN7400N (see Section 2-9) and M for Small-Outline
Integrated Circuit (SOIC)—DM7400M (see Section 2—10). Other prefixes and suffixes
are too numerous to list in this textbook but are readily available from the manufactur-
ers websites listed in Appendix A.

Let’s look in more detail at one of these ICs, the 7408 (see Figure 3—19). The
7408 is a 14-pin DIP IC. The power supply connections are made to pins 7 and 14. This
supplies the operating voltage for all four AND gates on the IC. Pin 1 is identified by
a small indented circle next to it or by a notch cut out between pin 1 and 14 (see Figure
3-19). Let’s make the external connections to the IC to form a clock oscillator enable
circuit similar to Figure 3—17.

In Figure 3-20, the first AND gate in the IC was used and the other three are
ignored. The IC is powered by connecting pin 14 to the positive power supply and pin 7
to ground. The other connections are made by following the original design from

GND E@ @

Figure 3-19 The 7408 quad two-input AND gate IC pin configuration.

—_

Pl o] [+ [ [] []
RESRERERENE

SECTION 3-5 | USING IC LOGIC GATES

.' Helpful

Hint
For example, the basic part
number 7408 would
become SN74LSO8N if it
were manufactured by
Texas Instruments (SN) as
a Low-Power Schottky
family (LS) in a plastic
DIP (N) package.

» Common
Misconception

Students often think that a
gate output receives its
HIGH or LOW voltage
level from its input pin.
You need to be reminded
that each gate has its own
totem-pole output
arrangement and receives
its voltage from V¢ or
ground.
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Clock
oscillator

1
Enable O\. Switch

Disable ©
0

Receiving
device

=] [=]

7408

— GND

(=] L] 5] [=] [s] [=]

14 DC power
supply

[\

=]

Figure 3-20 Using the 7408 TTL IC in the clock enable circuit of Figure 3—17.

Figure 3—17. The clock oscillator signal passes on to the receiving device when the
switch is in the enable (1) position, and it stops when in the disable (0) position.
The pin configurations for some other logic gates are shown in Figure 3-21.

] o] o] [ [o] [l ]

[14] Ve

1

GND

=] L] B 1= 5] (=]

(a)

] o] o] [ [o] [l ]

14| Vee

1

RESNERERCRENE

(d)

GND

—_

ool

Vo

] o] o] [ [o] [l ]

RESNERERCRENE

(©)

Figure 3-21 Pin configurations for other popular TTL and CMOS AND and OR gate ICs:
(a) 7411 (74HC11); (b) 7421 (74HC21); (c) 7432 (74HC32).

3-6  Introduction to Troubleshooting Techniques

Like any other electronic device, ICs and digital electronic circuits can go bad.
Troubleshooting is the term given to the procedure used to find the fault, or trouble,

in the circuits.

To be a good troubleshooter, you must first understand the theory and operation
of the circuit, devices, and ICs that are suspected to be bad. If you understand how a
particular IC is supposed to operate, it is a simple task to put the IC through a test or to
exercise its functions to see if it operates as you expect.
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Figure 3-22 Logic pulser and logic probe.

There are two simple tools that we will start with to test the ICs and digital cir-
cuits. They are the logic pulser and logic probe (see Figure 3—22). The logic probe has
a metal tip that is placed on the IC pin, printed-circuit board trace, or device lead that
you want to test. It also has an indicator lamp that glows, telling you the digital level at
that point. If the level is HIGH (1), the lamp glows brightly. If the level is LOW (0), the
lamp goes out. If the level is floating (open circuit, neither HIGH nor LOW), the lamp
is dimly lit. Table 3—5 summarizes the states of the logic probe.

TABLE 3-5 | Logic Probe States

Logic Level Indicator Lamp
HIGH (1) On

LOW (0) Off

Float Dim

The logic pulser is used to provide digital pulses to a circuit being tested. By
applying a pulse to a circuit and simultaneously observing a logic probe, you can tell
if the pulse signal is getting through the IC or device as you would expect. As you be-
come more and more experienced at troubleshooting, you will find that most IC and
device faults are due to an open or short at the input or output terminals.

Figure 3-23 shows four common problems that you will find on printed-circuit
boards that will cause opens or shorts. Figure 3—23(a) shows an IC that was inserted
into its socket carelessly, causing pin 14 to miss its hole and act like an open. In
Figure 3-23(b), the printed-circuit board is obviously cracked, which causes an open
circuit across each of the copper traces that used to cross over the crack. Poor sol-
dering results in the solder bridge evident in Figure 3-23(c). In the center of this
photo, you can see where too much solder was used, causing an electrical bridge be-
tween two adjacent IC pins and making them a short. Experienced troubleshooters
will also visually inspect printed-circuit boards for components that may appear to
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Figure 3-23 Four common printed-circuit faults: (a) misalignment of pin 14; (b) cracked
board; (c) solder bridge; (d) burned transistor.
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be darkened from excessive heat. Notice the four transistors in the middle of Figure
3-23(d). The one on the lower left looks charred and is probably burned out, thus
acting like an open.

The following troubleshooting examples will illustrate some basic troubleshoot-
ing techniques using the logic probe and pulser.

EXAMPLE 3-5 'l Helpful

The IC AND gate in Figure 3-24 is suspected of having a fault and you L Hint

want to test it. What procedure should you follow? You should be aware that
these troubleshooting

examples assume that the
IC is removed from the

Keep unused input HIGH circuit board. In-circuit
to enable the AND gate testing will often give false

5V 4 readings because of the

Vee E ( ?war external circuitry
1 f SUPPY connected to the IC. In
13 that case, the circuit
ﬁ Pulser = schematic must be studied
\ Jur to determine how the other
ICs may be affecting the
(pulses) readings.

10
Probe
9 (flashing light)

7408 ZI

?WWWMMH

1
Q
Z
S]

Figure 3-24 Connections for troubleshooting one gate of a quad AND IC.

Solution: First you apply power to V¢ (pin 14) and GND (pin 7). Next
you want to check each AND gate with the pulser/probe. Because it takes a
HIGH (1) on both inputs to an AND gate to make the output go HIGH, if
we put a HIGH (+5 V) on one input and pulse the other, we would expect
to get pulses at the output of the gate. Figure 3—24 shows the connections
to test one of the gates of a quad AND IC. When the pulser is put on pin 12,
the light in the end of the probe flashes at the same speed as the pulser, in-
dicating that the AND gate is passing the pulses through the gate (similar
in operation to the clock enable circuit of Figure 3—16).

The next check is to reverse the connections to pins 12 and 13 and
check the probe. If the probe still flashes, that gate is okay. Proceed to the
other three gates and follow the same procedure. When one of the gate out-
puts does not flash, you have found the fault.

As mentioned earlier, the key to troubleshooting an IC is understanding how the
IC works.
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> | Common
Misconception

You may mistakenly think
that if you want a pin to be
LOW (like pin 1), you can
just leave it unconnected
and it will assume a LOW
level. That is not true. All
inputs must be tied HIGH
or LOW to have
predictable results.
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EXAMPLE 3-6

Sketch the connections for troubleshooting the first gate of a 7432 quad OR
gate.

Power
supply =

— 1 Vee
Keep unused Pulser
input LOW to
enable OR gate.

7432

—
=~

—_
(3]

—
—_

—_
(=)

JHEHEEEE

Figure 3-25 Connections for troubleshooting one OR gate of a 7432 IC.

Solution: The connections are shown in Figure 3-25. The probe should be
flashing if the gate is good. Notice that the second input to the OR gate be-
ing checked is connected to a LOW (0) instead of a HIGH. The reason for
this is that the output would always be HIGH if one input were connected
HIGH. Because one input is connected LOW instead, the output will flash
together with the pulses from the logic pulser if the gate is good.

EXAMPLE 3-7

Assume that you used a logic probe to record the levels shown in Figures
3-26 (a), (b), (c), and (d). Determine which gate is faulty in each IC.

1[1] UVCCEI 11 Vee|14] 1
0|Z [13] 1 1[2] [13] 0
0[3] zll 1[3] [12] 0
' [4] i o

1 [5] [10] 0 1 [5] [10] 0
o [€] zo | (& ol
o [7] snp B 0 [7]cnD (8] 1

(@) (b)

Figure 3-26 Troubleshooting integrated circuit AND and OR gates.
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11 Vee|14] 1 o[1 Vee|14] 1
1[2] 13] 1 02@ [13] 1
0[3]nc @120
0[4] 1] o 1[4 1] o
10] 0 1 5@ [10] 0
9]0 1[6 @9 0

1 [5]
o[7) & 8]0 0 [7]cND 8]0

1210 013

1[6] 1|

(c) (d)
Figure 3-26 (Continued)

Answers: Figure 3-26(a) Gate 2
Figure 3-26(b) Gate 3
Figure 3-26(c) Gate 1
Figure 3-26(d) Gate 4

Review Questions

3-8. Which pins on the 7408 AND IC are used for power supply connec-
tions, and what voltage levels are placed on those pins?

3-9. How is a logic probe used to troubleshoot digital ICs?

3-10. How is a logic pulser used to troubleshoot digital ICs?

3-7 The Inverter

The inverter is used to complement, or invert, a digital signal. It has a single input and
a single output. If a HIGH level (1) comes in, it produces a LOW-level (0) output. If a
LOW level (0) comes in, it produces a HIGH-level (1) output. The symbol and truth
table for the inverter gate are shown in Figure 3-27. (Note: The circle is the part of the
symbol that indicates inversion. The inversion circle will be used on other gates in up-
coming sections.)

Input > - Output
A X

Figure 3-27 Inverter symbol and truth table.
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Input A

Output X
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A—I>O—X=Z

L

(a

)

fuffm

(b)

Figure 3-28 Timing analysis of an inverter gate: (a) waveform sketch and
(b) oscilloscope display.

The operation of the inverter is very simple and can be illustrated further by
studying the timing diagram of Figure 3—28. The timing diagram graphically shows us
the operation of the inverter. When the input is HIGH, the output is LOW, and when
the input is LOW, the output is HIGH. The output waveform is, therefore, the exact
complement of the input. -

The Boolean equation for an inverter is written X = A(X = NOT A). The bar
over the A is an inversion bar, used to signify the complement. The inverter is some-
times referred to as the NOT gate.

3-8 The NAND Gate

The operation of the NAND gate is the same as the AND gate except that its output is
inverted. You can think of a NAND gate as an AND gate with an inverter at its output.
The symbol for a NAND gate is made from an AND gate with the inversion circle
(bubble) at its output, as shown in Figure 3-29(a).

Input A — — A 4 1 0 =
Output X =AB 1 X=AB
Input B — B —

(a) (b)

Figure 3-29 NAND gate: (a) symbol; (b) AND-INVERT equivalent of a NAND gate with
A=1B=1

In digital circuit diagrams, you will find the small circle used whenever comple-
mentary action (inversion) is to be indicated. The circle at the output acts just like an
inverter, so a NAND gate can be drawn symbolically as an AND gate with an inverter
connected to its output, as shown in Figure 3-29(b).

The TTL form of a NAND is the 7400 IC (or the 74LS00 or 74HCOO0, etc.) Figure
3-30 shows the output results for all possible input combinations applied to a 7400
quad NAND.
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Figure 3-30 Inputs and outputs of a 7400 quad NAND IC.

The Boolean equation for the NAND gate is written X = AB. The inversion bar
is drawn over (A and B), meaning that the output of the NAND is the complement of
(A and B) [NOT (A and B)]. Because we are inverting the output, the truth table out-
puts in Table 3—6 will be the complement of the AND gate truth table outputs. The easy
way to construct the truth table is to think of how an AND gate would respond to the
inputs and then invert your answer. From Table 3—-6, we can see that the output is LOW
when both inputs A and B are HIGH (just the opposite of an AND gate). Also, the out-
put is HIGH whenever either input is LOW.

TABLE 3-6 | Two-Input NAND Gate
Truth Table

— Output is always
B X = AB HIGH unless both
inputs are HIGH.

—_——0 O ;

0
1
0
1

S = = =

NAND gates can also have more than two inputs. Figure 3-31 shows three- and
eight-input NAND gate symbols. The truth table for a three-input NAND gate (see
Table 3—7) shows that the output is always HIGH unless all inputs go HIGH.

A_
B_
C_

A — D —
B — X=ABC E X =ABCDEFGH
C—

F_
G_
H_

Figure 3-31 Symbols for three- and eight-input NAND gates.
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Helpful

Hint

Some students find it easier
to analyze a NAND gate by
solving it as an AND gate

and then inverting the
result.
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TABLE 3-7 | Truth Table for a Three-Input

NAND Gate
A B C X
0 0 0 1
0 0 1 1
0 1 0 1
0 1 1 1
1 0 0 1
1 0 1 1
1 1 0 1
1 1 1 0

Timing analysis can also be used to illustrate the operation of NAND gates. The
following examples will contribute to your understanding.

EXAMPLE 3-8

Sketch the output waveform at X for the NAND gate shown in Figure 3-32,
with the given input waveforms in Figure 3—-33.

A —oI1
X
B_

Figure 3-32
Solution: A
B 1 | I
Answer —> X
N Y
The output goes
LOW when both
inputs are HIGH

Figure 3-33 Timing analysis of a NAND gate.

EXAMPLE 3-9

Sketch the output waveform at X for the NAND gate shown in Figure
3-34(a), with the given input waveforms at A, B, and Control.

o

(a)

A
B

]

Control

Figure 3-34(a) Timing analysis of a NAND gate with a Control input: (a) logic
symbol; (b) waveforms.
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Solution: In Figure 3-34(b), the Control input waveform is used to
enable/disable the NAND gate. When it is LOW, the output is stuck HIGH.
When it goes HIGH, the output will respond LOW when A and B go HIGH.

A1 L1 L1 L 1 L1

s L1 I

Control |

Answer —> X

N
LOW output

when all inputs
HIGH
(b)
Figure 3-34(b)

3-9 The NOR Gate

The operation of the NOR gate is the same as that of the OR gate except that its output is
inverted. You can think of a NOR gate as an OR gate with an inverter at its output. The
symbol for a NOR gate and its equivalent OR-INVERT symbol are shown in Figure 3-35.

A _
BD;XZA*'B Analyze a NOR

by solving it as
0 an OR and then
) 0 1 X=A+B invert the result.

B

Figure 3-35 NOR gate symbol and its OR-INVERT equivalent with A = 0,B = 0.

The TTL form of a NOR is the 7402 IC (or the 74L.S02 or 74HCO02, etc.) Figure 3-36
shows the output results for all possible input combinations applied to a 7402 quad NOR.

GND

7402

~\1"’<><§
I nmn
S o -

S

Figure 3-36 Inputs and outputs of a 7402 quad NOR IC.
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@ Helpful

Hint

To solve a timing analysis
problem, it is useful to look
at the gate’s truth table to
see what the unique
occurrence is for that gate.
In the case of the NOR,
the odd occurrence is when
the output goes HIGH

due to all LOW inputs.
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The Boolean equation for the NOR function is X = A + B. The equation is
stated “X equals not (A or B).” In other words, X is LOW if A or B is HIGH. The truth
table for a NOR gate is given in Table 3—8. Notice that the output column is the com-
plement of the OR gate truth table output column.

TABLE 3-8 | Truth Table for a

NOR Gate o el
utput is always
A B X=A4 + B /LOW unless both
inputs are LOW.
0 0 1
0 1 0
1 0 0
1 1 0

Now let’s study some timing analysis examples to get a better grasp of NOR gate
operation.

EXAMPLE 3-10

Sketch the output waveform at X for the NOR gate shown in Figure 3-37,
with the given input waveforms in Figure 3-38.

A R
i>on:A+B
B

Figure 3-37

Solution:

B ] ] I ]
Answer —> X I
X goes HIGH
when both inputs
are LOW

Figure 3-38 NOR gate timing analysis.

EXAMPLE 3-11

Sketch the output waveform at X for the NOR gate shown in Figure 3-39,
with the given input waveforms in Figure 3—40.

A

B DX:A+B+C
c
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Solution:

Answer —> X |_

Figure 3-40 Three-input NOR gate timing analysis.

EXAMPLE 3-12
Sketch the waveform at the B input of the gate shown in Figure 3—-41 that

will produce the output waveform shown in Figure 3—42 for X. Repeat for
the NAND gate.

A c — J—
B D —

Figure 3-41

Solution:

x T T_ Y u
B '_ D

% = Don’t care (B could be HIGH or LOW
and get the same output at X.)

Figure 3-42 Input waveform requirement to produce a specific output.

Review Questions

3-11. What is the purpose of an inverter in a digital circuit?
3-12. How does a NAND gate differ from an AND gate?

3-13. The output of a NAND gate is always HIGH unless all inputs are
made (HIGH/LOW).

3-14. Write the Boolean equation for a three-input NOR gate.

SECTION 3-9 | THE NOR GATE
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3-15. The output of a two-input NAND gate is (HIGH/LOW)

ifA=1,B=0.
3-16. The output of a two-input NOR gate is (HIGH/LOW)
ifA=0,B=1.

3-10 Logic Gate Waveform Generation

Using the basic gates, a clock oscillator, and a repetitive waveform generator circuit,
we can create specialized waveforms to be used in digital control and sequencing cir-
cuits. A popular general-purpose repetitive waveform generator is the Johnson shift
counter, which is explained in detail in Chapter 13. For now, all we need are the output
waveforms from it so that we may use them to create our own specialized waveforms.

The Johnson shift counter that we will use outputs eight separate repetitive wave-
forms: A, B, C, D; and their complements, A, B, C, D. The input to the Johnson shift
counter is a clock oscillator (C,). Figure 3—43 shows a Johnson shift counter with its
input and output waveforms.

1-kHz C
Clock
oscillator

P Johnson
shift counter

T
B B C

S —
| —

c, #1 # #3 #4 #5 #6 #7 #8

Time 0 1 2 3 4 5
reference —+—F—+— }
(ms)

=

=]

=

|

Ql

o

(a) (b)
Figure 3-43 Johnson shift counter waveform generation: (a) waveform sketch; (b) logic

analyzer display.

The clock oscillator produces the C, waveform, which is input to the Johnson
shift counter. The shift counter uses C, and internal circuitry to generate the eight
repetitive output waveforms shown.
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Now, if one of those waveforms is exactly what you want, you are all set. But let’s
say we need a waveform that is HIGH for 3 ms, from 2 until 5 on the millisecond time
reference scale. Looking at Figure 3—43, we can see that this waveform is not available.

Using some logic gates, however, will enable us to get any waveform that we de-
sire. In this case, if we feed the A and B waveforms into an AND gate, we will get our

HIGH level from 2 to 5, as shown in Figure 3—44.

The A and B
waveforms are

both HIGH for 3 ms » B
starting at the 2-ms

mark.

X

1 5

(3]
[*)}

(3]
W

\A—
=

Figure 3-44 Generating a 3-ms HIGH pulse using an AND gate and a Johnson shift counter.

JOHNSON SHIFT COUNTER SIMULATION

- l Helpful

Hint
The circuitry and operation
of the Johnson shift counter
are given in Chapter 13. For
now, you need to know only
that it is used to provide a
combination of sequential
waveforms that we will use
to create specialized
waveforms and improve our
understanding of the basic
gates. It is helpful if you
have a photocopy of Figure
3-43(a) to work on for
aligning the waveforms to
solve the problems.

A MultiSIM® simulation of the Johnson shift counter is shown in Figure 3—45. The waveforms are
produced by the Word Generator by listing the correct sequence of binary digits in the display area

0 | 1 2 | 3 | 4 | 5 | 6 | 7 | 8 |
XLA1
A S 1 A
.
|| - ||
- )
Logic
analyzer
B XWGI Ul X B
0 — 16 A -
- (0] - - -
8 8:_ B AND2 £
§ 0 %: corT
— |
c 30| &k ¢
L Johnson I8 | X | & ||
shift :% X %E Logic Analyzer-XLAL x|
counter — X §E_
D S B S Time (S) D
S 50000p 2050m  4050m  6050m  8050m  10.050m
i 1 1 1
— (OBNO) Gl e T i —
f C |l Tem2
AlENs =8 & I i
A&l 1 [~ F = |
E B |10 E
B &= s e ey
Word Generator-XWG1 x| fedl el S |
: c e = = .
1 (e e EEREY; uoBn0un0unouoouoouoeuounounouoouEI D & — —
B € Hex 00000000000000000000000010101010 D' & S S
Burst | oo 11
" Dec 00000000000000000000000010101001 = e
F _sen | : X ¢ .
% Binary 00000000000000000000000010100101 £ ;ﬂ’
set. | | ssci 00000000000000000000000010010101 F Tem 1
| | [~ Toagsr 00000000000000000000000001010101 5 "C’:klm |
"""“1'1 [F | 00000000000000000000000001010110 L
Sibtii] 00000000000000000000000001011010 Trigz
G | || fimauensy NANAARRONAANAAANANARAOAANT AT ; | G
— T 4 *
[1 = e 00000000000000000000000000000000 e T
00000000000000000000000000000000 [ Hop | 7 o soooops 0238 | ClocksiDiv [ 10 | set |
— Ready (% Trigger =l Flesat = raarms 0120 Set IEcltemal uuaig Quakfi |
G FReverse || T&-Ti 7847 me =l - 4 ('E"
0 i 2 T @ps 1 6 [ 7 T 5 ]

T

Figure 3-45 Using MultiSIM® to simulate the Johnson shift counter waveforms.
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required to cycle through the correct succession of HIGH/LOW states. The Logic Analyzer shows
the levels of the Johnson waveforms and the output waveform that would occur if A and B were con-
nected to a two-input AND gate.

MultiSIM exercise: Use MultiSIM to open the file fig3_45 from the textbook website. Run the sim-
ulation to create the waveforms shown in Figure 3—45. Make the following changes to the gate (U1)
and rerun the simulation as follows:

(a) Change Ul to a two-input OR gate (OR2).
(b) Change Ul to a three-input AND gate (AND3) and add the C,, pulses as the third input waveform.
(¢) Change the inputs to the AND3 gate so that only the first two C,, pulses are output at X.

Working through the following examples will help you to understand logic gate

E Team operation and waveform generation.

Discussion
Could we obtain a LOW EXAMPLE 3-13
pulse from 4 to 5 instead of
a HIGH by using the Which Johnson counter outputs will you connect to an AND gate to get a
Cozllgimented signals of A 1-ms HIGH-level output from 4 to 5 ms?
an K

Solution: Referring to Figure 3—43, we see that the two waveforms that
are both HIGH from 4 to 5 ms are A and D; therefore, the circuit of Figure
3-46 will give us the required output.

4 5
g:}_ﬁ_

Figure 3-46 Solution to Example 3—-13.

EXAMPLE 3-14

Which Johnson counter outputs must be connected to a three-input AND gate to enable just the C#4
pulse to be output?

Solution: Referring to Figure 3-43, we see that the C and D waveforms are both HIGH only during the
C, 4 period. To get just the C,#4 pulse, you must provide C), as the third input. Now, when you look at
all three input waveforms, you see that they are all HIGH only during the C,#4 pulse (see Figure 3-47).

C, dAw #3 #4 #5 #6 #7 N\,

3 S
Answers< C ] I_ — > Cl— —X
4 5
D ~
X #4

Note: C and D are used to enable just
the #4 pulse of the C, line to get through.

Figure 3-47 Solution to Example 3-14.
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EXAMPLE 3-15

Sketch the output waveform that will result from inputting A, B, and C into
the three-input OR gate shown in Figure 3—-48(a).

Figure 3-48(a)

Solution: The output of an OR gate is always HIGH unless all inputs are
LOW. Therefore, the output is always HIGH except between 5 and 6, as
shown in Figure 3—48(b).

5 6

I I <— Answer

(b)
Figure 3-48(b) Solution to Example 3-15.

EXAMPLE 3-16

Sketch the output waveform that will result from inputting C,, B, and C
into the NAND gate shown in Figure 3—49.

9}

=

i

Figure 3-49

Solution: From reviewing the truth table of a NAND gate, we determine
that the output is always HIGH unless all inputs are HIGH. Therefore,
the output will always be HIGH except during pulse 7, as shown in
Figure 3-50.

|#7| <— Answer

Figure 3-50 Solution to Example 3-16.

EXAMPLE 3-17

Sketch the output waveforms that will result from inputting A, B, and D
into the NOR gate shown in Figure 3-51.

A
B% Oo—X
D

Figure 3-51
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Which of the three inputs
could we ground and still

get the same answer?
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Solution: Reviewing the truth table for a NOR gate, we determine that
the output is always LOW except when all inputs are LOW. Therefore, the
output will always be LOW except from O to 1, as shown in Figure 3-52.

0 1
'_I <— Answer

Figure 3-52  Solution to Example 3-17.

EXAMPLE 3-18

Sketch the output waveforms for the gates shown in Figure 3-53. The
inputs are connected to the Johnson shift counter of Figure 3—43.

A—
==
c— A

D

(b)

A
C
03 S

S

(d)

i

Figure 3-53

Solution: The output waveforms are shown in Figure 3-54.

6 7

I I <— Answer

(a)

0 HIGH 8

<— Answer

(b)
8

7
I <— Answer

(c)

|#5 I <— Answer

(d)
Figure 3-54 Solution to Example 3-18.
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EXAMPLE 3-19

Determine which shift counter waveforms from Figure 3—43 will produce
the output waveforms shown in Figure 3-55.

0 1 3 8

I —

0 | # | | #4 | 8

[«
(o]

|#2| |#3| |#4|

EERR

Answers: 1=A, C,D 2:Cp,B,5 3=A,B,D 4=C_,AD

Figure 3-55 Solution to Example 3-19.

EXAMPLE 3-20

By using combinations of gates, we can obtain more specialized wave-
forms. Sketch the output waveforms for the circuit shown in Figure 3-56.

— ) Doy
.

Al =

D

Figure 3-56

Solution: The output waveforms are shown in Figure 3-57. (Note: the X
and Y waveforms must be aligned carefully to get the correct output at Z.)

3 5
A | I
Answers Y I #4 I I #5 I I #6 I
z | owa L1 #s5 |

Figure 3-57  Solution to Example 3-20.
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EXAMPLE 3-21

Sketch the output waveforms for the circuit shown in Figure 3-58.

(;_\—_\ 14

5T —

Cp—\_

c— ) — >
D

Ol =
~

Figure 3-58

Solution: The output waveforms are shown in Figure 3-59.

w I #1 I
X I #4 I
Answers 6 8
Y I
6 8
VA I #1 I I #4 I I

Figure 3-59  Solution to Example 3-21.

3-11 Using IC Logic Gates

All the logic gates are available in various configurations in the TTL and CMOS fam-
ilies. To list just a few: The 7404 TTL and the 4049 CMOS are hex (six) inverter ICs,
the 7400 TTL and the 4011 CMOS are quad (four) two-input NAND ICs, and the
7402 TTL and the 4001 CMOS are quad two-input NOR ICs. Other popular NAND
and NORs are available in three-, four-, and eight-input configurations. Consult a TTL
or CMOS data manual for the availability and pin configuration of these ICs. The pin
configurations for the hex inverter, the quad NOR, and the quad NAND are given in
Figures 3—60 and 3-61. (High-speed CMOS 74HC04, 74HCO00, and 74HCO2 have the
same pin configuration as the TTL ICs.)

CHAPTER 3 | BASIC LOGIC GATES



[ 15
wlnl

(=] L] [s] =] (=] 2] [=]

6

GND | 7

7404

14| Ve

2

0

8

1] [ = =T o] -]

<
4

8

A A

B
3 B
IS

4049

Figure 3-60 7404 TTL and 4049 CMOS inverter pin configurations.
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Figure 3-61 (a) 7402 TTL NOR and 4001 CMOS NOR pin configurations; (b) 7400 TTL
NAND and 4011 CMOS NAND pin configurations.
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EXAMPLE 3-22

Draw the external connections to a 4011 CMOS IC to form the circuit
shown in Figure 3-62.

A_
B —

o
il

Solution: Referring to Figure 3-63, notice that Vpp is connected to the
+5-V supply and Vg to ground. According to the CMOS data manual, V),
can be any positive voltage from +3 to +15 V with respect to Vg (usually

ground).
% Voo
ﬁ -
VSS @

4011

D

Figure 3-62

5V 4

b

slalclcinicls

Power

f supply

2

1

Q

\{Jl;ll;llilbﬂ

]

Figure 3-63

3-12 Summary of the Basic Logic Gates and
IEEE/IEC Standard Logic Symbols

By now you should have a thorough understanding of the basic logic gates: inverter,
AND, OR, NAND, and NOR. In Chapter 5, we will combine several gates to form
complex logic functions. Because the basic logic gates are the building blocks for
larger-scale ICs and digital systems, it is very important that the operation of these
gates be second nature to you.

A summary of the basic logic gates is given in Figure 3—-64. You should memo-
rize these logic symbols, Boolean equations, and truth tables. Also, a table of the most
common IC gates in the TTL and CMOS families is given in Table 3-9. You will need
to refer to a TTL or CMOS data book for the pin layout and specifications.
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Inverter:

_ A X
A —l>o— X=A . A 1 X
1 0
AND:
A B X
A — B o] o] o A—]
B } X=AB 0 1 0 B & X
1 0 0
1 1 1
OR:
A B X
A A
0 0 0
1 0 1
1 1 1
NAND:
A B X
A —— .
} X=AB 01 04 1 A & P>~—x
B — 0 1 1 B
1 0 1
1 1 0
NOR:
A B X
A ol o0f 1 A— ~
>1
B :E>Oi X=A+B ol 1 0 B 2 X
1 0 0
1 1 0
(a) (b) ()
Figure 3-64 Summary of logic gates: (a) traditional logic symbols with Boolean equation;
(b) truth tables; (c) [IEEE/IEC standard logic symbols.
TABLE 3-9 | Common IC Gates in the TTL and CMOS Families
Number of Number Part Number
Gate Inputs of Gates Basic LS HC 4000
Name per Gate per Chip TTL TTL CMOS CMOS
Inverter 1 6 7404 T4L.S04 T4HCO04 4069
AND 2 4 7408 741L.S08 T4HCO8 4081
3 3 7411 74LS11 T4HC11 4073
4 2 7421 741821 — 4082
OR 2 4 7432 741832 T4HC32 4071
3 3 — — TAHC4075 4075
4 2 — — — 4072
NAND 2 4 7400 74L.S00 T4HCO0 4011
3 3 7410 74LS10 T4HC10 4013
4 2 7420 741.S20 T4HC20 4012
8 1 7430 741L.S30 — 4068
12 1 74134 7418134 — —
13 1 74133 74L.S133 — —
NOR 2 4 7402 741L.S02 T4HCO02 4001
3 3 7427 741827 T4HC27 4025
4 2 7425 741825 T4HC4002 4002
5 2 74260 741.S260 — —
8 1 — — — 4078
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Also, in Figure 3-64(c), we introduce the IEEE/IEC standard logic symbols.
This alternate standard for logic symbols was developed in 1984. It uses a method of
determining the complete logical operation of a device just by interpreting the nota-
tions on the symbol for the device. This includes the basic gates as well as the more
complex digital logic functions. Unfortunately, this standard has not achieved wide-
spread use, but you will see it used in some newer designs. Most digital IC data books
will show both the traditional and the new standard logic symbols, although most cir-
cuit schematics still use the traditional logic symbols. For this reason, the summary in
Figure 3-64 shows both logic symbols, but throughout the remainder of this text we
will use the traditional logic symbols. (A complete description of the IEEE/IEC stan-
dard for logic symbols is provided in Appendix C.)

Review Questions

3-17. What is the function of the Johnson shift counter in this chapter?
3-18. What are the part numbers of a TTL inverter IC and a CMOS NOR IC?

3-19. What type of logic gate is contained within the 7410 IC? the
74HC27 IC?

B Summary

In this chapter, we have learned that
1. The AND gate requires that all inputs are HIGH to get a HIGH output.
2. The OR gate outputs a HIGH if any of its inputs are HIGH.

3. An effective way to measure the precise timing relationships of digital
waveforms is with an oscilloscope or a logic analyzer.

4. Besides providing the basic logic functions, AND and OR gates can
also be used to enable or disable a signal to pass from one point to another.

5. Several ICs are available in both TTL and CMOS that provide the basic
logic functions.

6. Two important troubleshooting tools are the logic pulser and the logic
probe. The pulser is used to inject pulses into a circuit under test. The probe
reads the level at a point in a circuit to determine if it is HIGH, LOW, or
floating.

7. An inverter provides an output that is the complement of its input.
8. A NAND gate outputs a LOW when all of its inputs are HIGH.
9. A NOR gate outputs a HIGH when all of its inputs are LOW.

10. Specialized waveforms can be created by using a repetitive waveform
generator and the basic gates.

11. Manufacturers’ data manuals are used by the technician to find the pin
configuration and operating characteristics for the ICs used in modern
circuitry.

| Glossary .

Boolean Equation: A logic expression that illustrates the functional operation of a
logic gate or combination of logic gates.

Complement: A change to the opposite digital state. A 1 becomes a 0, and a O be-
comes a 1.

96 CHAPTER 3 | BASIC LOGIC GATES



Disable: To disallow or deactivate a function or circuit.
Enable: To allow or activate a function or circuit.

Fault: The problem in a nonfunctioning electrical circuit. It is usually due to an open
circuit, short circuit, or defective component.

Float: A logic level in a digital circuit that is neither HIGH nor LOW. It acts like an
open circuit to anything connected to it.

Gate: The basic building block of digital electronics. The basic logic gate has one or
more inputs and one output and is used to perform one of the following
logic functions: AND, OR, NOR, NAND, INVERT, exclusive-OR, or
exclusive-NOR.

Hex: When dealing with integrated circuits, a term specifying six gates on a single IC
package.

Inversion Bar: A line over variables in a Boolean equation signifying that the digital
state of the variables is to be complemented. For example, the output of a
two-input NAND gate is written X = AB.

Johnson Shift Counter: A digital circuit that produces several repetitive digital
waveforms useful for specialized waveform generation.

Logic Probe: An electronic tool used in the troubleshooting procedure to indicate a
HIGH, LOW, or float level at a particular point in a circuit.

Logic Pulser: An electronic tool used in the troubleshooting procedure to inject a
pulse or pulses into a particular point in a circuit.

NOT: When reading a Boolean equation, the word used to signify an inversion bar.
For example, the equation X = AB is read “X equals NOT AB.”

Quad: When dealing with integrated circuits, the term specifying four gates on a
single IC package.

Repetitive Waveform: A waveform that repeats itself after each cycle.

Troubleshooting: The work that is done to find the problem in a faulty electrical
circuit.

Truth Table: A tabular listing that is used to illustrate all the possible combinations
of digital input levels to a gate and the output that will result.

Waveform Generator: A circuit used to produce specialized digital waveforms.

N Problem s |1

Section 3-1
3-1. Build the truth table for:

(a) athree-input AND gate.
(b) afour-input AND gate.

3-2. If we were to build a truth table for an eight-input AND gate, how
many different combinations of inputs would we have?

3-3. Describe in words the operation of:

(a) an AND gate.
(b) an OR gate.

PROBLEMS
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Section 3-2
3—4. Determine the logic level at W, X, Y and Z in Figure P3—4.

1 0
w 0 Y
0 0
1 1
X 0 z
1 0
Figure P3-4

3-5. Write the Boolean equation for

(a) A three-input AND gate
(b) A four-input AND gate
(c) A three-input OR gate

3-6. Determine the logic level at W, X, Y and Z in Figure P3-6.

Figure P3-6

Section 3-3

3-7. Sketch the output waveform at X for the two-input AND gates shown
in Figure P3-7.

A — A —
X X
L D

A A
s T s T L1
X X
(@) (b)
Figure P3-7
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3-8. Sketch the output waveform at X for the two-input OR gates shown in

Figure P3-8.
A A
A A
s U snnnnn
X X
(@) (b)
Figure P3-8

3-9. Sketch the output waveform at X for the three-input AND gates
shown in Figure P3-9.

A — A —
B — X B — X
C — C —

A A
B _1 | B | |
c I nnmr._ c ™1 1 M
X X
(a) (b)
Figure P3-9

3-10. The input waveform at A is given for the two-input AND gates

shown in Figure P3-10. Sketch the input waveform at B that will produce
the output at X.

A — A —
) )
B — B —

A A
B B
X N X

(@) (b)

Figure P3-10
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C 3-11. Repeat Problem 3-10 for the two-input OR gates shown in Figure
P3-11.

(@ (b)
Figure P3-11

Section 3-4

3-12. Using Figure P3—12, sketch the waveform for the enable signal that
will allow pulses 2, 3 and 6, 7 to get through to the receiving device.

Clock
oscillator

Enable

Receiving
device

signal
Clock 1 2 3 4 5 6 7 8
oscillator
Enable
signal

Figure P3-12

3-13. Repeat Problem 3-12, but this time sketch the waveform that will
allow only the even pulses (2, 4, 6, 8) to get through.

Section 3-5
3-14. How many separate OR gates are contained within the 7432 TTL IC?

3-15. Sketch the actual pin connections to a 7432 quad two-input OR TTL
IC to implement the circuit of Figure 3—18.

3-16. How many inputs are there on each AND gate of a 7421 TTL IC?

3-17. The 7421 IC is a 14-pin DIP. How many of the pins are not used for
anything?

Section 3-6
T* 3-18. What are the three logic levels that can be indicated by a logic probe?
T 3-19. What is the function of the logic pulser?

*The letter T designates a problem that involves Troubleshooting.
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T 3-20. When troubleshooting an OR gate such as the 7432, when the pulser
is applied to one input, should the other input be connected HIGH or
LOW? Why?

T 3-21. When troubleshooting an AND gate such as the 7408, when the
pulser is connected to one input, should the other input be connected HIGH

or LOW? Why?

CT 3-22. The clock enable circuit shown in Figure P3-22 is not working. The
enable switch is up in the enable position. A logic probe is placed on the fol-
lowing pins and gets the following results. Find the cause of the problem.

Clock 1 5V 4+
oscillator |1_ Vee | 14 Dglggr}/]er
—12] sl |
1 (Enable) :I —
Switch [ ]
o B B
0 (Disable) I:
4 7408 E
Receiving E EI
device
o] <]
fE 5]
— GND
Figure P3-22
Probe on Pin Indicator Lamp
1 Flashing
2 On
3 Off
7 Off
14 On

CT 3-23. Repeat Problem 3-22 for the following troubleshooting results.

CT 3-24. Repeat Problem 3-22 for the following troubleshooting results.

PROBLEMS

Probe on Pin

Indicator Lamp

N IUSI S

1

Flashing
Off
Off
Off
On

Probe on Pin

Indicator Lamp

A QW=

Flashing
On

Off
Dim

On
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Section 3-7
3-25. For Figure P3-25, write the Boolean equation at X. If A = 1, what

is X?
o

Figure P3-25

3-26. For Figure P3-26, write the Boolean equation at X and Z. If A = 0,
what is X? What is Z?

X
A—l>o—o—|>o— z
Figure P3-26

3-27. Using Figure P3-26, sketch the output waveform at X and Z if the
timing waveform shown in Figure P3-27 is input at A.

Figure P3-27
Section 3-8

3-28. For Figure P3-28, write the Boolean equation at X and Y and build
a truth table for each.

A— C—
X Y
B— D —

Figure P3-28

3-29. Determine the logic levels at W, X, Y and Z in Figure P3-29.

0 1

w 0— Y
0 1
1 1

X 1 V4
0 1

Figure P3-29

3-30. Using Figure P3-28, sketch the output waveforms for X and Y, given
the input waveforms shown in Figure P3-30. (X = AB,Y = CD)
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Figure P3-30

Section 3

-9
3-31. Determine the logic level at W, X, Y and Z in Figure P3-31.

0 0
w 1 Y

0 0

0 1
1 z

1

X
1

Figure P3-31

3-32. Using Figure P3-32, sketch the waveforms at X and Y with the
switches in the down (0) position. Repeat with the switches in the up (1)
position.

A—\_ C
T Ome .

oW o>

(Up)
(Down) X

(Up)
(Down)

Figure P3-32

3-33. In words, what effect does the switch have on each circuit in Figure
P3-32?

3-34. For Figure P3-34, write the Boolean equation at X and Y and build
a truth table for each.

A D
C F

Figure P3-34

PROBLEMS
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3-35. Referring to Figure P3-34, sketch the output at X and Y, given the
input waveforms in Figure P3-35. X =A + B+ C,Y =D + E + F)

A | | | | | D | | | | |
5| E 1

¢l l r 11 LI
X Y

Figure P3-35

Section 3-10

3-36. The Johnson shift counter outputs shown in Figure 3—43 are con-
nected to the inputs of the logic gates shown in Figure P3-36. Sketch and
label the output waveform at U, V, W, X, Y, and Z.

3-37. Repeat Problem 3-36 for the gates shown in Figure P3-37.

J O]
T

Q
a
~

\
Al x|

@UH

Ol = >

Al |

&

:
Y

D

]
Y

c

p

Figure P3-36 Figure P3-37

3-38. Using the Johnson shift counter outputs from Figure 3—43, label the
inputs to the logic gates shown in Figure P3-38 so that they will produce
the indicated output.
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(a)

1 | I_

(b)

e

(©)
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I
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0 1 7 8
(e)
L 0 8
—} Vs e[ |55 ]
I
)
Figure P3-38
C 3-39. Determine which lines from the Johnson shift counter are required

at the inputs of the circuits shown in Figure P3-39 to produce the wave-
forms at U, V, W, and X.

il
8

v LT+
B | L

!

UKTJ
|
|

s

Figure P3-39

C 3-40. The waveforms at U, V, W, and X are given in Figure P3-39. Sketch
the waveforms at Y and Z.

Section 3-11

3-41. Make the external connections to a 7404 inverter IC and a 7402
NOR IC to implement the function X = A + B.
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T 3-42. When troubleshooting a NOR gate like the 7402, with the logic pulser
applied to one input, should the other input be held HIGH or LOW? Why?

T 3-43. When troubleshooting a NAND gate like the 7400, with the logic pulser
applied to one input, should the other input be held HIGH or LOW? Why?

T 3-44. The following data table was built by putting a logic probe on every
pin of the hex inverter shown in Figure P3—44. Are there any problems with
the chip? If so, which gate(s) are bad?

. . + Power
Pin  Logic Level SV 1 supply
1 HIGH v
2 LOW 1 14 < =
S A T §7
4 LOW .
5 LOW 12 ?E’i
6 HIGH
1
7 LOW —| 3 i? 12
8 HIGH —
9 LOW [
10 LOW L4 § ; E’_
11 LOW —
12 LOW —| 5 | 10]
13 HIGH
14 HIGH E iz’—
GND | 7 8
]

Figure P3-44

CT 3—-45. The logic probe in Figure P3—45 is always OFF (0) whether the
switch is in the up or down position. Is the problem with the inverter or the
NOR, or is there no problem?

° + Power
b

S5V suppl
. — supply
Switch
*— J__

(i Logic
probe

=
9}
3
9]

N

e
D o

7402

sinininininin
) L L
A
TR G E
ainininiaioic

GND GND

] ] B TR =

7404

Figure P3-45
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CT 3-46. Another circuit constructed the same way as Figure P3—45 causes
the logic probe to come on when the switch is in the down (0) position.
Further testing with the probe shows that pins 2 and 3 of the NOR IC are
both LOW. Is anything wrong? If so, where is the fault?

T 3-47. Your company has purchased several of the 7430 eight-input
NANDs shown in Figure P3-47. List the steps that you would follow to
determine if they are all good ICs.

14 | Ve

1

g

T 3-48. The data table above was built by putting a logic probe on every pin
of the 7427 NOR IC shown in Figure P3-48 while it was connected in a
digital circuit. Which gates, if any, are bad, and why?

HRBRBREE
[=ILe]l=]=E] ==

Figure P3-47

Pin  Logic Level
1 LOW
s Low [ 14] vee
S Low B 5]
6  HIGH 3 12
o o H 2]
8 Flashing E EI
9  HIGH
10 LOW E E
11 Flashing
12 HIGH E EI
13 HIGH
14 HIGH a7 5]
Figure P3-48
mmmm Schematic Interpretation Problems m———— E:)JE?—'E

See Appendix G for the schematic diagrams.

S 3-49. What are the component name and grid location of the two-input
AND gate and the two-input OR gate in the Watchdog Timer schematic?

S 3-50. A logic probe is used to check the operation of the two-input AND
and OR gates in the Watchdog Timer circuit. If the probe indicator is ON
for pin 2 of both gates and flashing on pin 1, what will pin 3 be for (a) the
AND gate and (b) the OR gate?
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3-51. If you wanted to check the power supply connections for the 8031
IC (U8) on the 4096/4196 circuit, which pins would you check, and what
level should they be?

3-52. On the 4096/4196 sheet 1 schematic, there are several gates labeled
Ul. Why are they all labeled the same?

3-53. Describe a method that you could use to check the operation of the
inverter labeled U4:A of the Watchdog Timer. Assume that you have a
dual-trace oscilloscope available for troubleshooting.

3-54. Locate the line labeled RAM_SL at location D8 of the HC11DO0
schematic. To get a HIGH level on that line, what level must the inputs to
U8 be?

3-55. Locate the output pins labeled E and R/W on U1 of the HC11DO0
schematic. During certain operations, line E goes HIGH and line R/W is
then used to signify a READ operation if it is HIGH or a WRITE operation
if it is LOW. For a READ operation, which line goes LOW: WE_B or OE_B?

MultiSIM® Exercises I

E3-1. Load the circuit file for Section 3-2. Read the instructions in the
Description window. The switches are used to input a 1 (up) or a 0 (down)
to each gate input. Each switch can be moved by pressing the appropriate
letter. The lamp connected to each gate output comes ON if the output
is HIGH.

(a) What is the level at X and Y if all switches are up? Try it.

(b) What is the level at X and Y if all switches are down? Try it.

(c) Experimentally complete a truth table for each gate.

E3-2. Load the circuit file for Section 3-3. The Logic Analyzer shows the
input waveforms A and B, and the output waveforms X and Y. Gate 1 and
Gate 2 are hidden from your view; each is either an AND or an OR. Use the
Logic Analyzer display to determine:

(a) What Gate 1 is, and
(b) What Gate 2 is.

E3-3. Load the circuit file for Section 3—4. This circuit is used to enable
or disable the clock signal (Cp) from reaching the Logic Analyzer similar
to Figures 3-16 and 3-17.

(a) Switch A must be in the (up/down) position for the
clock to be enabled.

(b) Switch B must be in the (up/down) position for the
clock to be enabled. Try both conditions.

E3-4. Load the circuit file for Section 3-5. All of the parts to build the
clock enable circuit of Figure 3-20 are given. Make all of the necessary
connections to make the circuit work and test its operation. What position
must the Enable Switch be in to allow the receiving device to receive the
clock pulses from Cp?

E3-5. Load the circuit file for Section 3—6a. This circuit is used to trou-
bleshoot the number-4 gate of a 7408 Quad AND IC similar to Figure
3-24. Because this 7408 is working properly, the Logic Probe will flash
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when power is turned on. To troubleshoot the number-1 gate of the 7432
Quad NOR IC, what should be connected to the following pins?

(a) Pin 1?

(b) Pin 2?

(¢) Pin 3?

(d) Pin7?

(e) Pin 147 Test your answers by moving the connections from the 7408
over to the 7402.

T E3-6. Load the circuit file for Section 3—6b. There are one or more gates
in each of the ICs shown that are bad. Use a Logic Pulser and Probe to find
which gate or gates are bad (similar to Example 3-5).

(a) Which gate(s) are bad in the 7408?
(b) Which gate(s) are bad in the 7411?
(¢) Which gate(s) are bad in the 74327
E3-7. Load the circuit file for Section 3-9a. Read the instructions in the
Description window. The switches are used to input a 1 (up) or a 0 (down) to

each gate input. Each switch can be moved by pressing the appropriate letter.
The lamp connected to each gate output comes ON if the output is HIGH.

(a) What is the level at X and Y if all switches are up? Try it.
(b) What is the level at X and Y if all switches are down? Try it.

(c¢) Experimentally complete a truth table for each gate.

E3-8. Load the circuit file for Section 3-9b. The Logic Analyzer shows
the input waveforms A and B, and the output waveforms X and Y. Gate 1
and Gate 2 are hidden from your view, but each is either a NAND or a
NOR. Use the Logic Analyzer display to determine:

(a) What Gate 1 is, and
(b) What Gate 2 is.

E3-9. Load the circuit file for Section 3-10a. This is the Johnson shift
counter waveform generator from Figure 3—43. It is illustrated with A and
B input to an AND gate.

(a) Is the output waveform correct?
(b) Write the Boolean equation at X.
(c) What is the time width of the X-waveform pulse?

E3-10. Load the circuit file for Section 3—-10b. Change the inputs to the
AND gate to A and C.

(a) What is the time at the rising edge, falling edge, and total pulse width
of the X-output?

(b) Add Cp as a third input to the AND gate. How many positive pulses
are output at X?

(¢) What is the width of each positive pulse?
E3-11. Load the circuit file for Section 3—10c. The object here is to deter-
mine what gate is inside of the subcircuits labeled gate I and gate 2. The

output of gate 1 is displayed on the bottom trace. The next trace up is the
output of gate 2.

(a) Whatis gate 1?
(b) What is gate 2?
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E3-12. Load the circuit file for Section 3-10d. The object here is to de-
termine what gate is inside of the subcircuits labeled gate 3 and gate 4. The
output of gate 4 is displayed on the bottom trace. The next trace up is the
output of gate 3.

(a) What is gate 3?

(b) What is gate 4?

E3-13. Load the circuit file for Section 3—10e. Connect a logic gate to the
Johnson outputs so that it will provide the following to the Logic Analyzer:
(a) The first three Cp pulses.

(b) A HIGH level from the 4 mS level to the 8 mS level.

MultiSIM® Troubleshooting Exercises mumm—

E3-14. The following circuit files have faults in them. Study the logic op-
eration and truth table of the AND gate in Section 3—1 before attempting to
find the faults.

(a) AND_t-shoot_a
(b) AND_t-shoot_b
(1) Connect the A and B switches to the inputs and the logic probe indica-
tor to the output of the first gate. Complete a truth table by observing the

state of the logic probe indicator as you apply HIGH and LOW Ievels to the
inputs by pressing the letters A or B on your keyboard.

(2) Repeat for each gate.

(3) Which truth tables indicate that the gate is not operating properly?

(4) Delete the bad AND gate, replace it, and validate the circuit operation.
E3-15. The following circuit files have faults in them. Study the logic op-

eration and truth table of the OR gate in Section 3-2 before attempting to
find the faults.

(a) OR_t-shoot_a
(b) OR_t-shoot_b
(1) Connect the A and B switches to inputs and the logic probe indicator to
the output of the first gate. Complete a truth table by observing the state of

the logic probe indicator as you apply HIGH and LOW levels to the inputs
by pressing the letters A or B on your keyboard.

(2) Repeat for each gate.

(3) Which truth tables indicate that the gate is not operating properly?

(4) Delete the bad OR gate, replace it, and validate the circuit operation.
E3-16. The following circuit files have faults in them. Study the logic op-

eration and truth table of the NAND gate in Section 3—8 before attempting
to find the fault.

(a) NAND_t-shoot_a
(b) NAND_t-shoot_b
(1) Connect the A and B switches to the inputs and the logic probe indica-
tor to the output of the first gate. Complete a truth table by observing the

state of the logic probe indicator as you apply HIGH and LOW Ievels to the
inputs by pressing the letters A or B on your keyboard.

(2) Repeat for each gate.
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3-1.
3-2.

3-3.

3-4.

3-6.

3-7.

3-8.

3-9.

(3) Which truth tables indicate that the gate is not operating properly?
(4) Delete the bad NAND gate, replace it, and validate the circuit operation.
E3-17. The following circuit files have faults in them. Study the logic op-

eration and truth table to the NOR gate in Section 3-9 before attempting to
find the faults.

(@) NOR_t-shoot_a
(b) NOR_t-shoot_b
(1) Connect the A and B swtiches to the inputs and the logic probe indica-
tor to the output of the first gate. Complete a truth table by observing the

state of the logic probe indicator as you apply HIGH and LOW levels to the
inputs by pressing the letters A and B on your keyboard.

(2) Repeat for each gate.
(3) Which truth tables indicate that the gate is not operating properly?
(4) Delete the bad NOR gate, replace it, and validate the circuit operation.

Answers to Review Questions

True 3-10. It provides digital pulses to the

To illustrate how the output circuit being tested, which can

level of a gate responds to all be observed using a logic

possible input-level combina- probe.

tions 3-11. Aninverter is used to comple-

To depict algebraically the ment or invert a digital signal.

operation of a logic gate 3-12. A NAND gate is an AND gate

All inputs must be LOW. with an inverter on its output.
. To illustrate graphically how 3-13. HIGH

the output levels change in 3-14. X=A+B+C

response to input-level changes 3-15. HIGH

When the level of an input 3-16. LOW

signal will have no effect on 3-17. Itis used as a repetitive wave-

the output f

orm generator.
HIGH

3-18. 7404; 4001

3-19. Triple, three-input NAND

o gates; triple, three-input NOR
It uses an indicator lamp to tell gates

you the digital level whenever
it is placed in a circuit.

Positive power supply of 5 V to
pin 14, ground at 0 V to pin 7

ANSWERS TO REVIEW QUESTIONS
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Programmable Logic Devices:
CPLDs and FPGAs with
VHDL Design

OUTLINE

4-1 PLD Design Flow

4-2 PLD Architecture

4-3 Using PLDs to Solve Basic Logic Designs

4-4 Tutorial for Using Altera’s Quartus® II Design and Simulation Software
4-5 FPGA Applications

OBJECTIVES

Upon completion of this chapter, you should be able to:

» Explain the benefits of using PLDs.

* Describe the PLD design flow.

e Understand the differences between a PAL, PLA, SPLD, CPLD, FPGA and an
ASIC.

* Explain how a graphic editor and a VHDL text editor are used to define logic to
a PLD.

* Interpret the output of a simulation file to describe logic operations.

* Interpret VHDL code for the basic logic gates.

INTRODUCTION

As you can imagine, stockpiling hundreds of different logic ICs to meet all the possi-
ble requirements of complex digital circuitry became very difficult. Besides having all
of the possible logic on hand, another problem was the excessive amount of area on a
printed-circuit board that was consumed by requiring a different IC for each different
logic function. In many cases, only one or two gates on a quad or hex chip were used.

Then came “programmable logic”—the idea that implementing all logic designs
using 7400- or 4000-series ICs is no longer needed. Instead, a company will purchase
several user-configurable ICs that will be customized (i.e., programmed) to perform
the specific logic operation that is required. These ICs are called programmable logic
devices (PLDs).



4-1 PLD Design Flow

Samples of two PLDs are shown in Figure 4—1. They contain thousands of the basic
logic gates plus advanced sequential logic functions inside a single package. This in-
ternal digital logic, however, is not yet configured to perform any particular function.
One way to configure it is for the designer to first use PLD computer software to draw
the logic that he or she needs implemented. This is called CAD (computer-aided de-
sign). The PLD software then performs a process called schematic capture, which
reads the graphic drawing of the logic and converts (compiles) it to a binary file that
accurately describes the logic to be implemented. This binary file is then used as an in-
put to a programming process that electronically alters the internal PLD connections
(synthesizes) to make it function specifically as required. Hundreds, or even thou-
sands, of digital logic ICs will be replaced by a single PLD.

Another way to define the logic to be programmed into the PLD is to use a high-
level language called Hardware Description Language (HDL). A specific form of HDL
used by several manufacturers is called VHDL, which stands for VHSIC Hardware
Description Language (where VHSIC stands for Very High-Speed Integrated Circuit).
In this case, the inputs, outputs, and logic processes are defined using statements based
on the C programming language. This method is somewhat more difficult to learn, but
depending on the logic, it can be a more powerful—and simpler—tool with which to
define complex or repetitive logic.

Figure 4-2 illustrates the design flow. First we need to define the digital logic
problem that we want to solve. Once we have a good understanding of the problem, we
can develop the equations to use in solving the logic operation that we want the circuit
to perform.

(2)
Figure 4-1 Sample PLDs: (a) Altera MAX CPLD; (b) Altera Cyclone FPGA.

(b)

Develop the equations

Enter the design into

Define the problem. to solve the required ~ ——> the PC b.y drawmgAa
logic operations schematic or by using
’ a VHDL text editor.

Simulate the
input/output
conditions via timing
waveform analysis.

Program the internal
circuitry of the PLD
to implement the
logic operations.

Test the final
programmed PLD via
actual input and
output signals.

Figure 4-2 PLD product design flow.
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After we have completed that work on paper, we will enter the design into a per-
sonal computer (PC) by drawing a schematic diagram using the CAD tools provided
with the PLD software. In some cases, the design will instead be entered using the
VHDL text editor provided. After the PC has analyzed the design, it will allow us to
perform a simulation of the actual circuit to be implemented. To do this, we specify the
input levels to our circuit, and we observe the resultant output waveforms on the PC
screen using the waveform analysis tool provided.

If the computer simulation shows that our circuit works correctly, we can pro-
gram the logic into a PLD chip that is connected by a cable to the back of our PC. The
final step would be to connect actual inputs and outputs to the chip to check its per-
formance in a real circuit.

To illustrate the power of a PLD, let’s consider the logic circuit required to im-
plement X = AB + B + C. Figure 4-3 shows the circuitry required to implement the
logic using 7400-series ICs. As shown, we would need four different ICs to solve this
equation. Wires are shown connecting one gate of each IC to one gate of the next IC
until the logic requirements are met.

To solve this same logic using a PLD, we would draw the schematic or use
VHDL to define the logic, then program that into a PLD. One possible PLD that could
be used to implement this logic is the Altera EPM7128S (see Figure 4-4). After com-
pleting the steps listed in Figure 4-2, the internal circuitry of the PLD is configured (in
this case) to input A, B, and C at pins 29, 30, and 31 and output to X at pin 73. The PLD
software selected which pins to use, and as you can see, only a small portion of the
PLD is actually used for this circuit.

This particular PLD is an 84-pin IC in a plastic leaded chip carrier (PLCC)
package having 21 pins on a side. The notch signifies the upper left corner of the IC.
Pin 1 is located in the middle of the upper row adjacent to a small indented circle;

s

(a)
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(b)

Figure 4-3 Implementing the equation X = AB + B + C using 7400-series logic ICs: (a) logic diagram;

(b) connections to IC chips.
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Figure 4-4 Implementing the equation X = AB + B + C using a PLD.

subsequent pin numbers are counted off counterclockwise from there. (A photo-
graph of this particular chip is shown in Figure 4—1[a].)

As you may suspect, the price of a PLD is higher than a single 7400-series IC,
but we’ve only used a small fraction of the PLD’s capacity. We could enter and program
hundreds of additional logic equations into the same PLD. The only practical limita-
tion is the number of input and output pins that are available. Many PLDs are erasable
and reprogrammable, allowing us to test many versions of our designs without ever
changing ICs or the physical wiring of the gates.

We will learn design entry and waveform simulation in this chapter, and we will
continue to explore PLD examples and problems throughout the remainder of this text.

One of the leading manufacturers of PLDs is Altera Corporation. Altera offers a full
line of CPLDs, FPGAs, and ASICs (all explained in Section 4-2). This manufacturer of
programmable logic was chosen for this textbook because they are an industry leader and
offer a high level of support to colleges and universities. They also provide a free down-
load version of their design and development software called Quartus II: Web Edition,
which we will use throughout the text to design and simulate FPGA-based logic circuits.

PLD development boards that attach directly to the USB port of a PC are avail-
able so that you can experience programming and debugging actual PLD ICs. These
development boards allow you to program and reprogram repeatedly, so they are a
great option for all of your digital experimentation. Typically, a PLD development
board will contain a CPLD or an FPGA, a USB port to connect to your PC, and several
I/0 switches and LEDs to test your design. The board that we will use throughout this
textbook is the Altera DE2 Development and Education board. This, and several other
development boards, are available through the Altera University Program. Figure 4-5
shows the DE2 development board.

USB USB USB Ethernet
Blaster Device Host Mic LineLine Video VGA Video 10/100M
Port  Port Port In In Out In Port Port  RS-232 Port

9V DC Power
Supply Connector ; I I I l 1 I t I 1
27-MHz Oscillator A 17 gt Al o UU ol
i ey =

L, LR

24-bit Audio Codec

=p PS/2 Keyboard/Mouse Port
- VGA 10-bit DAC
Ethernet 10/100M Controller
Expansion Header 2 (JP2)

Power ON/OFF Switch
USB Host/Slave Controller
TV Decoder (NTSC/PAL)

Altera USB Blaster Controller Chipset
Altera EPCS16 Configuration Device

«—— Expansion Header 1 (JP1)

Altera Cyclone II FPGA
RUN/PROG Switch for JTAG/AS Modes

16x2 LCD Module

7-Segment Displays
18 Red LEDs
18 Toggle Switches

4 Dy F Switches

50-MHz Oscillator  8-MB SDRAM  512-KB SRAM 4-MB Flash Memory

Figure 4-5 The Altera DE2 Development and Education board. (Courtesy of Altera
Corporation.)
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4-2 PLD Architecture

Basically, there are four types of PLDs: simple programmable logic devices (SPLDs),
complex programmable logic devices (CPLDs), field-programmable gate arrays
(FPGAs), and application-specific integrated circuits (ASICs).

The SPLD

The SPLD is the most basic and least expensive form of programmable logic. It con-
tains several configurable logic gates, programmable interconnection points, and may
also have memory flip-flops. (Flip-flops are covered in Chapter 10.) To keep logic di-
agrams easy to read, a one-line convention has been adopted, as shown in Figure 4-6,
which is just a small part of an SPLD, showing two inputs and four outputs. (A typical
SPLD like the PAL in Figure 4-9 has 16 inputs plus their complements and 8 outputs.)
As you can see in Figure 4-6, the A input is split into two different lines: A, and its
complement A. (The triangle symbol is a special type of inverter having two outputs: a
true and a complement.) The same goes for the B input and any others that are on the
SPLD. The W, X, ¥, and Z AND gates are programmable to have any of those four lines
(A, A, B, B) as inputs.

The internal SPLD interconnect points are either made or not made by the PLD
programming software. In Figure 4-6, the inputs to the W AND gate are connected to
A and B. (The connections are shown by a dot.) The inputs to the X AND gate are con-
nected to A and B, and so on. The outputs of these AND gates are called the product
terms, because W is the Boolean product of A and B and X is the Boolean product of
Aand B.

The product terms in Figure 4-6 are not very useful by themselves. The circuit is
made more effective by adding an OR gate to the structure, as shown in Figure 4-7. This
new configuration is the foundation for a programmable array logic (PAL)-type
SPLD. As Figure 4-7 shows, by OR-ing the four product terms together, we now have
the Boolean sum of the four product terms, simply called the Sum-of-Products (SOP).
The SOP is the most common form of Boolean equation used to represent digital logic.
(For more on SOPs, see Section 5-6.)

The programmable logic array (PLA) goes one step further by providing
programmable OR gates for combining the product terms. Figure 4—8 shows a small
portion of a PLA. In this illustration, the PLA provides two SOP equations. The
inputs to the first OR gate are programmed to connect to all four product terms
(X = AB + AB + AB + A B). The inputs to the second OR gate are programmed to
connect to only the first and third product terms (Y = AB + AB).

v A
— 2 2
Inputs
Ve
= & <5
W =AB
X=AB
Y=AB
Z=AB

w X Y V4

Product terms

Figure 4-6 One-line convention for PLDs.
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Figure 4-7 PAL architecture of an SPLD.
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Figure 4-8 PLA architecture of an SPLD.

Some SPLDs also contain a flip-flop memory section and data-steering circuitry.
Flip-flop memory circuitry is used in a type of digital circuitry called sequential logic.
This type of logic is a form of digital memory that changes states based on previous
logic conditions and specific logic control inputs. (Sequential logic is covered in detail
in Chapters 12 and 13.) The data-steering circuitry takes care of input and control
signal interconnections and logic output destinations.

PAL16L8

A sample of a typical PAL device is the PAL16L8 shown in Figure 4-9. The number
16 in the part number signifies that it has 16 inputs. The 8 signifies 8 outputs and the
letter L means that the outputs are active-LOW. An active-LOW output is one that goes
LOW instead of HIGH when activated. Ten of the inputs in the figure are labeled with
the letter I. Each of these can provide the true and the complement of the level placed
on the pin. The other 6 inputs are labeled 1/0. This means that they can be used as an
input or an output. To come up with a total of 8 outputs, the other 2 dedicated outputs
labeled O are provided on pins 12 and 19.
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Figure 4-9 The PAL16L8 SPLD logic diagram. (Courtesy of Texas Instruments)



The CPLD

The CPLD is made by combining several PAL-type SPLDs into a single IC package,
as shown in Figure 4-10. Each PAL-type structure is called a macrocell. Each macro-
cell has several I/O connection points, which go to the chips’ external leads. The
macrocells are all connected to control signals and to each other via the programmable
interconnect matrix shown in the center of the structure.

The Altera MAX 7000S series is an example of a CPLD family. These CPLDs
perform the functions of thousands of individual logic gates. They also feature a
nonvolatile characteristic, meaning that when power is removed from the chip, they
will remember their programmed logic and interconnections. (This type of memory is
called EEPROM or Flash memory and is covered in Chapter 16.) These ICs can be re-
peatedly programmed to implement new designs or correct faulty ones, thus eliminat-
ing the need to rewire circuitry or buy new logic.

Control signal
connections

1

PAL-type PAL-type
macrocell macrocell

SUOT)OAUUOD /[
SUOTOAUUOD /[

PAL-type
macrocell

PAL-type
macrocell

— —
= =
@) ©)
(e} (@]
g g
=] =
@ [¢]
=3 =3
= =2
9] o
=] =
w w

XLIBW UOT)OUUOIINUI S[qRuIteiSor

Figure 4-10 Internal structure of a CPLD.

The FPGA

As the name implies, a Field-Programmable Gate Array (FPGA) is an array of gates
interconnected in a row-column matrix that can be programmed in the field by a com-
puter via a USB connection. The FPGA differs from the CPLD in that, instead of solv-
ing the logic design by interconnecting logic gates, it uses a look-up table (LUT)
method to resolve the particular logic requirement. This allows PLD manufacturers to
form a more streamlined design, creating a much denser and faster PLD. Besides hav-
ing thousands of internal logic elements, FPGAs have hundreds of I/O pins with pro-
grammable internal interconnects and storage registers. The Altera Cyclone® series is
an example of an FPGA family.

To see how a look-up table works, refer to Figures 4-11(a) and (b). In Figure
4-11(a), the conventional logic for the equation X = ABCD + ABCD + ABCD is
implemented using 7400-series ICs. In this case, X is HIGH for three different combi-
nations of the four inputs (X is HIGH when ABCD = 1111 or 1010 or 0000).

Figure 4-11(b) shows the same logic implemented in an FPGA LUT. An LUT
operates similar to a truth table in that it provides for all possible input combinations
and produces a HIGH when the desired combinations of 1s and Os are provided at the
inputs. In Figure 4-11(b), the routing of the logic levels is controlled by the 15 cas-
caded data selectors (trapezoid symbols). They are actually multiplexers, which are
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Figure 4-11 X = ABCD + ABCD + A B C D: (a) implemented using 7400-series ICs;
(b) implemented within a LUT of an FPGA (showing the flow for ABCD).

covered in Chapter 8, but for now all we need to understand is that when the control in-
put A, B, C, or D is HIGH, the logic level on the TRUE input is passed through from
left to right. When it is LOW, the logic level on the complement input is passed
through. The external A control input actually controls eight data selectors: B controls
four, C controls two, and D controls one.

This illustration of a LUT shows the flow of logic when the inputs are set at
A=1,B=0,C = 1and D = 0. In this case, since A = 1, then all logic levels con-
nected to the eight TRUE As are passed through. Therefore, by just looking at the high-
lighted data path, a 1 is passed through to the B data selector. Now, since the B data
selector control input is 0, then the data passes through the B to the C data selector, and
so on. The end result of this path is that a 1 passes through to X when ABCD = 1010.
To confirm that you understand this logic, follow the logic for ABCD = 1111 and then
for ABCD = 0000 to see that these conditions are also met.

As you can see, the result at X is dependent on the logic levels programmed into
the SRAM (static random-access memory) memory cells (covered in Chapter 16).
These memory cells are volatile and will need to be reinitialized along with the inter-
nal interconnections and registers each time the FPGA is powered on. Although
CPLDs have the advantage of being non-volatile, FPGAs are much denser and faster
so are used more often in middle to high-end applications.

The FPGA that is on the Altera DE-2 Development board shown in Figure 4-5 is
the Cyclone EP2C35F672C6N. It contains 33,216 look-up tables and has 475 pins
dedicated for input/output to external circuitry. According to the ordering Information
at the Altera Cyclone Web site, the 672 in the part number indicates the number of pins
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Figure 4-11 Continued

and the letter F' denotes that it is a FineLine Ball Grid Array (BGA). In order to pro-
vide for 672 pins, the BGA pins are on the bottom of the IC setup as 26 rows by 26
columns. (The four outside corner pins are left off.)

The ASIC

Once a logic design has been created and tested on an FPGA, and if there is a large
quantity demand, the design can be transferred to an application-specific integrated
circuit (ASIC). ASICs are available that are pin compatible and functionally equivalent
to their corresponding FPGA product. An important feature of ASICs is that the logic
function is hard-coded into the IC, making them non-volatile, so the user does not have
to reconfigure the IC at each power-on.
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*4-3  Using PLDs to Solve Basic Logic Designs

So, the next obvious question is “How do I design logic with a PLD?” We will use the
Quartus® II software to design and simulate solutions modeled after Altera FPGAs.
Then, if your laboratory has the PLD programmer boards like the DE-2 shown in
Figure 4-5, you can test the actual operation of the FPGA with switches and lights.
Even without the boards, however, the design and simulation software is a great learn-
ing tool for digital logic.

Figure 4—12 shows the flow of operations required to design, simulate, and pro-
gram an FPGA. Several methods are actually available to perform the design entry, but
we will address the two most common: graphic, and VHDL. The block (schematic)
editor enables you to connect predefined logic symbols (AND, NAND, OR, etc.)
together with inputs and outputs to define the logic operation that you need to implement.
The VHDL editor is a text editor that helps you to define the logic in a programming
language environment. In a text form, you specify the inputs, outputs, and logic operations
that you need to implement.

The next step performed by the software is to compile and synthesize the design.
A compiler is a language and symbol translation program that interprets VHDL state-
ments and logic symbols, then translates them into a binary file that can be used to syn-
thesize, then simulate and program the design into the FPGA IC. The compiler uses
several symbol and VHDL library files to obtain the information needed to define the
logic entered during the design entry stage. Report files are then generated that de-
scribe such things as I/O pin assignments, internal FPGA signal routing, and error
messages. Synthesizing the design is the process the software completes to develop a
model of the PLD’s internal electrical connections, which will produce the actual logic
functions that will later be simulated, then programmed into the PLD.

Design entry

Block (Schematic) Text (VHDL)
editor editor

Logic symbol Compile
and VHDL and _
library files synthesize

Y !

Simulate
. Program
input/output .
device
waveforms
- S Programmer board
Waveform simulator Mm
W mo|
AT1nm i S X
t —0
B— c = FPGA | oL
X —n h (e SE
A o]
55 e (HD oD
95
N o

Figure 4-12 FPGA design flow.

*Note: The color bar on the edge of a page indicates that the material in that area covers the implementation of digital logic using
PLD hardware and software. This method of logic implementation can be omitted without compromising the thorough coverage
of digital electronics presented in the remainder of the book.
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The waveform simulator provides a means to check the logic operation of your
design. To use it, draw the input waveforms using the CAD tool provided, and the pro-
gram will show the output response as if these inputs were applied to an actual FPGA.
Finally, if you have an FPGA programmer board and the waveform simulation was ac-
curate, you can program the FPGA and test it with actual inputs and outputs.

Quartus® II Software

Figures 4—13(a), (b), and (c) are the actual computer screens that you will see when
running the Quartus® II software to implement a simple 2-input AND gate following

{4 fig4_13.bdf

(a)
E® fig4_13.vhd i - o] x|
!
Library ) LIBRARY ieee; Declare which VHDL [
Declaration USE ieee.std logic 1164.aLL; library to use
ENTITY (Figh_13) IS
Entity PORT(
declaration a, b: IN std_logic;
R OuT std_logic);
END 5
ARCHITECTURE .f]l oF IS
Architecture BEGIN
body ®<=a AND\bj; }—Dehne the logic
EHD @re;
Jﬂ
[Cine 77 0ol 1 TINSl« | £

(b)

=10l =]
Simulation Waveforms

Master Time Bar 0pz 'l >| Painter; | Opz Interval; | Opz Start; | End: |
o, vt | P22 40us 8.0 us 120us 16.0ug
Ops =
i
1 al| BO
L | I | L T
3] «| s0 ﬁ mn mn T

l— X is HIGH if A and B are both high
(©

Figure 4-13 Computer screen displays generated by Quartus® II software for the design of a 2-input AND gate:
(a) block editor file; (b) alternative method using the VHDL text editor file; (c) simulation waveform file.
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the design flow outlined in Figure 4-12. A tutorial on how to run the software appears
in Section 4—4.

Figure 4-13(a) is produced by the block (schematic) editor. This method of
design allows us to define the inputs, outputs, and circuit logic simply by drawing the
logic diagram. This screen shows a 2-input AND gate with two input pins, A and B,
and one output pin, X. This circuit was drawn by choosing each circuit component
from a library of available symbols and then making each interconnection.

Figure 4-13(b) shows an alternate method of defining the same AND gate design
using the VHDL text editor. The VHDL program is divided into three sections: library
declaration, entity declaration, and architecture body. As with most computer lan-
guages, the first statements of the program are used to declare the library source for re-
solving and translating the language within the body of the program. In VHDL this is
called the library declaration. The IEEE standard library (ieee.std_ logic_1164.ALL)
is used most often by the VHDL compiler to translate references to the inputs, outputs,
and logic statements used in the program.

The entity declaration defines the input (a, b) and output (x) ports to the CPLD.
Note that the entity name (fig4_13) must match the file name (fig4_13.vhd) and it
appears identically in three locations in the program listing. Also note the use of the
underscore in the name because hyphens are not allowed.

The architecture body defines the internal logic operations (x < = a AND b)
that will be performed on those ports. (The symbol < = means that output x receives
the value of input @ ANDed with input b.) The architecture name is arbitrary and it ap-
pears twice. The one used here is arc. As with the entity name, it cannot contain hy-
phens and it must start with a letter.

To make the reading of VHDL programs easier, a formatting convention has
been established. Basically, all capitalized words are VHDL-reserved keywords, and
all lower-case words and letters are variables. Even though VHDL is not case sensitive,
it is good practice for you to follow the convention presented in Figure 4—13(b). For
example, writing the equation x < = a AND b as X < = A AND B would make no
difference to VHDL, but it is harder to distinguish the keyword AND from the vari-
ables A, B.

You have probably guessed that for defining the action of a simple AND gate,
VHDL design is more time-consuming than graphic entry, but we will see in later chap-
ters that it is a much easier way to define logic when the circuits become more complex.

Figure 4-13(c) shows the simulation of the circuit produced by the waveform
simulation editor. To produce that screen, the waveforms were first drawn for all possible
combinations of A and B (like building a truth table). Then as the simulation is run, the
software determines the logic state that would result at X for each combination of inputs
and shows the result as the X waveform.

EXAMPLE 4-1
Figure 4-14 shows five computer screens generated by the Quartus® II

software. Each screen produces, or is the result of, a different logic circuit.
Determine the Boolean equation that is being implemented in each case.

Solutions:

(a) X=A+B
(b) X = ABC
(¢) X =AB

(d) X = AB + BC
(e) X =A + (BO)
Y=AB+B+C
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Figure 4-14 Computer screens generated by the Quartus® II software for Example 4-1.
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& fig4_14d.bdf

E® fig4_14evhd

LIBRARY ieep;
USE ieee.std logic_116&._ALL;

ENTITY figh 14e IS

PORT{
a, b, cz IH std_logic;
X, U= ouT std logic);

EHD figh 14e;

ARCHITECTURE arc OF figh 14e 1S
BEGIH
#<= {a OR (b AHD HOT c));
y<= ((a AHD b) OR HOT (b OR c));
END arc;

(e)

Figure 4-14 Continued

*4-4  Tutorial for Using Altera’s Quartus” II Design and
Simulation Software

To get started, you first need to download the free Quartus® II Web Edition Software.
There are several versions available for download. The most appropriate version (and
the one used throughout this text) is version 9.1 sp2. The reason for using this version
is that when Altera migrated from version 9.1 sp2 to version 10, it needed to drop the
capability to create vector waveform files (vwf files). These files are used to produce
waveform simulations from within the Quartus® II design environment. The main reason
a designer would use version 10 (and beyond) is if they have a need to use the highest-
end CPLDs and FPGAs that weren’t supported by earlier versions of the software. If
you need that high level of development, the most current software version will be

*This section is also available as a series of podcast lectures on the textbook companion website.

126 CHAPTER 4 | PROGRAMMABLE LOGIC DEVICES: CPLDs AND FPGAs WITH VHDL DESIGN




required. In that case however, to perform waveform simulations, Altera recommends
the use of another program called ModelSim® which runs external to the Quartus® II
environment. QSIM®, another waveform simulator, runs external to Quartus® IIin ver-
sion 10 but should be internal in later versions. It will look and act just like the vector
waveform editor described in this text.

For the best overall learning experience, it is recommended that you download
and install the Quartus® IT Web Edition version 9.1 sp2. This very popular version will
continue to be available to download for many years to come from the Altera archives
download site. (https://www.altera.com/download/archives)

In this tutorial we will implement a simple Boolean equation (X = AB + CD)to
illustrate the steps involved to design, simulate, and program an FPGA using Altera’s
Quartus® II software.

1. Start the Altera Quartus® I software. The main screen is shown in Figure 4—15.

4’ Quarkus IT 1ol x|

ile  Edit Wiew Projeck  Assignments  Processing  Tools  Window  Help
DEE@ (S| Ba| o o [
He@RE|T|ron|so(r|e|® ale

Project Mavigator —————————————————1 « x

. Getting Started
With Quartus® Il Software

Start Designing Start Learning

Designing with Quartus If software The audiofvideo interactive tutorial teaches
requires a profect you the basic features of Quartus N software

cﬁ“ﬁ I:u?n?‘:&r:i;d Open Interactive Tutorial
Open Existing Project
Open Recent Project:
decodera

Figure 4-15 Quartus® II main screen. (Courtesy of Altera Corporation.)

Create a New Project

All of our designs will be contained within a “Project.” Within the project we will
create our design using the Block Design Editor to draw a schematic or the Text Editor
to enter a VHDL program. We will also create a simulation file for the project to test
the operation of our circuit before it is programmed into an FPGA.

2. To create a new project:

Press Create a New Project then press Next
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Figure 4-16 The New Project Wizard screen (1 of 5).
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YWihat iz the name of the top-level design entity for thiz project? Thiz name iz caze sensitive and must
exactly match the entity name in the design fils.

Ibooleam _I

ze Existing Project Settings ...

< Back | Mext > | Finish | Cancel

Figure 4-17 The New Project Wizard screen (1 of 5 [Continued]).
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The New Project Wizard screen is shown in Figure 4-16. The first page of
the New Project Wizard asks for the Directory, Name, and Top-Level Entity
of the project. A good place to keep all of your projects is in your
MyDocuments folder (or a removable flash drive). This figure shows a new
sub-directory named alterafiles and a working directory named booleanl.
All future FPGA work should be placed in the alterafiles subdirectory, and a
new working directory (booleanl in this case) should be made for each new
project.

3. Next you need to fill in a meaningful name and top-level entity for your
project. I chose booleanl as shown in Figure 4—17. Notice: the name
booleanl appears on all three lines. Press Next and Yes to create the new
subdirectory.

4. The second wizard screen is shown in Figure 4-18. We have no additional
design files to add, so press Next.

New Project Wizard: Add Files [page 2 of 5] N ﬂ

Select the design filles you want to include in the project. Click Add &ll to add all design files in the
project directomy ta the project. Mote: pou can always add design files ba the project later.

File name: I | Add |
File name | Tupe |Library | Design enty/sy... |HDL version Add &l |

Hemave

Froperties
B

Do

il

« | [ |
Specify the path names of any non-default ibranes. User Libraries... |

< Back | Mest > | Finish Cancel

Figure 4-18 The New Project Wizard screen (2 of 5).

5. The third wizard screen is shown in Figure 4—-19. This screen will allow us
to specify the actual FPGA that we will target for our design. In the drop-
down box for the Family, select Cyclone II. Place a check in the box for
Specific device. Highlight the EP2C35F672C6 and press Next.

6. The fourth wizard screen is shown in Figure 4-20. We have no additional
EDA tools to use so press Next to proceed to the fifth screen.
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Figure 4-19 The New Project Wizard screen (3 of 5).

New Project Wizard: EDA Tool Settings [page 4 of 5] ll

Specify the ather EDA tools - in addition ta the Quartus || software - used with the project.

— Design EntrdSypnthesi

Tool name: I <Mone>

Led Led

Formnat: I

™ Fiun this tool automatically to synthesize the curent design

r Simulation

Tool name: |<None> j

Farmmiats I j

™ Run gate-level simulation automaticaly after compilation

— Timing Analpsis

Tool name: |<N0ne>

Led Lo

Formnat: I

™ B this baol sutomatically fter compilstion

< Back | MNest > | Finish Cancel

Figure 4-20 The New Project Wizard screen (4 of 5).
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7. The fifth wizard screen is shown in Figure 4-21. This shows a summary of
all of the choices that we have made. Press Finish to complete the New
Project Wizard.

Mew Project Wizard: Summary [page 5 of 5] 1[
“when you click Finigh, the project will be created with the following settings:
Froject directory:
C:/Documents and SettingsAwwlk Ay Documentsd alterafles/booleant/
Project name: boolean
Top-level design entity: boolean
Mumber of files added: 1]
Mumber of user libraries added: 0
Device azzignments:
Family name: Cyclone ||
Device: ERP2C35FE7ZCE
EDA tools:
Dezign enty/senthesis: <Mone>
Sirnulation: <Monex
Timing atalysis: <Mone>
Operating conditions:
Core voltage: 1.2
Junction temperature range;  0-85 °C
< Back | [diEst | Finizh Cancel

Figure 4-21 The New Project Wizard screen (5 of 5).

Create a Block Design File (bdf)

8. To draw the logic circuit for our Boolean equation, we will use the block ed-
itor to create a Block Design File by drawing the schematic for the Boolean

equation

X =AB + CD.

Choose File > New (see Figure 4-22).

9. Highlight Block Diagram/Schematic File and press OK. A blank work-
space appears. We will draw our digital logic circuit in this workspace.

10. Before drawing the logic circuit we need to name this bdf file and save it as
part of our project.
Choose File > Save As and enter the File name as boolean!. Place a check

mark in the space labeled Add file to current project and press Save (see
Figure 4-23).
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Figure 4-22 The screen used to select a new Block Diagram File.
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Figure 4-23 Display used to save a new Block Diagram File.

Draw the Digital Logic for the Boolean Equation

11. Right-click the mouse in the empty workspace.

Choose Insert > Symbol and type and2 in the Name field and press OK
(see Figure 4-24).
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Figure 4-24 Adding a 2-input AND gate to the bdf file.

12. Drop the and?2 gate in the bdf file workspace by moving your mouse to a suit-
able location and pressing the left mouse button.

13. To implement the equation X = AB + CD we will need a total of two AND
gates and one OR gate. Repeat steps 11 and 12 for another 2-input AND gate
(and2) and a 2—-input OR gate (0r2).

We also have to provide four input pins for A, B, C, and D and one output pin
for X. Repeat steps 11 and 12 for four input pins (named input) and one
output pin (named output).

The bdf workspace should now look like Figure 4-25.

£ boolean.bdi= |

|BrAasOaaEE|a|B|a|a<e|O0o N

T Y e =TIV

Figure 4-25 Gates and input/output pins inserted into the bdf file.
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Make the Circuit Connections

14. Before making all of the circuit connections, pin names should be assigned
to the four inputs and one output. Double-click on the word pin_name inside
the first input pin. Enter the lowercase letter a for pin name and press OK.
This assigns the name « to that pin. Repeat for b, ¢, d, and x.

(Note: We use lowercase letters for input and output names to be consistent
with the convention used by the VHDL language. We will redesign this logic
using VHDL near the end of this tutorial.)

15. We will now make the circuit connections. As you move the mouse pointer
close to the end point of any symbol input or output, the pointer automati-
cally becomes a cross-hair. This is called the Smart Drawing Tool. Press and
hold the left mouse button as you drag a connection line from the a-input
symbol to the input of the first AND gate. Repeat for all of the connections
so that the bdf file looks like that shown in Figure 4-26.

7 booleanl.bdf* |
H WADD'T"I “j[ﬁ-ﬁ:é|@\||aﬁ|ﬂl =4 [0S N ™

Figure 4-26 The wired bdf file.

16. To save the updated bdf file:
Choose File > Save. (Notice the asterisk is removed from the file name.)

Compiling the Project

17. Now we will compile the project. In this step Quartus® II performs an
analysis and synthesis of the bdf file to make sure that there are no errors
in our logic. It then fits the design to a template of an EP2C35F672C6
FPGA. Finally, it runs an assembler and timing analyzer. To run the
compiler:

Choose Processing > Start Compilation.
The compilation takes several seconds. When it is complete it should give a
message that indicates “Full compilation was successful”. (The warnings

will be resolved later when we define pin numbers for the input/output) (see
Figure 4-27). Press OK.
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Tasks - x

| Flow: [FullDesign Quartustt x|
- -
fle - TG \l) Full Campilation was successful (4 warnings)
C1 Start Project

Z1 Advisors

Z1 Create Design OK |

21 assign Constraints
+ E W Compile Design 000022
v Bl I Analysiz & Synthesis 000002
W B M Fitter [Flace & Route] 000013
v Bl - Azsembler [Generate programmin | 00:00:05
W B W Classic Timing Analysis 00:00:m

.. B ET0A BlaHink adribar |

Figure 4-27 Compilation results.

Create a Vector Waveform File (vwf) to Simulate the Design*

18. The Vector Waveform File (vwf) provides a way for us to draw waveforms
that step through all possible combinations of inputs for a, b, ¢, and d and
produce the resulting output at x. To create a Vector Waveform File:

Choose File > New > Verification/Debugging Files > Vector Waveform
File > OK (see Figure 4-28).

New
- Mew Quartus || Project

i 50PC Builder System

B Design Files

- BHDL File

- Block DiagramyS chematic File

- EDIF File

- State Machine File

- Spztemyenlog HOL File

- Tl Script File

- Werilog HOL File

- WHDL File

[#- Memony Files

= Yerification/Debugging Files

- |n-Syztem Sources and Probes File
- Logic Analyzer Interface File
ignalT ap |l Logic Analyzer File

[ Other Files

ok I LCarcel

&

Figure 4-28 The screen used to create a new vwf file.

*All vwf files in this text were created with Quartus version 9.1 sp2. Another alternative to vector waveform simulation is to use
ModelSim® software. This would require the creation of a VHDL testbench file that could be written after you have a firm
understanding of the VHDL language.
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19. Before drawing the simulation waveforms we need to name this vwf file and
save it as part of our project.

Choose File > Save As and enter a file name of booleanl. Place a check
mark in the space labeled Add file to current project and press Save (see
Figure 4-29).

savens ]
Save in: I@ boolean j &= £F B~

\Cidb
| _Jincremental_db

Desktop

o

My Documents

e
o
Iy Camputer

S
2

File name: Iboolean1 j Save |
j Cancel |
v/

Save az lype: IVector wiaveform File [ wwf]

v Addfile to current project

Figure 4-29 The screen display used to save a new Vector Waveform File.

20. To build this simulation file we first need to specify an end time of 16 ws and
a grid size of 1 ws for our waveform display:

Choose Edit > End time > /6 > us > OK. Then:

Choose Edit > Grid Size > Period > I > us > OK (see Figures 4-30
and 4-31).

]
Time: |16 fus =]

Figure 4-30 Screen used to set the waveform’s end time.

Gridsize Y

Base grid on
€ Clock setings:
| I|
& Time perind:
Period: |1 us =
ak. | Cancel |

Figure 4-31 Screen used to set the waveform’s grid size.
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21. To see the entire 16 ws display:

5] bacleant bdf

Choose View > Fit In Window.

Your vwf screen should look like Figure 4-32.

| & Compilation Feport - Flaw Sum,.. | i booleanl vwi* |

|

kA
* e

o

B
=

o5 o ey I e v | 3|
) (e 2 i ) 0 B e

oo
oo
i ]
Pt
s

Master Time Bar| 0Ops j_tl Painter: | 0ps 1ht‘erva|:-| Ops St'art;-l End: |

sl ot B A0us

.E:D‘.us 120us 1E. ULL4

Marne Ops 0ps
i

il | 3

Figure 4-32 The vwf screen showing a 16 ws end time and a 1 ws grid size.

Add the Inputs and Outputs to the Waveform (vwf) Display

22,

We now need to add the inputs and outputs that we want to simulate on the

waveform display. The Quartus® II software provides a helpful utility to do

this called the “Node Finder.”

Choose View > Utility Windows > Node Finder (see Figure 4-33).

Wigw Project  Assignments  Processing  Tools  Window  Help

LIEilisy 4 4 ﬁ Project Mavigator  Alk+0
Mode Einder
Full Screen Chrl+Alk+Space ﬁ i i
m Tcl Conscle Alk+2
B Eit in Window Cerl+ ] Messages Alk+3
®\ Zoom In Chri+Space B status Alk+4
@\ Zoorm Cuk Ctrl+Shift+Space e change Manager  Alt+5 |
& zoom... A Tasks Alb+6

BL? ramnare ko WaveFarmns in Fils

Figure 4-33 Using the Node Finder utility to list inputs and outputs for the vwf file.

23. In the Node Finder pop-up window that appears:
Choose Filter: Design Entry (All Names).
Press List (the display should look like Figure 4-34).
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|
Mamed. |- x| Fiter. | Design Entry [l names) 7 | Customize... I List I Q
jJ V¥ Include subentities Stop |

Modes Found:
MHame | Agzignments | Tupe | Creator |

s Unazzigned  [nput Uzer entered
b Unazsigned  [nput Uzer enterad
I c Unazzigned  |nput Uzer entered
B d Unazzigned  [nput Uzer entered
& inst Unassigned  Combinational Uzer entered
& inzt] Unazzigned  Combinational Uzer entered
F inst? Unazzigned  Combinational Uzer entered
P Unassigned  Output Uzer entered

Figure 4-34 The Node Finder screen listing all inputs and outputs of the project.

24. Next we will use the computer mouse to drag the input and output names
from the Node Finder screen to the booleani.vwf screen. You can do this by
using the mouse to drag each individual input/output with the left mouse
button, or you can highlight all five names by holding the CTRL key while
you left-click on each of the five input/output names, then drag them all at
once (see Figure 4-35).

booleant. bdf I @ Compilation Report - Flowe Summ... I ﬁ boolean] . ywi= |
I aster Time Bar: Opz ¢| DI Puairker: | Opz Intereal Ops Start; | End:
M Value at S 40us 8.0us 12.0us 16.0 u4
ame Ope ? ns
-0 a BEO
1 b BO
-2 c EQ
w3 d ED
o) % B

j Filter: |Design Entry [all names]ﬂ Cusgtomize... | List I Q
jJ ¥ Include subentities Stop |

Modes Found:

Mame Agzighments | Type Creatar -

Input

It
Input

Input Uszer entered
5 A izt Unagszigned  Combinational Uszer entered
E G izt Unazzigned  Combinational Uszer entered
= ! ! i I
o o inzt? Unaszigned  Combinational Uzer entered
=] P =l
= y

Figure 4-35 Dragging the input/output names from the Node Finder screen to the
vwf screen.

Create Timing Waveforms for the Inputs

25. In order to test all of the possible combinations for our four inputs we need
to create a series of timing waveforms that step through all 16 possible
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combinations of input logic levels. The easiest way to do this is to form a
binary counter that counts from 0000 up to 1111 just like we did with truth
tables in Chapter 3.

In the vwf screen, left-click on the first input, a, to highlight it.
Choose Edit > Value > Clock.

Enter a period of 2 us.

Press OK.

The a-waveform is shown in Figure 4-36.

boolean. bdf I @ Compilation Repaort - Flows Surmm... I @ boolean. vef= |

Master Time Bar: 0ps 4| >| Painter: | 0ps Interval: 0 ps Start: | 0ps End:| 160us
N 0 ps 40us B0 us 120 us 16.0u
ame Ops 0ps
i

=0 a ED
-1 b BD
-2 c BD
- d BO
o 4 W B
< |

Figure 4-36 The a-waveform drawn as a clock with a period of 2 us.

26. To draw the b-waveform as a clock with a period of 4 us, highlight the b
input, then:

Choose Edit > Value > Clock.
Enter a period of 4 us.
Press OK.

27. Repeat for the c-waveform (8 us) and the d-waveform (/6 us). When com-
pleted, the vwf screen with all four clock waveforms should look like

Figure 4-37.
baonlzant. bdf I @ Compilation Repart - Flowe Sum.. I '@ booleanT. vwf* |
taster Time Bar: Ops 4| 'l Painter: | Ops Inkareal: 0 ps Stark: | 0ps End:| 160us
= 40us B us 120us 16.0uq
ame 0 ps 0ps
1]
=0 a BO
-1 b BO |
w2 c BO
[ d| BO |
o 4 % B
< I

Figure 4-37 Waveforms showing a binary count on the a, b, ¢, and d inputs of the vwf file.

28. Save the vwf file:
Choose File > Save. (Notice the asterisk is removed from the file name.)
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Perform a Functional Simulation of the x-Output

29. Now that we have the input stimulus defined, the Quartus® II software can
use those inputs to determine the level at x for each combination of inputs. A
functional simulation shows the output waveforms without taking into con-
sideration propagation delays of the internal circuitry. This gives us a simple
view of the predicted output so we can check design results.

Choose Assignments > Settings.
Then on the left side of the window shown in Figure 4-38 highlight

Simulator Settings, and for Simulation Mode choose Functional > OK.
Now to create a netlist file to enable the simulation:

Choose Processing > Generate Functional Simulation Netlist > OK.

Settings - boolean1 ) |
Categorny:
- General Simulator Settings
- Files
- Librarigs Select simulation options.
- Device
[#- Dperating Settings and Conditions . . : —
- Compiation Pracess Settings Simulation mode: | [t g
(- EDA Tool Settings Simulation input: Iboolean‘l.vwf | Add Multiple Files... |
[H- Analysiz & Synthesis Settings
- Fitter Settings Simulation period
Bl Timing Analysis Settings & Rur simulation until all wector stimuli are used
- &ggembler
- Design Assistart 7 End simulation at I ng b
- SignalTap Il Logic Analyzer
- Logic Analyzer Interface Glitch filtering options: IAuto j

el
[+

- Simulator Settings

- PowerPlay Power &nalyzer Settings More Seftings... |

- S5M Analyzer

Drescription:

Specifies the type of simulation to perfarm far the current Simulation facus. d

i
oK. I Cancel |

A

Figure 4-38 The Settings window for specifying the Functional Simulation mode.

30. To process the simulation:
Choose Processing > Start Simulation.

After a few moments a message stating “Simulation was successful”” should
appear.

Press OK.

The simulation waveforms are shown in Figure 4-39. (Nofe: You may have
to expand the size of the Simulation Waveforms to suit your needs and
choose View > Fit in Window to see the entire 16 us waveform.) Accord-
ing to the Boolean equation X = AB + CD, X should be HIGH if A AND B
are both HIGH OR if C AND D are both HIGH. Study the waveforms to
prove to yourself that the simulation shows a valid result.
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Simulation Waveforms

Simulation mode; Functional !
hd|
m Master Time Bar: | 0 ps <| >| F'ointer:l Opz  Interval:| Ops  Start End:|
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Figure 4-39 Results of the simulation for the Boolean equation X = AB + CD.

Programming the FPGA Using the Altera Development
and Education Board*

The next step in our development process is to program our logic function into an
actual FPGA and test its operation using input switches and an output LED. The de-
velopment board chosen to perform this task is the Altera DE2. This board has an
Altera EPC2C35F672C6 FPGA along with several other I/0 devices and memory
circuits.

Assigning pins:

31. Previously, when the compiler determined the logic necessary to implement
our Boolean equation, it assigned arbitrary pins to our a, b, ¢, and d inputs
and our x output. However, the DE2 board has several switches, pushbuttons,
and LEDs hard-wired to specific pins on the FPGA. Therefore, to exercise
our FPGA, we need to assign those specific pin numbers to our inputs and
output. Table 4-1 shows a partial list of the pin connections on the FPGA
that are hard-wired directly to the I/O on the DE2 board. (A complete list is
provided in the DE2 users manual as an Excel .csv file.)

TABLE 4-1 | EPC2C35F672C6 FPGA Pin Assignments to the DE2 Board (Partial List)

Input Switches Output LEDs
Switch Name FPGA Pin Number LED Number FPGA Pin Number
SWO0 A N25 LEDRO X AE23
SWI1 B N26 LEDR1 AF23
SW2C P25 LEDR2 AB21
SW3 D AE14 LEDR3 AC22
SwW4 AF14 LEDR4 AD22
SW5 ADI13 LEDRS5 AD23
SW6 ACI13 LEDRG6 AD21
SW7 Cl13 LEDR7 AC21

*The DE2 board is demonstrated in this chapter, but any development board built around an Altera FPGA or CPLD will work.
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The pin numbering scheme used in Table 4-1 may seem a little unusual
at first, but if you look at the data sheet for our FPGA you see that the
IC package is a BGA (Ball Grid Array) set up as 26 rows by 26 columns.
The columns are labeled sequentially from 1 to 26, but the rows use the
letters A through Y (skipping /, O, Q, and X) then AA, AB, AC, AD, AE,
and AF.

Figure 4-40 shows a close-up photograph of the switches and LEDs we will

be using. [Inputs a and b are shown LOW; inputs ¢ and d are shown HIGH.
The red LED used for output x (LEDRO) is just above switch SWO.]

’\"-'_:j J‘Iﬁ.‘.i

e

[
SDRAM 8MB
m'mmuumuum:;/ oo M=————— 0
SRAM 512K8 © FLASH a1

LEDRE  LEDRS LEpas LEDR3 LEDR2 LEDR1 LEDRO LEDGT

LEDGE  LERGh
., |

LTI 7 S 7

Figure 4-40 DE2 board switches and LED used for testing our Boolean logic.

Pin assignments are made by using the Assignment Editor.

Choose Assignments > Pins.

The pin assignment window is shown in Figure 4-41.

In the Location column, enter the pin numbers from Table 4-1 for a, b, c, d,
and x. (Shortcut: Just type N25, N26, etc. in each location.) The completed
table is shown in the bottom section of Figure 4-42. The top section of
Figure 4—42 shows that the pin assignments were made automatically to the
schematic bdf file.

Re-compile the project:

32. Now that we have defined specific pin assignments, we need to re-compile
the project so that Quartus® will map our logic in the optimum FPGA loca-
tion and connect the internal input/output to the correct external pins.

Choose Processing > Start Compilation.

After a successful compilation, we are ready to program the FPGA.
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Figure 4-41 The pin assignments window.
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Figure 4-42 The completed pin assignments (bottom) and bdf file (top) showing assigned pins.

Program the FPGA on the DE2 board:

33. The final step is to program the FPGA that is on our DE2 board. If this is the
first time that this host computer has been used with this software, you will
need to follow the instructions in the DE2 user’s manual for installing the
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USB driver for the DE2 board. This driver facilitates communications with
the JTAG interface that is provided on the board. The acronym JTAG stands
for Joint Test Action Group. This is an IEEE standard that defines a method
for testing and transferring data into digital circuitry.

Connect the USB cable from your board to the host computer and apply
power to the DE2.

Choose Tools > Programmer.

The programmer window is shown in Figure 4-43. If this is the first time us-
ing this host computer for programming FPGAs, you may have to choose
Hardware Setup to specify that you are using the USB-Blaster. Also be
sure to select Mode: JTAG.

i Quartus II - C:/Documents and Settings/wwk /My Documents /alterafiles (boole Al
File Edt Processing Tools ‘Window

(:Ea Hardware Setup. |

Made: e 2
F-’rqgress'. | 0%
["" Enable realtime 5P to allow background programming [for Ma 1| devices)
P Start | Fils _ |Dex_rjce | Checksum | Usercods: E'fngﬁfgal‘]:i
a6t | bodlean sof EP2CIEFET2 O0ZFE27F  FFFFFFFF

il Auto Detect

> Delste I

Baddrie. ||« | 5
For Help, press FL [ o[

Figure 4-43 The programmer window for downloading our Boolean.sof file to the FPGA
via the USB-Blaster cable using the JTAG programming mode.

Choose Start in the programmer window to begin the programming process.

When the Progress window shows 100%, the device programming is com-
plete, and it is time to test our logic.

Test the logic on the DE2 board:

34. Think back to the Boolean equation that we are implementing: X = AB + CD.
This means that if A and B are both HIGH or C and D are both HIGH, the
LED at X will come on. Test the logic in the FPGA by sliding the appropri-
ate switches. You should see the LED only comes on for a HIGH A and B or
a HIGH C and D.

VHDL Design Entry

In this section, we will create the design for booleanl (X = AB + CD) using the VHDL
text editor instead of the block design (schematic) editor. After we define the inputs, out-
puts, and Boolean equation using the VHDL text editor, we will then recompile the
project and check the simulation to be sure that the same output results are implemented.

(Note: The following steps assume that you are still working in the booleanl project
created in steps 1-34. If not, reopen the project by choosing:

File > Recent Projects > c: \ ... \ booleanl.
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[If this is a new project to be implemented using VHDL, go back to steps 1-7 to create
a new project first.])

35. To get a blank VHDL Text Editor screen:
Choose File > New > VHDL File > OK (see Figure 4-44).

hew . |

- S0PC Builder System |
=8 Design Files
- AHDL File
‘- Black Diagram./Schematic File
-ELIF File
- State Machine File
- Spztermyfenlog HOL File
- Tl Scnpt File

=+ Memoany Files
i Hewadecimal [Intel-F ormnat] File
L. Memoary Initializatian File
= Veritication/Debugaing Files
- |n-Syztem Sources and Probes File
- Logic Analvzer Interface File
- SignalT ap Il Logic Analyzer File
- Wector Wavetorm File
[=1- Other Files
-~ BHDL Inchude File
- Block Spmbaol File
- Chain Description File
- Synopays Design Constraints File
- Text File =

e
=

ok I Cancel

A

Figure 4-44 Window used to get a blank VHDL text editor screen.

36. Type in the VHDL program for X = AB + CD as shown in Figure 4-45.

% Vhdll.vhd= |
;E 1 LIERARY ieee;
2 T3E ieee.std_logic_lls‘l.ALL;
&k 3
& 4 = ENTITY hooleanl IZ
B 5 B PORT |
v & a, b, o, d: TN std logic
T 7 ] OUT std logic):
= a END booleanl:
&= 9
- 10 = ARCHITECTURE arc OF booleanl IS
A 11 = BEGIN
% 12 x<= (& LND b} OR {(c LND d);
% 13 END arc:
%

Figure 4-45 The VHDL program listing.

37. To save the VHDL program as part of the current project:
Choose File > Save As > File name: booleanl.

Add a check mark next to: Add file to current project then press Save (see
Figure 4-46).
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Figure 4-46 Saving the VHDL program as part of the current project.

38. Now we want to compile the program to check for errors. However, since we
have already compiled a design for this project using the Block Design File
booleanl.bdf we need to remove it from the current project or else there will
be a conflict error because the project won’t know which design to use. To
remove the bdf file from the project:

Choose Assignments > Settings.
Highlight the Category Files.

Highlight the File name booleanl.bdf then press Remove > OK (see
Figure 4-47).

(Note: This does not delete the bdf file from your computer; it only keeps it
from being compiled with the vid file and eliminates the conflict that would
occur. Later you could use the Assignments Settings to Add the bdf file
back and remove the vid file.)

Settings - booleani x|
Category:
- Files
- Libraries Select the design files you want to include in the project. Click Add All to add all design files in the
. Device project directony to the project.
[#- Operating Settings and Conditions
[#- Compilation Process Settings - .
Fil : Add
B ED Tool Settings 1 name _I _l
[+

- Analysis & Synthesis Settings File name Type Library | Design ent. Add Al |
- Fitter Settings boalean] . bdf Block Diagram/S chematic File <Mone>

[#- Timing Analysis Settings booleanl. vhd WHOL File <Mone> Remawve |

- &gsembler

.. Desigh Assistant ;] |

- SignalT ap Il Logic Analyzer

- Logic &nalyzer Interface Down |
- Simulator Settings E— |

- PowerPlay Power Analyzer Settings

- S5M Analyzer

el
[+

Figure 4-47 Removing the bdf file from the current project.
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39. To compile the project:
Choose Processing > Start Compilation.
After a successful compilation press OK.

40. Now you can follow the steps previously outlined to perform a simulation
and then program the FPGA IC.

(Note: The pin assignments previously made for this project will apply to the
design created using VHDL. Also, you don’t need to re-create the Vector
Waveform File booleani.vwf.) To open the previously created one:

Choose File > Open > File Name: booleanl.vwf > Open. (Note: Files
of type: All files must be Highlighted to see the vwf files as a choice.) Then
follow the steps outlined previously for performing a simulation.)

4-5 FPGA Applications

The logic design problems in this section will be solved using the tools provided in the
Quartus® I software program. If you haven’t already done so, you must work step by
step through the tutorial instructions presented in Section 4—4. In each of the examples
that follow, your goal is to design the logic circuit, perform a simulation of your cir-
cuit, and then, if you have a programmer board, you should download your results and
test it on an actual FPGA with switches and LEDs.

EXAMPLE 4-2

Use Altera Quartus® I software to design the FPGA logic to implement the
Boolean equation X = AB + AB.

(a) Design the logic using the block editor to create a Block Design File
(bdf) called ex4_2.bdf.

(b) Test the operation of the CPLD logic by using the waveform editor to
create a Vector Waveform File (vwf) called ex4_2.vwf. The simulation
should show all possible combinations of inputs.

Solution: The results of the design are shown in Figures 4-48(a) and (b).
(The project files for all examples can be found on the textbook companion
website.)

|BrAcD1 1A |a |0 |# (s ejOooN |

(a)

Figure 4-48 Solution to the equation X = AB + AB: (a) Block Design File;
(b) Vector Waveform File.
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Figure 4-48 Continued

EXAMPLE 4-3

Use Altera Quartus® II software to design the FPGA logic to implement the
Boolean equation X = ABC.

(a) Design the logic using the block editor to create a Block Design File
(bdf) called ex4_3.bdyf.

(b) Test the operation of the FPGA logic by using the waveform editor to
create a Vector Waveform File (vwf) called ex4_3.vwf. The simulation
should show all possible combinations of inputs.

Solution: The results of the design are shown in Figures 4-49(a) and (b).
(The bdf and vwf files can also be found on the textbook companion

website.)
=10j ]
|@lrAcOa M |a|@@a<sieooN |

(@)
Figure 4-49 Solution to the equation X = ABC: (a) Block Design File;
(b) Vector Waveform File.
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Figure 4-49 Continued

EXAMPLE 4-4

Use Altera Quartus® I software to design the FPGA logic to implement the
Boolean equation X = ABC + ABC.

(a) Design the logic using the block editor to create a VHDL File (vhid)
called ex4_4.vhd.

(b) Test the operation of the FPGA logic by using the waveform editor to
create a Vector Waveform File (vwf) called ex4_4.vwf. The simulation
should show all possible combinations of inputs.

Solution: The results of the design are shown in Figures 4-50(a) and (b).
(The vhd and vwf files can also be found on the textbook companion
website.)

|Bnss|Eessmn|os|BEy | =[z2 |

L A

2 LIERARY ieee;

3 U3E ieee.std logic 1164.ALL:

i

5 & ENTITY ex4 4 IS

& = FORT |

7 &, b, z: IN std logic:

g e OUT std logic):

a END ex‘l_‘l:

ID.. e

11 = ARCHITECTURE arc OF ex4_4 I3

1z = BEGIN

13 ¥<= (MNOT a AND b AND o) OR (a AND b AND NOT o) :

14 END arc: ;

15 ex4_4.vhd i
] i — H

()

Figure 4-50 Solution to the eqution X = ABC + ABC: (a) VHDL program;
(b) Vector Waveform File.
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Figure 4-50 Continued

I Summary

In this chapter, we have learned that

1. PLDs can be used to replace 7400- and 4000-series ICs. They contain
the equivalent of thousands of logic gates. CAD tools are used to configure
them to implement the desired logic.

2. The two most common methods of PLD design entry are (graphic)
entry and VHDL entry. To use graphic entry, the designer uses CAD
tools to draw the logic to be implemented. To use VHDL entry, the designer
uses a text editor to write program descriptions defining the logic to be
implemented.

3. PLD design software usually includes a logic simulator. This feature
allows the user to simulate levels to be input to the PLD, and it shows the
output simulation to those input conditions.

4. Most PLDs are erasable and reprogrammable. This allows users to test
many versions of their logic design without ever changing ICs.

5. Basically, there are four types of PLDs: SPLDs, CPLDs, FPGAs, and
ASICs. SPLDs use the PAL or PLA architecture. They consist of several
multiinput AND gates whose outputs feed the inputs to OR gates and memory
flip-flops. CPLDs consist of several interconnected SPLDs. FPGAs are the
most dense form of PLD, solving logic using a look-up table to determine
the desired output. ASICs are functionally equivalent to FPGAs but their
logic is permanently hard-coded into the IC.

P GLO'S'S @Iy

Architecture Body: The section in a VHDL program defining the logic functions to
be implemented.

ASIC (application-specific integrated circuit): ASICs are functionally equiva-
lent and pin compatible with their sister FPGA. Used for large quantity
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applications, their logic is hard-coded, making them a non-volatile ver-
sion of an FPGA.

Block Editor: A software tool provided as part of the PLD development package. It
provides a way to enter designs by drawing a schematic to create a Block
Design File.

CAD: Computer-Aided Design. This type of design uses a computer to aid in the
drawing and logic development of a logic circuit. It eliminates many of the
manual, time-consuming tasks once associated with logic design.

CPLD: Complex Programmable Logic Device. A PLD consisting of more than 100
interconnected SPLDs. A single chip can be programmed to implement
hundreds of logic equations and operations.

Compiler: A language translation software module used by CPLD development sys-
tems to convert a schematic or VHDL code into a binary file to represent
the digital logic to be implemented.

Entity Declaration: The section of a VHDL program defining the input and output
ports.

FPGA: Field-Programmable Gate Array: The most dense form of PLD. It uses
a look-up table to resolve its logic operations. Its main disadvantage is
that most FPGAs are volatile, losing their memory when power is
removed.

Library Declaration: The section of a VHDL program declaring the software li-
braries to be included in the program. These libraries are used by the com-
piler to resolve references to the various program commands.

Look-Up Table: Used by FPGA logic to determine the output level of a circuit based
on the combinations of logic levels at its inputs. It is constructed as a truth
table except that its outputs are only HIGH for specific combinations of in-
puts solving the given logic product terms.

Nonvolatile: Internal memory is maintained even when power is removed from
the IC.

PAL: Programmable Array Logic: Its basic structure contains multiple inputs to
several AND gates, the outputs of which are connected to a series of
fixed ORs.

PLA: Programmable Logic Array: Its basic structure contains multiple inputs to
several AND gates, the outputs of which are connected to a series of pro-
grammable ORs.

PLD: Programmable Logic Device: An IC containing thousands of undefined logic
functions. A software development tool is used to specify (i.e., program)
the specific logic to be implemented by the IC. PLD is the general term
used to represent PLAs, PALs, SPLDs, CPLDs, and FPGAs.

Product Terms: Input variables that are ANDed together (e.g., ABC, ABC).

Schematic Capture: A method used by PLD software to input a design that is defined
by a schematic.

SPLD: Simple Programmable Logic Devices: A programmable, digital logic IC
containing several PAL or PLA structures with internal interconnections
and memory registers.

GLOSSARY
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Sum-of-Products (SOP): Two or more product terms that are ORed together (e.g.,
ABC + ACD + BCD).

Synthesize: The creation of a model of the PLD’s internal electrical connections that
will produce the actual logic functions defined by the user.

VHDL: VHSIC (Very High Speed Integrated Circuit) Hardware Description Language.
A programming language used by PLD software to define a logic design by
specifying a series of 1/0O definitions and logic equations.

VHDL Editor: A software program facilitating entry of text-based instructions com-
prising the VHDL program.

Waveform Simulator: The part of a PLD software development tool that allows users
to simulate the input of several signals to a logic circuit and observe its re-
sponse in a Vector Waveform File.

I Problem s

Section 4-1

4-1. How does programmable logic differ from discrete digital logic like
the 7400 series?

4-2. What are two common ways to configure or define logic to PLD pro-
gramming software?

4-3. What does HDL stand for in the acronym VHDL?
4-4. List the six steps in the PLD design flow.

4-5. How many different ICs would it take to implement the following
equations?

(a) X = AB + BC
(b) Y=AB+BC+ C+D

4-6. How is pin 1 identified in the PLCC package style used for the PLD
in Figure 447

4-7. What is the purpose of the PLD programmer boards shown in
Figure 4-5?
Section 4-2
4-8. How many product terms are in the following equations?
(a) X = AC + BC + AC
(b) Y = ABC + BC
(¢) Z= ABC + ACD + BCD
4-9. How does a PLA differ from a PAL?

4-10. Redraw the PLA circuitry of Figure 4-8 to implement the following
SOP equations:

(a) X=AB + AB + AB
(b) Y = AB + AB
4-11. Why is it advantageous to use a CPLD or ASIC that is nonvolatile?
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4-12. Refer to the data sheets in Appendix B (or the manufacturer’s Web
site) to determine the number of usable gates and macrocells in each of the
following CPLDs:

(a) Altera MAX EPM7128S
(b) Xilinx XC95108

4-13. Instead of interconnecting logic gates, the FPGA solves its logic re-
quirements by using what method?

4-14. Draw a 2-input look-up table (LUT) similar to Figure 4-11(b) for
the equation X = A B + AB.

4-15. Because most FPGAs are volatile, what must be done each time they
are powered up?

Section 4-3

4-16. What are the two most common methods of design entry for FPGA
development software?

4-17. What is the function of the compiler in FPGA development soft-
ware?

4-18. What is the purpose of the three pin stubs in the bdf file shown in
Figure 4-13(a)?

4-19. VHDL allows the user to enter the logic design via a
editor.

4-20. Define the purpose of the following three VHDL program segments:
(a) Library

(b) Entity

(¢) Architecture

4-21. Write the VHDL entity declare for a three-input AND gate.

4-22. Write the VHDL architecture for a three-input AND gate.

4-23. Draw the logic circuit to be implemented by the following VHDL
architecture body:

ARCHITECTURE arc OF p4_23 IS

BEGIN

x < = (aAND (bOR¢));

y < = (aORNOT b) AND NOT (b AND c);
z < = NOT (b AND ¢) ORNOT (a OR ¢);
END arc;

I FPGA Problems I

The following problems will be solved using the Altera Quartus® II software. You will
be asked to solve the design using the block design entry method or the VHDL design
entry method. In either case you will demonstrate the circuit operation by producing a
Vector Waveform File (vwf) that exercises all possible inputs to your circuit. The final
step, if you have a programmer board like the DE-2, is to download your design to an
FPGA and demonstrate its operation to your instructor.
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Section 4-4

C4-1. Use an FPGA to implement the following Boolean equation:
X = AB.

(a) Create a Block Design File called prob_c4_1.bdf to define the logic
circuit.

(b) Create a Vector Waveform File called prob_c4_1.vwfto test the
operation of your design by showing the output waveform for all possible
input conditions.

(c) Build a truth table for the Boolean equation.
(d) Download the design to the FPGA on your programmer board

and demonstrate its operation by monitoring the output LED as you
step through all switch combinations shown in your truth table from

part (c).

C4-2. Use an FPGA to implement the following Boolean equation:
X =AB + AB.

(a) Create a Block Design File called prob_c4_2.bdf to define the logic
circuit.

(b) Create a Vector Waveform File called prob_c4_2.vwf to test the
operation of your design by showing the output waveform for all possible
input conditions.

(c) Build a truth table for the Boolean equation.
(d) Download the design to the FPGA on your programmer board

and demonstrate its operation by monitoring the output LED as you
step through all switch combinations shown in your truth table from

part (c).

C4-3. Use an FPGA to implement the following Boolean equation:
X = ABC.

(a) Create a Block Design File called prob_c4_3.bdf to define the logic
circuit.

(b) Create a Vector Waveform File called prob_c4_3.vwf to test the
operation of your design by showing the output waveform for all possible
input conditions.

(c) Build a truth table for the Boolean equation.

(d) Download the design to the FPGA on your programmer board
and demonstrate its operation by monitoring the output LED as you
step through all switch combinations shown in your truth table from

part (c).

C4-4. Use an FPGA to implement the following Boolean equation:
X = ABC + A BC.

(a) Create a VHDL File called prob_c4_4.vhd to define the logic circuit.

(b) Create a Vector Waveform File called prob_c4_4.vwf to test the
operation of your design by showing the output waveform for all possible
input conditions.

(c) Build a truth table for the Boolean equation.

(d) Download the design to the FPGA on your programmer board
and demonstrate its operation by monitoring the output LED as you
step through all switch combinations shown in your truth table from

part (c).
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C4-5. Use an FPGA to implement the following Boolean equation:
X=AB + CD.

(a) Create a VHDL File called prob_c4_5.vhd to define the logic circuit.
(b) Create a Vector Waveform File called prob_c4_5.vwf to test the
operation of your design by showing the output waveform for all possible
input conditions.

(c) Build a truth table for the Boolean equation.

(d) Download the design to the FPGA on your programmer board
and demonstrate its operation by monitoring the output LED as you
step through all switch combinations shown in your truth table from

part (c).
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OUTLINE

Combinational Logic

Boolean Algebra Laws and Rules
Simplification of Combinational Logic Circuits Using Boolean Algebra
Using Quartus® II to Determine Simplified Equations

De Morgan’s Theorem

Entering a Truth Table in VHDL Using a Vector Signal

The Universal Capability of NAND and NOR Gates

AND-OR-INVERT Gates for Implementing Sum-of-Products Expressions
Karnaugh Mapping

5-10 System Design Applications
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OBJECTIVES

* Write Boolean equations for combinational logic applications.

» Utilize Boolean algebra laws and rules for simplifying combinational logic
circuits.

* Apply De Morgan’s theorem to complex Boolean equations to arrive at simpli-
fied equivalent equations.

* Design single-gate logic circuits by utilizing the universal capability of NAND
and NOR gates.

* Troubleshoot combinational logic circuits.

e Implement sum-of-products expressions utilizing AND-OR-INVERT gates.

 Utilize the Karnaugh mapping procedure to systematically reduce complex
Boolean equations to their simplest form.

* Describe the steps involved in solving a complete system design application.




INTRODUCTION

Generally, you will find that the simple gate functions AND, OR, NAND, NOR, and
INVERT are not enough by themselves to implement the complex requirements of
digital systems. The basic gates will be used as the building blocks for the more com-
plex logic that is implemented by using combinations of gates called combinational
logic.

5-1 Combinational Logic

Combinational logic employs the use of two or more of the basic logic gates to form
a more useful, complex function. For example, let’s design the logic for an automobile
warning buzzer using combinational logic. The criterion for the activation of the warn-
ing buzzer is as follows: The buzzer activates if the headlights are on and the driver’s
door is opened or if the key is in the ignition and the door is opened.

The logic function for the automobile warning buzzer is illustrated symbolically
in Figure 5—1. The figure illustrates a combination of logic functions that can be writ-
ten as a Boolean equation in the form

B =KandD or HandD
which is also written as
B = KD + HD

This equation can be stated as “B is HIGH if K and D are HIGH or if H and D are
HIGH.”

Key inignition ——— K |
B
Door opened D

B ‘Warning
buzzer

Headlightson ———  H | B=KD+ HD
B
D

Figure 5-1 Combinational logic requirements for an automobile warning buzzer.

When you think about the operation of the warning buzzer, you may realize that
it is activated whenever the door is opened and either the key is in the ignition or the
headlights are on. If you can realize that, you have just performed your first Boolean
reduction using Boolean algebra. (The systematic reduction of logic circuits is per-
formed using Boolean algebra, named after the nineteenth-century mathematician
George Boole.)

The new Boolean equation becomes B = D and (K or H), also written as
B = D(K + H). (Notice the use of parentheses. Without them, the equation would
imply that the buzzer activates if the door is opened with the key in the ignition or any
time the headlights are on, which is invalid. B # DK + H. Parentheses are always re-
quired when an OR gate is input to an AND gate.) The new equation represents the
same logic operation, but is a simplified implementation, because it requires only two
logic gates, as shown in Figure 5-2.




l Helpful
Hint

Use parentheses in VHDL
equations to maintain
order of operations.
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Door opened b B Warning
buzzer

Key in ignition K
Headlights on /
An OR gate input

to an AND gate
requires parentheses.

Figure 5-2 Reduced logic circuit for the automobile buzzer.

VHDL Proof of the Automobile Buzzer Circuit Reduction

An easy way to prove to yourself that the reduced circuit of Figure 5-2 is equivalent to
the original circuit in Figure 5-1 is to describe each equation in a VHDL program and
then run a simulation of all possible input conditions. The VHDL program is listed in
Figure 5-3(a). The original circuit is described using the variable name “b_original”
and the variable name for the reduced circuit is “b_reduced.” As mentioned in Chapter 4,
VHDL is not case-sensitive, but it is common practice to use a formatting scheme that
capitalizes keywords like BEGIN, AND, OR, and NOT and uses lowercase for vari-
ables like k, d, and h. Also, since VHDL equations have no order of precedence, it is
mandatory to use parentheses to maintain proper grouping. The double hyphen (--) in
the program is used to begin a comment. Comments are used for program documenta-
tion and are ignored by the VHDL compiler.

_imlx

LIBRARY ieee; ——Automobile Buzzer :‘
USE ieee.std_logic_ 1164 _ALL;

ENTITY fig5_3 1S

PORT{
k, d, h : IH std logic;
b original, b _reduced : OUT std logic);
EMD fig5_3;

ARCHITECTURE arc OF fig5_3 1S
BEGIH
b_original<{={k AMD d) OR (h AHD d);
b_reduced<= d AHD (kK OR h};

EMD arc;
Q !Oh fig5_3.vhd e
- LIJ

(a)

Te 5T TNET <] |

Figure 5-3 Design for comparing the two forms of the automobile buzzer circuit:
(a) VHDL program; (b) Symbol file; (c) Vector waveform file.

After you compile a .bdf or .vhd design you can create a block symbol file (.bsf).
A .bsf file shows the inputs and outputs in a symbolic block diagram form. To create a
block symbol file:

CHAPTER 5 | BOOLEAN ALGEBRA AND REDUCTION TECHNIQUES



Choose File > Create/Update > Create Symbol files.

The block symbol file in Figure 5-3(b) shows the inputs (k, d, and /&) and outputs
(b_original and b_reduced).

The simulation file is shown in Figure 5-3(c). Notice in the simulation that the
waveform for b_reduced is identical to b_original, proving equality.

Ef| fig5_3.bsf

—

|

@ o |
N !

N f»-
CE . z
CEEk b_original [— &
ceeE

A coME—d b_reduced [—3 é
CEl z
R Z-

@J\ g Z!

T E e Z
.. j fee g g g e g g g g f

W s il

4Eb fig5_3 Simulation Repork E - |EI|£|
taster Time Ear: Ops <| PI Fainter: | 0ps |nterwal: | Ops Start: | End: |
) vae | PPS 40us 8.0us 120us 16.0ug
arne Ops | ps
i
- k. B0
o BD | I |
E h BO
E b_original BD
E boreduced | BO
M fig5_:3.vwf
R
The output waveforms are identical (©)

Figure 5-3  Continued

EXAMPLE 5-1

Write the Boolean logic equation, and draw the logic circuit and truth table Team

that represents the following function: A bank burglar alarm (A) is to acti- Discussion

vate if it is after banking hours (H) and the front door (F) is opened or if it

is after banking hours (H) and the vault door is opened (V). What other applications of
. . ) . . Boolean logic can you think

Solution: A = HF + HV. The logic circuit and truth table are shown in of in the home, automobile,

Figure 5-4. industry, and so on?
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Discussion

How would this answer
change if the parentheses
were dropped?
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After hours
— )

Front door open

A Burglar
alarm

After hours
— )

Vault door open

»—»—»—.—oooo::
—_—_0 O == O o

—_ O~ O~ O ~OolL
—_——0 O O O O

Figure 5-4 Solution to Example 5-1.

EXAMPLE 5-2

Using common reasoning, reduce the logic function described in Example
5-1 to a simpler form.

Solution: The alarm is activated if it is after banking hours and if either the
front door is opened or the vault door is opened (see Figure 5-5). The sim-
plified equation is written as

A=H(F +YV) (Notice the use of parentheses.)

After hours H A Burglar
alarm
F
Vault door open

Vv

Figure 5-5 Solution to Example 5-2.

EXAMPLE 5-3

Write the Boolean equation for the logic circuit shown in Figure 5-6.
A —
B —_—
C —_
D —_—
: )

Figure 5-6 Combinational logic circuit for Example 5-3.

Solution: X = (AB + CD)E
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EXAMPLE 5-4

Figure 5-7 shows a gray water reclamation tank having five inputs and
three outputs. The inputs are used to monitor HIGH/LOW levels on the
quantities shown, and the outputs are used to illuminate the color lights in
the Process Monitoring Station. The system is designed to capture gray
water before it goes into a septic system. Gray water is the water drained in
the bathroom sink or shower and water drained in a washing machine. This
recycled water can then be used in the toilet or for landscape irrigation. In
this example, logic gates are connected to the figure to turn on the blue
light (B) if the water is at the mid level (M) and there is a HIGH pressure
(P) or if the water is at the mid level (M) and there is a HIGH opacity (c).
(Opacity is a measure of water clarity.)

(a) Reduce that Boolean equation to a simpler form.

(b) Write the Boolean equation for the new logic that would turn on the red
light (R) if the PH level (H) or the Opacity (C) or the Pressure (P) are
HIGH while the water is at the mid level (M). (The word while indicates
an AND function).

(c) Write the Boolean equation for the new logic that would turn on the
green light (G) if the PH level (H) or the Pressure (P) are HIGH while
the water is at the mid level (M) or the full level (F).

(d) Write the Boolean equation for the new logic that would turn on the
blue light (B) if the Opacity (C) and the pressure (P) are HIGH while
the water is at the mid level (M) or the full level (F).

Water Reclamation Tank g:@,/ Full level (F)

“““““““““““““““““““ E !,/—o— Mid level (M)

Process Monitoring Station

j@m — o 0 0
PH level (H) Red (R) J J

Opacity (C) —g Green (G)

Pressure (P) Blue (B) —o

Figure 5-7 Gray water reclamation tank with input sensors and a process monitoring
station.
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»' Helpful

Hint
The distributive law shown
for four variables is
sometimes called the FOIL
method (first, outside,
inside, last).
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AC +AD + BC + BD
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Solutions:

(a) B = M(P + C)
b)) R=H+ C+ PM

(©) G=(H+ P)M+ F)
(d B = CPM + F)

5-2 Boolean Algebra Laws and Rules

Boolean algebra uses many of the same laws as those of ordinary algebra. The OR
function (X = A + B) is Boolean addition, and the AND function (X = AB) is
Boolean multiplication. The following three laws are the same for Boolean algebra as
they are for ordinary algebra:

1. Commutative law of addition: A + B = B + A, and multiplication: AB = BA.
These laws mean that the order of ORing or ANDing does not matter.

2. Associative law of addition: A + (B + C) = (A + B) + C, and multipli-
cation: A(BC) = (AB)C. These laws mean that the grouping of several vari-
ables ORed or ANDed together does not matter.

3. Distributive law: AMB + C) = AB + AC, and (A + B)(C + D) =
AC + AD + BC + BD. These laws show methods for expanding an equa-
tion containing ORs and ANDs.

These three laws hold true for any number of variables. For example, the com-
mutative law can be applied to X = A + BC + D to form the equivalent equation
X=BC+A+D.

You may wonder when you will need to use one of the laws. Later in this chap-
ter, you will see that by using these laws to rearrange Boolean equations, you will be
able to change some combinational logic circuits to simpler equivalent circuits using
fewer gates. You can gain a better understanding of the application of these laws by

studying Figures 5-8 to 5-13.
A :j > Is B :j >
X=A+B equivalent X=B+A
to: A

Figure 5-8 Using the commutative law of addition to rearrange an OR gate.

=

L — Is
} X=ABC equivalent
to:

X=BCA

9

> O 9w

T
I

Figure 5-9 Using the commutative law of multiplication to rearrange an AND gate.

A A
B Is X=A+(B+C()
equivalent
to: B
c X=A+B)+C c

Figure 5-10 Using the associative law of addition to rearrange the grouping of OR gates.

a % >

A —] A——————]
equivalent
B —_—
X=(AB)C
c —} “wr €

Figure 5-11 Using the associative law of multiplication to rearrange the grouping of AND gates.
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A—m——— A AB
X=A(B+C) Is B

equivalent X=AB+AC

B to: — AC
C C—

Figure 5-12 Using the distributive law to form an equivalent circiut.

A —
Cc —
A A —]
: o L
}Xz (A+B)(C+D) equivalent
c to: B
=l e o—
B ——]
D —

Figure 5-13 Using the distributive law to form an equivalent circiut (FOIL method).

In addition to the three basic laws, several rules concern Boolean algebra. The
rules of Boolean algebra allow us to combine or eliminate certain variables in the equa-

tion to form simpler equivalent circuits.

The following example illustrates the use of the first Boolean rule, which states

that anything ANDed with a 0 will always output a 0.

EXAMPLE 5-5

A bank burglar alarm (B) will activate if it is after banking hours (A) and
someone opens the front door (D). The logic level of the variable A is 1
after banking hours and O during banking hours. Also, the logic level of the
variable D is 1 if the door sensing switch is opened and O if the door sens-
ing switch is closed. The Boolean equation is, therefore, B = AD. The
logic circuit to implement this function is shown in Figure 5-14(a).

After hours A — B=AD Burglar A — B=A-0=0
Door open D — alarm 0 — )

Burglar
alarm

(a) (b)

Figure 5-14 (a) Logic circuit for a simple burglar alarm: (b) disabling the
burglar alarm by making D = 0.

Later, a burglar comes along and puts tape on the door sensing switch,
holding it closed so that it always puts out a 0 logic level. Now the Boolean
equation (B = AD) becomes B = A - 0 because the door sensing switch is
always 0. The alarm will never sound in this condition because one input to
the AND gate is always 0. The burglar must have studied the Boolean rules
and realized that anything ANDed with a 0 will output a 0, as shown in
Figure 5-14(b).

Example 5-5 helped illustrate the reasoning for Boolean Rule 1. The other nine

rules can be derived using common sense and knowing basic gate operation.

Rule 1: Anything ANDed with a 0 is equal to 0 (A - 0 = 0).
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Rule 2: Anything ANDed with a 1 is equal to itself (A - 1 = A). From Figure 5-15,
we can see that, with one input tied to a 1, if the A input is 0, the X output is 0; if A is
I, X is 1. Therefore, X is equal to whatever the logic level of A is (X = A).

A

Al [ X
| }X:/\-I:A (1) } ?}XequulsA

Figure 5-15 Logic circuit and truth table illustrating Rule 2.

Rule 3:  Anything ORed with a 0 is equal to itself (A + 0 = A). In Figure 5-16, be-
cause one input is always 0, if A = 1, X = I, and if A = 0,X = 0. Therefore, X is
equal to whatever the logic level of A is (X = A).

A
X=A+0=A
0

Figure 5-16 Logic circuit and truth table illustrating Rule 3.

0]l X
01l0
011

— ol|x

} X equals A

Rule 4: Anything ORed with a 1 isequalto 1 (A + 1 = 1). In Figure 5-17, because
one input to the OR gate is always 1, the output is always 1, no matter what A is
X =1.

| All | X
’ _ _ 011
") D —xean=s o1

Figure 5-17 Logic circuit and truth table illustrating Rule 4.

} X equals 1

Rule 5: Anything ANDed with itself is equal to itself (A - A = A). In Figure 5-18,
because both inputs to the AND gate are A, if A = 1,1 and 1 equals 1, andif A = 0,0
and 0 equals 0. Therefore, X is equal to whatever the logic level of A is (X = A).

A

AlA|lX
A 01010
A } X=A-A=A R }XequalsA

Figure 5-18 Logic circuit and truth table illustrating Rule 5.

Rule 6: Anything ORed with itself is equal to itself (A + A = A). In Figure 5-19,
because both inputs to the OR gate are A, if A = 1,1 or 1 equals 1, and if A = 0,0 or
0 equals 0. Therefore, X is equal to whatever the logic level of A is (X = A).

. AlA] X

/ olollo
X=A+A=A :

A :E>7 o Lirit }XequalgA

Figure 5-19 Logic circuit and truth table illustrating Rule 6.

Rule 7: Anything ANDed with its own complement equals 0. In Figure 5-20, be-
cause the inputs are complements of each other, one of them is always 0. With a zero
at the input, the output is always 0 (X = 0).
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AlA |l X

. olt1|[o
- X=A-A=
. } o sl }Xequdls()

Figure 5-20 Logic circuit and truth table illustrating Rule 7.

Rule 8: Anything ORed with its own complement equals 1. In Figure 5-21, because
the inputs are complements of each other, one of them is always 1. With a 1 at the in-
put, the output is always 1 (X = 1).

| AlA]l X
- A= 0Of1]1
K:E>7X_A+A_l 1o 1}Xequa]sl

Figure 5-21 Logic circuit and truth table illustrating Rule 8.

Rule 9: A variable that is complemented twice will return to its original logic level.
As shown in Figure 5-22, when a variable is complemented once, it changes to the
opposite logic level. When it is complemented a second time, it changes back to its
original logic level (A = A).

A
0
1

- olx
S =l
=1

p —>oA{>0— x-ii-a

Figure 5-22 Logic circuit and truth table illustrating Rule 9.

} X equals A

Rule10: A + AB =A + BandA + AB = A + B. This rule differs from the others
because it involves two variables. It is useful because, when an equation is in this form,
one or more variables in the second term can be eliminated. The validity of these two
equations is proven in Table 5—1. In each case, equivalence is demonstrated by showing
that the truth table derived from the expression on the left side of the equation matches
that on the right side.

TABLE 5-1 | Using Truth Tables to Prove the Equations in Rule 10

A B A + AB A+ B A B A + AB A+ B
0 0 0 0 0 0 1 1
0 1 1 1 0 1 1 1
1 0 1 1 1 0 0 0
1 1 1 1 1 1 1 1
1 1 1 !

Equivalent outputs Equivalent outputs

Table 5-2 summarizes the laws and rules that relate to Boolean algebra. By
using them, we can reduce complicated combinational logic circuits to their sim-
plest form, as shown in the next sections. The letters used in Table 5-2 are variables
and were chosen arbitrarily. For example, C + CD = C + D is also a valid use of
Rule 10(a).
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TABLE 5-2 | Boolean Laws and Rules for the
Reduction of Combinational
Logic Circuits

Laws

1 A+B=B+A
AB = BA

2 A+B+C)=A@+B) +C
A(BC) = (AB) C

3 AB + C) = AB + AC
(A + B)(C + D)=AC + AD + BC + BD

Rules

1 A-0=0

2 A-1=A

3 A+0=A4

4 A+1=1

5 A-A=A

6 A+A=A

7 A-A=0

8 A+A=1

9 A=A

10 () A+ AB=A + B
(b) A+ AB=A+ B

Review Questions

5-1. How many gates are required to implement the following Boolean
equations?

(@ X=@A+ BC

(b) Y=AC + BC

(¢) Z= (ABC + CD)E
5-2. Which Boolean law is used to transform each of the following
equations?

(@ B+D+E)=B+D)+E

(b) CAB = BCA

(¢c) B+ CA+D)=BA+BD+ CA+ CD
5-3. The output of an AND gate with one of its inputs connected to 1

will always output a level equal to the level at the other input. True or
false?

5-4. The output of an OR gate with one of its inputs connected to 1 will
always output a level equal to the level at the other input. True or false?

5-5. If one input to an OR gate is connected to 0, the output will always be
0 regardless of the level on the other input. True or false?

5-6. Use one of the forms of Rule 10 to transform each of the following
equations:

(a) B+ AB =2
(b) B+ BC =2
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5-3  Simplification of Combinational Logic Circuits

Using Boolean Algebra

Often in the design and development of digital systems, a designer will start with sim-
ple logic gate requirements but add more and more complex gating, making the final
design a complex combination of several gates, with some having the same inputs. At
that point, the designer must step back and review the combinational logic circuit that
has been developed and see if there are ways of reducing the number of gates without
changing the function of the circuit. If an equivalent circuit can be formed with fewer
gates or fewer inputs, the cost of the circuit is reduced and its reliability is improved.
This process is called the reduction or simplification of combinational logic circuits
and is performed by using the laws and rules of Boolean algebra presented in the pre-
ceding section.

The following examples illustrate the use of Boolean algebra and present some
techniques for the simplification of logic circuits.

EXAMPLE 5-6

The logic circuit shown in Figure 5-23 is used to turn on a warning buzzer
at X based on the input conditions at A, B, and C. A simplified equivalent
circuit that will perform the same function can be formed by using Boolean
algebra. Write the equation of the circuit in Figure 5-23, simplify the equa-
tion, and draw the logic circuit of the simplified equation.

B A
B B(A+C)
A A+0O)
c -
X Warning
C buzzer

Figure 5-23 Logic circuit for Example 5-6.

Solution: The Boolean equation for X is

X=BA+C(C +C
To simplify, first apply Law 3 [B(A + C) = BA + BC]:

X=BA+ BC+ C
Next, factor a C from terms 2 and 3:

X=BA+ CB+ 1)
Apply Rule4 (B + 1 = 1):

X=BA+C-1
Apply Rule 2 (C -1 = C):
X=BA+ C
Apply Law 1 (BA = AB):
X =AB + C <« simplified equation

SECTION 5-3 | SIMPLIFICATION OF COMBINATIONAL LOGIC CIRCUITS USING BOOLEAN ALGEBRA
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shown here.
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The logic circuit of the simplified equation is shown in Figure 5-24.

A —_
B _

Warning
C buzzer

X=AB+C

Figure 5-24 Simplified logic circuit for Example 5-6.

EXAMPLE 5-7

Repeat Example 5-6 for the logic circuit shown in Figure 5-25.

A—rt A+B
B_

Ol
-

Figure 5-25 Logic circuit for Example 5-7.

Solution: The Boolean equation for X is
» Common
Misconception X=A+BBC+A

Without the parentheses in To simplify, first apply Law 3 [(A + B)BC = ABC + BBCI:
the first equation, the logic
X=ABC+ BBC + A
Apply Rule 5 (B - B = B):
X=ABC+ BC+ A

(A+B)BC

is invalid.

Factor a BC from terms 1 and 2:
X=BCA+1)+A
Apply Rule4 (A + 1 = 1):
X=BC-1+A
Apply Rule 2 (BC - 1 = BO):
X =BC + A < simplified equation

The logic circuit for the simplified equation is shown in Figure 5-26.

B_
C_

X=BC+A

A

Figure 5-26 Simplified logic circuit for Example 5-7.
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EXAMPLE 5-8

Repeat Example 5-6 for the logic circuit shown in Figure 5-27(a).

[ x

>c B
[\ BC
_J
(@)

Figure 5-27 Logic circuit for Example 5-8: (a) Original circuit and
(b) Simplified circuit.

Solution: The Boolean equation for X is
X=( + BB+ B+ BC
To simplify, first apply Law 3 [(A + B)B = AB + BB]:
X =AB + BB + B + BC
Apply Rule 7 (BB = 0):
X=AB+0+ B+ BC
Apply Rule 3 (AB + 0 = AB):
X =AB + B + BC
Factor a B from terms 1 and 2:
X =BA+ 1)+ BC
Apply Rule4 (A + 1 = 1):
X=B-1+BC
Apply Rule 2 (B - 1 = B):
X =B+ BC
Apply Rule 10(b) (B + BC = B + C):
X =B+ C < simplified equation

The logic circuit of the simplified equation is shown in Figure 5-27(b).

The logic level at A
has no effect on the

output.
A Not used
B _
{>C D— X=B+C
C
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EXAMPLE 5-9

Repeat Example 5-6 for the logic circuit shown in Figure 5-28(a).

A A+B
B——o _
[ (A+B)B+C)
C— B+C
)

(a)

Figure 5-28 Logic circuit for Example 5-9: (a) Original circuit and
(b) Simplified circuit.

Solution: The Boolean equation for X is
X=1[A+ BB+ 0B
To simplify, first apply Law 3:
X = (AB + AC + BB + BC)B
The BB term can be eliminated using Rule 7 and then Rule 3:
X = (AB + AC + BO)B
Apply Law 3 again:
X = ABB + ACB + BCB
Apply Law I:
X = ABB + ABC + BBC
Apply Rules 5 and 7:
X=AB+ ABC +0-C
Apply Rule I:
X = AB + ABC
Factor an AB from both terms:
X=AB(1 + O
Apply Rule 4 and then Rule 2:
X = AB <« simplified equation

The logic circuit of the simplified equation is shown in Figure 5-28(b).

A_
X=AB
B —

C

Not used
(b)
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LOGIC SIMPLIFICATION

The MultiSIM® Logic Converter is used in Figure 5-29 to simplify the cir-
cuit of Figure 5-28(a). The simplified equation that it determines for X is
AB as shown in the lower box of the Logic Converter.

MultiSIM exercise:

(a) Use MultiSIM to open the file fig5_29 from the textbook companion
website. Double-click on the Logic Converter symbol (XLC1) to expand
its size. To have MultiSIM simplify the circuit, press the first button
under Conversions to create a truth table. Press the second button to

Ager

AND2

c ] >—
XLl AND2
D ———— a3
Q Q9 © QO Q O Q @ Q
alslel T T 1T T Ty
Logic Converter-XLC1 il
o0 D00 00O
A B C D E F G H our %
ooo 0o o 0o o *|——  Conversions —
oo oo i
ooz o1 0 E
003 o1 = =+ 1o[z
oo4 1 0 0 g | |
0ns 1 0 1
oo | 1 1 D i el =+ 2B |
oo7 1 1 1 = =" a5 |
|P.|EF —+ 1-:||1|
= — I |
EE —+  HAND |
Iﬁ-B

@ﬁg5_29

Figure 5-29 Using MultiSIM® to simplify the combinational logic circuit of
Example 5-9.
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write the logic equation for that truth table, and then press the third
button to write the simplified equation. Notice that the simplified
equation shown in the lower box is AB just like we got for Example
5-9. (Note: For help on using the Logic Converter, highlight the sym-
bol by left-clicking once on it and pressing the F1 key to display its
Help Screen.)

(b) Build the logic circuit from Example 5-7 to see if MultiSIM comes
up with the same simplified equation as the textbook did. The circuit
is drawn by first selecting File > New, then right-clicking in the
empty workspace and selecting Place Component. Type the name
of the gate (AND2, OR2, etc.) and left-click where you want to place it.
Next, hook up the Logic Converter as shown to supply the inputs A,
B, and C and monitor the resulting output at X. Double-click on the
Logic Converter and sequentially press the three Conversions but-
tons [as we did in part (a)] and see if the simplified equation is
BC + A.

(c) Repeat for Example 5-8.

(d) An alternate method of simplifying Boolean equations is to enter the
equation to be simplified in the lower box of the Logic Converter in-
stead of drawing the logic circuit. Next you will press the fourth
Conversions button to form a truth table from the equation and then
press the third Conversions button to convert that truth table to the sim-
plified equation.

Test this method by simplifying the equation presented in Example 5—6
[X = B(A + C) + Cshould reduceto X = AB + C].

5-4  Using Quartus® II to Determine
Simplified Equations

Part of the compilation process performed by the Quartus® II software is to determine
the simplest form of the circuit before it synthesizes its logic. This eliminates unnec-
essary inputs and minimizes the number of gates used in the FPGA. If we redo
Example 5-9 using Quartus® II, the software will warn us of unused inputs and will
also give us the final simplified equation. The VHDL program, ex5_9.vhd, is given in
Figure 5-30(a). The original Boolean equation X = [(A + B)(B + C)]B is entered in
VHDL as x < = ((a OR NOT b) AND (b OR ¢)) AND b;. The Waveform Editor was
used to create the vector waveform file (ex5_9.vwf) shown in Figure 5-30(b). If you
study the results carefully you will see that x only goes HIGH when a and b are both
HIGH, regardless of c.

When the ex5_9.vhd program was compiled, the Compilation Report produced
the warning message shown in Figure 5-31. As you can see, it tells us that after sim-
plifying the equation, there is no output that is dependent on pin c. This is the same re-
sult that we got in the reduction performed in Example 5-9.

Note: To view the Compilation Report of Figure 5-31:
Choose Processing > Compilation Report.
Then to view the Analysis & Synthesis Messages:

In the left column of the report, expand the Analysis & Synthesis folder by clicking
on its “+” sign, then choose Messages.
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LIBRARY ieee; ——UHDL Solution to Ex 5-9
USE ieee.std logic 1164.40LL;

)

ENTITY ex5 9 I35

PORT(
a,b,c : IN std logic;
b : 0UT std_logic);
EHD ex5 O3

ARCHITECTURE arc OF ex5 9 IS _
T X=[(A+B)(B+C)|B

BEGIHN
¥<=((a OR HOT b) AND (b OR c))AHD IJ;<J
EHD arc;
W) ex5_9.vhd bl
[Line 2 [Col 1  [INS ¢ | @ 3

(a)

£+ en5_9 Simulation Report ::: ) ] [

Simulation Waveforms

b agter Time Bar: 0 ps j_'l Fainter: | 0pz Interval; | 0pz Start; | End: |

s [valie. | 40us 80us 120 us 16004
ame Ops | P
f
> a HO
= b | HO
| = 3 HO
hed * ED

ex5_9.vwf

X is HIGH for a AND b,
regardless of c.

(b)

Figure 5-30 Quartus® 11 solution to Example 5-9: (a) VHDL listing; (b) simulation file.

The Quartus® II software also provides us with the simplified equation that it will use
to synthesize the circuit. To view the equation:

Choose: Tools > Chip Planner > Edit > Find > Find What: x >
Find Next > Cancel.

In the Fan-In column click [ < GoTo].
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oty RSP Analysis & Synthesis Messages
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&SR Flow Settings i Info: Punning Quartus IT Analysis & Synthesia
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(JEE Flow Elapsed Time i Info: Found 2 desion units, including 1 entities, in source file
&R Flow OF Summary iy Info: Elahorating entity "ex5 97 for the top level hierarchy
-&HB FlowLog B Warning: Desion contains 1 input pinis) that do not drive logici
-3 Analysis & Syrithe e By Warning (15610): Mo output dependent on input pin "o
@E SUmmary ‘y Info: Implemented 5 dewice resources after synthesis - the final
i+l ¢&h_] Settings iy Info: Quartus II Analysis & Synthesis was successful. 0 srrors,
- ¢=HEE8 Parallel Comp
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Figure 5-31 The warning message produced by the Compilation Report describes the
c-input as not necessary.

The simplified equation appears in the equations box shown in Figure 5-32. (If
there is no Equations box, be sure that the Equations selection under the View menu
has a check mark.) The equation is listed as: A1L5(x~0) = (b&a). This states that
the x-output is mapped into FPGA location A1LS and its value is b&a. This can be
interpreted as x = ab, which matches the reduction we performed using algebra in
Example 5-9. The arithmetic operators used by Quartus® II for Boolean equations
are as follows:

& AND operator

! NOT operator

# OR operator

$ Exclusive-OR operator (covered in Chapter 6)

| Fardn[2/2) | <GoTo | || Equations [1/1] GaTo> |Fan-Out[1/1)
5 5 () « A1LE [v70) = = A=
b (b) (b al }"=ab

-
4 F

Figure 5-32 The Equations window in the Chip Planner shows the reduced equation x = ab.

A more visual method to see the reduced equation is to use the Netlist Viewer:
Choose Tools > Netlist Viewers > Technology Map Viewer — Post Mapping.

Double-click on the block diagram and the reduced circuit will appear with the inputs
and outputs as shown in Figure 5-33. The logic diagram shows x = ab with c being a
“don’t care”
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-2 Technology Map Yiewer - Post-Mapping | = |EI|5I
@ Higrarchy i Fage Title: I Post-Mapping: Display ~ Page: I 1af1 vl
Ba= Hierarchy List
@ |[=Dess =l
@ o :D: P.rimitives ]
: [+-= Pins

#h o 2 > Y .
e o — I_-—-"'I T
c--\L x=ab

ﬁ ? ¢ ="don't care"

W = -

Hierarchy List E il M

Figure 5-33 The Netlist Viewer showing the reduced logic circuit for x = ab.

EXAMPLE 5-10

Use the Quartus®j1 software to determine the simplified equation for
X = (ABC + B)BC.

Solution: In this example we’ll use the Block Editor method of design in-
stead of VHDL. The logic circuit is drawn to produce the ex5_10.bdf file
shown in Figure 5-34. When the project is compiled, the compiler creates
the warning message shown in Figure 5-35. The message states that the
output of the logic circuit does not depend on input-a (this makes a an un-
used input). The Chip Planner is then used to see the final simplified equa-
tion determined by the Fitter, as shown in Figure 5-36. The simplified
equation is x = (!c & b), which is the same as x = bc. Prove to yourself
that this is correct by reducing the original equation using Boolean algebra.
The Netlist Viewer in Figure 5-37 shows the reduced circuit for x = bc
with a = “don’t care.”

& ex5_10.bdf

Figure 5-34 The bdf file for X = (ABC + B)BC.
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Figure 5-35 The compilation warning stating that input-a is unused.

| Fanin(2/2) | <GoTo | || Equations [1/1] GoTo> |Fan-Out(1/1)
b [b] @ A1L1 (27T) = a| i
= o) lc&b) «+ —— x=hc

w
4 2

Figure 5-36 The equations window in the Chip Planner shows the simplified equation x = bc.

‘= Technology Map Yiewer - Post-Mapping - 10| x|
- Hierarchy ——— - x Page Title: I Post-tdapping: Dizpl  Page: I 1af j
o — F 1
] ta= Hierarchy Lisk
@ |[sBssis =
= I Primitives
E | 5
@ ;. [#-=* Pins
= [T Mets b —
- N, -
a[ ==
= -
% B Hierarchy List A F | 4| | H 2

Figure 5-37 Using the Netlist Viewer to see the reduced circuit for x = bc with a = “don’t care.”
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5-5 De Morgan’s Theorem

You may have noticed that we did not use NANDs or NORs in any of the logic circuits
in Section 5-3. To simplify circuits containing NANDs and NORs, we need to use a
theorem developed by the mathematician Augustus De Morgan. This theorem allows
us to convert an expression having an inversion bar over two or more variables into an
expression having inversion bars over single variables only. This allows us to use the
rules presented in the preceding section for the simplification of the equation.
In the form of an equation, De Morgan’s theorem is stated as follows:
A-B=A+8B
A+B=A-B
Also, for three or more variables,
A-B-C=A+B+C
A+B+C=A-B-C

Basically, to use the theorem, you break the bar over the variables and either change
the AND to an OR or change the OR to an AND.

To prove to ourselves that this works, let’s apply the theorem to a NAND gate
and then compare the truth table of the equivalent circuit to that of the original NAND
gate. As you can see in Figure 5-38, to use De Morgan’s theorem on a NAND gate,
first break the bar over the A - B, then change the AND symbol to an OR. The new
equation becomes X = A + B. Notice that inversion bubbles are used on the OR gate
instead of inverters. By observing the truth tables of the two equations, we can see that
the result in the X column is the same for both, which proves that they provide an
equivalent output result.

A — A -
X=A-B X=A+B
B — B

A | B | X=AB A | B | X=A+B

0| o0 1 0| o0 1

0 | 1 1 0| 1 1

1| o 1 1] o 1

1 1 0 1 1 0
\Equivalent

result

Figure 5-38 De Morgan’s theorem applied to NAND gate produces two identical truth tables.

Also, by looking at the two circuits, we can say that an AND gate with its output
inverted is equivalent to an OR gate with its inputs inverted. Therefore, the OR gate
with inverted inputs is sometimes used as an alternative symbol for a NAND gate.

By applying De Morgan’s theorem to a NOR gate, we will also produce two
identical truth tables, as shown in Figure 5-39(a). Therefore, we can also think of an
OR gate with its output inverted as being equivalent to an AND gate with its inputs in-
verted. The inverted input AND gate symbol is also sometimes used as an alternative
to the NOR gate symbol.
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A_
B_

C —]

D —

Original circuit

A | B | X=A+B A | B A-B
0 0 1 0 0 1
0 1 0 0 1 0
1 0 0 1 0 0
1 1 0 1 1 0
\ Equivalent /
result
(a)
NOR

A —] equivalent A —

Do -

X = } X = X =ABCD
Dy it

D — \/ D —|

Inversion Final equivalent circuit

bubbles
cancel

(b)

0

444

Inverter :

NAND__

1 -

(©)

Figure 5-39 (a) De Morgan’s theorem applied to NOR gate produces two identical truth tables; (b) using the alternative
NOR symbol eases circuit simplification; (c) summary of alternative gate symbols.
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When you write the equation for an AND gate with its inputs inverted, be care-
ful to keep the inversion bar over each individual variable (not both) because A - B is
not equal to A - B. (Prove that to yourself by building a truth table for both.) Also,
A + Bisnotequalto A + B.

The question always arises: Why would a designer ever use an inverted-input OR
gate symbol instead of a NAND? Or why use an inverted-input AND gate symbol in-
stead of a NOR? In complex logic diagrams, you will see both the inverted-input and
the inverted-output symbols being used. The designer will use whichever symbol makes
more sense for the particular application.

For example, referring to Figure 5-38, let’s say you need a HIGH output level
whenever either A or B is LOW. It makes sense to think of that function as an OR
gate with inverted A and B inputs, but you could save two inverters by just using a
NAND gate.
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Also, referring to Figure 5-39(a), let’s say you need a HIGH output whenever
both A and B are LOW. You would probably use the inverted-input AND gate for your
logic diagram because it makes sense logically, but you would use a NOR gate to ac-
tually implement the circuit because you could eliminate the inverters.

The alternative methods of drawing NANDs and NORs are also useful for the
simplification of logic circuits. Take, for example, the circuit of Figure 5-39(b). By
changing the NOR gate to an inverted-input AND gate, the inversion bubbles cancel,
and the equation becomes simply X = ABCD. Figure 5-39(c) summarizes the alterna-
tive representations for the inverter, NAND, and NOR gates.

The following examples illustrate the application of De Morgan’s theorem for
the simplification of logic circuits.

EXAMPLE 5-11

Use Quartus® II to prove the validity of the De Morgan’s theorem circuits
of Figures 5-38 and 5-39. Draw the circuits using the Block Editor and
prove equivalence by performing a simulation with all possible input
conditions.

Solution: The NAND and NOR circuits of Figures 5-38 and 5-39 are
duplicated in the bdf file shown in Figure 5-40. W is the output of a NAND
while X is the output of an inverted-input OR gate that is supposed to be
equivalent. Y is the output of a NOR while Z is the output of an inverted-
input AND gate that is supposed to be equivalent.

fexs_11.bdf

Kl =

Figure 5-40 The bdf file of circuits used to prove De Morgan’s theorem.

The vector waveform file in Figure 5—41 shows every combination of input
for A, B and C, D. By studying the resultant waveforms you can see that the
output at Wis identical to X and the output at Y is identical to Z, proving De
Morgan’s theorem.
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€ ex5_11 Simulation Report % =101 x|
taster Time Bar: Ops J_PI Painter: | Ops Interval: | Ops Start: | End: |
o | velieat | B 4.0 us 8.0us 120 us 16.0 ug
0ps P
i]
e o) B0 M L L L L e LT
|  b| BO BEER [
| [w| BT L L] L i
o] L] e L] | | il
o  c| so WLl L LT LT
| d| BO BEER [
| (v| BT |1 1 M1 1
| *{ 2| B1 (1 . M1 1
ﬁ ex5_11.vwf
.

*Equivalent outputs

Figure 5-41 The waveform simulation demonstrating equivalent outputs.

EXAMPLE 5-12

Write the Boolean equation for the circuit shown in Figure 5-42. Use De
Morgan’s theorem and then Boolean algebra rules to simplify the equation.
Draw the simplified circuit.

~ ‘l -
Helpful
Hint
You must use parentheses } X

to maintain proper

grouping whenever you Figure 5-42
break the bar over a

NAND or if an OR gate is

input to an AND gate. Solution: The Boolean equation at X is

X =AB-B

S

>}

Applying De Morgan’s theorem produces
X=@A+B)-B

(Notice the use of parentheses to maintain proper grouping. Rule: Whenever
you break the bar over a NAND you must use parentheses.) Using Boolean
algebra rules produces

X = AB + BB
=AB+ 0
= AB < simplified equation

The simplified circuit is shown in Figure 5-43.
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Bubble = inverter.
A /
A —CO _
_ OR X=AB
B X=AB B —

Figure 5-43 Simplified logic circuit for Example 5-12.

EXAMPLE 5-13

Repeat Example 5-12 for the circuit shown in Figure 5-44.

—
] )
e

Figure 5-44

Solution: The Boolean equation at X is
X=AB-B+C
Applying De Morgan’s theorem produces
X=@A+B)-BC

(Notice the use of parentheses to maintain proper grouping.) Using
Boolean algebra rules produces

= BC <« simplified equation

The simplified circuit is shown in Figure 5-45.

A Not used

C4|>oj}

Figure 5-45 Simplified logic circuit for Example 5-13.

Also remember from Figure 5-39(a) that an AND gate with inverted
inputs is equivalent to a NOR gate. Therefore, an equivalent solution to
Example 5-13 would be a NOR gate with B and C as inputs, as shown in
Figure 5-46.
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Perform De Morgan's

theorem backward to
/ convert to a NOR.
Is
B —( o . B _
X=B-C equivalent X=B+C=B-C
c —=0O to: C

Figure 5-46 Equivalent solution to Example 5-13.

EXAMPLE 5-14

Repeat Example 5-12 for the circuit shown in Figure 5-47.

A—T 7\ 4B
=0 e
BaN

C
D

Figure 5-47

Solution:

X=(AB-C+ D)AB

AB-C+ D + AB

AB + C+ D + AB
+B+C+D+A+B

=A+ B+ C+ D < simplified equation

I
o

The simplified circuit is shown in Figure 5-48.

>

D

Figure 5-48 Simplified logic circuit for Example 5-14.

EXAMPLE 5-15
Use De Morgan’s theorem and Boolean algebra on the circuit shown in

Figure 5-49 to develop an equivalent circuit that has inversion bars cover-
ing only single variables.
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Figure 5-49

Y

)

Solution: The Boolean equation at X is

X=AB-(B + O

Applying De Morgan’s theorem produces
X=A+B- -B+0O

(Notice the use of parentheses to maintain proper grouping.) Using Boolean

algebra rules produces

X =AB + AC +

= AB + AC + BC < final equation (sum-of-products form)

BB + BC

The equivalent circuit is shown in Figure 5-50.

A—o—

o

AB

>ZC3 >

C

BC

Figure 5-50 Logic circuit equivalent for Example 5-15.

Notice that the final equation actually produces a circuit that is more complicated
than the original. In fact, if a technician were to build a circuit, he or she would choose
the original because it is simpler and has fewer gates. However, the final equation is in
a form called the sum-of-products (SOP) form. This form of the equation was
achieved by using Boolean algebra and is very useful for building truth tables and
Karnaugh maps, which are covered in Section 5-8.

EXAMPLE 5-16

Using De Morgan’s theorem and Boolean algebra, prove that the two cir-

cuits shown in Figure 5-51 are equivalent.

T
1>
Figure 5-51

e
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Team
Discussion

The final circuit in this
example is actually more
complicated than the
original. As you will see
later, it is in the form for
implementation using
AND-OR-INVERT gates
and programmable logic
devices. Besides, it is much
easier to fill in a truth
table from a sum of
products (SOP). Build a
truth table from the
original equation and then
from the final SOP to
prove the point.
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Solution: They can be proved to be equivalent if their simplified equations
match.

X, =AB-(A + B) X, =AB+ A+ B
—AB+ A+ B =AB + AB

— AB + AB < Tquvarent

EXAMPLE 5-17

Use Quartus® II to simplify the equations:

X=AB + (B + O)
Y=AB+ B+ C

Solution: The logic for X and Y can be entered using the Block Editor or
the VHDL Text Editor. VHDL entry was used in this example. Figure 5-52
shows the VHDL program with the equations for X and Y appearing in the
Architecture block.

fBexs a7vhd e [ ]
|B o |EE|4%%% |08 R@y | =|=2
1 - =
2 LIBRARY ieee; —=Uzing WHDL to Simplify Equations
3 U3E ieee.std logic 1164.4LL:
4
5 BEENTITY 'ex5 17 IS
& B FORT |
i a,b,o t IN std logic;
= ¥, ¥ : OUT =td logic): Note: Parentheses are
9 END -ex5 1%: used to ensure correct
10 order of operations.
11 BEARCHITECTURE arc OF ex5 17 IS
s | BEGIMN
13 %<=NOT{ (s AND B) OR (NOT b O cj):
ig ye={a HAND h) OR (b NOR o) [
15 END arc: @ |
16 X
a | exb_17.vhd [

Figure 5-52 VHDL program for Example 5-17.

After performing a save and compile, the simplified equation was
determined by using the Netlist Viewer technique that was presented
in Figure 5-33. The logic circuit shown in Figure 5-53 for x is:
x =a + b + ¢ which can be De Morganized to: x = abc. The logic
circuit shown for y is: y = a + b which can be reverse De Morganized to:
y = ab.
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Figure 5-53 The output of the Netlist Viewer shows the logic circuits used to write the simplified equations
for x and y.

EXAMPLE 5-18

Draw the logic circuit for the following equation, simplify the equation,
and construct a truth table for the simplified equation

X=A-B+A-(A+ 0O

Solution: To draw the circuit, we have to reverse our thinking from the
previous examples. When we study the equation, we see that we need two
NANDs feeding into an OR gate, as shown in Figure 5-54. Then we have
to provide the inputs to the NAND gates, as shown in Figure 5-55.

— O

)m

Figure 5-54 Partial solution to Example 5-18.

S

) O

_4 >:A-(71+C>
A+C

Figure 5-55 Logic circuit of the equation for Example 5-18.

C

SECTION 5-5 | DE MORGAN’S THEOREM 185



Next, we use De Morgan’s theorem and Boolean algebra to simplify the
equation:

X=A-B+A-(A+ 0O
—=A+B +A+A+ 0
=A+B+A+A-C
=A+A+AC + B
=A+AC+ B

Apply Rule 10:
X=A+ C+ B < simplified equation

This equation can be interpreted as: X is HIGH if A is LOW or C is
LOW or B is HIGH. Now, to construct a truth table (Table 5-3), we need
three input columns (A, B, C) and eight entries (2° = 8),and we fillin a 1
for XwhenA = 0,C = 0,orB = 1.

TABLE 5-3 | Truth Table for Example 5-18

X=A+C+B

[T o e e M o) h
—_—oO0oO~R—~0oO0O| W
—o—~,O0o~,Oo~O| N

[ o Y S WU

EXAMPLE 5-19
Repeat Example 5-18 for the following equation:
X=AB-A+C) +AB-A+B+C

Solution: The required logic circuit is shown in Figure 5-56. The Boolean
equation simplification is

X=AB-(A+C)+AB-A+B+C
=AB+A+C+AB-(A-B-C)
=@A+B)+A-C+ AABBC
=A+ B+ AC+ ABC
=A(l + C) + B + ABC
=A + B + ABC

=A + B(l + AC)

= A + B < simplified equation
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_

A+B+C

Figure 5-56 Logic circuit for the equation of Example 5-19.

TABLE 5-4 | Truth Table for Example 5-19

X=1ifA=0or

X=4+B< B~

A B C

0 0 0 1
0 0 1 1
0 1 0 1
0 1 1 1
1 0 0 0
1 0 1 0
1 1 0 1
1 1 1 1

Three columns are used in the truth table (Table 5-4) because the
original equation contained three variables (A, B, C). C is considered a
don’t care, however, because it does not appear in the final equation and it

does not matter whether it is 1 or O.

From the simplified equation (X = A + B), we can determine that
X = 1 when A is O or when B is 1, and we fill in the truth table accordingly.

EXAMPLE 5-20

Complete the truth table and timing diagram for the following simplified

Boolean equation:

X = AB + BC + ABC

Solution: The required truth table and timing diagram are shown in Figure
5-57. To fill in the truth table for X, we first put a 1 for X when A = 1,
B=1.Then X=1forB=1,C=0. Then X=1forA=0,B=0,
C = 1. All other entries for X are 0.

The timing diagram performs the same function as the truth table, ex-
cept it is a more graphic illustration of the HIGH and LOW logic levels of
X as the A, B, and C inputs change over time. The logic levels at X are filled

in the same way as they were for the truth table.
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151 12 13 1y ts te t7 tg

Answer
yEEE A
A B C X
oo o 0o
0|0 |1 1< ABC |B
0 1 0 1< BC
0 1 1 0
1 o |o 0 c
1o |1 0 -
1 1 0 1< AB, BC
I IR 1< AB Y .
et e
ABC BC AB, BC AB

Figure 5-57 Truth table and timing diagram depicting the logic levels at X for
all combinations of inputs.

EXAMPLE 5-21

Repeat Example 5-20 for the following simplified equation:
X =ABC + ABC + ABC

Solution: The required truth table and timing diagram are shown in Figure

5-58.
131 12 13 ty ts te 17 Ig
/Answer A
A B C X
0 0 0 0 o
0 0 1 1< ABC B
0 1 0 0
0 1 1 0 -
1 0 0 1< ABC C
1 0 1 0
1 1 0 0
1 1 1 1< ABC X

Figure 5-58 Truth table and timing diagram depicting the logic levels at X for
all combinations of inputs.

Bubble Pushing

A shortcut method of forming equivalent logic circuits, based on De Morgan’s theo-
rem, is called bubble pushing and is illustrated in Figure 5-59. As you can see, to
form the equivalent logic circuit, you must

1. Change the logic gate (AND to OR or OR to AND).

2. Add bubbles to the inputs and outputs where there were none, and remove
the original bubbles.

Prove to yourself that this method works by comparing the truth table of each
original circuit to its equivalent.

Notice in Figure 5-59 that we have equivalent logic circuits for the AND and OR
gates (V and W). It is worth pointing out here that you will be seeing these two equiv-
alents often when studying data memory ICs and microprocessor circuitry (Chapters
16 and 17).
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Figure 5-59 (a) Original logic circuits; (b) equivalent logic circuits.

Active-LOW Input/Output used in Microprocessor Systems

Figure 5-60 shows part of the gating circuitry that is often used to access microproces-
sor memory. Microprocessor control signals are usually active-LOW, meaning that
they issue a LOW when they want to perform their specified task. Also, for the micro-
processor to activate the block labeled Memory, the line labeled MA (memory access)
must be made LOW. (The overbars on the variables signify that they are active-LOW.)

The gating shown in Figure 5-60 will provide the LOW at MA if MEM is LOW
and either WR is LOW or RD is LOW. The control signals from the microprocessor
meet these conditions whenever the microprocessor is reading (RD) or writing (WR)
from memory (MEM). For example, if the microprocessor is to read from memory, it
will make the (RD) line go LOW to signify that it wants to read, and it will make the
(MEM) line go LOW to signify that it wants to read its information from memory.
With these two lines LOW, MA is LOW, which activates the block labeled Memory.
(When working with circuitry like this, it is better not to think of the bubbles as invert-
ers; instead, think of that line as a part of the circuit that requires a LOW to “do its
thing” or satisfy that input.)

The OR gate with three bubbles outputs a LOW if either input is LOW. This sym-
bol makes the logic easy to understand, but to actually implement the circuit, its equiv-
alent (the 7408 AND gate) would be used. Also, the AND gate with three bubbles
would actually be an OR gate (the 7432).

Microprocessor
control M
signals AND gate emory
— O— This line must go LOW
— MA to access Memory.
RD MA Y
- J
MEM Q
\%{—J
OR gate

Figure 5-60 Typical gating circuitry used for microprocessor memory access.

SECTION 5-5 | DE MORGAN’S THEOREM

.' Helpful

Hint
At this point, it is
enlightening to see a
schematic of an actual
microprocessor-based
system like that of a PC or
those in Appendix G. Try
to identify the active-LOW
signals and gates that can
be bubble-pushed.

» Common
Misconception

Students often want to
invert the signal labeled
MA because it enters a
bubble before the memory.
That is a dangerous habit.
It is better to interpret the
bubble as signifying that
the memory requires a
LOW to be accessed. Also,
the overbar on MA
specifies that that line goes
LOW when active.
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LOGIC SIMPLIFICATION

Figure 5-61 shows how the MultiSIM® Logic Converter can be used to
solve the simplification of the logic circuit presented in Example 5-12
(Figure 5-42). The simplified equation that it determines for X is A'B as
shown in the lower box of the Logic Converter. [Note: MultiSIM uses the
prime (') symbol to represent an inversion overbar, so AB is written A’B.]

MultiSIM exercise:

(a) Use MultiSIM to open the file fig5_61 from the textbook companion
website. Double-click on the Logic Converter symbol (XLC1) to expand
its size. To have MultiSIM simplify the circuit, press the first button
under Conversions to create a truth table. Press the second button to
write the logic equation for that truth table, and then press the third but-
ton to write the simplified equation. Notice that the simplified equation
shown in the lower box is A'B just as we got for Example 5-12.

Ul
T
B e
NAND2 u2
e
AND2
XLC1
D ——— a3
L e e O B At

Logic Converter-XLC1 ;E[
WS R S
A B C D EF G A Qu (%
poo oo 1] *| ——  Conversions —
oo oo 1
ooz 1 0 i]
ooz | 1 0 e S|
[Teiz = aB |
= s4'F ae |
AB

@ﬁg5_61

Figure 5-61 Using MultiSIM® to simplify the combinational logic circuit of
Example 5-12.
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(b) Build the logic circuit from Example 5-13 to see if MultiSIM comes
up with the same simplified equation as the textbook did. (The simpli-
fied equation for X should be B'C".)

(¢) Repeat for Example 5-14.
(d) Repeat for Example 5-15.

(e) An alternate method of simplifying Boolean equations is to enter the
equation to be simplified in the lower box of the Logic Converter in-
stead of drawing the logic circuit. Next you will press the fourth
Conversions button to form a truth table from the equation and then
press the third Conversions button to convert that truth table to the sim-
plified equation. [Note: When entering an equation that has an overbar
over more than one letter, parentheses must be used. For example, ABC
is written (A’'BC)’.]

Test this method by simplifying the equation presented in
Example 5-18 [X = (AB')" + (A(A" + C))' should reduce to
X=A"+C + B].
(f) Repeat for Example 5-19.

Review Questions

5-7. Why is De Morgan’s theorem important in the simplification of
Boolean equations?

5-8. Using De Morgan’s theorem, you can prove that a NOR gate is equiv-
alent to an (OR, AND) gate with inverted inputs.

5-9. Using the bubble-pushing technique, an AND gate with one of its in-
puts inverted is equivalent to a (NAND, NOR) gate with its
other input inverted.

5-10. Using bubble pushing to convert an inverted-input OR gate will
yield a(n) (AND, NAND) gate.

5-6  Entering a Truth Table in VHDL Using
a Vector Signal

Suppose we wanted to implement the logic for the truth table shown in Table 5-5. One
method would be to write the Boolean equation for X by listing each combination of
ABC that produces a HIGH at X, then simplify the equation and build the logic circuit.
We could also write the equation for X as a VHDL architecture statement, and let the
software synthesize it in an FPGA. However, in this section we will use techniques that
employ several new concepts important to VHDL programmers.

The first thing that we need to do is to define an internal signal to represent the
three inputs. This internal signal will group the three inputs together as a 3-bit vector.
Let’s call this new internal vector signal “input.” The following signal declare is placed
within the architecture body, just before the BEGIN statement:

SIGNAL input: STD_LOGIC_VECTOR(2 downto 0);

This vector signal named input is similar to an array with three elements called
input(2), input(1), and input(0). The specification (2 downto 0) defines three elements
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TABLE 5-5 | Truth Table to Be Entered Using a Vector
Data Type as an Internal Signal

Inputs Output
A B C X
0 0 0 1
0 0 1 0
0 1 0 1
0 1 1 0
1 0 0 1
1 0 1 1
1 1 0 1
1 1 1 0
input(2) input(1) input(0)

starting with element (2), then (1), then (0). To assign values to the three elements, the
following assignment statements are placed just after the BEGIN statement:

input(2)<= a; --Move «a to element 2 of the internal vector signal
input(1)<=b; --Move b to element 1 of the internal vector signal
input(0)<<= c; --Move c to element 0 of the internal vector signal

[Note: The text following the double hyphen (--) is treated as a comment by
VHDL. Comments are ignored by the VHDL compiler but are very useful for docu-
menting our programs so that when you look at the program listing three months from
now, you’ll have a little help remembering why you did something the way you did.]

The final step is to assign the desired outputs for X for each input combination.
We do this with the Selected Signal Assignment as follows:

WITH input SELECT

x<= ‘1 WHEN “000”, -- x equals 1 when input equals “000”
‘0’ WHEN “001”, -- x equals 0 when input equals “001”
‘1’ WHEN “010”, -- x equals 1 when input equals “010”
‘0’ WHEN “0117, -- x equals 0 when input equals “011”
‘1’ WHEN “100”, -- x equals 1 when input equals “100”
‘1’ WHEN “101”, -- x equals 1 when input equals “101”
‘1> WHEN “1107, -- x equals 1 when input equals “110”
‘0’ WHEN “1117, -- x equals 0 when input equals “111”
‘1> WHEN others;

The selected signal assignment is built to look just like the truth table entries. The
last assignment uses the term others. This is required because the std_logic type dec-
laration allows for many other bit states besides 1 and 0. [For example, a hyphen (-)
can be used to specify “don’t care” and a Z can be used to specify “High impedance (or
Float).” A complete list of the std_logic data types is in Appendix E.] The “others” as-
signment will never be made because we will be inputting 1°s and 0’s to a, b, and ¢ but
VHDL requires us to include it to cover all possibilities known to the language.

Also note that when making assignments, single quotes are used for making bit
assignments and double quotes are used for making vector assignments. The complete
VHDL program listing is shown in Figure 5-62.

An easy way to test the results of the program is to run a simulation and compare
the waveforms with the original truth table. This is done in Figure 5-63.
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E% fig5_sz.vhd =13

LIBRARY ieee; =00 -
USE ieee.std_logic_1164.aLL; -- Entering a Truth Table Using =
-- a Uector, a Signal and
ENTITY fig5 62 IS -- Selected Signal fAssignment
PORT, e e
Declare a,b,c : IH std logic;
SI?Ili)ﬁtL ® : OUT std logic);
before END fig5_62;
BEGIN

ARCHITECTURE arc OF fig5 62 IS .
= A vector with

Make SIGNAL input @ std_logic_vector({2 DOWNTOD @);<—5 . .
assignments BEGIN

after BEGIN input(2)<=a; --move a to element 2 of the internal vector signal
input{1)}<=b; --move b to element 1 of the internal vector signal
input{B8)<{=c; -—-move c to element 8 of the internal vector signal
WITH input SELECT Selected signal assignment

® €= "1" UHEHN 888", -- % equals 1 when input equals "@ag"
'8" WHEH 881", -- x equals B when input equals "861"
1" WHEN 818", -- % equals 1 when input equals "@1@8"
N()te:_Singlel *@° WHEHM 811", -- % equals 8 when input equals "@811"
q”‘)t?f‘;flb“s atnd *4" WYHEW "188", -- x equals 1 when input equals "1@@"
Ouf;gz:tgjsj "1' WHEH 181", -- % equals 1 when input equals "181"
'1' WHEHM 118", -- x equals 1 when input equals "118"
‘@' WHEH 141", -- x equals B when input equals "111"
1" WHEH o s ;
END 5
are @ fig5_62vhd %
[Line 26 [Cal 1  [TINS < _ _ >|—'
output level sent to X input (0) figh B
input (1)
input (2) e L a |
@ “— b
—
inst
(b)
Figure 5-62 Program for entering a truth table in VHDL using a vector, a signal, and the
selected signal assignment: (a) VHDL listing; (b) Block Symbol File (bsf).
£ Fig5_62 Simulation Repork - |EI|5|
Simulation Waveforms
M aster Time B ar: Ops ‘I’lPDintEIil 0 ps Intewal:| 0pz Start:| End:|
o [ veleat | P22 40 us 80 us 120us 16,00
ame Ops s
]
| c BD
=4 b BO |
=4 a B0
hed M B1
0 ON fics. 60.vwi

Figure 5-63 Waveform display used to check the simulation with the original truth table.
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EXAMPLE 5-22

Design a logic circuit that can be used to tell when a 3-bit binary number is within the range of 2
(010,) to 6 (110,) inclusive. Use the VHDL selected signal assignment method discussed previously.
Perform a simulation of your design by creating an vwf file that steps through the entire range of in-
put possibilities 000, to 111,.

Solution: The VHDL program is shown in Figure 5-64 and the waveform simulation is shown in
Figure 5-65.

ioix]

LIBRARY ieee; =000 e |

USE ieee.std_logic_1164.ALL; —— Using Vector, Signal and =
-- Selected Signal Assignment

EHTITY ex5_ 22 IS = -

PORT(
a,b,c : IH std _logic;
S : OUT std_logic);
EHD ex5_22;

ARCHITECTURE arc OF ex5 22 IS
SIGHAL input : std_logic_vector{2 DOWHTOD 8);
BEGIH
input{2)<{=a; ——move a to element 2 of the internal vector signal
input{1)<=b; --move b to element 1 of the internal vector signal
input{8)<=c; --move ¢ to element @ of the internal vector signal

Make X yy 1y input SELECT

HIGH for 4

2.3.4.5 ¥ <= '8' WHEN 888", —— x equals 8@ when input equals 888"

and 6 0" WHEH 861", -- % equals @ when input equals “@81"

*1' WHEN 818", -- % equals 1 when input equals "@18" s
'1' WHEH 811", -- x equals 1 when input equals "@11"
‘1" WHEHM 188", -- x equals 1 when input equals "188" - ]. w |
"1 WHEH 181", -- % equals 1 when input equals 181" P [
'1' WHEM "118", -- x equals 1 when input equals "11@" P
*@" WHEM 111", -- x equals 8 when input equals "111"
@' WHEH others; inst

PR ek @ ex5_22.vhd -

o TC 5 o [ (b)

(a)

Simulation Waveforms

Mazter Time Bar: 0 pz J_*l Painter: | 0 psz Interyal: | 0pz Start: | End: |

N Value at | 0o 40 us B.0us 12.0us 16.0 u4
ame | "o | s
1]
o cf Bo Wl L L T e L
[ e | T
B e P P
ked | BO

@ ex5_22.vwf

x is HIGH for 2, 3,4, 5 and 6

Figure 5-65 Waveform simulation of Example 5-22.

CHAPTER 5 | BOOLEAN ALGEBRA AND REDUCTION TECHNIQUES



EXAMPLE 5-23

A water reclamation plant needs to have a warning system to monitor its three water overflow hold-
ing tanks. Each tank has a HIGH/LOW level sensor. Design a system that activates a warning alarm
whenever two or more tank levels are HIGH.

Solution: The program listing is shown in Figure 5-66. The three tanks are grouped together as a
vector instead of having three different variable names. This simplifies the program because now we
don’t have to define an internal vector signal and assign three variables to the signal like we did in
Example 5-22.

The simulation in Figure 5-67 shows the alarm is HIGH whenever two or more tanks are HIGH.

E{‘f ex5 23.vhd ] 1= |E| ILI
LIBRARY ieee; 0 oo |
USE ieee.std logic 1164.0LL; -- YWater Tank Monitoring o

EMTITY ex5_ 23 IS

PORT(
tank : IN std_logic_vector(Z downto 8);
alarm T OUT std_logic);

EHD ex5_23;

ARCHITECTURE arc OF ex5_23 IS tank (2)

tank (1)

BEGIN e
WITH tank SELECT / ank (0)
SIaAN €= "D WREN P, Stoboionsisiioocoooosoocons

8" WHEN 881", -- alarm is HIGH for ==

@' YHEH 818", -- any combination of e

*1° WHEH "811", —- two or more tanks HIGH. — k]

B8 WHEHW "™88", ---—-—--—— —

1" WHEH "M81". Dot tankc[2.0]  alarm

1" WHEH 118",
1" WHEH "111",
'8" UHEN others;

EHD arc; @ x5 23.vhd et

[Line 22 [Col 1  TINSI4| | ] (b)

(2)
Figure 5-66 Solution to Example 5-23: (a) VHDL listing; (b) Block Symbol File (bsf).

& a5 23 Simulation Report jfl: ; o ] [

Simulation Waveforms
M aster Time Bar: Ops 1| | Painter: Ops Interval: | 0ps Start: | End: |

pe 40us B0 us 12.0us 16.0 ug
'\\.l' | t 1 1 I
M ame anussa b
]
m tank(2] | B0
| tank[l] | BO [ I | I
d tank[0] | EO
E alarm BO
@ ex5_23.ywf
e

L alarm goes HIGH for 2 or more HIGH tanks

Figure 5-67 Simulation file for Example 5-23.
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5-7  The Universal Capability of NAND
and NOR Gates

NAND and NOR gates are sometimes referred to as universal gates because, by uti-
lizing a combination of NANDs, all the other logic gates (inverter, AND, OR, NOR)
can be formed. Also, by utilizing a combination of NORs, all the other logic gates (in-
verter, AND, OR, NAND) can be formed.

This principle is useful because you often may have extra NANDs available but
actually need some other logic function. For example, let’s say that you designed a cir-
cuit that required a NAND, an AND, and an inverter. You would probably purchase a
7400 quad NAND TTL IC. This chip has four NANDs in a single package. One of the
NANDs will be used directly in your circuit. The AND requirement could actually
be fulfilled by connecting the third and fourth NANDs on the chip to form an AND.
The inverter can be formed from the second NAND on the chip. How do we convert a
NAND into an inverter and two NANDs into an AND? Let’s see.

An inverter can be formed from a NAND simply by connecting both NAND in-
puts, as shown in Figure 5-68. Both inputs to the NAND are, therefore, connected to
A. The equation at X is X = A - A = A, which is the inverter function.

Connect both inputs to A
to form an Inverter.

A L
:>o—x X=A*A=A (Inverier)

Figure 5-68 Forming an inverter from a NAND.

The next task is to form an AND from two NANDs. Do you have any ideas?
What is the difference between a NAND and an AND? If we invert the output of a
NAND, it will act like an AND, as shown in Figure 5-69.

A—r -
5 Do—#::)o— X=AeB=AB(AND)

NAND Inverter

. J

AND

Figure 5-69 Forming an AND from two NANDs.

Now back to the original problem; we wanted to form a circuit requiring a
NAND, an AND, and an inverter using a single 7400 quad NAND TTL IC. Let’s make
the external connections to the 7400 IC to form the circuit of Figure 5-70, which con-
tains a NAND, an AND, and an inverter.

—cen DS
: Do

Figure 5-70 Logic circuit to be implemented using only NANDs.
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First, let’s redraw the logic circuit using only NANDs. Now, using the con-
figuration shown in Figure 5-71, we can make the actual connections to a single
7400 IC, as shown in Figure 5-72, which reduces the chip count from three ICs
down to one.

T

H_J “ ~ J
c Inverter AND } X

Figure 5-71 Equivalent logic circuit using only NANDs.

+5V (Vo)

7400

Tt
Ve

Figure 5-72 External connections to a 7400 TTL IC to form the circuit of Figure 5-71.

a

e

bJL*ﬁEJL:JEHL;JL'J_

LR

Besides forming inverters and ANDs from NANDs, we can form ORs and
NORs from NANDs. Remember from De Morgan’s theorem that an AND with an in-
verted output (NAND) is equivalent to an OR with inverted inputs. Therefore, if we
invert the inputs to a NAND, we should find that it is equivalent to an OR, as shown
in Figure 5-73.

A

Al
}X:X-E:A+B(0R>
s ]

Figure 5-73 Forming an OR from three NANDs.

Dl
B

Now, to form a NOR from NANDs, all we need to do is invert the output of
Figure 5-73, as shown in Figure 5-74.
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.' Helpful

Hint
It is instructive for you to
make a chart on your own
showing how to convert
NANDs into any of the
other four logic gates.
Repeat for NORs.

>4 | Common
Misconception

When sketching an inverter
constructed from a NOR
or a NAND gate, students
often mistakenly show only
a single input into the gate
instead of two inputs tied
together.
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o
Do{:)o— X=A*B=A+B=A+B(NOR)
L

Figure 5-74 Forming a NOR from four NANDs.

The procedure for converting NOR gates into an inverter, OR, AND, or NAND
is similar to the conversions just discussed for NAND gates. For example, to form an
inverter from a NOR gate, just connect the inputs as shown in Figure 5-75.

Connect both inputs to A
to form an inverter.

A X =A+ A = A (Inverter)

Figure 5-75 Forming an inverter from a NOR gate.

Take some time now to try to convert NORs to an OR, NORs to an AND, and NORs
to a NAND. Prove to yourself that your solution is correct by using De Morgan’s theorem
and Boolean algebra.

EXAMPLE 5-24

Make the external connections to a 4001 CMOS NOR IC to implement the
function X = A + B.

Solution: We will need an inverter and an OR gate to provide the function
for X. An inverter can be made from a NOR by connecting the inputs, and an
OR can be made by inverting the output of a NOR, as shown in Figure 5-76.

>
I
=
+
S
Il
2
+
S

-
Inverter OR

Figure 5-76 Implementing the function X = A + B using only NOR gates.

The pin configuration for the 4001 CMOS quad NOR can be found in
a CMOS data book. Figure 5-77 shows the pin configuration and external

connections to implement X = A + B.
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A 1] o Voo | 14 |—— Vpp=+3Vio 415V
{@ o
- @:
3 m
_E\I_@ 10| X=A+B
B [6 | @ 9

Figure 5-77 External connections to a 4001 CMOS IC to implement the circuit of
Figure 5-76.

EXAMPLE 5-25
Troubleshooting

You have connected the circuit of Figure 5-77 and want to test it. Because
the Boolean equationis X = A + B, you firsttry A = 0, B = 1 and expect
to get a 1 output at X, but you don’t. Vpp is set to +5V, and Vg is con-
nected to ground. Using a logic probe, you record the results shown in
Table 5-6 at each pin. Determine the trouble with the circuit.

TABLE 5-6 | Logic Probe Operation®

Probe on Pin Indicator Lamp
1 Off
2 Off
3 On
4 Off
5 On
6 On
7 Off
8 Dim
9 Off

10 Off
11 On
12 Dim
13 Dim
14 On

“Lamp off, 0; lamp on, 1; lamp dim, float.
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Solution: Because A = 0, pins 1 and 2 should both be 0, which they are.
Pin 3 is a 1, because 00 into a NOR will produce a 1 output. Pin 6 is 1, be-
cause it is connected to the 1 at B. Pin 5 matches pin 3, as it is supposed to.
Pin 4 sends a 0 to pins 8 and 9, but pin 8 is floating (not O or 1). That’s it!
The connection to pin 8 must be broken.

To be sure that the circuit operates properly, the problem at pin 8
should be corrected and all four combinations of inputs at A and B should
be tested.

EXAMPLE 5-26

(a) Write the simplified equation that will produce the output waveform at
X, given the inputs at A, B, and C shown in Figure 5-78.

(b) Draw the logic circuit for this equation.
(¢) Redraw the logic circuit using only NAND gates.

A
B
C
X
Figure 5-78
Solution:

(a) The first HIGH pulse at X is produced forA = 1,B = 0, C = 0 (AB C).
The second HIGH pulse at X happens whenA = 1,B = 1,
C = 0 (ABC). Therefore, X is 1 for AB C or ABC.

X = ABC + ABC
Simplifying yields
X=ACB + B)
= AC(1)
= AC <« simplified equation
(b) The logic circuit is shown in Figure 5-79(a).

(¢) Redrawing the same circuit using only NANDs produces the circuit
shown in Figure 5-79(b).
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B — Not used

(a)

o e

B — Not used

(b)

Figure 5-79 (a) Logic circuit that yields the waveform at X; (b) circuit of part
(a) redrawn using only NANDs.

Review Questions
5-11. Why are NAND gates and NOR gates sometimes referred to as
universal gates?

5-12. Why would a designer want to form an AND gate from two NAND
gates?

5-13. How many inverters could be formed using a 7400 quad NAND IC?

5-8  AND-OR-INVERT Gates for Implementing
Sum-of-Products Expressions

Most Boolean reductions result in an equation in one of two forms:

1. Product-of-sums (POS) form
2. Sum-of-products (SOP) form

The POS expression usually takes the form of two or more ORed variables within
parentheses ANDed with two or more other variables within parentheses. Examples of
POS expressions are

X=@A+B- -B+ 0
X=B+C+D)-(BC+E)
X=A+C-B+E)-(C+B)
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The SOP expression usually takes the form of two or more variables ANDed to-
gether ORed with two or more other variables ANDed together. Examples of SOP ex-
pressions are

X = AB + AC + ABC
X=ACD + CD + B
X = BCD + ABDE + CD
The SOP expression is used most often because it lends itself nicely to the de-
velopment of truth tables and timing diagrams. SOP circuits can also be constructed
easily using a special combinational logic gate called the AND-OR-INVERT gate.
For example, let’s work with the following equation:
X =AB + CD
Using De Morgan’s theorem yields
X =AB-CD
Using De Morgan’s theorem again puts it into a POS format:
X=@A+B)-(C+ D) «POS
Using the distributive law produces an equation in the SOP format:

X=AC+AD + BC + BD <« SOP

Now, let’s fill in a truth table for X (Table 5-7). Using the SOP expression, we put a
latXforA =0,C = 1;forA =0,D =0;forB=1,C = l;andforB = 1,D = 0.
That wasn’t hard, was it?

However, if we were to use the POS expression, it would be more difficult to
visualize. We would put a 1 at X for A = 0 or B = 1 whenever C = 1 or D = 0.
Confusing? Yes, it is much more difficult to deal intuitively with POS expressions.

TABLE 5-7 | Truth Table Completed Using

the SOP Expression
A B C D X
0 0 0 0 1
0 0 0 1 0
0 0 1 0 1
0 0 1 1 1
0 1 0 0 1
0 1 0 1 0
0 1 1 0 1
0 1 1 1 1
1 0 0 0 0
1 0 0 1 0
1 0 1 0 0
1 0 1 1 0
1 1 0 0 1
1 1 0 1 0
1 1 1 0 1
1 1 1 1 1
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A Product of

B j>1 two sums. j
}X: (A + B)(C + D)

C
D

Figure 5-80 Logic circuit for the POS expression.

Drawing the logic circuit for the POS expression involves using OR gates feed-
ing into an AND gate, as shown in Figure 5-80. Drawing the logic circuit for the SOP
expression involves using AND gates feeding into an OR gate, as shown in Figure
5-81. The logic circuit for the SOP expression used more gates for this particular ex-
ample, but the SOP form is easier to deal with and, in addition, there is an IC gate
specifically made to simplify the implementation of SOP circuits.

T
C —

A—Q Sum of several

D—Q products. )
X=AC +AD + BC + BD

B JE——

C—

B —
D—Q :
Figure 5-81 Logic circuit for the SOP expression.

That gate is the AND-OR-INVERT (AOI). AOIs are available in several different
configurations within the TTL or CMOS families. Skim through your TTL and CMOS
data books to identify some of the available AOIs. One AOI that is particularly well
suited for implementing the logic of Figure 5-81 is the 74L.S54 TTL IC. The pin con-
figuration and logic symbol for the 741.S54 are shown in Figure 5-82.

Dy P A
2 —_
=H 1
C
= —LE zi}
< 1] B
= [
13— Y=AB + CDE + FG + HIK
[o] 1o o_H |
HO—
oNp [ 7 | aLssa 5 ] 114
N -

AND OR-INVERT

Figure 5-82 Pin configuration and logic symbol for the 74L.S54 AOI gate.
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>4 | Common
Misconception

Students often forget the
inverter, which makes the
output active-LOW. The
equations so far have been
active-HIGH, but in later
chapters, you will see why

active-LOW is so common.
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Notice that the output at Y is inverted, so we have to place an inverter after Y.
Also, two of the AND gates have three inputs instead of just the two-input gates that
we need, so we just connect the unused third input to a 1. Figure 5-83 shows the re-
quired connections to the AOI to implement the SOP logic circuit of Figure 5-81.
Onmitting the inverter from Figure 5-83 would provide an active-LOW output function,
which may be acceptable, depending on the operation required. (The new equation
wouldbe X = AC + AD + BC + BD.)

Inverter required to

A— : cancel effect of bubble.

C —_

z R

D JE—

! {>o X
B JE—

c—| X =AC +AD + BC + BD
E —_— N

D

1 —_

74LS54

Figure 5-83 Using an AOI IC to implement an SOP equation.

EXAMPLE 5-27

Simplify the circuit shown in Figure 5-84 down to its SOP form, then draw
the logic circuit of the simplified form using a 74L.S54 AOI gate.

A —
Cc —

B—— | p—x

C —

A

—

Figure 5-84 Original circuit for Example 5-27.

Ol

Solution:

X =(AC + BC)-(A+ B+ D)
=AC+BC+A+B+D
= AC- BC + ABD
=@+ OB + C) + ABD
=AB + AC + BC + CC + ABD
=AB + AC + BC + ABD <« SOP

The simplified circuit is shown in Figure 5-85.
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Put 1 01? 5
unused input.
A —_—
C —_
1 —_
_ {>o X
B ——]
c—| X =AB + AC + BC + ABD
A—T
B
p—1L /
74LS54

Figure 5-85 Using an AOI IC to implement the simplified SOP equation for
Example 5-27.

Review Questions

5-14. Which form of Boolean equation is better suited for completing
truth tables and timing diagrams, SOP or POS?

5-15. AOI ICs are used to implement (SOP, POS) expressions.

5-16. The equation X = AB + BCD + DE has only three product terms.
If a 74L.S54 AOI IC is used to implement the equation, what must be done
with the three inputs to the unused fourth AND gate?

5-9 Karnaugh Mapping

We learned in previous sections that by using Boolean algebra and De Morgan’s theo-
rem, we can minimize the number of gates that are required to implement a particular
logic function. This is very important for the reduction of circuit cost, physical size,
and gate failures. You may have found that some of the steps in the Boolean reduction
process require ingenuity on your part and a lot of practice.

Karnaugh mapping was named for its originator, Maurice Karnaugh, who in 1953
developed another method of simplifying logic circuits. It still requires that you reduce
the equation to an SOP form, but from there, you follow a systematic approach, which
will always produce the simplest configuration possible for the logic circuit.

A Karnaugh map (K-map) is similar to a truth table in that it graphically shows
the output level of a Boolean equation for each of the possible input variable combina-
tions. Each output level is placed in a separate cell of the K-map. K-maps can be used
to simplify equations having two, three, four, five, or six different input variables.
Solving five- and six-variable K-maps is extremely cumbersome; they can be more
practically solved using advanced computer techniques. In this book, we solve two-,
three-, and four-variable K-maps.

Determining the number of cells in a K-map is the same as finding the number of
combinations or entries in a truth table. A two-variable map requires 2> = 4 cells. A
three-variable map requires 2° = 8 cells. A four-variable map requires 2* = 16 cells.
The three different K-maps are shown in Figure 5-86.

Each cell within the K-map corresponds to a particular combination of the
input variables. For example, in the two-variable K-map, the upper left cell corre-
sponds to A B, the lower left cell is AB, the upper right cell is AB, and the lower right
cell is AB.

SECTION 5-9 | KARNAUGH MAPPING

Team
Discussion

What other options are

available instead of

inputting a 1 to the second

AND gate?

Team
Discussion

How could you create the
AND-OR logic function
using 5 NAND gates? (Hint:

Use bubble pushing.)
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>4 | Common
Misconception

Students sometimes design
their own layouts for
K-maps by moving the
overbars. This move can
produce invalid results if it
causes more than one
variable to change as you
move from cell to cell.
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c ¢ CD CD CD CD
AB AB
3 g AB AB
a AB AB
A AB AB

Figure 5-86 Two-, three-, and four-variable Karnaugh maps.

Also notice that when moving from one cell to an adjacent cell, only one vari-
able changes. For example, look at the three-variable K-map. The upper left cell is
A B C; the adjacent cell just below it is ABC. In this case, the A C remained the same
and only the B changed, to B. The same holds true for each adjacent cell.

To use the K-map reduction procedure, you must perform the following steps:

1. Transform the Boolean equation to be reduced into an SOP expression.
2. Fill in the appropriate cells of the K-map.

3. Encircle adjacent cells in groups of two, four, or eight. (The more adjacent
cells encircled, the simpler the final equation is; adjacent means a side is
touching, not diagonal.)

4. Find each term of the final SOP equation by determining which variables re-
main constant within each circle.

Now, let’s consider the equation

X = A(BC + BC) + ABC
First, transform the equation to an SOP expression:
X =ABC +ABC + ABC
The terms of that SOP expression can be put into a truth table and then transferred to a
K-map, as shown in Figure 5-87. Working with the K-map, we now encircle adjacent
I’s in groups of two, four, or eight. We end up with two circles of two cells each, as
shown in Figure 5-88. The first circle surrounds the two 1’s at the top of the K-map,
and the second circle surrounds the two 1’s in the left column of the K-map.

Once the circles have been drawn encompassing all the 1’s in the map, the final
simplified equation is obtained by determining which variables remain the same
within each circle. Well, the first circle (across the top) encompasses A B C and A BC.
The variables that remain the same within the circle are A B. Therefore, A B becomes
one of the terms in the final SOP equation. The second circle (left column) encom-
passes A B C and ABC. The variables that remain the same within that circle are A C.
Therefore, the second term in the final equation is A C.

c ¢
A | B | C| X /T\ | |
oo o] 1 <—(AE€)/AB/’
0 |0 |1 I <—(ABO) il 1
o |1 |0 I <—(ABO) )'
0 |1 1 0
1 oo 0 AB
1o |1 0
1 1|0 0 AB
1 1 1 0

Figure 5-87 Truth table and Karnaugh map of X = ABC + A BC + ABC.
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These are the variables
that remained constant

C C within each circle.
AB f 1 1 H
AB |\ 1 \1
X=AB+AC
AB
AB

Figure 5-88 Encircling adjacent cells in a Karnaugh map.

‘Because the final equation is always written in the SOP format, the answer is
X = AB + A C. Actually, the original equation was simple enough that we could have
reduced it using standard Boolean algebra. Let’s do it just to check our answer:

X=ABC + ABC + ABC
AB(C + C) + ABC

There are several other points to watch out for when applying the Karnaugh map-
ping technique. The following examples will be used to illustrate several important
points in filling in the map, determining adjacencies, and obtaining the final equation.
Work through these examples carefully so that you do not miss any special techniques.

EXAMPLE 5-28

Simplify the following SOP equation using the Karnaugh mapping technique:

X=AB + ABC + ABC + ABC
Solution:

1. Construct an eight-cell K-map (see Figure 5-89), and fill in a 1 in each
cell that corresponds to a term in the original equation. (Notice that AB
has no C variable in it. Therefore, AB is satisfied whether C is HIGH or
LOW, so AB will fill in two cells: ABC + ABC.)

c ¢
| (1)
— V }
1
AB \1 ‘\*
AB|| 1 X=AB+C Answer
5|

Figure 5-89 Karnaugh map and final equation for Example 5-28.
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2. Encircle adjacent cells in the largest group of two or four or eight.

3. Identify the variables that remain the same within each circle, and
write the final simplified SOP equation by ORing them together.

EXAMPLE 5-29

Simplify the following equation using the Karnaugh mapping procedure:

X = ABCD + ABCD + ABCD + ABCD + ABCD + ABCD

Solution: Because there are four different variables in the equation, we
need a 16-cell map (2* = 16), as shown in Figure 5-90.

CD CD CD CD

B (M)
AB L+
—
AB (1 1) 1> X=ABD + ABC + CD  Answer
5 |\

Figure 5-90 Solution to Example 5-29.

EXAMPLE 5-30

Simplify the following equation using the Karnaugh mapping procedure:
X = BCD + ABCD + ABCD + ABCD + ABCD

Solution: Notice in Figure 5-91 that the BC D term in the original equa-
tion fills in fwo cells: ABC D + ABC D. Also notice in Figure 5-91 that we
could have encircled four cells and then two cells, but that would not have
given us the simplest final equation. By encircling four cells and then
another four cells, we are sure to get the simplest final equation. (Always
encircle the largest number of cells possible, even if some of the cells have

already been encircled in another group.)

CD CD CD CD
» Common -
Misconception AB I
—
Students often solve a map _ L
. . - AB|[ 1 1 1
like this by encircling 4

and 2 instead of 4 and 4. _

Analyze both results to see AB h 1 J 1 J X=BD + BC Answer
why choosing 4 and 4 is _

better. AB

Figure 5-91 Solution to Example 5-30.
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EXAMPLE 5-31

Simplify the following equation using the Karnaugh mapping procedure:
X=ABC + ACD + AB + ABCD + ABC

Solution: Notice in Figure 5-92 that a new technique called wraparound
is introduced. You have to think of the K-map as a continuous cylinder in
the horizontal direction, like the label on a soup can. This makes the left
row of cells adjacent to the right row of cells. Also, in the vertical direction,
a continuous cylinder like a soup can lying on its side makes the top row of
cells adjacent to the bottom row of cells. In Figure 5-92, for example, the
four top cells are adjacent to the four bottom cells, to combine as eight cells
having the variable B in common.

Another circle of four is formed by the wraparound adjacencies of the
lower left and lower right pairs combining to have AD in common. The final
equation becomes X = B + AD. Compare that simple equation with the
original equation that had five terms in it.

lecb e oo cb

AB Ll 1 1 1)

AB S|
AB| 1) (1
AB /1 h

Y, 1 1 \1

X=B+AD Answer

Figure 5-92 Solution to Example 5-31 illustrating the wraparound feature.

EXAMPLE 5-32

Simplify the following equation using the Karnaugh mapping procedure:

X =B(CD + C) + CD(A + B + AB)

Solution: Before filling in the K-map, an SOP expression must be formed:
X =BCD + BC + CD(AB + AB)
= BCD + BC + ABCD + ABCD

The group of four 1’s can be encircled to form A B, as shown in
Figure 5-93. Another group of four can be encircled using wraparound to
form B C. That leaves two 1’s that are not combined with any others. The
unattached 1 in the bottom row can be combined within a group of four, as
shown, to form BD.

The last 1 is not adjacent to any other, so it must be encircled by itself
to form ABCD. The final simplified equation is

X=AB+ BC + BD + ABCD
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Misconception

Students often neglect to
include the single
encirclement (4-variable)
term in the final equation.

Figure 5-93  Solution to Example 5-32.

EXAMPLE 5-33
Simplify the following equation using the Karnaugh mapping procedure:
X=AD + ABD + ACD + ACD
Solution: First, the group of eight cells can be encircled, as shown in
Figure 5-94. A is the only variable present in each cell within the circle, so

the circle of eight simply reduces to A. (Notice that larger circles will re-
duce to fewer variables in the final equation.)

E Team CD| CD cD |cD
Discussion iB /1 1 | 1\

What is the final equation
of a map that has all cells AB| | 1 1 1 1
filled in?

2|

K Four corners = BD

3
B
R

Figure 5-94 Solution to Example 5-33.

Also, all four corners are adjacent to each other because the K-map
can be wrapped around in both the vertical and horizontal directions.
Encircling the four corners results in B D. The final equation is

X=A+BD

EXAMPLE 5-34

Simplify the following equation using the Karnaugh mapping procedure:

X=ABD + ACD + ABC + ABCD + ABCD
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Solution: Encircling the four corners forms B D, as shown in Figure 5-95.
The other group of four forms BC. You may be tempted to encircle the C D
group of four as shown by the dotted line, but that would be a redundancy
because each of those 1’s is already contained within an existing circle.

Therefore, the final equation is

Figure 5-95

X=BD + BC

D CD

C

| cD
LK» BD

——t——> BC

|a>
&
_l =0

o
s
-

/: 1

it
o

Redundancy j

Solution to Example 5-34.

5-10 System Design Applications

Let’s summarize the entire chapter now by working through two complete design
problems. The following examples illustrate practical applications of a K-map to en-
sure that when we implement the circuit using an AOI, we will have the simplest pos-

sible solution.

SYSTEM DESIGN 5-1

Design a circuit that can be built using an AOI and inverters that will out-
put a HIGH (1) whenever the 4-bit hexadecimal input is an odd number

from O to 9.
TABLE 5-8 | Hex Truth Table Used to Determine the Equation
for Odd Numbers? from 0 to 9
D C B A DEC
0 0 0 0 0
0 0 0 1 1 —ABCD
0 0 1 0 2
0 0 1 1 3 «— ABCD
0 1 0 0 4
0 1 0 1 5 «— ABCD
0 1 1 0 6
0 1 1 1 7 «— ABCD
1 0 0 0 8 o
1 0 0 1 9 «—ABCD

30dd number = ABCD + ABCD + ABCD + ABCD + ABCD.

SECTION 5-10 | SYSTEM DESIGN APPLICATIONS

Team
Discussion

So what’s wrong with
being redundant?

Team
Discussion

The LSB (variable A) is
always HIGH for an odd
number. Why can’t we just
say “odd number = A”?
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CD CD CD CD

0Odd number = AD + ABC where A =LSB
1

Output = 1

D for odd

{>O numbers

R

74LS54 (AOI)

(b)

Figure 5-96 (a) Simplified equation derived from a Karnaugh map;
(b) implementation of the odd-number decoder using an AOL.

Solution: First, build a truth table (Table 5-8) to identify which hex codes
from 0 to 9 produce odd numbers. (Use the variable A to represent the 2°
hex input, B for 2! C for 22, and D for 23 .) Next, reduce this equation into
its simplest form by using a Karnaugh map, as shown in Figure 5-96(a).
Finally, using an AOI with inverters, the circuit can be constructed as shown
in Figure 5-96(b).

SYSTEM DESIGN 5-2

A chemical plant needs a microprocessor-driven alarm system to warn
of critical conditions in one of its chemical tanks. The tank has four
HIGH/LOW (1/0) switches that monitor temperature (7), pressure (P),
fluid level (L), and weight (W). Design a system that will notify the mi-
croprocessor to activate an alarm when any of the following conditions
arise:

1. High fluid level with high temperature and high pressure

2. Low fluid level with high temperature and high weight

3. Low fluid level with low temperature and high pressure

4. Low fluid level with low weight and high temperature
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Solution: First, write in Boolean equation form the conditions that will
activate the alarm:

alarm = LTP + LTW + LTP + LWT

Next, factor the equation into its simplest form by using a Karnaugh map,
as shown in Figure 5-97(a). Finally, using an AOI with inverters, the circuit
can be constructed as shown in Figure 5-97(b).

LW LW LW LW
— Team
P Discussion
7P| (1 1) By rereading conditions 2
and 4, can you logically
explain why the weight is
TP
@—1/ ! 1> _ irrelevant and doesn’t
_ Alarm = TP + PL +TL appear in the final
TP | (1 1 equation?
(a)
T
—t
L 4|>O——0 1 — Microprocessor
alarm
W —_—

74LS54 (AOI)

(b)

Figure 5-97 (a) Simplified equation derived from a Karnaugh map;
(b) implementation of the chemical tank alarm using an AOL

Review Questions
5-17. The number of cells in a Karnaugh map is equal to the number of en-
tries in a corresponding truth table. True or false?

5-18. The order in which you label the rows and columns of a Karnaugh
map does not matter as long as every combination of variables is used. True
or false?

5-19. Adjacent cells in a Karnaugh map are encircled in groups of 2, 4, 6,
or 8. True or false?

5-20. Which method of encircling eight adjacent cells in a Karnaugh map
produces the simplest equation: two groups of four, or one group of eight?
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B Summary

In this chapter, we have learned that

1. Several logic gates can be connected together to form combinational
logic.

2. There are several Boolean laws and rules that provide the means to form
equivalent circuits.

3. Boolean algebra is used to reduce logic circuits to simpler equivalent
circuits that function identically to the original circuit.

4. De Morgan’s theorem is required in the reduction process whenever in-
version bars cover more than one variable in the original Boolean equation.

5. NAND and NOR gates are sometimes referred to as universal gates
because they can be used to form any of the other gates.

6. AND-OR-INVERT (AOI) gates are often used to implement sum-of-
products (SOP) equations.

7. Karnaugh mapping provides a systematic method of reducing logic
circuits.

8. Combinational logic designs can be entered into a computer using
schematic block design software or VHDL.

9. Using vectors in VHDL is a convenient way to group like signals to-
gether similar to an array.

10. Truth tables can be implemented in VHDL using vector signals with
the selected signal assignment statement.

11. Quartus® II can be used to determine the simplified equation of com-
binational circuits.

i Glossary M

Active-LOW: An output of a logic circuit that is LOW when activated, or an input
that needs to be LOW to be activated.

Adjacent Cell: Cells within a Karnaugh map that border each other on one side or the
top or bottom of the cell.

AND-OR-INVERT (AOI) Gate: An integrated circuit containing combinational
logic consisting of several AND gates feeding into an OR gate and then an
inverter. It is used to implement logic equations in the SOP format.

Boolean Reduction: An algebraic technique that follows specific rules to convert a
Boolean equation into a simpler form.

Bubble Pushing: A shortcut method of forming equivalent circuits based on De
Morgan’s theorem.

Cell: Each box within a Karnaugh map. Each cell corresponds to a particular combi-
nation of input variable logic levels.

Chip Planner: A Quartus® II software tool used to display the simplified equation to
be programmed into an FPGA.
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Combinational Logic: Logic circuits formed by combining several of the basic logic
gates to form a more complex function.

De Morgan’s Theorem: A Boolean law used for equation reduction that allows the
user to convert an equation having an inversion bar over several variables
into an equivalent equation having inversion bars over single variables only.

Don’t Care: A variable appearing in a truth table or timing waveform that will have
no effect on the final output regardless of the logic level of the variable.
Therefore, don’t-care variables can be ignored.

Equivalent Circuit: A simplified version of a logic circuit that can be used to per-
form the exact logic function of the original complex circuit.

Floorplan Editor Display: A Quartus® II display that is used to view and modify the
layout and configuration of a CPLD.

Inversion Bubbles: The bubble (or circle) can appear at the input or output of a logic
gate. It indicates inversion (1 becomes 0; 0 becomes 1).

Karnaugh Map: A two-dimensional table of Boolean output levels used as a tool to
perform a systematic reduction of complex logic circuits into simplified
equivalent circuits.

Logic Array Block (LAB): Several logic cells put together as a group. The Altera
EPM7128SLC CPLD has 8 LABs, each containing 16 logic cells.

Logic Cell: Also known as a macrocell, and is an array of AND-OR logic and 1/0
registers.

Netlist Viewer: A Quartus® II software tool used to display the simplified logic cir-
cuit to be programmed into an FPGA.

Product-of-Sums (POS) Form: A Boolean equation in the form of a group of
ORed variables ANDed with another group of ORed variables [e.g.,
X=A+B+C)MB+ DA+ O]

Redundancy: Once all filled-in cells in a Karnaugh map are contained within a circle,
the final simplified equation can be written. Drawing another circle around
a different group of cells is needless (redundant).

Selected Signal Assignment: A VHDL statement that executes specific assignments
based on the value of the specified signal used in the statement.

Signal: A VHDL architecture statement that declares one or more inputs as internal
signals.

Sum-of-Products (SOP) Form: A Boolean equation in the form of a group of
ANDed variables ORed with another group of ANDed variables (e.g.,
X = ABC + BDE + A D).

Type declaration: A VHDL entity statement that defines what type of input or output
data is to be used.

Universal Gates: The NOR and NAND logic gates are sometimes called universal
gates because any of the other logic gates can be formed from them.

Vector: A grouping of like signals similar to an array.

Wraparound: The left and right cells and the top and bottom cells of a Karnaugh map
are actually adjacent to each other by means of the wraparound feature.

GLOSSARY
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mmms Problems

Section 5-1

5-1. Write the Boolean equation for each of the logic circuits shown in
Figure P5-1.

(@ (b)

A
. [
B

C

© )

Figure P5-1

5-2. Refer to the gray water reclamation tank in Figure 5-7 (Example 5-4).
Write the Boolean equation and draw the logic circuit to implement the fol-
lowing functions:

(@) Turn on the red light (R) if there is a HIGH opacity (C) and
pressure (P) when the level is full (F).

(b) Turn on the green light (G) if there is a HIGH opacity (C) and
pressure (P) when the level is mid (M) or full (F).

(¢) Turn on the blue light (B) when the tank level is full and any of the sen-
sors for PH (H), opacity (C), or pressure (P) are HIGH.

Section 5-2

5-3. Draw the logic circuit that would be used to implement the following
Boolean equations. Also, construct a truth table for each of the equations.
(Hint: Where applicable, apply Law 3 to the equation first. Do not simplify
the equation for this problem.)

(@ M= (AB) + (C + D)

b)N=A+ B+ OD

(¢c) P=(AC + BCO)A + O)

d Q=@ + B)BCD

() R=BC+ D+ AD

) S=BA+C) +AC+ D
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5-4. Write the Boolean equation and then complete the timing diagram at
W, X, Y, and Z for the logic circuits shown in Figure P5—4.

%

(a)

;

(b)

K
T

(©

T

a—Lo T

5-5. State the Boolean law that makes each of the equivalent circuits

D
(d)
Figure P5-4
shown in Figure P5-5 valid.
c
D
127 X=C+D+A+E+B
B
Original circuit
Figure P5-5
PROBLEMS

SISTOIES

X=A+B+C+D+E

Equivalent circuit
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A— A——i
B PE—
c —D—L B —:>_L
= C =
b } X =(ABC)D s } X =(AB)CD

Original circuit Equivalent circuit

(b)

c }X:(A+B)C X=AC+ BC

B_

Original circuit Equivalent circuit
(©

Figure P5-5 Continued

5-6. Using the 10 Boolean rules presented in Table 5-2, determine the
outputs of the logic circuits shown in Figure P5-6.

(2 (

A—] B
M N
o — ) O—
(@) (b
= =
b= 0 ¢
© @
- g
R
i —
© )
h

A —
A—

A

%

)

)
)
)
)

® (
Figure P5-6

Section 5-3

5-7. Write the Boolean equation for the circuits of Figure P5-7. Simplify
the equations, and draw the simplified logic circuit.
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o C

e :

(© (d)

Figure P5-7

5-8. Repeat Problem 5-7 for the circuits shown in Figure P5-8.

[ X

()

o
-

A
B
C
A
B
C

(b)

A

G

(©)

Figure P5-8

5-9. Draw the logic circuit for the following equations. Simplify the equa-
tions, and draw the simplified logic circuit.

(a) V=AC + ACD + CD
(b) W= (BCD + O)CD

PROBLEMS
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GND

(¢©) X= (B + D)A + C) + ABD
() Y = AB + BC + ABC
(e) Z = ABC + CD + CDE

5-10. Construct a truth table for each of the simplified equations of
Problem 5-9.

5-11. The pin layouts for a 74HCT08 CMOS AND gate and a 74HCT32
CMOS OR gate are given in Figure P5—11. Make the external connections
to the chips to implement the following logic equation. (Simplify the logic
equation first.)

X=(A+B)(D + C) + ABD

[1] [14] Vee [1] [14] Ve
bl Toql
Pl %
[4] 1] [4] [11]
[5] [10] E@ [10]
ool %1
[7] B GND 7] 3 |
74HCTO8 74HCT32

Figure P5-11

5-12. Repeat Problem 5-11 for the following equation
Y = AB(C + BD) + BD

Section 5-5

5-13. Write a sentence describing how De Morgan’s theorem is applied in
the simplification of a logic equation.

5-14. (a) De Morgan’s theorem can be used to prove that an OR gate with
inverted inputs is equivalent to what type of gate?
(b) An AND gate with inverted inputs is equivalent to what type of
gate?

5-15. Which two circuits in Figure P5-15 produce equivalent output
equations?

:)Oiw A OW
Y
B —— B—O

(a) (©)

Figure P5-15

5-16. Use De Morgan’s theorem to prove that a NOR gate with inverted
inputs is equivalent to an AND gate.
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5-17. Draw the logic circuit for the following equations. Apply De Mor-
gan’s theorem and Boolean algebra rules to reduce them to equations hav-
ing inversion bars over single variables only. Draw the simplified circuit.
(@ W=AB+A+C

(b) X =AB + C + BC

(¢c) Y= (AB) + C + BC

d)y Z=AB+ (A + O)

5-18. Write the Boolean equation for the circuits of Figure P5-18. Use De

Morgan’s theorem and Boolean algebra rules to simplify the equation.
Draw the simplified circuit.

o]

X |
—

(a) (b)

Figure P5-18

C

5-19. Repeat Problem 5-17 for the following equations.

(a) W= AB + CD + ACD

(b) X=A+ B-BC + BC

(¢) Y=ABC + D + AB + BC

(d) Z = (C + D)ACD(AC + D)

5-20. Repeat Problem 518 for the circuits of Figure P5-20.

(@

[

(b)

Figure P5-20

PROBLEMS
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D#*

CD

CD

CD

5-21. Design a logic circuit that will output a 1 (HIGH) only if A and B are
both 1 while either C or D is 1.

5-22. Design a logic circuit that will output a O only if A or B is 0.

5-23. Design a logic circuit that will output a LOW only if A is HIGH or
B is HIGH while C is LOW or D is LOW.

5-24. Design a logic circuit that will output a HIGH if only one of the in-
puts A, B, or Cis LOW.

5-25. Design a circuit that outputs a 1 when the binary value of ABCD
(D =LSB)is > 11.

5-26. Design a circuit that outputs a LOW when the binary value of ABCD
(D = LSB)is > 7and < 10.

5-27. Complete a truth table for the following simplified Boolean equations.
(@ W=ABC + BC + AB

(b) X =AB + ABC + BC

() Y=CD+ABCD + BCD + ACD

(d) Z=ABCD + AC + CD + BC

5-28. Complete the timing diagram in Figure P5-28 for the following
simplified Boolean equations.

(@ X =ABC + ABC + AC

(b) Y =B + ABC + AC

(¢) Z= BC + AB + ABC

Figure P5-28

5-29. Use the bubble-pushing technique to convert the gates in Figure
P5-29.

*The letter D designates a circuit D esign problem.
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= Do

(@) (b)

1 = >

(c) @

Figure P5-29

5-30. Some computer systems have two disk drives, commonly called
drive A and drive B, for storing and retrieving data. Assume that your com-
puter has four control signals provided by its internal microprocessor to
enable data to be read and written to either drive. Design a gating scheme
similar to that provided in Figure 5-60 to supply an active-LOW drive se-
lect signal to drive A (DS,,) or to drive B (DS,,) whenever they are read or
written to. The four control signals are also active-LOW and are labeled
RD (Read), WR (Write), DA (drive A), and DB (drive B).

5-31. Draw the connections required to convert
(a) A NAND gate into an inverter

(b) A NOR gate into an inverter

5-32. Draw the connections required to construct
(a) An OR gate from two NOR gates

(b) An AND gate from two NAND gates

(¢) An AND gate from several NOR gates
(d) A NOR gate from several NAND gates

5-33. Redraw the logic circuits of Figure P5-33 to their equivalents using

4

D C
Section 5-7
only NOR gates.
A
B
c

(a)

(c)

Figure P5-33

PROBLEMS
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5-34. Convert the circuits of Figure P5-34 to their equivalents using only
NAND gates. Next, make the external connections to a 7400 quad NAND
to implement the new circuit. (Each new equivalent circuit is limited to four
NAND gates.)

‘ [ o

)

—~
o

Figure P5-34

Section 5-8

5-35. Identify each of the following Boolean equations as a POS expres-
sion, a SOP expression, or both.

(@) U= ABC + BC + AC

b)) V=@A+ OB+ 0

() W=AC(B + O

(d) X=AB + C + BD

(¢) Y= (AB + D)(A + CD)

) Z=(A + B)(BC + A) + AB + CD

5-36. Simplify the circuit of Figure P5-36 down to its SOP form, then

draw the logic circuit of the simplified from implemented using a 74L.S54
AOI gate.

B

:D_L
:DI
:D_L
EDI}

c
D
B
c
B
D

A%y >

Figure P5-36
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Section 5

-9

5-37. Using a Karnaugh map, reduce the following equations to a mini-
mum form.

(a) X =ABC + AB+ AB

(b) Y =BC + ABC + BC

(¢) Z=ABC + ABC + ABC + ABC

5-38. Using a Karnaugh map, reduce the following equations to a mini-
mum form.

(a) W= B(CD + AD) + BC(A + AD)

(b) X =ABD + B(CD + ACD) + ABD

(¢) Y=A(CD + CD) + ABD + ABCD

(d Z=BCD + BCD + CD + CDB + AB)

5-39. Use a Karnaugh map to simplify the circuits in Figure P5-39.

—) >
O

—) >
) > >

B — o

o
o

>

Figure P5-39

Section 5-10

C

PROBLEMS

5-40. Seven-segment displays are commonly used in calculators to display
each decimal digit. Each segment of a digit is controlled separately, and
when all seven of the segments are on, the number 8 is displayed. The upper
right segment of the display comes on when displaying the numbers 0, 1, 2,
3,4,7,8, and 9. (The numerical designation for each of the digits O to 9 is
shown in Figure P5—40 and described in more detail in Section 12-6.)
Design a circuit that outputs a HIGH (1) whenever a 4-bit BCD code trans-
lates to a number that uses the upper right segment. Use variable A to repre-
sent the 2° BCD input. Implement your design with an AOI and inverters.
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Figure P5-40

CD 5-41. Repeat Problem 5—40 for the lower left segment of a seven-segment

display (0, 2, 6, 8).

T 5-42. The logic circuit of Figure P5—42(a) is implemented by making con-
nections to the 7400 as shown in Figure P5-42(b). The circuit is not work-
ing properly. The problem is in the IC connections or in the IC itself. The
data table in Figure P5-42(c) is completed by using a logic probe at each

pin. Identify the problem.

Test conditions

A=1
B=1
Cc=1
X should equal 0
Probe on pin: Indicator lamp
1 On
2 On
A 1% |_ 15V 3 Off
A 5 _|: — 5 Off
2 13 6 Off
8 On
10 Dim
@ 4 1 f—x 11 On
12 On
13 Off
5 10 14 On
6 9 (c)
7 | GND 8
7400 :I
(b)
Figure P5-42
T 5-43. Repeat Problem 5-42 for the circuit shown in Figure P5-43.
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Test conditions

Indicator lamp

A=0
B=1
Cc=1
X should equal 0
Probe on pin:
1
2
1 Ve 14F+5V 3
A cc 4
A—0 — 5
2 13 6
B—— 7
c O | Gl
10
(a) 4 11 11
12
13
p— s | 10 11
—
6 @z’i
7 | GND 8 X
7400

(b)

Figure P5-43

mmmmm Schematic Interpretation Problems m—"————

See Appendix G for the schematic diagrams.

S

CS

5-44. Find U8 in the HC11DO0 schematic. Pins 11 and 12 are unused so
they are connected to V. What if they were connected to ground instead?

5-45. Find U1:A in the Watchdog Timer schematic. This device is called
a flip-flop and is explained in Chapter 10. It has two inputs, D and CLK,
and two outputs, Q4 and Q5. Write the Boolean equation at the output (pin 3)
of U2:A.

5-46. Write the Boolean equation at the output (pin 3) of U12:A in the
Watchdog Timer schematic. (Hint: Use the information given in Problem
5-45.)

5-47. Locate the U14 gates in the 4096/4196 schematic.
(a) Write the Boolean equation of the output at pin 6 of U14.
(b) What kind of gate does it turn into if you use the bubble-pushing tech-
nique?
(¢) This is a 74HCO0S8. What kind of logic gate is that?
(d) Complete the following sentence: Pin 3 of U14:A goes LOW if
OR if .

5-48. U10 of the 4096/4196 schematic is a RAM memory IC. Its opera-
tion is discussed in Chapter 16. To enable the chip to work, the Chip Enable
input at pin 20 must be made LOW. Write a sentence describing the logic
operation that makes that line go LOW. (Hint: Pin 20 of U10 goes LOW if

)

SCHEMATIC INTERPRETATION PROBLEMS
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Off
Off
On
On
On
Off
Off
On
Off
On
On
On
Off
On
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mmmmm MultiSIM® Exercises I

ES5-1. Load the circuit file for Section S-1a. This circuit is an automobile
warning system used to warn you if you leave your key in the ignition or
leave your headlights on as you leave your car.

(a) Write the Boolean equation at B. Test your Boolean equation by moving
the appropriate switches.

(b) The equation and the circuit can be reduced to a simpler form using
just two gates and three switches to perform the same operation. What
is the reduced equation? Test your reduced equation by building the
new circuit.

E5-2. Load the circuit file for Section 5-1b.

(a) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?

(b) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?
E5-3. Load the circuit file for Section 5-3a.

(a) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?

(b) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?

E5-4. Load the circuit file for Section 5-3b.

(a) What is the Boolean equation at X?

(b) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?

(c) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?

E5-5. Load the circuit file for Section 5-3c. Use the gates that are provided

to draw the logic circuit for the following equation: X = (ABC + B)BC.

(a) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?

(b) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?

(c) Draw the simplified circuit using the Logic Converter.

ES-6. Load the circuit file for Section 5-3d. Use the gates that are

provided to draw the logic circuit for the following equation: X =
ABD + CD + CDE.

(a) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?

(b) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?

(c) Draw the simplified circuit using the Logic Converter.

E5-7. Load the circuit file for Section 5-3e. The Combinational logic cir-

cuit inside of the box labeled “COMBO1” produces an output at X. Use the

waveforms shown on the Logic Analyzer to determine the Boolean logic
that is inside circuit “COMBO1.” Write the equation at X.

E5-8. Load the circuit file for the Section 5-3f. The combinational logic
circuit inside of the box labeled “COMBO2” produces an output at X.
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Study the waveforms shown on the Logic Analyzer to determine the
Boolean logic that is inside circuit “COMBO2.” Write the equation at X.

ES-9. Load the circuit file for Section 5—4a. The circuit shown has a

Boolean equation of X = (AB)’(A + B)’. The prime (') is used instead of

an overbar.

(a) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?

(b) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?

E5-10. Load the circuit file for Section 5—4b. The circuit shown is a com-
binational logic circuit.

(a) What is the Boolean equation at X?
(b) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?

(¢) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?

C E5-11. Load the circuit file for Section 5—4¢. Use the gates that are
provided to draw the logic circuit for the following equation:
X =AB + C) + (BO)'.
(a) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?
(b) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?

(c) Draw the simplified circuit using the Logic Converter.

C ES5-12. Load the circuit file for Section 5-4d. Use the gates that are
provided to draw the logic circuit for the following equation: X =
(ABC' + D)’ + (AB' + BC')".
(a) Create a truth table using the Logic Converter. How many different in-
put combinations produce a 1 in the output?

(b) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?
(¢) Draw the simplified circuit using the Logic Converter.

ES-13. Load the circuit file for Section 5—e. On a separate piece of paper
use the “bubble-pushing” technique to convert the gates connected to X and Y.

(a) What logic gate could be used to provide the logic at X?

(b) What logic gate could be used to provide the logic at Y? Check your
answer by observing the output at X and Y on the Logic Analyzer.

CD ES5-14. Load the circuit file for Section 5—4f. The Word Generator is set
up to output a binary up-counter waveform similar to the one commonly
used in the textbook. Design a circuit that will output a HIGH if only one
of the inputs A, B, or C is LOW. Connect the output of your design to the
Logic Analyzer. Study the four waveforms to see if your design worked.

D ES5-15. Load the circuit file for Section 5-4g. The Word Generator is set
up to output a binary up-counter waveform similar to the one commonly
used in the textbook. Design a circuit that will output a HIGH when the bi-
nary value of ABCD (D = LSB) is greater than 11. Connect the output of
your design to the Logic Analyzer. Study the five waveforms to see if your
design worked.
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E5-16. Load the circuit file for Section 5-4h. The Word Generator is set
up to output a binary up-counter waveform similar to the one commonly
used in the textbook. Design a circuit that will output a LOW when the bi-
nary value of ABCD (D = LSB) is greater than 7 and less than 10. Con-
nect the output of your design to the Logic Analyzer. Study the five
waveforms to see if your design worked.

MultiSIM® Troubleshooting Exercises mumm——

E5-17. The following circuit files have faults in them. Study the combina-
tional logic circuit operation in Section 5—1 before attempting to find the faults.
(a) AND-OR_t-shoot_a (b) AND-OR_t-shoot_b

(1) The circuit should operate the same as the automobile warning system
presented in Figure 5-1 (B = KD + HD). Test the logic operation by
exercising all combinations for K, H, and D by pressing each of those
keys on your keyboard.

(2) What problems do you observe?

(3) Use the Logic Probe indicator to determine which gate is not operating
properly. Which gate is bad?

(4) Delete the bad gate, replace it, and validate proper circuit operation.
E5-18. The following circuit files have faults in them. Study the combi-
national logic circuit operation in Example 5-6 before attempting to find
the faults.

(a) AND-OR_t-shoot_c (b) AND-OR_t-shoot_d

(1) The circuit should operate the same as Example 5-6 in Figure 5-23,
which reduces to X = AB + C. Test the logic operation by exercising
all combinations for A, B, and C by pressing each of those keys on
your keyboard.

(2) What problems do you observe?

(3) Use the Logic Probe indicator to determine which gate is not operating
properly. Which gate is bad?

(4) Delete the bad gate, replace it, and validate proper circuit operation.
E5-19. The following circuit files have faults in them. Study the combi-
national logic circuit operation in Example 5-8 before attempting to find
the faults.

(a) AND-OR-invert_t-shoot_a (b) AND-OR-invert_t-shoot_b

(1) The circuit should operate the same as Example 5-8 in Figure 5-27,
which reduces to X = B + C. Test the logic operation by exercising all
combinations for A, B, and C by pressing each of those keys on your
keyboard.

(2) What problems do you observe?

(3) Use the Logic Probe indicator to determine which gate is not operating
properly. Which gate is bad?

(4) Delete the bad gate, replace it, and validate proper circuit operation.

E5-20. The following circuit files have faults in them. Study the combi-
national logic circuit operation in Example 5-9 before attempting to find
the faults.

(a) AND-OR-invert_t-shoot_c (b) AND-OR-invert_t-shoot_d
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(1) The circuit should operate the same as Example 5-9 in Figure 5-28(a),
which reduces to X = AB. Test the logic operation by exercising all
combinations for A, B, and C by pressing each of those keys on your
keyboard.

(2) What problems do you observe?

(3) Use the Logic Probe indicator to determine which gate is not operating
properly. Which gate is bad?

(4) Delete the bad gate, replace it, and validate proper circuit operation.

T ES-21. The following circuit files have faults in them. Study the combina-
tional logic circuit operation in Example 5—13 before attempting to find the
faults.

(a) NAND-NOR_t-shoot_a (b) NAND-NOR_t-shoot_b

(1) The circuit should operate the same as Example 5-13 in Figure 5-44,
which reduces to X = B C. Test the logic operation by exercising all
combinations for A, B, and C by pressing each of those keys on your
keyboard.

(2) What problems do you observe?

(3) Use the Logic Probe indicator to determine which gate is not operating
properly. Which gate is bad?

(4) Delete the bad gate, replace it, and validate proper circuit operation.

T E5-22. The following circuit files have faults in them. Study the combina-
tional logic circuit operation in Example 5—15 before attempting to find the
faults.

(a) NAND-NOR_t-shoot_c (b) NAND-NOR_t-shoot_d

(1) The circuit should operate the same as Example 5-15 in Figure 5-49,
which reduces to X = AB + AC + BC. Test the logic operation by ex-
ercising all combinations for A, B, and C by pressing each of those
keys on your keyboard.

(2) What problems do you observe?

(3) Use the Logic Probe indicator to determine which gate is not operating
properly. Which gate is bad?

(4) Delete the bad gate, replace it, and validate proper circuit operation.

CT E5-23. Load the circuit file for Section 5—4i. The 7400 shown is a quad
NAND.
(a) If no other ICs are available, how many gates on the 7400 are required
to implement the equation X = A'B?
(b) One of the gates on this 7400 is bad. Use the Logic Analyzer to deter-
mine which one.

(c) With the three remaining good gates, connect the circuit for X = A’'B.
Route its output to the Logic Analyzer to check its operation.
(X =1ifA=0ANDB = 1).

T ES5-24. Load the circuit file for Section 5-4j. The 7400 shown is a quad

NAND.

(a) On a separate piece of paper write the Boolean equation for the circuit
shown.

(b) Simplify the equation.

(¢) Use the Logic Analyzer to observe the waveforms. Are they what you
expect? If not, troubleshoot the circuit using the Logic Analyzer.

(d) Is one of the gates bad? Substitute gate-4 for the bad gate and retest the
circuit.
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EEEEEE FPGA Problems |

The following problems are solved using the Altera Quartus® II software. In each
case the design is completed by building a block design file (bdf) or a VHDL file
(vhd) and then proving the results by producing a simulation (vwf) file. [Note: If you
build a vhd file having the same name as the bdf file there will be a conflict. You
must first remove the bdf file from the project using steps 38 through 40 in Section
4-4. This will ensure that the compiler uses the current file to synthesize and simu-
late your design. You can use the same simulation (vwf) file for either design
method. The simulation will be performed on whichever project file is currently set.]
Also be sure to complete step 29 in Section 4—4 to perform a functional simulation
without propagation delays.

A final step that can be performed is to download the design to an FPGA on a
programmer board like the Altera DE2 and demonstrate it to your instructor.

Section 5-1

C5-1. Prove that the reduced circuit for the bank alarm in Figure 5-5 is
equivalent to its original in Figure 5—4. Call the output of the original cir-
cuit original and call the output of the reduced circuit reduced.

(a) Enter the logic circuit for the original circuit and for the reduced
circuit in the same block design file called prob_c5_1.bdf. Prove that the
equations produce identical results by building a vector waveform file
called prob_c5_1.vwf that tests all possible input conditions at H, F,

and V.

(b) Enter the logic equation for the original circuit and for the reduced
circuit in the same VHDL file called prob_c5_1.vhd. Prove that the
equations produce identical results by building a vector waveform file
called prob_c5_1.vwf that tests all possible input conditions at H, F,
and V.

(¢) Download your design to an FPGA IC. Discuss your observations of
the alarm LED (reduced) with your instructor as you try various
combinations of the switches representing banking hours (H), vault door
(V), and front door (F).

C5-2. Design the logic to implement the following Boolean equation (do
not reduce):

X =AB + BC + CD

(a) Enter the logic circuit for the equation as a block design file called
prob_c5_2.bdf. Simulate the results of your design by building a vector
waveform file called prob_c5_2.vwf that tests all possible input conditions
atA, B, C, and D.

(b) Enter the logic circuit for the equation as a VHDL file called
prob_c5_2.vhd. Simulate the results of your design by building a vector
waveform file called prob_c5_2.vwf that tests all possible input conditions
atA, B, C, and D.

(c) Download your design to an FPGA IC. Discuss your observations of
the output LED (X) with your instructor as you try various combinations
of the switches representing A, B, C, and D.

C5-3. Repeat problem C5-2 (a), (b), and (c) for the following equation:
Y = ABC + AD + BD
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Section 5-2

C5-4. Ten rules for Boolean reduction were given in Table 5-2. The 10th
rule states that:

1. A+ AB=A + Band
2.A+AB=A+B
(a) Create a block design file (prob_c5_4.bdf) and a vector waveform file

(prob_c5_4.vwf) to prove that both equations in (1) and both equations in
(2) are equivalent.

(b) Create a VHDL file (prob_c5_4.vhd) and a vector waveform file

(prob_c5_4.vwf) to prove that both equations in (1) and both equations in
(2) are equivalent.

Section 5-4

C5-5. Use the Quartus® II software to determine the simplified form of
the following Boolean equation:

X = AB(B + ABC)

Enter the circuit design using the Block Editor to create a file called
prob_c5_5.bdf. Determine the simplified equation by using the Netlist
Viewer technique shown in Figure 5-33.

C5-6. Repeat Problem C5-5 for the following equations:
(a) Y= BC(ABC + AB)  (b) Z = A(ABC + BC)

Section 5-5

C5-7. Use the Quartus® II software to determine the simplified form of
the following Boolean equations:

(@ Y=A+ C + BC (b) Z=(A + C) + BC

Enter the circuit design using the VHDL text editor to create a file called
prob_c5_7.vhd. Determine the simplifed equation by using the Netlist
Viewer technique shown in Figure 5-33.

C5-8. Design the logic to implement the circuit in Example 5-13 (do not
reduce):

(a) Enter the logic circuit given in the example as a block design file
called prob_c5_8.bdf. Simulate the results of your design by building a
vector waveform file called prob_c5_8.vwf that tests all possible input
conditions at A, B, and C.

(b) Enter the logic circuit for the equation as a VHDL file called
prob_c5_8.vhd. Simulate the results of your design by building a vector
waveform file called prob_c5_8.vwf that tests all possible input conditions
at A, B, and C.

(¢) Download your design to an FPGA IC. Discuss your observations of
the output LED (X) with your instructor as you try various combinations
of the switches representing A, B, and C.

C5-9. Repeat problem C5-8 (a), (b), and (c¢) for Example 5-14.

C5-10. Design the logic using the VHDL text editor to implement the
following Boolean equations:

(@) X=ABA+B) (b)Y=A+B+AB (¢) Z=AB+ A+ B
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Enter all three equations in the same architecture section of the program
(prob_c5_10.vhd). Determine which two of those equations yield equiva-
lent outputs by studying their waveforms in the vector waveform file
(prob_c5_10.vwf).

C5-11. A chemical processing plant has four HIGH/LOW sensors on each
of its chemical tanks. [Temperature (T), Pressure (P), Fluid Level (L), and
Weight (W)]. Several different combinations of sensor levels need to be
constantly monitored. Design an FPGA solution using a VHDL program
(prob_c5_11.vhd) that will tell the circuit to turn on any of the three indi-
cator lights [Emergency (E), Warning (W), or Check (C)] if the listed con-
ditions are met:
1. (Emer) Emergency: Shut down and drain system if any of the follow-
ing exists:
(a) High T with high P with low W
(b) High T with high P with low L
(c) High T with low P with (low W or low L)
2. (Warn) Warning: Check controls and perform corrections if any of the
following exists:
(a) High P with high L with low W
(b) High P with high W with low L
(c) High P with low L with low T
3. (Chec) Check: Read gauges and report if any of the following exists:
(a) Any two levels are high (b) Any time W is high

Build a vector waveform file (prob_c5_11.vwf) to simulate the operation
of all three indicator lights and then download the program to an FPGA to
demonstrate its complete operation to your instructor.

C5-12. Quartus® II provides active-LOW input, active-LOW output gates
called BNAND2 and BNOR?2 in the primitive symbols library of the Block
Editor. Use those gates in a block design file (prob_c5_12.bdf) to imple-
ment the microprocessor memory gating scheme presented in Figure 5-60.
Exercise the design by creating a vector waveform file (prob_c5_12.vwf)
that illustrates the following sequence of events:

(a) Read from memory (d) Wait

(b) Wait (all control signals HIGH) (e) Repeat (a)—(d) once again
(c) Write to memory

[Hint: Specialized (nonrepetitive) control waveforms can be created by
highlighting areas of a waveform and selecting a HIGH level or LOW
level from the left side menu.] After a successful simulation, download
the design to an FPGA and discuss your observations with your instruc-

tor as you physically simulate read/write operations with the on-board
switches.

C5-13. Create a block design file (prob_c5_13.bdf) using BNAND and
BNOR gates to implement the computer disk drive controller explained in
Problem 5-30. Exercise the design by creating a vector waveform file
(prob_c5_13.vwf) that illustrates the following sequence of events:

(a) Read from disk A (d) Wait
(b) Wait (all control signals HIGH) (e) Repeat (a)—(d) once again
(¢) Write to disk drive B

[Hint: Specialized (nonrepetitive) control waveforms can be created by
highlighting areas of a waveform and selecting a HIGH level or LOW level
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from the left side menu.] After a successful simulation, download the de-
sign to an FPGA and discuss your observations with your instructor as you
physically simulate read/write operations with the on-board switches.

Section 5-6

(C5-14. Design a logic circuit using VHDL (prob_c5_14.vhd) that can be
used to tell when a 4-bit binary number is odd and within the range of 6
(0110,) to 14 (1110,) inclusive. Use the VHDL selected signal assignment
method shown in Example 5-22. Perform a simulation of your design by
creating a vector waveform file (prob_c5_I14.vwf) that steps through the
entire range of input possibilities 0000, to 1111,. After a successful simu-
lation, download the design to an FPGA and discuss your observations
with your instructor as you physically count through all possibilities on the
on-board switches.

C5-15. A water reclamation plant needs to have a warning system to mon-
itor an overflow condition in its four chemical holding tanks. Each tank has
a HIGH/LOW level sensor. The tanks are labeled T3, T2, T1, and TO.
Design a system that activates a warning alarm whenever the two odd-num-
bered tanks (T3 and T1) are both HIGH or whenever the two even-num-
bered tanks (T2 and TO) are both HIGH. Write a VHDL program
(prob_c5_15.vhd) that groups the tanks together as a vector and uses the
selected signal assignment similar to the one used in Example 5-23.
Perform a simulation of your design by creating a vector waveform file
(prob_c5_15 vwf) that steps through the entire range of input possibilities
0000, to 1111,. After a successful simulation, download the design to an
FPGA and discuss your observations with your instructor as you physically
test all possibilities on the on-board switches.

Answers to Review Questions

5-1. (a) 2 (b) 3 (c) 4 5-10. NAND
5-2. (a) Associative law of addition 5-11. Because by utilizing a combi-
(b) Commutative law of nation of these gates, all other
multiplication gates can be formed
(¢) Distributive law 5-12. Because in designing a circuit
5-3. True you may have extra NAND
o gates available and can avoid
5-4. False using extra ICs
5-5. False 5-13. 4
5-6. (a) A+ B (b) B+ C 5-14. SOP
5-7. Because it enables you to 5-15. SOP
convert an expression having 5-16. They must be connected to
an inversion bar over more ground.
than one variable into an
. o . 5-17. True
expression with inversion bars
over single variables only 5-18. False
5-8. AND 5-19. False
5-9. NOR 5-20. One group of 8

ANSWERS TO REVIEW QUESTIONS
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Exclusive-OR and
Exclusive-NOR Gates

OUTLINE

6-1 The Exclusive-OR Gate

6-2 The Exclusive-NOR Gate

6-3 Parity Generator/Checker

6-4 System Design Applications

6-5 FPGA Design Applications with VHDL

OBJECTIVES

Upon completion of this chapter, you should be able to:

* Describe the operation and use of exclusive-OR and exclusive-NOR gates.

e Construct truth tables and draw timing diagrams for exclusive-OR and exclusive-
NOR gates.

* Simplify combinational logic circuits containing exclusive-OR and exclusive-
NOR gates.

* Design odd- and even-parity generator and checker systems.

» Explain the operation of a binary comparator and a controlled inverter.

e Implement circuits in FPGA ICs using VHDL.

INTRODUCTION

We have seen in the previous chapters that by using various combinations of the basic
gates, we can form almost any logic function that we need. Often, a particular combi-
nation of logic gates provides a function that is especially useful for a wide variety of
tasks. The AOI discussed in Chapter 5 is one such circuit. In this chapter, we learn
about and design systems using two new combinational logic gates: the exclusive-OR
and the exclusive-NOR.



6-1  The Exclusive-OR Gate

Remember, a two-input OR gate provides a HIGH output if one input or the other in-
put is HIGH or if both inputs are HIGH. The exclusive-OR, however, provides a
HIGH output if one input or the other input is HIGH, but not both. This point is made
more clear by comparing the truth tables for a two-input OR gate versus an exclusive-
OR gate, as shown in Table 6-1.

TABLE 6-1 | Truth Tables for an OR Gate versus an
Exclusive-OR Gate
A B X A B X
0 0 0 0 0 0
0 1 1 0 1 1
1 0 1 1 0 1
1 1 1 1 1 0
(OR) (Exclusive-OR)

The Boolean equation for the Ex-OR function is written X = AB + AB and can
be constructed using the combinational logic shown in Figure 6-1. By experimenting
and using Boolean reduction, we can find several other combinations of the basic gates
that provide the Ex-OR function. For example, the combination of AND, OR, and
NAND gates shown in Figure 6-2 will reduce to the “one or the other but not both”
(Ex-OR) function.

X =AB + AB

—] >0
o

B AB

Figure 6-1 Logic circuit for providing the exclusive-OR function.
A B
e

Figure 6-2 Exclusive-OR built with an AND-OR-NAND combination.

X=AB(A +B)
X=@A+B)YA+B)

X =AA +AB + BA + BB
X =AB + AB

)

The exclusive-OR gate is common enough to deserve its own logic symbol and
equation, as shown in Figure 6-3. (Note the shorthand method of writing the Boolean
equation is to use a plus sign with a circle around it.)

A o
p )D—X:A@B:ABH‘B

Figure 6-3 Logic symbol and equation for the exclusive-OR.

N

Helpful
Hint

&

The 741.S86 and
74L.S266 are commonly
used EX-OR ICs. See
Appendix A for
datasheet download
Web sites.
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6-2 The Exclusive-NOR Gate

The exclusive-NOR is the complement of the exclusive-OR. A comparison of the truth
tables in Table 6-2 illustrates this point.

TABLE 6-2 | Truth Tables of the Exclusive-NOR
versus the Exclusive-OR

X =AB + AB X = AB + AB
A B X A B X
0 0 U 0 0 0
et R I A R IRt
(1 1 1) 1 1 0
Exclusive-NOR Exclusive-OR

The truth table for the Ex-NOR shows a HIGH output for both inputs LOW
or both inputs HIGH. The Ex-NOR is sometimes called the equality gate because both
inputs must be equal to get a HIGH output. The basic logic circuit and symbol for the
Ex-NOR are shown in Figure 6—4.

X =AB + AB

A - L
5 )DO—X=A®B=AB+AB

Figure 6-4 Exclusive-NOR logic circuit and logic symbol.

Summary

The exclusive-OR and exclusive-NOR gates are two-input logic gates that provide a
very important, commonly used function that we will see in upcoming examples.
Basically, the gates operate as follows:

The exclusive-OR gate provides a HIGH output for one or the other inputs
HIGH, but not both (X = AB + AB).

The exclusive-NOR gate provides a HIGH output for both inputs HIGH or both
inputs LOW (X = AB + A B).

Also, the Ex-OR and Ex-NOR gates are available in both TTL and CMOS IC
packages. For example, the 7486 is a TTL quad Ex-OR and the 4077 is a CMOS quad
Ex-NOR.
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EXAMPLE 6-1

Determine for each circuit shown in Figure 6-5 if its output provides the

Ex-OR function, the Ex-NOR function, or neither.

B

0

(a)

0

(b)

(©)
Figure 6-5

Solution:
(a) X = (A + BAB
=A+ B+ AB
=AB + AB < Ex-NOR
(b) Y=A + BAB
—A+ B+ AB
=A+ B+ AB
= A+ B(l + A)
= A + B < neither (OR function)
(c) Z=AB+ A+ B
=ABA + B
= (A + B)A + B)
= AB + AA + BA + BB
= AB + AB <« Ex-OR

SECTION 6-2 | THE EXCLUSIVE-NOR GATE
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EXAMPLE 6-2

Write the Boolean equation for the circuit shown in Figure 6—6 and simplify.

2—_)D—L
el

e

Figure 6-6

Solution:
X =(AB + AB)A + B
= (AB + AB)AB
= ABAB + AB AB
= AB

EXAMPLE 6-3

Write the Boolean equation for the circuit shown in Figure 6-7 and simplify.

Figure 6-7
Solution: Hint:
X =ABB + C) + ABB + O) X = IN,IN, + IN,IN,

=((A+ BB+ C)+ABBC
= AB + AC + BB + BC
= AB + AC + BC

Review Questions
6-1. The exclusive-OR gate is the complement (or inverse) of the OR gate.
True or false?

6-2. The exclusive-OR gate is the complement of the exclusive-NOR gate.
True or false?

6-3. Write the Boolean equation for an exclusive-NOR gate.
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6-3 Parity Generator/Checker

Now let’s look at some digital systems that use the Ex-OR and Ex-NOR gates. We start
by studying the parity generator.

In the transmission of binary information from one digital device to another, it
is possible for external electrical noise or other disturbances to cause an error in the
digital signal. For example, if a 4-bit digital system is transmitting a BCD 5 (0101),
electrical noise present on the line during the transmission of the LSB may change a
1 to a 0. If so, the receiving device on the other end of the transmission line would
receive a BCD 4 (0100), which is wrong. If a parity system is used, this error would be
recognized, and the receiving device would signal an error condition or ask the trans-
mitting device to retransmit.

Parity systems are defined as either odd parity or even parity. The parity system
adds an extra bit to the digital information being transmitted. A 4-bit system will require
a fifth bit, an 8-bit system will require a ninth bit, and so on.

In a 4-bit system such as BCD or hexadecimal, the fifth bit is the parity bit and
will be a 1 or 0, depending on what the other 4 bits are. In an odd-parity system, the
parity bit that is added must make the sum of all 5 bits odd. In an even-parity system,
the parity bit makes the sum of all 5 bits even.

The parity generator is the circuit that creates the parity bit. On the receiving end,
a parity checker determines if the 5-bit result is of the right parity. The type of system
(odd or even) must be agreed on beforehand so that the parity checker knows what to
look for (this is called protocol). Also, the parity bit can be placed next to the MSB or
LSB as long as the device on the receiving end knows which bit is parity and which bits
are data.

Let’s look at the example of transmitting the BCD number 5 (0101) in an odd-
parity system.

As shown in Figure 6-8, the transmitting device puts a 0101 on the BCD lines.
The parity generator puts a 1 on the parity-bit line, making the sum of the bits odd
(0O+ 1+ 0+ 1+ 1= 3). The parity checker at the receiving end checks to see that
the 5 bits are odd and, if so, assumes that the BCD information is valid.

B B
1 1
C 0 0 C
1 1
D : D
S (Parity bit) -L- ]
. Parity ] Parity | Error
' generator checker ! indicator
Transmitting Receiving
device device

Figure 6-8 Odd-parity generator/checker system.

If, however, the data in the LSB were changed due to electrical noise somewhere
in the transmission cable, the parity checker would detect that an even-parity number
was received and would signal an error condition on the error indicator output.

This scheme detects only errors that occur to 1 bit. If 2 bits were changed, the
parity checker would think everything is okay. However, the likelihood of 2 bits being
affected is highly unusual. An error occurring to even 1 bit is unusual.

SECTION 6-3 | PARITY GENERATOR/CHECKER
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> Helpful
Hint

Typically, the error

indicator is actually a

signal that initiates a
retransmission of the

original signal or produces

an error message on a
computer display.
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EXAMPLE 6-4

Add a parity bit next to the LSB of the following hexadecimal codes to
form even parity: 0111, 1101, 1010, 1111, 1000, 0000.

Solution:

01111
11011
10100
11110
10001
00000

(. parity bit

The parity generator and checker can be constructed from exclusive-OR gates.
Figure 6-9 shows the connections to form a 4-bit even- and a 4-bit odd-parity genera-
tor. The odd-parity generator has the BCD number 5 (0101) at its inputs. If you follow
the logic through with these bits, you will see that the parity bit will be a 1, just as we
want. Try some different 4-bit numbers at the inputs to both the even- and odd-parity
generators to prove to yourself that they work properly. Computer systems generally
transmit 8 or 16 bits of parallel data at a time. An 8-bit even-parity generator can be
constructed by adding more gates, as shown in Figure 6—10.

A parity checker is constructed in the same way as the parity generator, except
that in a 4-bit system, there must be five inputs (including the parity bit), and the out-
put is used as the error indicator (1 = error condition). Figure 6—11 shows a 5-bit
even-parity checker. The BCD 6 with even parity is input. Follow the logic through the
diagram to prove to yourself that the output will be 0, meaning “no error.”

23 22 21 20 23 22 21 20
Ll Ll ey
\ The number
1 1 of I'sin
the input
plus parity
is odd.
1
Parity bit Parity bit= 1
(even) (odd)

Figure 6-9 Even- and odd-parity generators.

IC Parity Generator/Checker

You may have guessed by now that parity generator and checker circuits are available
in single IC packages. One popular 9-bit parity generator/checker is the 74280 TTL IC
(or 74HC280 CMOS IC). The logic symbol and function table for the 74280 are given
in Figure 6-12.
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27 26 25 24 23 22 21 20

Ll

Parity bit
(even)

Figure 6-10 Eight-bit even-parity generator.

Parity
bit 23 22 21 20

0 UI Uo

0

Error indicator
(0 =no error 1 = error)

Figure 6-11 Five-bit even-parity checker.

8 9 10 11 12 13 1 2 4
Iy Iy L I Iy Is I I; Iy Function table
Number of HIGH Sum Output
data inputs (/;—Ig) o DI
Even HIGH LOW <«
XE 20 Odd LOW HIGH
5 6
Vee =Pin 14
GND =Pin7

o =LOW if
Ig+ 1+ -+ 13
=Even

Figure 6-12 Logic symbol and function table for the 74280 9-bit parity generator/checker.

Q Inside
Your PC

One of the most prevalent
uses of parity is in the main
RAM memory in a PC.
Many systems use a 9-bit
memory scheme (8 bits
data, with 1 parity bit). The
extra bits add one-ninth to
the cost of the memory, and
parity checking slightly
increases the memory
access time. However, it is
well worth the expense to
ensure data integrity.



> | Common
Misconception

Students often have a hard
time understanding why
we use the sum-odd ()
output in an even system.
The key to understanding
that reasoning is found in
the function table for the
74280 in Figure 6-12.

The 74280 has nine inputs. If used as a parity checker, the first eight inputs would
be the data input, and the ninth would be the parity-bit input. If your system is looking
for even parity, the sum of the nine inputs should be even, which will produce a HIGH
at the = output and a LOW at the =, output.

6-4  System Design Applications

EXAMPLE 6-5
Parity Error-Detection System

Using 74280s, design a complete parity generator/checking system. It is to
be used in an 8-bit, even-parity computer configuration.

Solution: Parity generator: Because the 74280 has nine inputs, we have to
connect the unused ninth input (/) to ground (0) so that it will not affect
our result. The 8-bit input data are connected to I, through 7.

Now, the generator sums bits /, through I; and puts out a LOW on X, and
a HIGH on X if the sum is even. Therefore, the parity bit generated should
be taken from the X, output because we want the sum of all 9 bits sent to
the receiving device to be even.

Farity checker: The checker will receive all 9 bits and check if their sum
is even. If their sum is even, the X5 line goes HIGH. We will use the 2,
output because it will be LOW for “no error” and HIGH for “error.” The
complete circuit design is shown in Figure 6-13.

9-Bit
transmission
cable
8-Bit 1 8-Bit
digital : digital
computer : ; receiver
—1 1o —1 1o
— 1, . —1 [ s
I E I E
I I
3 J Parity 3
Iy 74280 Xo bit Iy 74280 Zo—>
Error indicator
Is Is ( 1 = error )
I Ig 0 = no error
I; I;
Iy Iy

244

Figure 6-13 Complete 8-bit even-parity error-detection system.
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EXAMPLE 6-6

Parallel Binary Comparator

Team

4-bit binary string A to the 4-bit binary string B. If the strings are exactly - .
Discussion

Design a system—called a parallel binary comparator—that compares the E
equal, provide a HIGH-level output to drive a warning buzzer.

. . . . Test bble-pushi
Solution: Using four exclusive-NOR gates, we can compare string A to st your bubble-pushing

. . . . ; . kills by determini
string B, bit by bit. Remember, if both inputs to an exclusive-NOR are the ivlia: thye :;]r)n;lt:ng
same (0—0 or 1—1), it outputs a 1. If all four Ex-NOR gates are outputting must be converted to
a 1, the 4 bits of string A must match the 4 bits of string B. The complete if Ex-ORs were used
circuit design is shown in Figure 6—-14. instead of Ex-NORs.

B Ay, _—— Each Ex-NOR
Binary 4, ‘)Doi checks for
string A 1 equality.

A 2 B

As
; A

B, — Warning
A, . — / buzzer
By )Do— 1ifA=B

Binary B, B, 0ifA+#B
string
B B, A

Figure 6-14 Binary comparator system.

EXAMPLE 6-7
Controlled Inverter

Often in binary arithmetic circuits, we need to have a device that comple-
ments an entire binary string when told to do so by some control signal.
Design an 8-bit controlled inverter (complementing) circuit. The circuit
will receive a control signal that, if HIGH, causes the circuit to complement
the 8-bit string and, if LOW, does not.

Solution: The circuit shown in Figure 6-15 can be used to provide the
complementing function. If the control signal (C) is HIGH, each of the in-
put data bits is complemented at the output. If the control signal is LOW,
the data bits pass through to the output uncomplemented. Two 7486 quad
exclusive-OR ICs could be used to implement this design.
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Dy — T
8-Bit D, p 3 .Controlled output
input e I Xy, ¢ HC=1,Xg7=Dy4
Ds :>D—'7X iC=0,Xy7=Dyr
4 5
D,
- X

—>—
Complementing 1

control signal
©)

Figure 6-15 Controlled inverter (complementing) circuit.

CONTROLLED INVERTER SIMULATION

Figure 6-16 shows a MultiSIM® simulation of a 4-bit controlled inverter.
Indictor probes are used to show logic levels on the inputs and outputs. In
this illustration, the binary string 0001 is hard wired to the D3—D,—D—D,

——gfg O
O e Y

Q -’—)EORZ ﬁ

U3

Q - EOR2 ﬁ

_Vec D,
5V ; 0 ’ U4
Control signal \ X3
(press space) )Di
7
EOR2
———O

- &
figs 16

Figure 6-16 Using MultiSIM® to simulate a controlled inverter.

246 CHAPTER 6 | EXCLUSIVE-OR AND EXCLUSIVE-NOR GATES



inputs. With the switch in the UP position, 5 V (‘1°) is applied as the control
signal, so all four inputs are complemented as shown.

MultiSIM Exercise:

(a) Load the file fig6_16 from the textbook companion website. Run the
simulation and press the space bar to move the control signal switch to
the 0 position. Press it again to return to the 1 position. Which position
creates the complement signal at the output?

(b) Reconstruct the circuit using ex-NORs instead of ex-ORs. What must
the level of the control signal be to create the complement at the output?
Why?

Review Questions

6—4. An odd parity generator produces a 1 if the sum of its inputs is odd.
True or false?

6-5. In an 8-bit parallel transmission system, if one or two of the bits are
changed due to electrical noise, the parity checker will detect the error.
True or false?

6—6. Which output of the 74280 parity generator is used as the parity bit in
an odd system?

6-7. If all nine inputs to a 74280 are HIGH, the output at 2y will be
(HIGH, LOW)?

6-5 FPGA Design Applications with VHDL

In this section we will design circuits related to Ex-ORs and Ex-NORs by building
graphic design files and VHDL programs. Several new concepts related to FPGAs will
be introduced, including the use of 7400-series macro-functions, grouping nodes into
a common bus, changing a group’s radix, and creating a VHDL Process Statement
and For Loop.

Example 6-8 examines the characteristics of odd and even parity by using the
predefined macro-function for the 74280 parity generator. Examples 6-8, 6-9, and
6—10 will group common inputs and outputs together as a bus. These groups can be
displayed in the Waveform Editor in any of four different radixes: bin, hex, oct, or dec.
Example 6-10 introduces the concept of using loops in VHDL to perform repetitive
operations.

EXAMPLE 6-8

The 74280 Parity Generator Using an Input
Bus Configuration

Demonstrate the operation of the 74280 parity generator by building a
Block Diagram File (bdf) and a Vector Waveform File (vwf). While creating
the bdf file, when in the enter symbol mode, type: 74280b. [The Quartus®
symbol library provides the original 74280 having discrete inputs (scalar
configuration) and the 74280b which groups the inputs together as a bus
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(vector configuration)]. Generate a binary count on the 9-bit bus input so
that several combinations of odd and even parity will be observed in the
wwf file.

Solution: The ex6_8.bdf file is shown in Figure 6-17. The 9-bit input is
configured as a bus by specifying the name as D/[8..0]. This way, when the
connection line is drawn from the pinstub to the 74280b, it will be a bus
line as signified by its thickness.

i ex6_s.bdf 1 -0 x|

i 742800 i
e DD LUTEUT M Sum_odd

P 0.0 BUT ¢ .

(0.0 D_IE}QQ — Da.0] EERM DUTRUT  ——, Sum_gwen

i | e PARITY GEN SR SR S

Figure 6-17 The block design file for Example 6-8.

Figure 6-18 shows the simulation report for the ex6_8.vwf file. The
D-input waveform is set up as a counter by right-clicking on D and choosing:
Value > Count Value > Radix > Binary > Timing > Count Every
1 ms > OK. The two output waveforms prove the operation of the 74280
as specified in Figure 6-12. The Sum_even goes HIGH whenever the sum
of the HIGH input bits is even. The Sum_odd goes HIGH whenever the
sum of the HIGH input bits is odd.

£ pxf_ 8 Simulation Report

Simulation Waveforms
tazter Time Bar: 0 pz 1| +| Painter: 0 pz [nteral; | 0 pz Start; | 0 pz

[ pz 2.E|I Lz 4.E|I Lz E.EII Lz E.EII Lz 'IEI.!:I Lz 12.!]

Name Walue ..
0 pz 33
D B 000... | f 000000000 0000000071 3 00000001 0° 000000011 0000001 00 00000071 01 ::(]

Sum_geven B1
Sum_odd B0

Choose Binary Radix to show 14 and Os. @ ex6_8.vwf

Figure 6-18 The vector waveform file for Example 6-8.

CE |
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EXAMPLE 6-9
FPGA Parallel Binary Comparator

Reproduce the parallel binary comparator of Example 66 using Quartus®
II software tools. Complete the circuit using both design entry methods: bdf
and VHDL. Test its operation by building a vwf file that inputs several 4-bit
input combinations at A/3..0] and B/3..0]. (Make some equal and some not.)

Solution: The block design method (ex6_9.bdf) is shown in Figure 6-19.
All four bits of the A-string are grouped together as a common bus A/3..0].

& ex6_9.bdf

Figure 6-19 The block design file for Example 6-9.

The same with B[3..0]. To get the inputs labeled correctly for the
compiler, right-click on the line leaving the pinstubs and choose Bus Line.
Right-click on each line entering a gate and choose Node Line. Right click
on each node line, choose properties and provide a Node Name as shown.

The simulation file (ex6_9.vwf) is shown in Figure 6-20. The A and B
inputs were initially set up as counters with a hexadecimal radix. Then several

£ exb_9 Simulation Reporkt - |EI|£|

Simulation Waveforms
td azter Time Bar: 0p= 1| | Painter: 0 p= [nteral; | 0 pz Start; | 0 pz End: | 16.0 us

[ pz 4.0 usz 2.0 us 12.0us 16.0 uz
N Walue at 1 . :
arne 0ze 53
o A HO D% 1 42434435 B 7 8 9 A BACADYENF
o B Ha AR FREREREDERED LD ER TN ER I AD ED 4
(o 3 W B1 | [ |
B2A 4 4 A 4
@ ex6_9.vwf

Figure 6-20 The simulation file for Example 6-9.
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of the B values were changed to force inequality. To do this, high-light the
hex number that you wish to change, then right-click on it and choose:
Value > Arbitrary Value, then enter a new number and press OK. The
proof that the circuit works can be seen by noting that the output at W goes
HIGH whenever the A-bits equal the B-bits.

The VHDL design entry method (ex6_9.vhd) is shown in Figure 6-21.
The results of this design must also be tested by recompiling the project
using the vid file and performing a simulation.

(Note: Be sure that the simulation is being performed on the VHDL
design by following steps 38 through 40 in Section 4-4.)

=

LEHRPRY Tepez = = 0z 0 06— A
USE ieee.std logic 1164 .ALL; -- Parallel Binary -- [
-— Comparator =
EREEEY e 2 3 2 =020 A
PORT(
a IHM std_logic_vector {3 DOWNTD 8);

b : IM std logic_vector {3 DOWHTO 8);

u 0UT std logic);
END exb_9 ;
exf_3
ARCHITECTURE arc OF exd 9 IS et 3[3,.0] w —3
BEGIN et b[3..0]
w<={a{@) XHOR b{@)) AND (a{1) XHOR b{1)) AKD
(af2) SHOR b({2)) AND (a{3) SHOR b{3)); inst
EMD arc; @ )
ex6_9.vhd -
[Line 15 [Col 1 TINS ¢ | L'J

Describes the circuit of Figure 6-19

(@
Figure 6-21 Solution to Example 6-9: (a) VHDL listing; (b) block symbol file (bsf).

EXAMPLE 6-10

FPGA Controlled Inverter

Reproduce the controlled inverter of Example 67 using Quartus® II soft-
ware tools. Complete the circuit using both design entry methods: bdf and
VHDL. Test its operation by building a vwf file that inputs a count on the
data input d/3..0] while the control input, ¢, randomly goes LOW then
HIGH to complement the bits.

Solution: The ex6_10.bdf file is shown in Figure 6-22. Note that the data
inputs d/3..0] and the controlled output x/3..0] are grouped together as a
bus for simplicity.

The simulation file (ex6_10.vwf) is shown in Figure 6-23. Notice that
when the complementing control signal ¢ is LOW, the data bits are passed
out to x uncomplemented, but when ¢ is HIGH, the data bits at x are com-
plemented.

The VHDL design entry method (ex6_10.vhd ) is shown in Figure 6-24.
This is our first introduction to sequential process loops. The loop control
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B ex6_10.bdf

Figure 6-22 The block design file for Example 6-10.

£ ey 10 Simulation Repork - | I:Ilil
Simulation Waveforms

b azter Time Bar: 0 pz 1| v Painter: 0 ps Intersval: | 0 ps Start; | End: |

1 pz 4.0 uz 8.0u= 1200z 16.0 Lig
N Walue at i i ]
ame I:l ps =
]
c BDO [ I |

USIE

d B 0000 0000 3 0001 % 00O 0001 % 0100y 0101 % 0110y 0111
] B 0000 0000 % 0001 % 1107 3 1100 3 0100 % 0101 3 1001 3 1000

@ ex6_10.vwf
J

J

Note: x =d

Figure 6-23 The simulation file for Example 6-10.

is useful whenever you need to perform repetitive operations or assignments.
In this case we are XORing each data bit input with the complementing
control signal to assign each x output. This is considered to be a sequential
operation. This means that when executing the program, x(3) is assigned
before x(2), and x(2) is assigned before x(/), and so on. If, instead of using
the process loop, we assigned each output with separate statements we
would be making concurrent assignments. This way, x(3) will receive its
logic level concurrently (at the same time) with x(2), x(1), and x(0). The
concurrent assignments would be made using the following program seg-
ment in place of the process loop:

x(3)< = d(3) XOR c;
x(2)< = d(2) XOR c;
x(1)< = d(1) XOR c;
x(0)< = d(0) XOR c;
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CESTTE— _inix

LIBRARY ieee: = 0@@—mmmmm (=
UZE ieee.std logic 1164.ALL; —-- Controlled Inwverter —--
—-— using a FOR LOOP -
ENTITY exf_10 IS —— within a PROCESS ——
PORT, e
o ! IN =td logic:
d : IN =std logic wvector (3 DOUNTO O)
x : OUT =td logie wector (3 DOWNTO O));
END ex6 10;

LRCHITECTURE arc OF ex6_10 I3

BEEGIN
FPROCESS (c,d)
EEGIN
FOR i IN 3 DOWNTS O LOOP Loop 4 times BT
®ii)<=d{i) HOR e fori=3,2,1then0 —
END LOCP MmO x[3.0]
END PROCESS; —c
END arc;
in=t

@ ex6_10.vhd il
(| | vl 4

S~ Sequential process

(a)

Figure 6-24 Solution to Example 6-10: (a) VHDL listing; (b) block symbol
file (bsf).

In this program either method works just as well, but as we will
learn, sequential statements will play a much more important role when we
design sequential circuits like counters and shift registers in Chapters 12
and 13.

B Summary

In this chapter, we have learned that

1. The exclusive-OR gate outputs a HIGH if one or the other inputs, but
not both, is HIGH.

2. The exclusive-NOR gate outputs a HIGH if both inputs are HIGH or if
both inputs are LOW.

3. A parity bit is commonly used for error detection during the transmis-
sion of digital signals.

4. Exclusive-OR and NOR gates are used in applications such as parity
checking, binary comparison, and controlled complementing circuits.

5. FPGAs can be used to implement circuits containing the exclusive gates.
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Glossary
Binary String: Two or more binary bits used collectively to form a meaningful binary
representation.
Bus: A group of inputs or outputs having a common use such as bits in a binary string.
Comparator: A device or system that identifies an equality between two quantities.

Concurrent: In VHDL, concurrent statements are those that are all executed at the
same time in the synthesized circuit.

Controlled Inverter: A digital circuit capable of complementing a binary string of
bits based on an external control signal.

Electrical Noise: Unwanted electrical irregularities that can cause a change in a digital
logic level.

Error Indicator: A visual display or digital signal that is used to signify that an error
has occurred within a digital system.

Exclusive-NOR: A gate that produces a HIGH output for both inputs HIGH or both
inputs LOW.

Exclusive-OR: A gate that produces a HIGH output for one or the other input HIGH,
but not both.

For Loop: In VHDL, the For Loop allows the programmer to specify multiple itera-
tions of program statements like assignments or circuit definitions.

Function Table: A chart that illustrates the input/output operating characteristics of
an integrated circuit.

Group: Inputs or outputs having common characteristics such as bits in a binary
string that can be put together as a “Group” and referred to as a single
name.

Macro-function: A library in the Quartus® II software containing most of the 7400-
series fixed-function logic.

Parity: An error-detection scheme used to detect a change in the value of a bit.

Process statement: In VHDL, the Process statement is used to declare the beginning
of a series of sequential operations.

Radix: A number system such as: binary, hexadecimal, octal, or decimal.

Sequential: In VHDL, sequential statements are those that are all executed one after
another in the synthesized circuit.

Transmission: The transfer of digital signals from one location to another.

I ProbLem s 1

Sections 6-1 and 6-2

6-1. Describe in words the operation of an exclusive-OR gate and of an
exclusive-NOR gate.

6-2. Describe in words the difference between

(a) An exclusive-OR and an OR gate
(b) An exclusive-NOR and an AND gate
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6-3. Complete the timing diagram in Figure P6-3 for the exclusive-OR
and the exclusive-NOR.

Figure P6-3

6-4. Write the Boolean equations for the circuits in Figure P6—4. Simplify
the equations and determine if they function as an Ex-OR, Ex-NOR, or
neither.

X

|

g}D
(b)
D[R
(d)

Y

(@

;
0

(©)

Figure P6-4
D 6-5. Design an exclusive-OR gate constructed from all NOR gates.
D 6-6. Design an exclusive-NOR gate constructed from all NAND gates.

6-7. Write the Boolean equations for the circuits of Figure P6-7. Reduce
the equations to their simplest form.

- T o
DI}

(

o

) (b)
Figure P6-7

C 6-8. Repeat Problem 6-7 for the circuits of Figure P6-8.
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B{ D@*X c—___|

C

(a) (b)
Figure P6-8

Section 6-3

6-9. Convert the following hexadecimal numbers to their 8-bit binary
code. Add a parity bit next to the LSB to form odd parity.

A7 4C 79 F3 00 FF

6-10. The pin configuration of the 74HC86 CMOS quad exclusive-OR IC
is given in Figure P6-10. Make the external connections to the IC to form
a 4-bit even-parity generator.

Vgt
Vgt

~
a

o= -1~ 1-]
(=]l =)= ]= ==

GND

Figure P6-10

6-11. Repeat Problem 6-10 for a 5-bit even-parity checker. Use the pin
configuration shown in Figure P6-11.

Vgt
Vgt

r\,<
a

GND

1ol -~ 1-]
[=]le === ==

Figure P6-11
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Section 6-4

6-12. Figure P6-12 shows another design used to form a 4-bit parity
generator. Determine if the circuit will function as an odd- or even-parity
generator.

23 22 21 20

|l

Parity
bit

Figure P6-12

CD

CD

CD S

CD S

6-13. Referring to Figure 613, design and sketch a 4-bit odd-parity error-
detection system. Use two 74280 ICs and a five-line transmission cable
between the sending and receiving devices.

6-14. Design a binary comparator system similar to Figure 614 using
exclusive-ORs instead of exclusive-NORs.

6-15. If the exclusive-ORs in Figure 6-15 are replaced by exclusive-
NORs, will the circuit still function as a controlled inverter? If so, should C
be HIGH or LOW to complement?

Schematic Interpretation Problems -

See Appendix G for the schematic diagrams.

6-16. Find Port 1 (P1.7-P1.0) of U8 in the 4096/4196 schematic. On
a separate piece of paper, draw an 8-bit controlled inverter for that
output port. The inverting function is to be controlled by the P3.5 output
(pin 15).

6-17. Find Port 2 (P2.7-P2.0) of U8 in the 4096/4196 schematic. This port
outputs the high-order address bits for the system (A8—A15). (Microcontroller
addresses are discussed further in Chapter 16.) On a separate piece of
paper, draw a binary comparator that compares the 4 bits A8—Al1 to the
4 bits A12-A15. The HIGH output for an equal comparison is to be input
to P3.4 (pin 14) of US.

MultiSIM® Exercises

E6-1. Load the circuit file for Section 6-2a. The switches are used to
input a 1(up) or a O(down) to each gate input. The lamp connected to each
gate output comes ON if the output is HIGH.

(a) What is the level at X and Y if all switches are up? Try it.
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(b) What is the level at X and Y if all switches are down? Try it.
(¢) Experimentally complete a truth table for each gate.

E6-2. Load the circuit file for Section 6-2b. The Logic Analyzer
shows the input waveforms A and B and the output waveforms X and Y.
Gate 1 and Gate 2 are hidden from your view, but each is either an
Ex-OR or an Ex-NOR. Use the Logic Analyzer display to determine the
following:

(a) What is Gate 1, and
(b) What is Gate 2?

T E6-3. Load the circuit file for Section 6—2c. This circuit is used to trou-
bleshoot the number-4 gate of a 7486 Quad Ex-OR IC. Because that gate is
working OK, the Logic Probe will flash.

(a) If the unused input (Pin13) was tied to ground instead of Vcc, would
the Logic Probe still flash? Why? Try it.

(b) Test the remaining three Ex-OR gates on the chip. Are any bad?

E6-4. Load the circuit file for Section 6-2d. Write the Boolean equa-
tion at X. Connect the circuit to the Logic Converter and check your
answer.

E6-5. Load the circuit file for Section 6-2e. Write the simplified Boolean
equation at X. Connect the circuit to the Logic Converter and check your
answer.

E6-6. Load the circuit file for Section 6-2f. Write the simplified Boolean
equation at X. Connect the circuit to the Logic Converter and check your
answer.

E6-7. Load the circuit file for Section 6-3. On a piece of paper, make
up a chart for the even parity bit that would be generated for the binary
count from 0000 to 1111 (0 to 15). Check all 16 of your answers
by pressing “step” on the Word Generator repeatedly as you compare
your parity bit with the Even Parity Light. Note: The number 1 is an odd
number, and the number 2 is even. Why do they both generate an even
parity bit?

D E6-8. Load the circuit file for Section 6—4. This is a Parallel Binary Com-
parator similar to Figure 6-14. Two 4-bit binary strings are provided by the
Word Generator.

(a) What type of Word Generator numbers turn the light ON?
(b) Let’s say that when you go to build the circuit in lab, you can’t find

any Ex-NORs but have four Ex-ORs. To get the same circuit function,
what must the AND gate be changed to? Try it.

I FPGA Problems I

The following problems are solved using the Altera Quartus® II software. In each
case the design is completed by building a block design file (bdf) or a VHDL file
(vhd) and then proving the results by producing a simulation (vwf) file. [Note:
If you build a vhd file having the same name as the bdf file there will be a conflict.
You must first remove the bdf file from the project using steps 38 through 40 in
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Section 4—4. This will ensure that the compiler uses the current file to synthesize
and simulate your design. Also, you can use the same simulation (vwf) file for ei-
ther design method. The simulation will be performed on whichever project file is
currently set.]

A final step that can be performed is to download the design to an FPGA on a pro-
grammer board like the DE2 and demonstrate it to your instructor.

C6-1. Use the macro-function library to test a parity circuit like in Exam-
ple 6-8. Use the 74280 (not the 74280b) to determine the odd/even parity
for several 1-digit hexadecimal numbers.

(a) Build a bdf file called prob_c6_1.bdf using the 74280 macrofunction.
Use a 4-bit group called D/3..0] to provide the hex digit input and include
both the sum_odd and sum_even outputs. Since you will only use four
inputs, just ground (gnd) the five unused bits.

(b) Simulate the operation by entering the following hex digits into
the D[3..0] group of an vwf file named prob_c6_I1.vwf: AF19714C.
(See Example 6-9 for entering specific group numbers into the
waveform.)

(c) Download your design to an FPGA IC. Discuss your observations of
the odd and even LEDs with your instructor as you use the switches to
step through the eight hex inputs.

C6-2. Redesign the binary comparator of Example 6-9 using Ex-ORs
instead of Ex-NORs. Bubble-push the original circuit to determine which
gate is required now instead of the AND.

(a) Build a bdffile (prob_c6_2.bdf) and run a simulation (prob_c6_2.vwf)
of the circuit with some equal, and some unequal, inputs at A/3..0] and
B[3..0].

(b) Build a VHDL file (prob_c6_2.vhd) and run a simulation
(prob_c6_2.vwf) of the circuit with some equal and some unequal inputs
at A/3..0] and B[3..0].

(¢) Download your design to an FPGA IC. Discuss your observations of
the W output LED with your instructor as you use the switches to step
through several combinations of equal and unequal inputs.

C6-3. Redo problem C6-2 (a), (b), and (c) for an 8-bit comparator.

C6-4. Quartus®II provides an 8-bit bus-oriented magnitude comparator
named 8mcompb. It compares an A-string with a B-string and provides
three outputs indicating less-than, greater-than, and equal. Build a
bdf file to exercise this macro-function. Simulate its operation by enter-
ing several 2-digit hex numbers as you monitor all three output wave-
forms.

C6-5. Redo Example 6-10 for an 8-bit controlled inverter.

(a) Build a bdf file and then perform a simulation to observe the invert/
non-invert function.

(b) Build a VHDL file and redo the simulation with the VHDL file set as
the current project.

(¢) Download your design to an FPGA IC. Discuss your observations
of the output LEDs with your instructor as you enter a binary string

on the switches and use a push-button to control the complementing
action.
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Answers to Review Questions

6-1. False 6-5. False
6-2. True 6-6. >;
6-3. X=AB + AB 6-7. LOW
6-4. False
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Arithmetic Operations
and Circuits

OUTLINE

7-1 Binary Arithmetic
7-2 Two’s-Complement Representation
7-3 Two’s-Complement Arithmetic
7-4 Hexadecimal Arithmetic
7-5 BCD Arithmetic
7—-6  Arithmetic Circuits
7-7 Four-Bit Full-Adder ICs
7-8 VHDL Adders Using Integer Arithmetic
7-9 System Design Applications
7-10  Arithmetic/Logic Units
7-11 FPGA Applications with VHDL and LPMs

OBJECTIVES

Upon completion of this chapter, you should be able to:

* Perform the four binary arithmetic functions: addition, subtraction,
multiplication, and division.

* Convert positive and negative numbers to signed two’s-complement notation.

e Perform two’s-complement, hexadecimal, and BCD arithmetic.

* Explain the design and operation of a half-adder and a full-adder circuit.

o Utilize full-adder ICs to implement arithmetic circuits.

» Explain the operation of a two’s-complement adder/subtractor circuit and
a BCD adder circuit.

» Explain the function of an arithmetic/logic unit (ALU).

* Implement arithmetic functions in FPGAs using VHDL.

INTRODUCTION

An important function of digital systems and computers is the execution of arithmetic
operations. In this chapter, we will see that there is no magic in taking the sum of two
numbers electronically. Instead, there is a basic set of logic-circuit building blocks, and
the arithmetic operations follow a step-by-step procedure to arrive at the correct answer.
All the “electronic arithmetic” will be performed using digital input and output levels
with basic combinational logic circuits or medium-scale-integration (MSI) chips.




7-1 Binary Arithmetic

Before studying the actual digital electronic requirements for arithmetic circuits, let’s
look at the procedures for performing the four basic arithmetic functions: addition,
subtraction, multiplication, and division.

Addition

The procedure for adding numbers in binary is similar to adding in decimal, except that
the binary sum is made up of only 1’s and 0’s. When the binary sum exceeds 1, you
must carry a 1 to the next-more-significant column, as in regular decimal addition.
The four possible combinations of adding two binary numbers can be stated as
follows:
0+ 0=20carry0
0+ 1=1carry0
1+0=1carry0
1+ 1=0carryl
The general form of binary addition in the least significant column can be written
Ao + BO = EO + Cout
The sum output is given by the summation symbol (), called sigma, and the

carry-out is given by C,,.. The truth table in Table 7-1 shows the four possible condi-
tions when adding two binary digits.

TABLE 7-1 | Truth Table for Addition of Two
Binary Digits (4, + B,) in the
Least Significant Column

AO B 0 20 Cout
0 0 0 0
0 1 1 0
1 0 1 0
1 1 0 1

If a carry-out is produced, it must be added to the next-more-significant column
as a carry-in (C,,). Figure 7-1 shows this operation and truth table. In the truth table,
the C;, term comes from the value of C,, from the previous addition. Now, with three
possible inputs, there are eight combinations of outputs (2° = 8). Review the truth
table to be sure that you understand how each sum and carry were determined.

¥ PN

¢, G, A | B | Gy Zi | Cou
A, Ao 0 0 0 0 0
0 0 1 1 0
+ B B 0 1 0 1 0
5, %, %, 0| 1 1 0 1
P 1| o o 1| o
CU ut ("‘oul ) 1 0 1 0 1
\ . 1 1 0 0 1
1 1 1 1 1

Figure 7-1 Addition in the more significant columns requires including C;, with A; + B;.
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Now let’s perform some binary additions. We represent all binary numbers in
groups of 8 or 16 because that is the standard used for arithmetic in most digital com-
puters today.

EXAMPLE 7-1

Perform the following decimal additions. Convert the original decimal
numbers to binary and add them. Compare answers. (a) 5 + 2; (b) 8 + 3;
(¢) 18 + 2;(d) 147 + 75;(e) 31 + 7.

Solution:
Decimal Binary
(a) 5 0000 010
+ 2 + 0000 0010
(b) 8 0000 1000
+ 3 + 0000 0011
(c) 18 0001 0010
+ 2 -+ 0000 0010
20 0001 0100 = 20,y
(d) 147 1001 0011
+ 75 + 0100 1011
222 1101 1110 = 222,V
(e) 31 0001 1111
+ 7 + 0000 0111
38 0010 0110 = 38,y
Subtraction

The four possible combinations of subtracting two binary numbers can be stated as
follows:

0 — 0 = Oborrow 0

0 — 1 = 1borrow 1
1 — 0 = 1borrow 0
1 — 1 = 0borrow 0

The general form of binary subtraction in the least significant (L.S) column can be written
Ap — By = Ry t Bouw

The difference, or remainder, from the subtraction is R, and if a borrow is required,
B, is 1. The truth table in Table 7-2 shows the four possible conditions when sub-
tracting two binary digits.

If a borrow is required, the Ay must borrow from A, in the next-more-significant
column. When A, borrows from its left, A increases by 2 (just as in decimal subtraction,
where the number increases by 10). For example, let’s subtract 2 — 1 (10, — 01,).
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TABLE 7-2 | Truth Table for Subtraction of
Two Binary Digits (A, — B) in

the Least Significant Column

AO BO RO Bout
0 0 0 0
0 1 1 1 ¢«— Borrow required
1 0 1 0 because Ay < By
1 1 0 0
Borrow 1
from A,
2
A A, A7B
B By =0 1
_Rl RO O 1

Because A was 0, it borrowed 1 from A;. A| becomes a 0, and Ay becomes 2 (2,
or 10,). Now the subtraction can take place: in the LS column, 2 — 1 = 1, and in the
more significant (MS) column, 0 — 0 = 0.

As you can see, the second column and all more significant columns first have to
determine if A was borrowed from before subtracting A — B. Therefore, they have
three input conditions, for a total of eight different possible combinations, as illustrated
in Figure 7-2.

Bin Bin ; E Al Bl Bin Rl BOU[
A A, ) 0 0 0 Borrow (B,,,) required
_ Bl BO Lo 0 0 1 1 1 <—/ because Bj, needs
! o 0 1 0 1 1 to borrow from
R, Ry 0 1 1 0 1 A, which is zero.
. Lo 1 0 0 1 0
B(Dll‘ out : /: } (l) g) (0) (0)
RESR 1 1 1 1 1

Figure 7-2  Subtraction in the more significant columns requires including B;, with A, B;.

The outputs in the truth table in Figure 7-2 are a little more complicated to fig-
ure out. To help you along, let’s look at the subtraction 4 — 1 (0100, — 0001,):

1
0 22
4 AAA A, 0 170 0
- 110 A3A2A1A0 - O 0 0 1
3,0 R;R.RR, 0 0 1 1 =3

To subtract 0100 — 0001, Ay must borrow from A, but A; is 0. Therefore, A;
must first borrow from A,, making A, a 0. Now A is a 2. A borrows from A;, making
A;alandAja 2. Now we can subtract to get 0011 (3;(). Actually, the process is
very similar to the process you learned many years ago for regular decimal subtrac-
tion. Work through each entry in the truth table (Figure 7-2) to determine how it
was derived.

Fortunately, as we will see in Section 7-2, digital computers use a much easier
method for subtracting binary numbers, called two’s complement. We do, however,

SECTION 7-1 | BINARY ARITHMETIC
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Hint

This table is difficult for

most students. It helps to

remind yourself where B;,

comes from and what

causes B, to be 1.
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need to know the standard method for subtracting binary numbers. Work through the
following example to better familiarize yourself with the binary subtraction procedure.

EXAMPLE 7-2

Perform the following decimal subtractions. Convert the original decimal
numbers to binary and subtract them. Compare answers. (a) 27 — 10;
(b)9 — 4;(c) 172 — 42;(d) 154 — 54; (e) 192 — 3.

Solution:
Decimal Binary
(a) 27 0001 1011
— 10 — 0000 1010
17 0001 0001 = 17,o¢
(b) 9 0000 1001
-4 — 0000 0100
5 0000 0101 = 5,
(c) 172 1010 1100
- 4 — 0010 1010
130 1000 0010 = 130,ov
(d) 154 1001 1010
- 54 — 0011 0110
100 0110 0100 = 100,ov
(e) 192 1100 0000
-_3 — 0000 0011
189 1011 1101 = 189,
Multiplication

Binary multiplication is like decimal multiplication, except you deal only with 1’s and
0’s. Figure 7-3 illustrates the procedure for multiplying 13 X 11.

Decimal Binary
13 0000 1101 (multiplicand)
x 11 x 0000 1011 (multiplier)
13 0000 1101
13 00001 101
143 000000 00
0000110 1
0001000 1111 (product)
8-bit answer = 1000 1111 = 14319 v

Figure 7-3  Binary multiplication procedure.

The procedure for the multiplication in Figure 7-3 is as follows:

1. Multiply the 2° bit of the multiplier times the multiplicand.

2. Multiply the 2! bit of the multiplier times the multiplicand. Shift the result
one position to the left before writing it down.
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3. Repeat step 2 for the 22 bit of the multiplier. Because the 22 bit is a 0, the re-
sult is 0.

4. Repeat step 2 for the 2 bit of the multiplier.

5. Repeating step 2 for the four leading 0’s in the multiplier will have no effect
on the answer, so don’t bother.

6. Take the sum of the four partial products to get the final product of 143,
(Written as an 8-bit number, the product is 1000 11115,.)

EXAMPLE 7-3

Perform the following decimal multiplications. Convert the original deci-
mal numbers to binary and multiply them. Compare answers. (a) 5 X 3;
(b)45 X 3;(c) 15 X 15;(d) 23 X 9.

Solution:
Decimal Binary V Common
(a) 5 0000 0101 ‘: Misconception
X 73 X w Most errors in binary
15 0000 0101 multiplication occur when
+ 00000 101 students are careless in the
00000 1111 = 0000 1111 = 15,,v vertical alignment of the
addition columns.
(b) 45 0010 1101
X 3 X 0000 0011
135 0010 1101
+ 00101 101
01000 0111 = 1000 0111 = 1354
(c) 15 0000 1111
X 15 X 0000 1111
75 0000 1111
+ 15 00001 111
225 000011 11
+ 0000111 1
0001110 0001 = 1110 0001 = 225,,Y
(d) 23 0001 0111
X 9 X 0000 1001 E Team
207 0001 0111 Discussion
00000 000 Develop a method to deter-
000000 00 mine the value to carry
0001011 1 when adding columns with
0001100 1111 = 1100 1111 = 207,,v several I’s in them, such as
those encountered when
multiplying 15 X 15.
Division

Binary division uses the same procedure as decimal division. Example 7—4 illustrates
this procedure.
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Helpful
Hint
It is beneficial to review the
procedure for base 10 long

division that you learned in
grade school.
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EXAMPLE 7-4

Perform the following decimal divisions. Convert the original decimal num-
bers to binary and divide them. Compare answers. (a) 9 + 3; (b) 35 + 5;
(¢) 135 + 15;(d) 221 + 17.

Solution:
Decimal Binary
(a) 3 11 =3,V
3) 9 0000 0011)0000 1001
-9 - 11
0 11
-1
0
(b) 7 111 = 7,0V
5) 35 0000 0101)0010 0011
- 35 - 101
0 111
— 101
101
— 101
0
() 9 1001 = 9,,v
15) 135 0000 1111)1000 0111
- 135 — 111 1
0 1111
— 1111
0
(d) 13 1101 = 13,,v
17) 221 0001 0001)1101 1101
- 17 — 1000 1
51 101 01
51 — 100 01
0 1 0001
— 10001
0

Review Questions
7-1. Binary addition in the least significant column deals with how many
inputs and how many outputs?

7-2. In binary subtraction, the borrow-out of the least significant column
becomes the borrow-in of the next-more-significant column. True or false?

7-3. Binary multiplication and division are performed by a series of addi-
tions and subtractions. True or false?
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7-2  Two’s-Complement Representation

The most widely used method of representing binary numbers and performing arith-
metic in computer systems is by using the two’s-complement method. With this
method, both positive and negative numbers can be represented using the same format,
and binary subtraction is greatly simplified.

All along we have seen representing binary numbers in groups of eight for a
reason. Most computer systems are based on 8- or 16-bit numbers. In an 8-bit system,
the total number of different combinations of bits is 256 (2%); in a 16-bit system, the
number is 65,536 (2'%).

To be able to represent both positive and negative numbers, the two’s-complement
format uses the most significant bit (MSB) of the 8- or 16-bit number to signify
whether the number is positive or negative. The MSB is therefore called the sign bit
and is defined as O for positive numbers and 1 for negative numbers. Signed two’s-
complement numbers are shown in Figure 7-4.

D;D¢DsD,D3D>D D,

Sign bit
@

DysD14D3D,D11D1gDgDgD7DsDsD D3 D, DDy

\

Sign bit
(b)

Figure 7-4 Two’s-complement numbers: (a) 8-bit number; (b) 16-bit number.

The range of positive numbers in an 8-bit system is 0000 0000 to 0111 1111 (O
to 127). The range of negative numbers is 1111 1111 to 1000 0000 (—1 to —128). In
general, the maximum positive number is equal to 2V~ — 1, and the maximum nega-
tive number is —(2N _1), where N is the number of bits in the number, including the
sign bit (e.g., for an 8-bit positive number, 287! — 1 = 127).

A table of two’s-complement numbers can be developed by starting with some
positive number and continuously subtracting 1. Table 7-3 shows the signed two’s-
complement numbers from +7 to —8.

Converting a decimal number to two’s complement, and vice versa, is simple
and can be done easily using logic gates, as we will see later in this chapter. For now,
let’s deal with 8-bit numbers; however, the procedure for 16-bit numbers is exactly
the same.

Steps for Decimal-to-Two’s-Complement Conversion
1. If the decimal number is positive, the two’s-complement number is the true
binary equivalent of the decimal number (e.g., +18 = 0001 0010).
2. If the decimal number is negative, the two’s-complement number is found by

(a) Complementing each bit of the true binary equivalent of the decimal
number (this is called the one’s complement).

(b) Adding 1 to the one’s-complement number to get the magnitude bits.
(The sign bit will always end up being 1.)

SECTION 7-2 | TWO’S-COMPLEMENT REPRESENTATION
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Discussion

Try to represent the number
160, in two’s-complement
for an 8-bit system. Why

doesn’t it work?
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TABLE 7-3 | Signed Two’s-Complement
Numbers +7 Through —8

Decimal Two’s Complement
+7 0000 0111
+6 0000 0110
+5 0000 0101
+4 0000 0100
+3 0000 0011
+2 0000 0010
+1 0000 0001

0 0000 0000
-1 1111 1111
-2 1111 1110
-3 1111 1101
—4 1111 1100
=5 1111 1011
-6 1111 1010
-7 1111 1001
-8 1111 1000

Steps for Two's-Complement-to-Decimal Conversion

1. If the two’s-complement number is positive (sign bit = 0), do a regular
binary-to-decimal conversion.

2. If the two’s-complement number is negative (sign bit = 1), the decimal sign
will be —, and the decimal number is found by

(a) Complementing the entire two’s-complement number, bit by bit.
(b) Adding 1 to arrive at the true binary equivalent.
(¢) Doing a regular binary-to-decimal conversion to get the decimal numeric
value.
The following examples illustrate the conversion process.

7 EXAMPLE 7-5
c Common
Misconception Convert +35;, to two’s complement.

As soon as some students
see the phrase ‘““convert to

two’s complement,” they go True binary = 0010 0011
ahead with the procedure

Solution:

Two’s complement = 0010 0011 Answer

for negative numbers
whether the original
number is positive or
negative.

EXAMPLE 7-6

Convert —35;, to two’s complement.
Solution:
True binary = 0010 0011
One’s complement = 1101 1100
Add1l = +1
Two’s complement = 1101 1101 Answer
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EXAMPLE 7-7

Convert 1101 1101 two’s complement back to decimal.
Solution: The sign bit is 1, so the decimal result will be negative.

Two’s complement = 1101 1101
Complement = 0010 0010

Add1 = +1
True binary = 0010 0011
Decimal complement = —35 Answer

EXAMPLE 7-8

Convert —98;, to two’s complement.

Solution:
True binary = 0110 0010
One’s complement = 1001 1101
Add1 = +1
Two’s complement = 1001 1110 Answer

EXAMPLE 7-9

Convert 1011 0010 two’s complement to decimal.
Solution: The sign bit is 1, so the decimal result will be negative.

Two’s complement = 1011 0010
Complement = 0100 1101

Add1l = +1
True binary = 0100 1110
Decimal complement = —78 Answer

Review Questions

7-4. Which bit in an 8-bit two’s-complement number is used as the sign bit?
7-5. Are the following two’s-complement numbers positive or negative?
(a) 1010 0011
(b) 0010 1101
(c) 1000 0000

7-3  Two’s-Complement Arithmetic

All four of the basic arithmetic functions involving positive and negative numbers can
be dealt with very simply using two’s-complement arithmetic. Subtraction is done by
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adding the two two’s-complement numbers. Thus, the same digital circuitry can be
used for additions and subtractions, and there is no need always to subtract the smaller
number from the larger number. We must be careful, however, not to exceed the
maximum range of the two’s-complement number: +127 to —128 for 8-bit systems,
and +32,767 to —32,768 for 16-bit systems (+2V"1 — 1 to —2V71).

When adding numbers in the two’s-complement form, simply perform a regular
binary addition to get the result. When subtracting numbers in the two’s-complement
form, convert the number being subtracted to a negative two’s-complement number
and perform a regular binary addition [e.g., 5 — 3 = 5 + (—3)]. The result will be a
two’s-complement number, and if the result is negative, the sign bit will be 1.

Work through the following examples to familiarize yourself with the addition
and subtraction procedure.

EXAMPLE 7-10

Add 19 + 27 using 8-bit two’s-complement arithmetic.
Solution:

19 = 0001 0011
27 = 0001 1011

EXAMPLE 7-11

Perform the following subtractions using 8-bit two’s-complement arithmetic.
(a) 18 — 7,

(b) 21 — 13;

(c) 118 — 54,

(d) 59 — 9.

Solution:

(a) 18 — 71is the same as 18 + (—7), so just add 18 to negative 7.

+18 = 0001 0010
—7 = 1111 1001
Sum = 0000 1011 = 11,

Note: The carry-out of the MSB is ignored. (It will always occur for posi-
tive sums.) The 8-bit answer is 0000 1011.

(b) +21 = 0001 0101
—13 = 1111 0011
Sum = 0000 1000 = 8,,

(¢) +118 = 0111 0110
—54 = 1100 1010
Sum = 0100 0000 = 644,

(d) +59 = 0011 1011
—96 = 1010 0000
Sum = 1101 1011 = —37,,
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Review Questions

7-6. Which of the following decimal numbers cannot be converted to 8-bit
two’s-complement notation?

(a) 89

(b) 135

(¢) —107

(d) —144
7-7. The procedure for subtracting numbers in two’s-complement notation
is exactly the same as for adding numbers. True or false?

7-8. When subtracting a smaller number from a larger number in two’s
complement, there will always be a carry-out of the MSB, which will be
ignored. True or false?

7-4 Hexadecimal Arithmetic*

Hexadecimal representation, as discussed in Chapter 1, is a method of representing
groups of 4 bits as a single digit. Hexadecimal notation has been widely adopted by
manufacturers of computers and microprocessors because it simplifies the documenta-
tion and use of their equipment. Eight- and 16-bit computer system data, program in-
structions, and addresses use hexadecimal to make them easier to interpret and work
with than their binary equivalents.

Hexadecimal Addition

Remember, hexadecimal is a base 16 numbering system, meaning that it has 16 differ-
ent digits (as shown in Table 7-4). Adding 3 + 6 in hex equals 9, and 5 + 7 equals C.
But, adding 9 + 8 in hex equals a sum greater than F, which will create a carry. The
sum of 9 + 81is 17, which is 1 larger than 16, making the answer 11 4.

TABLE 7-4 | Hexadecimal Digits with Their
Equivalent Binary and Decimal Values

Hexadecimal Binary Decimal
0 0000 0
1 0001 1
2 0010 2
3 0011 3
4 0100 4
5 0101 5
6 0110 6
7 0111 7
8 1000 8
9 1001 9
A 1010 10
B 1011 11
C 1100 12
D 1101 13
E 1110 14
F 1111 15

“Most scientific calculators perform number base conversions and arithmetic. This allows you to enter binary, octal, decimal, or
hexadecimal numbers and perform any of the arithmetic operations. In this chapter we will learn the step-by-step procedures for
performing these operations by hand, but as the numbers get more complex it is best to use your calculator for these functions.
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The procedure for adding hex digits is as follows:

1. Add the two hex digits by working with their decimal equivalents.
2. If the decimal sum is less than 16, write down the hex equivalent.

3. If the decimal sum is 16 or more, subtract 16, write down the hex result in
that column, and carry 1 to the next-more-significant column.

Work through the following examples to familiarize yourself with this procedure.

EXAMPLE 7-12

Add 9 + Cin hex.
Solution: C is equivalent to decimal 12.
12+ 9 =21

Because 21 is greater than 16: (a) subtract 21 — 16 = 5, and (b) carry 1 to
the next-more-significant column. Therefore,

9+ C =154 Answer

EXAMPLE 7-13

Add 4F + 2D in hex.
Solution:

4 F
+2D
7C Answer

Explanation: F + D = 15 + 13 = 28, whichis 12 with a carry (28 — 16 =
12). The 12 is written down as C; 4 + 2 + carry = 7.

EXAMPLE 7-14

Add A7C5 + 2DAS in hex.
Solution:

A7C5
+ 2DA38
D56D Answer

Explanation: 5 + 8 = 13, which is D, C + A = 22, which is 6 with a
carry.7 + D + carry = 21, whichis S withacarry. A + 2 + carry = 13,
which is D.

Alternative Method: An alternative method of hexadecimal addition, which you
might find more straightforward, is to convert the hex numbers to binary and

272 CHAPTER 7 | ARITHMETIC OPERATIONS AND CIRCUITS



perform a regular binary addition. The binary sum is then converted back to hex. For
example:

4F_, 0100 1111,

+2D " 40010 1101,
0111 11002 = 7C16

Hexadecimal Subtraction

Subtraction of hexadecimal numbers is similar to decimal subtraction, except that
when you borrow 1 from the left, the borrower increases in value by 16. Consider the
hexadecimal subtraction 24 — 0C.

24
- 0C
18
Explanation: We cannot subtract C from 4, so the 4 borrows 1 from the 2. This
changes the 2 to a 1, and the 4 increases in value to 20 (4 + 16 = 20). Now,
20— C=20—12=8,and 1 — 0 = 1. Therefore,
24 — 0C = 18

The next two examples illustrate hexadecimal subtraction.

EXAMPLE 7-15

Subtract D7 — A8 in hex.
Solution:

D7
— A8

2F Answer

Explanation: 7 borrows from the D, which increases its value to 23
(7 + 16 = 23), and 23 — 8 = 15, which is an F. D becomes a C, and
C—A=12-10=2.

EXAMPLE 7-16

Subtract AOSC — 24CA in hex.
Solution:

A05C
— 24CA
7B92 Answer

Explanation: C — A = 12 — 10 = 2. The 5 borrows from the 0, which
borrows fromthe A (5 + 16 = 21); 21 — C = 21 — 12 = 9. The 0 bor-
rowed from the A, but it was also borrowed from, so it is now a 15;
15 — 4 = 11, which is a B. The A was borrowed from, so it is now a 9;
9—-2=17.
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Review Questions

7-9. Why is hexadecimal arithmetic commonly used when working with
8-, 16-, and 32-bit computer systems?

7-10. When adding two hex digits, if the sum is greater than
(9, 15, 16), the result will be a two-digit answer.

7-11. When subtracting hex digits, if the least significant digit borrows
from its left, its value increases by (10, 16).

7-5 BCD Arithmetic

If human beings had 16 fingers and toes, we probably would have adopted hexadeci-
mal as our primary numbering system instead of decimal, and dealing with micro-
processor-generated numbers would have been so much easier. (Just think how much
better we could play a piano, too!) But, unfortunately, we normally deal in base 10 dec-
imal numbers. Digital electronics naturally works in binary, and we have to group four
binary digits together to get enough combinations to represent the 10 different decimal
digits. This 4-bit code is called binary-coded decimal (BCD).

So what we have is a 4-bit code that is used to represent the decimal digits that
we need when reading a display on calculators or computer output. The problem arises
when we try to add or subtract these BCD numbers. For example, digital circuitry
would naturally like to add the BCD numbers 1000 + 0011 to get 1011, but 1011 is an
invalid BCD result. (In Chapter 1, we described the range of valid BCD numbers as
0000 to 1001.) Therefore, when adding BCD numbers, we have to build extra circuitry
to check the result to be certain that each group of 4 bits is a valid BCD number.

BCD Addition

Addition is the most important operation because subtraction, multiplication, and divi-
sion can all be done by a series of additions or two’s-complement additions.
The procedure for BCD addition is as follows:
1. Add the BCD numbers as regular true binary numbers.
2. If the sum is 9 (1001) or less, it is a valid BCD answer; leave it as is.

3. If the sum is greater than 9 or there is a carry-out of the MSB, it is an invalid
BCD number; do step 4.

4. If it is invalid, add 6 (0110) to the result to make it valid. Any carry-out of
the MSB is added to the next-more-significant BCD number.

5. Repeat steps 1 to 4 for each group of BCD bits.

Use this procedure for the following example.

EXAMPLE 7-17
Convert the following decimal numbers to BCD and add them. Convert the
result back to decimal to check your answer.
(@ 8 +7;
(b) 9 +9;
(c) 52 + 63;
(d) 78 + 69.
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Solution:

(a) 8 = 1000
+ 7= 0111

Sum = 1111 (invalid BCD, so add six)
Add 6 = 0110

1 0101 = 0001 010lgcp = 15,0v
(b) 9= 1001

+9= 1001
Sum = 1 0010 (invalid because of carry)
cy
Add6 = _ 0110

1 1000 = 0001 1000gcp = 18;0v

(¢) 52 = 0101 0010
+63 = 0110 0011
Sum = 1011.0101

Add6 = 0110 —invalid

1 0001 0101 = 0001 0001 0101 = 115,4v

d) 78 = 0111 1000
+ 69 = 0110 1001
Sum = 1110'\0001 (both groups of 4
cy BCD bits are invalid)
Add 6 = 0110
1110 0111
Add6 = 0110
1 0100 0111 = 0001 0100 0111 = 147,/

When one of the numbers being added is negative (such as in subtraction), the
procedure is much more difficult, but it basically follows a complement-then-add
procedure, which is not covered in this book but is similar to that introduced in
Section 7-3.

Now that we understand the more common arithmetic operations that take place
within digital equipment, we are ready for the remainder of the chapter, which explains
the actual circuitry used to perform these operations.

Review Questions

7-12. When adding two BCD digits, the sum is invalid and needs correc-
tion if it is or if

7-13. What procedure is used to correct the result of a BCD addition if the
sum is greater than 9?

7-6 Arithmetic Circuits

All the arithmetic operations and procedures covered in the previous sections can be
implemented using adders formed from the basic logic gates. For a large number of
digits we can use medium-scale-integration (MSI) circuits, which actually have sev-
eral adders within a single integrated package.
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- l Helpful

Hint
To make yourself feel good
about your new found
knowledge, close your book
and design a circuit to
produce the sum and carry
function for a half-adder
[i.e., a circuit that provides
the table in Figure 7-5(b)].
Next, how about the
full-adder?
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Basic Adder Circuit

By reviewing the truth table in Figure 7-5, we can determine the input conditions that
produce each combination of sum and carry output bits. Figure 7-5 shows the addition
of two 2-bit numbers. This could easily be expanded to cover 4-, 8-, or 16-bit addition.
Notice that addition in the least-significant-bit (LSB) column requires analyzing only
two inputs (A, plus By) to determine the output sum () and carry (C,,), but any more
significant columns (2! column and up) require the inclusion of a third input, which is
the carry-in (C;,) from the column to its right. For example, the carry-out (C,,,) of the
2° column becomes the carry-in (Cy,) to the 2! column. Figure 7-5(c) shows the inclu-
sion of a third input for the truth table of the more significant column additions.

| 2 inputs 2 outputs
Cin Cin . !
A Ao E : 4y | By || Zo |C0u[
+ B, By, + |
o 0 0 0 0
%, 0 | 1 1 0
+ + : ! 1 0 1 0
C()l]l C()Ul S /1‘ 1 1 O 1
(a) ()
3 inputs 2 outputs
A] B] Cin z“1 Cout
0 0 0 0 0
0 0 1 1 0
0 1 0 1 0
0 1 1 0 1
1 0 0 1 0
1 0 1 0 1
1 1 0 0 1
1 1 1 1 1

(©)

Figure 7-5 (a) Addition of two 2-bit binary numbers; (b) truth table for the LSB addition;
(c) truth table for the more significant column.

Half-Adder

Designing logic circuits to automatically implement the desired outputs for these truth
tables is simple. Look at the LSB truth table; for what input conditions is the X bit
HIGH? The answer is A or B HIGH but not both (exclusive-OR function). For what in-
put condition is the C,, bit HIGH? The answer is A and B HIGH (AND function).
Therefore, the circuit design to perform addition in the LSB column can be imple-
mented using an exclusive-OR and an AND gate. That circuit is called a half-adder
and is shown in Figure 7-6. If the exclusive-OR function in Figure 7-6 is implemented

Ay ﬁ _ _

B D Zo=AgBy + 408y
0 7

} Cnul = A()BO

Figure 7-6 Half-adder circuit for addition in the LSB column.
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—
R J Coul - A(JBU

Xo=AgBy +ApBy

By

Figure 7-7  Alternative half-adder circuit built from an AND-NOR-NOR configuration.

using an AND-NOR-NOR configuration, we can tap off the AND gate for the carry,
as shown in Figure 7-7. [The AND-NOR-NOR configuration is an Ex-OR, as proved
in Figure 7-5(c).]

Full-Adder

As you can see in Figure 7-5, addition in the 2' (or higher) column requires three in-
puts to produce the sum (Z;) and carry (C,,,) outputs. Look at the truth table [Figure
7-5(c)]; for what input conditions is the sum output (2;) HIGH? The answer is that the
>, bit is HIGH whenever the three inputs (A;, By, C;,) are odd. From Chapter 6, you
may remember that an even-parity generator produces a HIGH output whenever the
sum of the inputs is odd. Therefore, we can use an even-parity generator to generate
our ; output bit, as shown in Figure 7-8.

) ;
B,

%, =1 for odd
Cin 7 number of HIGH

inputs

Figure 7-8 The sum () function of the full-adder is generated from an even-parity generator.

How about the carry-out (C,,) bit? What input conditions produce a HIGH at C,,,?
The answer is that C,,, is HIGH whenever any two of the inputs are HIGH. Therefore,
we can take care of C,,, with three ANDs and an OR, as shown in Figure 7-9.

C,, = 1 for any
t J
C' ou

m two inputs HIGH

Cin 1

Figure 7-9 Carry-out (C,,,) function of the full-adder.

The two parts of the full-adder circuit shown in Figures 7-8 and 7-9 can be com-
bined to form the complete full-adder circuit shown in Figure 7-10. In the figure, the ;
function is produced using the same logic as that in Figure 7-8 (an Ex-OR feeding an
Ex-OR). The C,, function comes from A;B; or C;, (A;B; + A;B;). Prove to yourself
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that the Boolean equation at C,, will produce the necessary result. [Hint: Write the
equation for C, from the truth table in Figure 7-5(c).] Also, Example 7-18 will help
you better understand the operation of the full-adder.

) >

in

Figure 7-10 Logic diagram of a full-adder.

F EXAMPLE 7-18
1 Helpful

Hint Apply the following input bits to the full-adder of Figure 7-10 to demon-
Wow, you should be getting strate its operation (A; = 0, B; = 1, G, = 1).

excited about this! We have
actually designed and
demonstrated a circuit that

Solution: The full-adder operation is shown in Figure 7-11.

adds two numbers. We are 0
developing the fundamental
building block for the

modern computer. C

out =
A =0 3 1
31:1—..—)> >

1

Correct
answer

. 7
C, =1 )D 21=0

Figure 7-11 Full-adder operation for Example 7-18.

EXAMPLE 7-19

VHDL Description of a Full-Adder

Write the VHDL statements required to implement the full-adder of Figure
7-8 and 9. Run a simulation to check the results of the ¥, and C,, bits.
Compare the simulator output to Figure 7-5(c).

Solution: The VHDL program is shown in Figure 7-12. Two equations
are in the architecture of the program depicting the Boolean equation for
the sum and carry. These are called concurrent statements because they
synthesize two logic circuits that will be executed concurrently (at the same
time) as soon as the inputs to the logic (a;, b, and ¢;,) are provided. The
simulation of the circuitry is shown in Figure 7-13. As you can see, the sum
bit suml is HIGH for any odd input and the carry cout is HIGH whenever
any two or more input bits are HIGH.
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_loixi

LIBRARY ieee; 0000 e |
USE ieee._std logic 1164_ALL; -— Full Adder -- =

EHTITY ex7_19 IS

PORT(
al : IH std_logic;
b1 : IH std logic;
cin : IM std_logic;
sumi : OUT std_logic;
cout : OUT std_logic
b
EHD ex7 19 ;
exr_19
ARCHITECTURE arc OF ex7_19 IS
= =—al  suml [—3
BEGIN b1 J
r_Cl::l.'lut{=l:él1 AHMD b1) OR (a1 aHD cin) OR (b1 AND cin); - oin
sumi<{={a1 X0R b1) XOR cin;

EHD arc; @ ex7_19.vhd i
[hine 18 ¢ 4| N (b)

- Concurrent statements

(a)
Figure 7-12  Solution for the full-adder: (a) VHDL listing; (b) block symbol file (bsf).

&b o719 Simulation Report - |I:I|5|

Simulation Waweforms

fazter Time Bar 0ps j_*l Pointer; | Ops Interval; | Ops Start; | End |

Name alue at ps 20 us 40us B0 us B0us |
0 ps IjS
= B0 |
= BO _________J"--————1_________J—————————-t::::
d cin BO T [ | I | I
kod sum EO | | | | 1
=4 T

icout BO I
cout is HIGH for 2 or more HIGH inputs

I
suml is HIGH for odd number of HIGH inputs

@ ex7_19.vwf

b 4

Figure 7-13 The simulation proving the operation of the full-adder.

FULL-ADDER SIMULATION

In Figure 7—14, MultiSIM® is used to simulate the operation of a full-adder.
It has three inputs and two outputs. The input level at A/, BI, and Cin are
shown in their LOW position but can be made HIGH by pressing the ap-
propriate key on your computer keyboard (A, B, or C). The Sum and Carry
outputs have LED probes connected to them to show when the Sum bit or
Carry bit is HIGH.
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—7—5V |
o 3 AND2 A
_ Cout
- Key= A Al _ )) OR2 |
EOR2
O
B
. AND2
Key =B Bl —Q
- o |
_ H > Sun
Key -C Cin EOR2
C
()I @
= fign 14
0 | 1 | 2 | 3 | 4 | 5 |
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Figure 7-14 Simulation of a full-adder constructed of AND, OR, and Ex-OR gates.

MultiSIM Exercise: On a piece of scrap paper, construct a truth table list-
ing all possible states of the three inputs. Use MultiSIM to open file
fig7_14 from the textbook website. Run the simulation and complete the
truth table for the results that you observe at Sum and Cout as you step
through each combination of A/, B1, and Cin. Does the truth table match
Figure 7-5(¢c)?

(a) Study your truth table and describe in words what it takes to get a
HIGH at the Sum output.

(b) Study your truth table and describe in words what it takes to get a
HIGH at the Cout output.

Block Diagrams

Now that we know the construction of half-adder and full-adder circuits, we can sim-
plify their representation by just drawing a box with the input and output lines, as shown
in Figure 7-15. When drawing multibit adders, a block diagram is used to represent the
addition in each column. For example, in the case of a 4-bit adder, the 29 column needs
only a half-adder because there will be no carry-in. Each of the more significant
columns requires a full-adder, as shown in Figure 7-16.

HA FA

™M

(@) (b)
Figure 7-15 Block diagrams of (a) half-adder; (b) full-adder.
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(MSB) (LSB)

Ay B, A, B, A, B, Ao B,
4-bit addition:
bit representations A B A B ( A B ( A B

Ay Ay A, Ay FA FA FA HA

+ B3 B, B) By
e — C, = C, z C, = C, s
T4Z3X, 2 % } L

%y Z; pY) Z Zg

Figure 7-16 Block diagram of a 4-bit binary adder.

Notice in Figure 7-16 that the LSB half-adder has no carry-in. The carry-out
(Coup) of the LSB becomes the carry-in (C;,) to the next full-adder to its left. The carry-
out (Cyyy) of the MSB full-adder is actually the highest-order sum output (Z).

Review Questions

7-14. Name the inputs and outputs of a half-adder.

7-15. Why are the input requirements of a full-adder different from those
of a half-adder?

7-16. The sum output () of a full-adder is 1 if the sum of its three inputs
is (odd, even).

7-17. What input conditions to a full-adder produce a 1 at the carry-out
(Cow)?

7-7 Four-Bit Full-Adder ICs

Medium-scale-integration (MSI) ICs are available with four full-adders in a single
package. Table 7-5 lists the most popular adder ICs. Each adder in the table contains
four full-adders, and all are functionally equivalent. However, their pin layouts differ
(refer to your data manual for the pin layouts). They each will add two 4-bit binary
words plus one incoming carry. The binary sum appears on the sum outputs (2 to ;)
and the outgoing carry.

TABLE 7-5 | MSI Adder ICs

Device Family Description

7483 TTL 4-bit binary full-adder, fast carry
74HC283 CMOS 4-bit binary full-adder, fast carry
4008 CMOS 4-bit binary full-adder, fast carry

Figure 7-17 shows the functional diagram, the logic diagram, and the logic symbol
for the 7483. In the figure, the least significant binary inputs (2°) come into the A,B, ter-
minals, and the most significant (2°) come into the A,B, terminals. (Be careful; depending
on which manufacturer’s data manual you are using, the inputs may be labeled A;B; to
AyB, or AgB, to A3Bs). The carry-out (C,,) from each full-adder is internally connected to
the carry-in of the next full-adder. The carry-out of the last full-adder is brought out to a
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14

out

Fast-look-ahead
cO‘.lt
carry
Ay
FA, P
By
G
C,
Ay ¢
FA, Z3
B
3 Ci
C,
A, ¢
FA, Z,
B,
G
A, ¢
FA, z
B,
G
Cin
7483
(a)
7483
(C)] —_
2] ( Cin
AB,
A,B,
©) 5
, 3053
A.B,
A+ B
AB,
2) Internal ITB;
T connections —_
3 A.B,
A, + B,
A3+ By
A.B,
(15) A3+ B, ZD_
2, ABy
~ A, + B,
Vee=Pin5
GND =Pin 12

() =Pin numbers

Figure 7-17 The 7483 4-bit full-adder: (a) functional diagram; (b) logic diagram;
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1011 8 7 3 4 1 16

A, B, Ay B, Ay By A, B,

13— Cy 7483 Cou — 14
0%, 3 %,
9 6 2 15
Vee=Pin5
GND = Pin 12

(©)

Figure 7-17 (Continued) (c) logic symbol.

terminal to be used as the sums (25) output or to be used as a carry-in (C;,) to the next full-
adder IC if more than 4 bits are to be added (as in Example 7-20).

Something else that we have not seen before is the fast-look-ahead carry [see
Figure 7-17(a)]. This is very important for speeding up the arithmetic process. For ex-
ample, if we were adding two 8-bit numbers using two 7483s, the fast-look-ahead
carry evaluates the four low-order inputs (A;B; to A4B,) to determine if they are going
to produce a carry-out of the fourth full-adder to be passed on to the next-higher-order
adder IC (see Example 7-20). In this way, the addition of the high-order bits (2*t027)
can take place concurrently with the low-order (2° to 2%) addition without having to
wait for the carries to propagate, or ripple, through FA; to FA, to FA; to FA, to be-
come available to the high-order addition. A discussion of the connections for the ad-
dition of two 8-bit numbers using two 7483s is presented in the following example.

EXAMPLE 7-20

Show the external connections to two 4-bit adder ICs to form an 8-bit adder
capable of performing the following addition:

ArAgAsA4A3ALA Ay

+ B;B4BsB,B,B,B,B,
S 26352, 553,53,

Solution: We can choose any of the IC adders listed in Table 7-5 for our
design. Let’s choose the 74HC283, which is the high-speed CMOS version
of the 4-bit adder (it has the same logic symbol as the 7483). As you can
see in Figure 7-18, the two 8-bit numbers are brought into the A;B;-to-
AyB, inputs of each chip, and the sum output comes out of the 24-to-%,
outputs of each chip.

The C;, of the least significant addition (A, + By) is grounded (0)
because there is no carry-in (it acts like a half-adder), and if it were left
floating, the IC would not know whether to assume a 1 state or O state.

The carry-out (C,,,) from the addition of A; + B3 must be connected
to the carry-in (C;,) of the A, + B, addition, as shown. The fast-look-ahead
carry circuit ensures that the carry-out (C,,,) signal from the low-order addi-
tion is provided in the carry-in (C;,) of the high-order addition within a very
short period of time so that the A, + B, addition can take place without hav-
ing to wait for all the internal carries to propagate through all four of the low-
order additions first. (The actual time requirements for the sum and carry
outputs are discussed in Chapter 9, when we look at IC specifications.)
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What if you only wanted to
add two 6-bit numbers?

8-bit inputs
Team
Discussion A; B; Ag Bg As Bs A, B, Ay By Ay By A By Ay By

How could you get at the Ay By A3 By A, By A B Ay By A3 By Ay B, A B
internal carry to output
0 E.? Cout 74HC283 Gy Cout 74HC283 c, 1
2, 2, s, 2, s, 2, s, T, =
g %, b 25 z, 3, s, %, %0
(High-order) (Low-order)
Sum output

Figure 7-18 8-bit binary adder using two 74HC283 ICs.

EIGHT-BIT BINARY ADDER SIMULATION

In Figure 7-19, MultiSIM® is used to simulate the operation of an 8-bit bi-
nary adder similar to Figure 7-18. MultiSIM® uses the label CO for C;, and
C4 for C,y,. The circuit is hard-wired to add the numbers 29 (0001 1101,)
plus 20 (0001 0100,). The Sum output LEDs indicate the correct answer of
0011 0001,, which is a decimal 49. Also notice for this case that there is a
carry out of the low-order 4 bits to the high-order 4 bits.

sV "

v
<

<t 0 A - <t o0 Al — o <t 0~ <t 0 Al — (=]
<<<< mmmm O <<<< mmmm O
74HC283 T4HC283
N NN
S=== ) S=== )
e ReRo] (o= Re R
nwnwnvnwn n v unvnwn
=t S =t e S

o

Sum§

Low-order to
High-order carry

@ﬁg?_m

Figure 7-19  Simulation of an 8-bit binary adder showing 29 + 20 = 29.
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MultiSIM® Exercise: Use MultiSIM® to open file fig7_19 from the text-
book website. Run the simulation and observe that 29 + 20 equals 49.

(a) Reconnect the inputs to determine the sum of 37 + 43.
(b) Reconnect the inputs to determine the sum of 200 + 88.

Review Questions

7-18. All the adders in the 7483 4-bit adder are full-adders. What is done
with the carry-in (C;,) to make the first adder act like a half-adder?

7-19. What is the purpose of the fast-look-ahead carry in the 7483 IC?

7-8  VHDL Adders Using Integer Arithmetic

The VHDL language allows us to describe the addition process as an arithmetic ex-
pression using the arithmetic operator and a new data type called integer. Previously
we declared inputs and outputs as std_logic or std_logic_vector. We used that data type
to represent a 1 or a 0, or a vector of 1’s and 0’s (array). The integer data type allows
us to specify inputs and outputs as numeric values other than 1 and 0 and perform arith-
metic operations on them.

When declaring an input or output as an integer, you must also specify the range
of the value. For example, if the inputs are for a 4-bit adder, the range of each number
will be 0 to 15 (0000, to 1111,). The result of a 4-bit addition will be a 5-bit sum hav-
ing a range of 0 to 31 (00000, to 11111,). When synthesizing the circuit, the software
determines how many input and output bits will be required and assigns the correct
number of pins to satisfy the range requested in the integer declare. For example, if the
range is 0 to 15, the software knows to allocate four individual input pins for that input
name. Figure 7-20 shows a VHDL program that uses the integer type to form a 4-bit
binary adder. The assignment statement in the architecture adds the astring plus the
bstring with the cin.

i
LIBRARY ieee; 0 e [
USE ieee.std logic 1164.all; —- 4-bit Binary Adder using —- _|

-— Integer Arithmetic =
ENTITY adder 4h 1S = @ o

PORT
{
cin = IN integer RANGE 8 TO 1;
astring : IH integer RAHGE 8 TO 15;
bstring : IN integer RAHGE @ T0 15;
sum_string : out integer RAHGE @ TO 31
}: adder_db
EMD adder_4b ;
x— cin SUMm_string [, 0]  pe—
RRCHITECTURE arc OF adder_4b IS )'P astring[3..0]
BEGIN et hztring [3...0]
sum_string<{=astring+bstring+cin; )
= inst
o Rl @adder_élb.vhd

(a)

Figure 7-20 Using the integer data type in a VHDL program to form a 4-bit adder:
(a) VHDL listing; (b) block symbol file (bsf).

SECTION 7-8 | VHDL ADDERS USING INTEGER ARITHMETIC 285




To verify the circuit operation, the simulation file shown in Figure 7-21 was
created. The values used for astring, bstring, and cin are arbitrary, and the radix used
for the string values is hexadecimal. Notice the additional output called sum_string4.
Sum_string4 is the fifth bit of the sum, which would have to be used as a carry-out if
this was to feed the carry-in of another 4-bit adder, like we did in Figure 7-18. It is

& adder 4b Simulation Repork - II:I|£|
Simulation Waveforms

M azter Time Bar: | 0pz 4| k| Pointer: 0pz Interval: | 0 ps Start: | End: |

) vaie at | PP 40us 80us 120 us 16.0ug
arme Ops s
1

o | cin BO | |
| | [ asting HO 0123 ndnonbarsn8rasayByCyDrEXNF
Ebstring HO NS AN AERD AFEN SN ANEN SRR EERD
=4 sum_string HOO | fO0 07 0304 07 3 08 5 09 0 OF %10 % 123772 10D Y 0F ¥ 1213
E sum_skringl4] B0

overflow or carry-out bit

@ adder_4b.vwf

Figure 7-21 The simulation file for the 4-bit adder of Figure 7-20.

& RTL Yiewer =l01
Hiarch&a' s Page Title: I adder_4b Page: I 1of jv
= Hieral SC
2B adder_db
:I:I: Frimitives
£ Pins
5= Input
(=== astring[3..0] hatring[3. 0]
¥ astring[0]
...2= astring[1]
- astring[2]
...2= astring[3]
=-== bstring[3..0]
-..== bstring[0]
.2 hstring[1]
-.2= bstring[2]
.27 hstring[3]
= Cin
=== Qutput
EID sum_string(4..0]
I:b sum_string[0]
I::= sur_string[1]
I:b sum_string[2]

e A

o= sum_string[ 3] =

é....l:::sum_string[ﬂll @‘%@@|||ﬂ| ‘ﬁﬁ|&|%ﬁ:
K |

Hierarchy List ;{ Fird f

Y

| v

cin

-

Yoz

Figure 7-22 The RTL window shows the generation of inputs and outputs as well as a
graphical interpretation of the addition function.
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also used to indicate that the sum exceeded (overflowed) the maximum value of a
4-bit number.

It is informative to look at the RTL viewer to see how Quartus® resolved the
astring, bstring, and sum_string integers.

Choose Tools > Netlist Viewers > RTL Viewer

As you can see in Figure 7-22 the RTL viewer gives us two important windows.
In the Hierarchy List you can see that the astring and bstring inputs are set up with 4
bits each to accommodate the integer range of O to 15. The output string (sum_string)
is set up with 5 bits to accommodate the integer range of O to 31. The second window
shows us a graphical look at the addition function.

7-9  System Design Applications

Each arithmetic operation discussed in Sections 7—1 through 7-5 can be performed by
using circuits built from IC adders and logic gates. First, we will design a circuit to per-
form two’s-complement arithmetic and then, we will design a BCD adder.

Two’s-Complement Adder/Subtractor Circuit

A quick review of Section 7-3 reminds us that positive two’s-complement numbers
are exactly the 